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CHAPTER

1 ABOUT THIS GUIDE

Revision history

Revision Date Description

A November 2018 Initial release of this document

Intended audience

This documentation is intended for the following audience: Users who
plan, install, configure, operate, or maintain ControlEdge™ 900 and
2020 controllers running the eCLR (IEC 61131-3) execution
environment.

Prerequisite skills

Knowledge of SCADA systems and experience of working in a
Microsoft Windows environment are required.

Introduction to ControlEdge Technology

Item Description

ControlEdge
PLC

ControlEdge 900 controllers running the eCLR (IEC 61131-3) execution
environment with PLC software options configured with ControlEdge
Builder.

ControlEdge
RTU

ControlEdge 2020 controllers running the eCLR (IEC 61131-3)
execution environment with RTU software options configured with
ControlEdge Builder.

ControlEdge
UOC

ControlEdge 900 controllers running the Honeywell control execution
environment (CEE) configured with Experion Control Builder.

Special terms

The following table describes some commonly used industry-wide
and Honeywell-specific terminology:
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Terminology Description

AI Analog Input

AO Analog Output

ControlEdge
Builder

A integrated configuration tool to design, configure, program and
maintain ControlEdge controllers.

CDA Control Data Access

CPM Control Processor Module

DD file Device Description file: A DD file is usually a zip file that can be
downloaded from the device vendor’s website. It contains information
about the device type, commands that are supported by the device, and
other devicespecific data. A DD file for a particular field device is used to
describe the device and to interpret messages and the device status.

DI Digital Input

DNP3 Distributed Network Protocol V3.0

DO Digital Output

EDS Electronic Data Sheet: A text file which specifies all the properties of an
EtherNet/IP™ device necessary for a Scanner module to communicate
with it. EDS files my be used in the first step of creating an I/O module
or device block for interfacing to an EtherNet/IP device.

EFM Electronic Flow Measurement

Enron
Modbus

An extension of standard Modbus supports for 32-bit Integer and
Floating Point variables, and historical and flow data.

EPM Expansion Processor Module

Expansion
I/O rack

I/O rack with EPM installed

Experion®
PKS

Experion® Process Knowledge System

FDAP Field Device Access Point

FD Field Device

HART-IP HART-IP extends the HART protocol to Ethernet connected nodes. This
facilitates host level systems and asset management applications to
access and integrate measurement and device diagnostics information
from HART-enabled field devices using the existing plant networking
infrastructure.

12
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Terminology Description

Local I/O
rack

I/O rack with CPM installed (non-redundant)

Meter run Meter run in a flow measurement system represents a physical system
comprising primary flow measurement element supported by devices
measuring secondary parameters like density, pressure, temperature and
composition etc., to determine the quantifiable flow through the
measurement system.

In ControlEdge RTU, meter run is used to calculate quantifiable flow
according to different standards mandated by AGA, API and other
international standards.

Modbus A communication protocol supports communication between Modbus
slave devices and Modbus master devices via serial port or Ethernet
port.

OPC UA An industrial machine-to-machine (M2M) communication protocol is
developed by the OPC Foundation, which provides a path forward from
the original OPC communications model (namely the Microsoft
Windows only process exchange COM/DCOM) to a cross-platform
service-oriented architecture (SOA) for process control, while enhancing
security and providing an information model.

PI Pulse Input

POU Programming Organization Unit

QTR Quantity Transaction Record

RTU Remote Terminal Unit

Redundant
Controller
Rack

Redundant Controller Rack with 2 Power supply slots, 2 CPM slots.

UIO Universal Input/Output Module

SCADA Supervisory Control and Data Acquisition

Related documents

The following list identifies publications that may contain information
relevant to the information in this document.
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n ControlEdge Builder Software Installation User’s Guide

n ControlEdge Builder Software Change Notice

n ControlEdge PLC and ControlEdge RTU Getting started

n ControlEdge 900 Platform Hardware Planning and Installation
Guide

n ControlEdge 2020 Platform Hardware Planning and Installation
Guide

n ControlEdge Builder Function and Function Block Configuration
Reference

n ControlEdge Builder Protocol Configuration Reference Guide

n ControlEdge PLC and ControlEdge RTU Network and Security
Planning Guide

n ControlEdge EtherNet/IP User's Guide

n ControlEdge RTU DNP3 Device Profile
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CHAPTER

2 GETTING STARTED WITH CONTROLEDGE
BUILDER

Before you start
Make sure all the hardware modules used in the system are installed
with the right firmware version and the engineering station has the
latest ControlEdge Builder. You can find the firmware and software
updates on http://www.honeywellprocess.com with valid credentials.

Before you begin with the configuration, ensure that ControlEdge
Builder has been correctly installed.

See ControlEdge Builder Software Installation User’s Guide for more
information regarding the ControlEdge Builder installation.

See ControlEdge 2020 Platform Hardware Planning and Installation
Guide for more information regarding ControlEdge 2020 controller
installation and configuration.

See ControlEdge 900 Platform Hardware Planning and Installation
Guide for more information regarding ControlEdge 900 controller
installation and configuration.

Launching ControlEdge Builder
Click Start > All Programs > Honeywell > ControlEdge Builder > ControlEdge
Builder to launch ControlEdge Builder and the Start Page appears.
Start Page is outside any project context, and enables the user to
select an option to start. It provides several options:

n Create Project: click the icon to create a new project with the
default controller configuration.

n Open Project: click the icon to open an existing project.

n Connect: click the icon to connect to a controller.

15



Figure 2-1: Start Page

TIP: When the third-party SCADA is EPKS Experion, you can
launch ControlEdge Builder from the Configuration Studio
(Control Strategy > ControlEdge Integration > Configure control
strategy).

Working with projects
You can create a new project or open an existing project in
ControlEdge Builder.

Creating a project
The configuration and programming details are stored in a project.

To create a new project

1. From the Start Page, click Create Project.

2. In the Create New Project from Template window, click General and
select the target template from the Available Templates list.

l Select 900cp1 to create a project for a ControlEdge 900
controller.

l Select SC-UCMX01 or SC-UCNN11 to create a project for a
ControlEdge 2020 controller.

l SC-UCMX01 is for a non-redundant controller.

l SC-UCNN11 is for a redundant controller.

3. Click Next. The Save As window appears.

16
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4. Select an appropriate directory to save the project and enter a
name for the project in the File name field.

l The project name must not contain any of the following
characters: '.\/:*?"<>|'.

l The project name must not exceed 24 characters.

l The directory path length must not exceed 171 characters.

5. Click Save. A project is created, and the Home Page appears. You
can click Set Controller Name under Controller and Programming and
enter the desired name for the controller.
If using Experion integration with ControlEdge 900 or 2020
controller, this name is used to identify the controller during
Experion configuration.

Figure 2-2: Home Page for ControlEdge 2020
controller
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Figure 2-3: Home Page for ControlEdge 900
controller

Item Description

1 Open Project: open an existing project.

If the existing project has stored a Device Description (DD)
file, and the DD revision is different with the one in the
ControlEdge Builder repository, a message will prompt you
to use the latest DD file.

2 Connect/Disconnect: connect/disconnect with a controller.

3 Project Name: display the project name.

4 After connecting with a controller, the connection status,
name, IP address, role and operating mode of the
connected controller are displayed.

5 FW: select and display the target firmware version used for
the project.

6 Controller HW: select and display the target hardware
version used for the project.

ATTENTION: This operation will reset the existing
DNP3 mapping table "Experion". If this table has
been used, it should be renamed before this
operation. And after this operation, it should be
bound to DNP3 slave protocol again.

18
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Item Description

7 Download: download the configuration to the connected
controller.

8
l More> Back To Start Page: return back to the Start Page.

l More> Upload project from controller: upload and open a
project in ControlEdge Builder, or save it to the PC.

9 Toolbar. See the table Description of toolbar icons.

10 Menu bar. See the table Description of menu bar items.

The following table lists the commonly used toolbar icons which
are highlighted in callout 9 of the picture above.

Table 2-1: Description of toolbar icons

Icon Name Description

ControlEdge
Configuration
Workspace

Click it to move to the Home Page.

IEC
Programming
Workspace

Click it to move to the IEC Programming
Workspace.

Make Click it to compile the changed worksheets.

Rebuild
Project

It is used to compile the whole project for
the first time or if an announced user library
has been changed. The command Rebuild
Project should only be used if 'Make'
generates compiling errors or you have
unzipped your project without the frontend
code.

Project
Control
Dialog

It is used to download a project to the
controller.

Debug on/off Click it to switch all worksheets between
offline and online mode.
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Icon Name Description

l Online: monitor the online values of the
project.

l Offline: configure the project.

The following table lists items for the menu bar. Depending on the
program part or editor you are working with, particular menu items
may not accessible.

Table 2-2: Description of menu bar items

Menu Description

File It can be used to create, save and zip/unzip projects, to
save a project as a template and to delete templates. It
also contains commands for printing, print setup and
print preview.

Edit It contains all commands which are necessary for
editing such as marking, choosing different working
modes or cutting and pasting.

View It is used to hide or show the different windows and
controls of the user interface (project tree window,
message window, cross references window, watch
window, Logic Analyzer, multi-element variable window,
Edit Wizard, Project Comparison Result window) as well
as the status bar and to switch the workspaces (if
implemented).

Project It is used to insert data type worksheets and POUs and
to announce libraries.

Build It consists of different commands for starting the
compilation after editing, for displaying the errors
detected while compiling, for building the cross
references and for removing the declarations of unused
local variables and FB instances.

Online The 'Online' menu provides commands for debugging a
project, calling the resource control dialog and
activating the powerflow display.

Extras It can be used to call the dialogs 'Shortcut Keys' and
'Options' as well as other optional tools, such as the

20
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Menu Description

pagelayout editor.

Help It contains all commands for calling the embedded
help.

For more information, from the menu bar, select Help > Contents,
and search Menu bar to display the details.

Opening an existing project

1. From the Start Page or Home Page, click Open Project. The default
folder of all the available projects in the system appears.

2. Select the target project and click Open, the project is opened.

Managing a project
In ControlEdge Builder, a project can be archived as a zipped file and
saved as a template. A previously archived project can be unzipped
and then used. It is recommended to zip your files regularly to back
up your work. You can also print parts of a project or the whole
project.

To save the opened project as a template

You can save an existing project as a template. Then you can select
this new template when you create a new project.

1. Click File > Save As Template. The Save As Template dialog box
appears.

2. Enter the Template Name and select Group.

3. Click OK.
The project will be saved as a template and it is displayed in the
Available Templates.

To save the opened project to a zipped file

EDS files cannot be saved when you back up a project, you must copy
them to the folder manually:
C:\ProgramData\Honeywell\ControlEdge Builder\EDSFiles.
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1. Click File > Save Project As / Zip Project As. The Save/Zip project as
dialog box appears.

2. From the Save as type drop-down list, select Zipped Project Files
(*zwt).

3. Select the required folder and enter a file name for the archive.

4. If user libraries are required in the zipped project, in the Zip
Options, select both Zip User-Libraries and Zip Frontend-Code.
If Zip Frontend-Code is not selected, when the project is unzipped,
the user libraries might become unusable.

5. Click Zip.

To extract a zipped project

1. Click File > Open Project / Unzip Project from the toolbar. The
Open/Unzip project dialog box appears.

2. From the Files of type drop-down list, select Zipped Project Files
(*zwt).

3. Select the zipped file you want to extract, and then click Unzip.

4. Click Yes to accept the folder specified, or click No to navigate to
another folder.

5. Click Save to extract the zipped project. You must select No or Not
to all if the "HWFBLib" overwrite dialog appears.

To print a project

1. Open the target project and click File > Print Project. The Print
Project dialog appears.

2. For the Range, select either:

l All to print the whole project; or,

l Selected to print the selected parts of the project.

3. For the Page Range, select either:

l All to print all pages; or,

l Enter the page numbers you want to print in the Pages field.

4. Print options can be used to print the following:

22
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l Data Type Worksheet

l Description Worksheet

l Variable Worksheet

l Code Worksheet

l Task and Resource Information

l Local Cross Reference

l Global Cross Reference

l OEM specific data

l Table of Contents

5. Click Print. The Save As dialog appears.

6. Select the target directory and click Save. A pdf file is saved.

To protect a project

Password protection restricts access to entire projects or parts of
projects or libraries. With password protection, you can:

n lock the entire project or library

n protect single POUs against unauthorized change

n restrict actions like downloading or starting/stopping a controller

1. Call the corresponding properties dialog and choose the desired
restrictions by marking the related checkboxes. Which dialog you
need for which restriction is described in the following table.
Confirm the security settings.

Target
Securable
object

Possible
restrictions

Dialog for defining
the security settings

Project folder Protection
of the
structures
within the
subtrees
and folders
of the
project.

Insertion and
deletion of
objects in the
following
folders:

Libraries

Data types

Logical POUs

These settings are
made in the dialog
'Project properties',
which is called
using the context
menu item
'Properties...' of the
project folder icon.
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Target
Securable
object

Possible
restrictions

Dialog for defining
the security settings

Configuration

Resources

Data types
worksheet

Protection
of data type
worksheets

Read
protection

Write
protection

Properties dialog of
the data types
worksheet icon.

POU folder Protection
of variables
worksheets,
code body
worksheets
and
description
worksheets

Read
protection

Write
protection

Properties dialog of
the data types
worksheet icon.

Configuration
folder

Protection
of
worksheets.

Read
protection

Write
protection

Properties dialog of
the corresponding
configuration folder
icon.

Resource
folder

Protection
of
worksheets
as well as
restriction
of download
and debug
commands

Read
protection
Write
protection
Download
protection
Debug
protection

Properties dialog of
the corresponding
resource folder
icon.

2. Call the dialog 'Project password' using the menu item 'Enter
password...' in the 'File' menu. In the dialog enter a password and
verify it by typing it a second time in the lower field 'Password
confirmation'.

3. The password protection becomes only valid after activating the
defined password. This means, that is it not enough to define a
password; you have to activate it explicitly by clicking on the
button 'Activate assword'. After activating the password, a key
symbol is added to each restricted object in the project tree.

24
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Bulk configuration
This feature only applies to ControlEdge 2020 controller.

ControlEdge Builder supports bulk configuration to create multiple
projects.

ControlEdge Builder provides bulkconfig.exe file and bulk_config_
template.xls template. These are installed in the main directory of
ControlEdge Builder. The default directory is C > Program Files or
Program Files (x86) > Honeywell > ControlEdge Builder > builder.

1. Open file-bulk_config_template.xls, and according to your
requirement, fill in the table. Each row is corresponding with a
project. Then save the file as another name.
To configure “create file?”, fill in “Yes” or “No”. “Yes” means create
the projects, “No” means don’t create the projects.

l To configure the “create file?”, fill in “Yes” or “No”. “Yes” means
create the projects, “No” means do not create the projects.

l To configure the serial ports, See "Configuring serial ports" on
page 44 for more information.

2. Open a command prompt window. Under the directory of
BulkConfig.exe, drag BulkConfig.exe into the command window and
press Enter, then the following display is shown indicating the
parameters should be configured:

Parameter Description

S Specify the project folder that you target to bulk copy
the configuration except the ones configured in the
excel file.

I Specify path to the excel file that you have saved as.

O Specify the destination folder that you want to save
the output bulk projects.
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3. Enter the above parameters and press Enter, bulk configuration
tool creates multiple projects accordingly in the “output” folder.
If you execute the tool with the privilege of administrator, all the
generated projects can only be accessed by the administrator.

Connecting a controller
Click Connect from the Home Page, and the Connect controller page
appears.

Select one of the following two methods to connect a controller:

n Scan the network to connect a controller

a. Click the Scan and Select tab to view detailed information for the
discovered controllers in the system.
Select the controller type. The available options are:

l : ControlEdge 2020 controller

l : ControlEdge 2020 controller simulator

l : ControlEdge 900 controller

l : ControlEdge 900 controller simulator

b. Select the user name and enter the password. For the initial
password of each user type, See "User privileges" on page 250
for more information.

c. Click Connect.
If the current and previously connected controller types are
different, the following dialog appears. Click OK to
automatically configure the settings.

d. Click IEC Programming Workspace and check that the build
settings is correct.

l The build settings for a physical controller is ARM_LE_GCC3.

26
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l The build settings for a controller simulator is I486_LE_
GCC3.

n Manually enter IP address to connect a controller

a. Click Connect manually tab, enter the IP address of the target
controller.

l For the non-redundant controller, if the DHCP client is not
enabled on ETH2, the default static IP address of ETH2 is
192.168.1.50.

l For the redundant controller, if DHCP clients are not
enabled on ETH1 and ETH2, the default static IP address of
the primary controller (CPM1) on ETH2 is 192.168.1.50, and
the secondary controller (CPM2) is 192.168.1.51.

b. Select the user name and enter the password. For the default
password of each user type, See "User privileges" on page 250
for more information.

c. Click Connect.
If the current and previously connected controller types are
different, the following dialog appears. Click OK to
automatically configure the settings.

d. Click IEC Programming Workspace and check that the build
settings is correct.

l The build settings for a physical controller is ARM_LE_GCC3.

l The build settings for a controller simulator is I486_LE_
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GCC3.

TIP: Due to the cyber security, ControlEdge Builder will
disconnect with the controller automatically if there is no
communication between them including displaying the
diagnostic view, uploading the datalog, downloading the
configuration, and upgrading the firmware for over ten
minutes.

Configuring controller start up
This function enables you to configure the controller status after the
power cycle.

For ControlEdge 900 controller, this feature is only applicable when
the mode switch is in REMOTE position.

Under Controller and Programming, select Configure Controller Start Up,
the Configure Controller Start Up page appears. There are four options
for controller start up:

n Last operating mode, or Running after an abnormal stop

This option is the default setting for ControlEdge 2020 controller.
The controller will start in the operating mode that it was last in
prior to a power off, unless there was an abnormal stop caused by
a system error such as a watchdog timeout issue. It will then start
in Running mode.

l If the controller was in Running mode before power off, the
controller will warm start in Running. If the warm start fails, the
controller will go to Stopped mode.

l If the controller was stopped manually before power off, the
controller will start in Stopped mode.

l If the controller was stopped abnormally before power off, the
controller will warm start in Running mode. If the warm start
fails, the controller will go to Stopped mode.

n Last operating mode, or Stopped after an abnormal stop

This option is the default setting for ControlEdge 900 controller.

28
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The controller will start in the operating mode that it was last in
prior to a power off, unless there was an abnormal stop caused by
a system error such as a watchdog timeout issue. It will then start
in Stopped mode.

l If the controller was in Running mode before power off, the
controller will warm start in Running. If the warm start fails, the
controller will go to Stopped mode.

l If the controller was stopped manually before power off, the
controller will start in Stopped mode.

l If the controller was stopped abnormally before power off, the
controller will start in Stopped mode.

n Running

The controller will warm start in Running mode. If the warm start
fails, the controller will go to Stopped mode.

n Stopped

The controller will start in Stopped mode.

ATTENTION: If you reboot the controller manually, the
configuration in this section will not take effect. For example: If
you select Running here, and you select Reboot Controller under
Maintenance, and click Cold Reboot. The controller will perform
cold start, but not warm start after it reboots.

Configuring controller redundancy
To disable redundancy

1. Under Controller and Programming, select Configure Controller
Redundancy.

2. Select Disable Controller Redundancy to disable the redundancy
function.

3. Click OK. Redundancy has been disabled. The IP address
configured for the secondary controller will be disabled.

To enable redundancy

1. Under Controller and Programming, select Configure Controller
Redundancy.

2. Select Enable Controller Redundancy, and then click OK.
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The configuration of I/O modules in the rack local to the
controller will be removed and a static IP address must be
configured for the secondary controller.

3. Configure the IP address of the controllers.

l If the Obtain an IP Address Automatically options of ETH1 and
ETH2 were enabled, this option will be disabled automatically.
Configure Primary Controller IP Address and Secondary Controller
IP Address manually.

l If the Obtain an IP Address Automatically options of ETH1 and
ETH2 were disabled, configure the Secondary Controller IP
Address manually.

Publishing to Experion
This function enables the user to publish the related configuration for
Experion to configure point and system status for ControlEdge 900
controller or ControlEdge 2020 controller in Experion.

n Experion server to ControlEdge 900 controller communication is
with the OPC UA protocol, so the OPC UA Server must be enabled
on the Ethernet port(s) connected to the same network as the
Experion Server.
Experion can read, write and monitor global variable, program
local variable and function block instance variable through the
Identifier defined by OPC UA protocol. The maximum length of the
Identifier is 73 characters.
Global variable's Identifier is @GV. <Varname>.
Program local variable's Identifier is <Program Instance
Name>.<Varname>.
Function block instance variable's Identifier is <Program Instance
Name>.<Function Block Instance>.<Varname>.

n Experion server to ControlEdge 2020 controller communication is
with the DNP3 protocol, so DNP3 must be enabled on the
Ethernet port(s) connected to the same network as the Experion
Server.

n For peer to peer connection to C300 or other Experion CEE based
controller, you need to publish the configuration to the Experion
Server through CDA.
Before that, you need to first:
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a. Install and start the ControlEdge integration service on the
Experion Server. See "Installing ControlEdge integration
service" in the ControlEdge Builder Software Installation User's
Guide for more information.

b. Select CDA Responder on the Ethernet port(s) connected to the
same network as the Experion Server. See "Configuring ETH1
and ETH2" on page 37 for more information.

c. Select CDA for the global variables or local variables you want
to publish to Experion.
See the following table for data type matching between
ControlEdge 900 controller variables and Experion Server
parameters.

Data type in ControlEdge 900
controller

Data type in Experion

IEC_BOOL BOOLEAN

IEC_SINT INT8

IEC_INT INT16

IEC_DINT INT32

IEC_USINT UINIT8

IEC_UINT UINT16

IEC_UDINT UINT32

IEC_REAL FLOAT32

IEC_LREAL FLOAT64

IEC_BYTE UINT8

IEC_WORD UINT16

IEC_DWORD UINT32

IEC_ULINT UINT64

IEC_LWORD UINT64

IEC_STRING STRING

C_STRUCT See Note1 below.

Note 1: Structure is a data type of I/O variable, so you should
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Data type in ControlEdge 900
controller

Data type in Experion

create a single variable for each parameter in the structure for
CDA communication.

i. Click IEC Programming Workspace on the toolbar.

ii. Perform either of the following methods to select CDA.

l From the variable sheets, select CDA.

l From the variable properties dialog, select CDA.

d. Compile the configuration to the controller. See "Compiling a
project" on page 237 for more information.

For more details about the Experion integration with ControlEdge
900 controller, see the Experion PKS ControlEdge PLC Integration
Reference.

For more details about the Experion integration with ControlEdge
2020 controller, see the Experion PKS DNP3 Interface Reference.

Publishing when ControlEdge Builder is launched
from Configuration Studio
In this scenario, ControlEdge Builder is launched from Configuration
Studio > Control Strategy > ControlEdge Integration > Configure control
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strategy, the ControlEdge Builder is already running under the user
credentials supplied from Configuration Studio.

1. From the Home Page, click Publish to Experion under
Miscellaneous. The project configuration will be published to
Experion directly.

2. If the publish fails for ControlEdge 2020 controller, you can export
the configuration manually.

a. A warning message appears that the publish has failed. Click
OK.

b. Click the browse icon, and select a location to store the
exported file.

TIP: It is recommended to save the file to the folder
"\\ControllerIntegration" shared on the current primary
Experion server.

c. Enter a name for the exported file, and click Save.

TIP: It is recommended to name the file as
"ControllerName_SAVED". For example, the controller
name is "NewController", then enter "NewController_
SAVED" for the file name.

d. Click Export. The exported file is saved successfully.

e. Click OK.

Publishing when ControlEdge Builder is launched
separately on an Experion node
In this scenario the Experion client components are available on the
node, but the context for establishing the connection to the Server
and the user credentials are not available from Configuration Studio.

Prerequisites

ControlEdge Builder is launched separately on an Experion node, not
from Configuration Studio.

1. From the Home Page, click Publish to Experion under
Miscellaneous.
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2. Enter Experion server, Domain, User name and Password.
See the following table for the parameter description.

Parameter Description

Experion
server

The base part of the Experion server name you would
like to connect to. For example if you have redundant
Experion Servers, enter the hostname of the server
without the last “A” or “B” letter.

Use
current
Windows
account

Connect with current Windows account. If you select
this checkbox, you do not need to enter Domain, User
name or Password.

Domain Domain name.

If you enter ".", it means current application domain.

User
name

User account name

Password Password for the user account, which is case-
sensitive.

3. Click Publish. A message appears indicating that the configuration
is published successfully. Click OK.

4. If the publish fails for ControlEdge 2020 controller, you can export
the configuration manually.

a. A warning message appears that the publish has failed. Click
OK.

b. Click the browse icon, and select a location to store the
exported file.

TIP: It is recommended to save the file to the folder
"\\ControllerIntegration" shared on the current primary
Experion server.

c. Enter a name for the exported file, and click Save.

TIP: It is recommended to name the file as
"ControllerName_SAVED". For example, the controller
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name is "NewController", then enter "NewController_
SAVED" for the file name.

d. Click Export. The exported file is saved successfully.

e. Click OK.

Publishing when ControlEdge Builder is launched on
non-Experion node
The “Experion client components” optional installation package must
be installed from the Experion Installation Media which you want to
communicate with for the Publish to Experion function to work. These
can be installed through the “Optional Components” selection on the
installation media. If these components are not installed, a message
appears indicating “Unable to publish to Experion as client
components are not installed”, but all other ControlEdge Builder
functions should continue to work as expected.

Prerequisites

n The "Experion client components" are installed on the
ControlEdge Builder node.

n ControlEdge Builder is installed on a same version of Microsoft
Windows that is supported for either Experion Client or Server that
you want to communicate with. Refer to the Experion
specifications for the specific release for supported operation
system details.

n ControlEdge Builder is launched.

1. From the Home Page, click Publish to Experion under
Miscellaneous.

2. Enter Experion server, Domain, User name and Password.
See the following table for the parameter description.

Parameter Description

Experion
server

The base part of the Experion server name you would
like to connect to. For example if you have redundant
Experion Servers, enter the hostname of the server
without the last “A” or “B” letter.
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Parameter Description

Use
current
Windows
account

Connect with current Windows account. If you select
this checkbox, you do not need to enter Domain, User
name or Password.

Domain Domain name.

If you enter ".", it means current application domain.

User
name

User account name

Password Password for the user account, which is case-
sensitive.

3. Click Publish. A message appears indicating that the configuration
is published successfully. Click OK.

4. If the publish fails for ControlEdge 2020 controller, you can export
the configuration manually.

a. A warning message appears that the publish has failed. Click
OK.

b. Click the browse icon, and select a location to store the
exported file.

TIP: It is recommended to save the file to the folder
"\\ControllerIntegration" shared on the current primary
Experion server.

c. Enter a name for the exported file, and click Save.

TIP: It is recommended to name the file as
"ControllerName_SAVED". For example, the controller
name is "NewController", then enter "NewController_
SAVED" for the file name.

d. Click Export. The exported file is saved successfully.

e. Click OK.
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CHAPTER

3 CONFIGURING COMMUNICATION

Configuring Ethernet ports
There are three Ethernet ports, ETH1, ETH2 and ETH3, on ControlEdge
2020 Controller. ETH3 can only be used to communicate with
Expansion I/O.

There are four Ethernet ports, ETH1, ETH2, ETH3 and ETH4, on
ControlEdge 900 Controller. ETH1 and ETH2 are used for
communicating with PC application and/or other controllers, or other
devices. ETH3 and ETH4 are used for communicating with EPMs on
the I/O network.

See the following tips for configuring the Ethernet ports:

n (This only applies to ControlEdge 2020 controller)The Ethernet
port will be enabled automatically once it is bound with a protocol.
If a port is not enabled, it consumes less power.

n For FTE networks, the ETH1 and ETH2 subnets must be the same,
but for non-FTE networks they must be different and not be
included in each other’s subnet.

n The ETH3 subnet must not be the same as subnets used for ETH1
and ETH2, and must be outside the ETH1 and ETH2 subnets.

Configuring ETH1 and ETH2

1. Click the arrow beside Configure Ethernet Ports from Home Page,
and select ETH1 or ETH2.

2. Under Network Setting, perform following steps to configure the IP
address of the Ethernet port for the non-redundant controller and
redundant controller.

NOTE: For ControlEdge 2020 controller, the 198.198.x.x
subnet is reserved, so do not configure the IP address on
this subnet.

l For the non-redundant controller, perform one of the following
methods:
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a. Click Obtain an IP address automatically to acquire an IP
address dynamically.
If DHCP client is enabled on any Ethernet port, and DHCP
server is not available, that port is assigned an IPv4LL
address which is in the 169.254.x.x subnet.

b. Select Use the following IP address to specify a static IP
address, and enter the IP Address, Subnet Mask and Gateway.

l For the redundant controller, select Use the following IP address
to specify a static IP address, and enter the Primary Controller IP
Address, Secondary Controller IP Address, Subnet Mask and
Gateway.
The Secondary Controller IP Address is unavailable if the
redundancy function is disabled. See "Configuring controller
redundancy" on page 29 for more information.

3. Under the Protocol Binding, select the protocol which you want to
bind to the port.
See the following table for details of the supported protocols:

Table 3-1: Protocol Supported by ETH1 and ETH2

Protocol Description

DNP3 Used for communication between the controller
and a DNP3 master such as a SCADA system like
Experion.

The controller acts as the DNP3 slave.

The TCP port number is configurable and the
default value is 20000.

Controller
Configuration
protocol

Used for ControlEdge Builder communication,
including data logging and diagnosis.

The TCP port number is 41103.

HART-IP HART-IP is a HART connection option over
Ethernet that facilities a HART Host system like
Honeywell FDM to access and integrate
information from the controller connected HART-
enabled field devices.

HART Host commands are passed through the
controller to the connected HART devices.
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Protocol Description

The TCP port number is configurable and the
default value is 5094.

Modbus
Slave

Used for communication between the controller
and a Modbus TCP master such as a SCADA
system like Experion.

The controller acts as the Modbus slave.

The TCP port number is configurable and the
default value is 502.

Modbus TCP
Master

Used for communication between the controller
and third-party Modbus slave devices.

The controller acts as the Modbus TCP Master.

For how to configure the Modbus TCP Master,
see "Modbus Master Configuration" in the
Function and Function Block Configuration
Reference Guide.

Enron
Modbus
Slave

Used for Electronic Flow Measurement (EFM)
application.

Wireless I/O Used for assigning Wireless I/O protocol to
Ethernet port.

OPC UA
Server

Used for communication between the controller
and an OPC UA client such as a SCADA system
like Experion or other controllers.

The controller acts as the OPC UA Server.

The TCP port number is configurable and the
default value is 4840.

OPC UA
Client

Used for communication between the controller
and an OPC UA server such as a SCADA system
like Experion or other controllers.

The controller acts as the OPC UA Client.

For how to configure the OPC UA Client, see
ControlEdge Builder Protocol Configuration
Reference Guide.
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Protocol Description

CDA
Responder

Used for communication between the controller
and C300 and other Experion CEE controllers.

The controller acts as a CDA responder.

It must be selected for either ETH1 or ETH2 if you
want to communicate with C300 or other
Experion CEE controllers.

EtherNet/IP
Server

Used for communication between the controller
and EtherNet/IP Client.

The controller acts as an EtherNet/ IP Server.

It must be selected for either ETH1 or ETH2 if you
want to communicate with EtherNet/IP Client.

4. Click Save to complete the Ethernet port configuration.

5. Click Back to return to the Home Page.

Configuring ETH3 and ETH4 for ControlEdge 2020
controller

Configuring I/O network communication for the non-
redundant controller

1. Click the arrow beside Configure Ethernet Ports from Home Page,
and select ETH3.

2. Under Protocol Binding, select the protocol Expansion I/O.
Information about supported protocol for port3 is listed in the
following table.

Table 3-2: Protocols Supported by ETH3

Protocol Description

Expansion I/O Used for Expansion I/O communication.

3. Under Network Setting, type in the IP Address and the Subnet Mask of
the Ethernet port.
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l The IP address cannot be in the same network subnet as ETH1
and ETH2.

l The first 100 IP addresses are reserved for I/O modules. The IP
address of ETH3 must be beyond this range.

l Do not configure the IP address on the 198.198.x.x subnet.

4. Click Save to complete the Ethernet port configuration.

5. Click Back to return to the Home Page.

Configuring I/O network communication for the
redundant controller

1. Click the arrow beside Configure Ethernet Ports from Home Page,
and select ETH3.

2. Select the protocol Expansion I/O under Protocol Binding.
See "Protocols Supported by ETH3" on the previous page for more
information.

3. Under Network Setting, configure the IP addresses. Type in the Slot
1 IP Address, Slot 2 IP Address and the Subnet Mask of the Ethernet
port.

l If redundancy is enabled: enter the Slot 1 IP Address, and Slot 2
IP Address is automatically incremented by 1. Enter the Subnet
Mask for the Ethernet port.
For example: Slot 1 IP Address is configured as 192.168.1.1, and
Slot 2 IP Address will be 192.168.1.2.

l If redundancy is disabled: enter the Slot 1 IP Address, and Slot 2
IP Address is disabled. Enter the Subnet Mask for the Ethernet
port.

l The IP address cannot be in the same network subnet as ETH1
and ETH2.

l The first 100 IP addresses are reserved for I/O modules. The IP
address of ETH3 must be beyond this range.

4. Click Save to complete the Ethernet port configuration.

5. Click Back to return to the Home Page.
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Configuring ETH3 and ETH4 for ControlEdge 900
controller
ETH4 has the same configuration as ETH3, so only ETH3 should be
configured manually.

Configuring I/O network communication for the non-
redundant controller

1. Click the arrow beside Configure Ethernet Ports from Home Page,
and select ETH3 or ETH4

2. Under Network Setting, enter the IP Address and the Subnet Mask of
the Ethernet port.

l The default IP address is 172.168.0.101.

l The range of the IP address is from 101 to 254.

l The IP address cannot be in the same network subnet as ETH1
and ETH2.

l If you want to communicate with EtherNet/IP devices, the IP
address must be in the same network subnet as the
EtherNet/IP device, and also it cannot be conflict with the EPM
IP address.

3. Select Ring Topology or Star Topology under I/O Network Topology.
This configuration should match the position of 100X switch on
the EPM hardware. For more information about the switch, see
“Assembling I/O racks” in the ControlEdge 900 Controller
Hardware Planning and Installation Guide.

NOTE: If you select EtherNet/IP Client for the Protocol Binding,
Start Topology is selected automatically.

4. If you want to communicate with EtherNet/IP devices, under
Protocol Binding, select EtherNet/IP Client.

5. Click Save to complete the Ethernet port configuration.

6. Click Back to return to the Home Page.
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Configuring I/O network communication for the
redundant controller

1. Click the arrow beside Configure Ethernet Ports from Home Page,
and select ETH3 or ETH4

2. Under Network Setting, configure the IP addresses. Enter the CPM A
IP Address, CPM B IP Address and the Subnet Mask of the Ethernet
port.

l If redundancy is enabled: enter the CPM A IP Address, and CPM B
IP Address is automatically incremented by 1. Type the Subnet
Mask for the Ethernet port.
For example: CPM A IP Address is configured as 172.168.0.101,
and CPM B IP Address will be 172.168.0.102.

l If redundancy is disabled: enter the CPM A IP Address, and CPM
B IP Address is disabled. Enter the Subnet Mask for the Ethernet
port.

l The default IP address is 172.168.0.101.

l The range of the IP address is from 101 to 254.

l The IP address cannot be in the same network subnet as ETH1
and ETH2.

l If you want to communicate with EtherNet/IP devices, the IP
address must be in the same network subnet as the
EtherNet/IP device, and also it cannot be conflict with the EPM
IP address.

3. Select Ring Topology or Star Topology under I/O Network Topology.
This configuration should match the position of 100X switch on
the EPM hardware. For more information about the switch, see
“Assembling I/O racks” in the ControlEdge 900 Controller
Hardware Planning and Installation Guide.

NOTE: If you select EtherNet/IP Client for the Protocol Binding,
Start Topology is selected automatically.

4. If you want to communicate with EtherNet/IP devices, under
Protocol Binding, select EtherNet/IP Client.

5. Click Save to complete the Ethernet port configuration.

6. Click Back to return to the Home Page.
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Configuring serial ports
The ControlEdge 2020 Controller supports two RS232 and two RS485
serial ports.

To configure serial ports:

1. From the Home Page, click the arrow besides Configure Serial Ports
to view the four options, RS232-1, RS232-2, RS485-1, and RS485-2.
Select the corresponding ports to be used.

2. Under General, the Port Name and Port Type are displayed
automatically. Select appropriate values from the Baud Rate, Parity,
Data Bits and Stop Bits drop-down lists. See the following table for
the parameter descriptions.

Parameter Description

Baud
Rate

300, 600, 1200, 2400, 4800, 9600, 19200, 38400,
57600, 115200

For non-redundant controller, RS232 does not
support 57600 and 115200.

Parity None, ODD, EVEN

Data Bits 7, 8

If you select Modbus RTU Slave or Modbus RTU
Master for the Protocol Binding, the Data Bits is set
as 8 by default.

Stop Bits 1, 2

For RS232-1 and RS232-2, there are two more options to
configure: Flow Control and Force Online. See the following table for
the parameter descriptions.

Parameter Description

Flow
Control

Only for RS232-1 and RS232-2

l None

l RTS-CTS

l RTS

Force
Online

Only for RS232-1 and RS232-2.

Force Online is used to save energy when there is no
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Parameter Description

device connected to the controller RS232 ports by
disabling it.

Select the desired option from the Force Online drop-
down list:

l Disable

It is selected by default and the controller is on
power saving mode. RS232 transmitter will detect
the connection of external device. If external
device is connected to the controller, the local
transmitter will be enabled for communication. If
there is no external device connected, the local
transmitter will remain disabled to save energy.

l Enable

RS232 transmitter will not detect external device
and if you force enable, more energy is consumed.

The following table describes four scenarios that will happen for
Force Online option between the controller and the device it
communicates.

Controller
Force
Online
Option

Third-party
Device
Force
Online
Option

Communication

Enabled Enabled Normal

Disabled Enabled Normal, with energy saving on the
controller

Enabled Disabled Normal, with energy saving on Device

Disabled Disabled Invalid configuration. Both devices would
consider there is no device connected to
it and hence there is no communication
between them.

3. If you want the controller to save energy and not sure if the device
connected to the controller is in power saving mode, perform the
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following steps to check:

a. Enable “force online” on the controller and make sure that the
controller communicates with the device.

b. Disable “force online” on the controller side and download.

c. Unplug the RS232 cable and then plug in the cable to make
“force online disabled” effective.

d. Check the communication status. If it is active, disable “force
online” to save energy.

4. Under Protocol Binding, select a port protocol from the Port
Protocol drop-down list.
The following table provides information about various protocols
supported by serial ports.

Protocol Description

Modbus
RTU
Slave

The controller acts as the Modbus Slave and used for
communication between:

l Controller and SCADA

l Controller and third-party Modbus Master
devices

If you select Modbus RTU Slave, Data Bits is set as 8 by
default.

Modbus
RTU
Master

The controller acts as the Modbus Master and used for
communication between The controller and third-party
Modbus Slave devices, for example I/O modules.

If you select Modbus RTU Master, Data Bits is set as 8
by default.

Modbus
ASCII
Slave

The controller acts as the Modbus Slave and used for
communication between:

l Controller and SCADA

l Controller and third-party Modbus Master

Modbus
ASCII
Master

The controller acts as the Modbus Master and used for
communication between The controller and third-party
Modbus Slave devices, for example: I/O modules.

User
Defined

User Defined protocol.
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Protocol Description

When you select this option, the Delimiter Mode
(Optional) panel appears including three settings: Read-
interval Timeout (ms), Max Length (Bytes) and End
Delimiter (Hex). You can configure them optionally to
validate if a data frame is sent completely.

l Read-interval Timeout (ms): The interval between the
last data packet sent and the first keepalive probe,
ranging from 0 to 10000 (ms). If the interval
between the arrivals of any two bytes exceeds this
Timeout, system regards it has already received a
complete data frame.

The default value is 0 which means this option is
disabled.

l Max Length (Bytes): The maximum number of bytes
for a data frame, ranging from 0 to 1024. If the
length of a received data frame exceeds the Max
Length, system regards it has already received a
complete data frame.

The default value is 0 which means this option is
disabled.

l End Delimiter (Hex): Configured special characters in
hexadecimal and based on bytes validates if a data
frame is sent completely. If the received data frame
has same characters with the End Delimiter, system
regards it has already received a complete data
frame.

The default setting is blank which means this option
is disabled.

For how to configure User Defined protocol, see
"User Defined Protocol" in the ControlEdge Builder
Function and Function Block Configuration
Reference.

5. Click Save to complete the serial configuration.
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Configuring protocols
You can configure protocols including Modbus Slave, OPC UA Client,
OPC UA Server, DNP3 Slave, HART-IP Server and the Enron Modbus
Slave.

ATTENTION: For ControlEdge 900 controller, from R140
onwards, the maximum quantity of the port number configured
for the bound protocols communication is 16.

Configuring a Modbus Slave

1. Click Configure Protocols > Modbus Slave and select the target
communication ports.

2. Select Slave ID ranging from 1 to 247. For Ethernet ports, the Port
number must be configured and Type must be selected from UDP
or TCP.

3. Select the required mapping table from the Mapping drop-down
list. See "Adding a Modbus Slave mapping table" on page 61 for
more information.
The same mapping table may be selected for use on multiple
ports. For example, this could be used when a SCADA system
communicates through 2 ports for redundant communication
channels.

Configuring an OPC UA Client
OPC UA client maintains sessions in response to each execution of
the UaConnect function block. One execution of the UaConnect
function block contains that one corresponding session will be
created by the OPC UA client on the controller and correspondingly
one session will be created on the target OPC UA server.

For more information of programing the OPC UA Client, see
ControlEdge Builder Protocol Configuration Reference Guide.

ATTENTION: Make sure that the OPC UA Server’s time is
synchronized to the controller’s time.

To configure an OPC UA client

1. Click Configure Protocols > OPC UA Client. The OPC UA Client page
appears.

2. Select the values for the Max Session Count and Max Subscription
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Per Session parameters.
See the following table for the parameter description.

Parameter Description

Max Session
Count

The maximum number of concurrent sessions
allowed by the client.

If you enter a value of 0, the number of
sessions allowed is unlimited.

The default value is 100.

Max
Subscriptions Per
Session

The maximum number of subscriptions
allowed by the client for one session.

If you enter a value of 0, the number of
subscriptions allowed is unlimited.

3. Click Save.

Configuring an OPC UA Server

ATTENTION: Make sure that the OPC UA client’s time is
synchronized to the controller’s time. It is recommended to use
the default values for the parameters of OPC UA Server.

To configure an OPC UA server

1. Click Configure Protocols > OPC UA Server. The OPC UA Server page
appears.

2. Configure the following parameters if required:

Parameter Description

Port The port that clients will use to connect. For
example: opc.tcp://192.168.0.15:4840

The default value is 4840.

Max Request Age The maximum age of a request (in
milliseconds) the server allows. Zero value is
defined as unlimited.

The default value, which is 0, indicating that
the request age allowed is unlimited.
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Parameter Description

Max Session
Count

The maximum number of concurrent sessions
the server allows.

If you enter a value of 0, the number of
sessions allowed is unlimited.

The default value is 100.

Max Subscription
Per Session

The maximum number of subscriptions
allowed by the server for one session.

If you enter a value of 0, the number of
subscription allowed is unlimited.

Max Session Per
Client

The maximum number of concurrent sessions
the server allows per client.

The default value, which is 0, indicating that
the number of sessions allowed is unlimited.

Min Session
Timeout

The minimum timeout for a session (in
milliseconds).

If you enter a value of 0, the minimum timeout
is unlimited.

The default value is 10000.

Max Session
Timeout

The maximum timeout for a session (in
milliseconds).

If you enter a value of 0, the maximum timeout
is unlimited.

The default value is 3600000.

Max Browse
Continuation
Points

The maximum number of browse continuation
points managed by a session.

The default value is 0.

Max Browse
Results

The maximum number of browse results for
one browse operation.

The default value, which is 0, indicating that
the number of browse results is unlimited.

Max Nodes To
Browse

The maximum number of nodes to browse.
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Parameter Description

The default value, which is 0, indicating that
the number of nodes allowed is unlimited.

Min Publishing
Interval

The minimum cycle rate of the Subscription.

The default value is 50 milliseconds.

Max Publishing
Interval

The maximum cycle rate of the Subscription.

The default value, which is 0, indicating that
the publishing interval allowed is unlimited.

Min Keep Alive
Interval

The minimum interval after which the
subscription sends a notification to the client.
This notification ensures the subscription is
maintained.

The default value is 5000 milliseconds.

Min Subscription
Lifetime

Provides assurance to the client that the
server is still alive.

The minimum period after which the
subscription will be deleted if no publish
request is received.

If you enter a value of 0, the subscription
lifetime allowed is unlimited.

The default value is 10000 milliseconds.

Max Subscription
Lifetime

Provides assurance to the server that the
client is still alive.

The maximum period after which the
subscription will be deleted if no publish
request is received.

The default value, which is 0 milliseconds,
indicating that the subscription lifetime
allowed is unlimited.

Max
Retransmission
Queue Size

The maximum number of messages allowed
per Subscription in the republish queue.

The default value is 10.

Max The maximum number of notifications allowed
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Parameter Description

Notifications Per
Publish

per Publish.

The default value, which is 0, indicating that
the number of notifications allowed is
unlimited.

Max Data Queue
Size

The maximum size of data monitored item
queues.

The default value is 100.

Max Event
Queue Size

The maximum size of event monitored item
queues.

The default value is 1000.

Max Subscription
Count

The maximum number of subscriptions that
can be created.

The default value, which is 0, indicating that
the number of subscriptions allowed is
unlimited.

Max Monitored
Item Count

The maximum number of items that can be
monitored.

The default value, which is 0, indicating that
the number of items allowed is unlimited.

Max Monitored
Item Per
Subscription
Count

The maximum number of items that can be
monitored for each subscription.

The default value, which is 0, indicating that
the number of items allowed is unlimited.

Max Monitored
Item Per Session
Count

The maximum number of items that can be
monitored for each session.

The default value, which is 0, indicating that
the number of items allowed is unlimited.

For more information about the parameter descriptions, see the
specification in the https://opcfoundation.org/.

3. Click Save.
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Configuring HART-IP Server

1. Click Configure Protocols > HART-IP Server and select the target
communication ports.

2. Enter port number in the Port.

Configuring DNP3 Slave

ATTENTION: DNP3 communication on ControlEdge 2020
controller is only applicable for the case of DNP3 event
generating rate less than 500 per second.

1. Click Configure Protocols > DNP3 Slave tab and select the target
Ethernet ports which you want to bind.

2. In the Physical Layer tab, configure the TCP port number.

3. In the Data Link Layer tab, select or type in the Master Address and
Controller Outstation Address.

4. Select Enable Self Address for the controller to respond with its
unique individual address, if a message is sent with the “Self
Address”. If Enable Self Address is not selected, the controller will
ignore the message that is sent to the “Self Address”.

5. Select Never from the Data Link Confirmation drop-down list and
type the value in Data Link Retries and Data Link Retry Timeout under
Data Link Settings. Maximum value for data link retries is 255 and
maximum value for retry timeout is 3,600,000ms.

l Never is selected by default. It is not recommended to select
MultiFrag or Always options.

l If you select MultiFrag or Always, ensure that the Data Link
Retries and Data Link Retry Timeout are set.

6. In the Application Layer tab, if you select Enable Unsolicited
Responses, the controller sends event data to SCADA without any
request from SCADA. Unsolicited Response is an operation mode
in which the outstation spontaneously transmits a response
without a specific request for the data.

Parameter Description

Send Null Unsolicited
Responses on
Reconnection

The DNP3 driver sends a null unsolicited
message upon reconnect once it is
selected.
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Parameter Description

Maximum Hold Delay
of
Class1/Class2/Class3

The maximum hold delay is the maximum
amount of time that the controller will
wait after an event occurs before sending
an unsolicited response. This setting
allows the controller to queue several
events before sending an unsolicited
response, improving bandwidth usage at
the expense of delayed communication.

Minimum value: 0 ms and maximum
value: 3,600,000ms.

Maximum Hold
Count of
Class1/Class2/Class3

The maximum hold count is the maximum
number of events that may be queued
before sending an unsolicited response.
This setting allows the controller to send
multiple events in a single message,
improving bandwidth usage at the
expense of delayed communication.

Unsolicited Response
Retries

Enter the number of times the DNP3
driver attempts to send the unsolicited
application fragment upon not receiving
confirmation.

The value can be 0 to 255.

Unsolicited Response
Retry Delay

Enter the time intervals between retry to
send the unsolicited response.

Delete the oldest
event when queue is
full

According to requirement, select Delete
the oldest event when queue is full or not.
If this option is checked, in case the
DNP3 event buffer is full, then any new
event overwrites the oldest event.

Validate Outstation
Address

Select this option, the controller only
accept data from some specific outstation
address.

Keepalive Interval Enter the interval that DNP slave station
sends response to master station to make
sure if the connection is normal.

Enable DNP3 Time
Synchronization

Enable time synchronization from the
DNP3 master.
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Parameter Description

DNP3 Time
Synchronization
Period

Select the time that the controller should
indicate to SCADA that the time
synchronization is required.

ATTENTION: If you select DNP3
Time Sync here, you cannot enable
Primary Server and Secondary
Server under Miscellaneous >
Configure Date/Time options at the
same time, or else you cannot
download your configuration.

Solicited response
confirmation timeout

Enter the time in milliseconds the DNP3
driver waits for confirmation for the sent
solicited application fragment.

Unsolicited response
confirmation timeout

Enter the time in milliseconds the DNP3
driver waits for confirmation for the sent
unsolicited application fragment.

Maximum value for timeout is
3600000ms.

Select before
operation timeout

Enter the time in milliseconds the DNP3
driver waits for SBO.

EFM Data Class Select the corresponding class for EFM
data to SCADA communication.

Set the time interval for getting the EFM
responses back to Experion from the
controller through the DNP3 virtual
terminal point.

There are three options defined by the
DNP3 master:

l Class 1

l Class 2

l Class 3

7. Click Mapping tab, and then select the required mapping table
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from the Mapping drop-down list. See "Adding a DNP3 Slave
mapping table" on page 62 for more information.
The same mapping table may be selected for use on multiple
ports. For example, this could be used when a SCADA system
communicates through 2 ports in a redundant arrangement.

8. In the Default Variation tab, configure the default variation for each
type of DNP3 point. Default variation defines the data format that
is used by the controller to send data to the DNP3 Master, when
the Master does not ask for a specific data variation.

Parameter Description

Binary
Input

Used to report the current value of a binary input
point with three options:

l Any variation

l Packed format

l Value with flags

Binary
Input
Event

Used to report events related to a binary input point
with four options:

l Any variation

l Value without time

l Value with absolute time

l Value with relative time

Double-
bit Binary
Input

Used to report the current value of a double-bit
binary input point with three options:

l Any variation

l Packed format

l Value with flags

Double-
bit Binary
Input
Event

Used to report events related to a double-bit binary
input point with four options:

l Any variation

l Value without time

l Value with absolute time
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Parameter Description

l Value with relative time

Binary
Output

Used to control or report the state of one or more
binary output points with three options:

l Any variation

l Packed format

l Status with flags

Binary
Output
Event

A Binary Output Event Object is an instance of a
report for an outstation’s corresponding Binary
Output Static object.

l Any variation

l Status without time

l Status with time

Binary
Output
Command
Event

A Binary Output Command Event object reports that
a command has been attempted on an outstation’s
corresponding binary output point.

l Any variation

l Status without time

l Status with time

Counter Used to report the current value of a counter point
with five options:

l Any variation

l 32-bit integer with flag

l 16-bit integer with flag

l 32-bit integer without flag

l 16-bit integer without flag

Frozen
Counter

Used to report the value of a counter point captured
at the instant when the count is frozen with seven
options:

l Any variation
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Parameter Description

l 32-bit integer with flag

l 16-bit integer with flag

l 32-bit integer with flag. time

l 16-bit integer with flag. time

l 32-bit integer without flag

l 16-bit integer without flag

Counter
Event

Used to report the value of a counter point after the
count has changed with five options:

l Any variation

l 32-bit integer with flag

l 16-bit integer with flag

l 32-bit integer with flag. time

l 16-bit integer with flag. time

Frozen
Counter
Event

Used to report, as an event, the value of a counter
point captured at the instant when the count is
frozen.

l Any variation

l 32-bit integer with flag

l 16-bit integer with flag

l 32-bit integer with flag. time

l 16-bit integer with flag. time

Analog
Input

Used to report the current value of an analog input
point with seven options:

l Any variation

l 32-bit integer with flag

l 16-bit integer with flag

l 32-bit integer without flag. time

l 16-bit integer without flag. time

l Single-precision float with flag
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Parameter Description

l Double-precision float with flag

Analog
Input
Event

Used to report events related to an analog input
point with nine options:

l Any variation

l 32-bit integer with time

l 16-bit integer with time

l 32-bit integer without time

l 16-bit integer without time

l Single-precision float with time

l Double-precision float with time

l Single-precision float without time

l Double-precision float without time

Analog
Input
Deadband

Used to set and report the deadband value of an
analog input point with four options:

l Any variation

l 16-bit integer

l 32-bit integer

l Single-precision float

Analog
Output
Status

Used to report the status of an analog output point
with seven options:

l Any variation

l 32-bit integer with flag

l 16-bit integer with flag

l Single-precision float with flag

l Double-precision float with flag

Analog
Output
Event

An Analog Output Event Object is an instance of a
report for an outstation’s corresponding Analog
Output Status object. There are nine options:
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Parameter Description

l Any variation

l 32-bit integer with time

l 16-bit integer with time

l 32-bit integer without time

l 16-bit integer without time

l Single-precision float with time

l Double-precision float with time

l Single-precision float without time

l Double-precision float without time

Analog
Output
Command
Event

An Analog Output Command Event object reports
that a command has been attempted on an
outstation’s corresponding Analog Output point.
There are nine options:

l Any variation

l 32-bit integer with time

l 16-bit integer with time

l 32-bit integer without time

l 16-bit integer without time

l Single-precision float with time

l Double-precision float with time

l Single-precision float without time

l Double-precision float without time

9. Select Flash or SD card from the drop-down list besides Save DNP3
Events to:.

o If you want to save DNP3 events to SD card, you must allocate
the space for DNP3 events first. See "Preparing SD card" on
page 251 for more information.

o Up to 80000 DNP3 events can be saved to Flash.

o Up to 198500 DNP3 events can be saved to SD card.

10. Click Save.
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Configuring Enron Modbus Slave

1. Click Configure Protocols > Enron Modbus Slave and select the target
communication ports.

2. Select Slave ID. For Ethernet ports, the port number must be
configured.
The port configured for Enron Modbus Slave cannot be the same
port as that configured for Modbus Slave.

Configuring SCADA mapping
When a controller acts as a slave to a master, such as in a SCADA
system, mapping tables are used to map controller variables to
protocol addresses.

Adding a Modbus Slave mapping table

1. From the Home Page, under I/O and Communications, select
Configure SCADA Mapping > Modbus Slave.

2. Click Add Mapping, and enter the mapping table name in the Name
field. Then, click OK.

3. Configure address mapping for each of the data types Discrete
Inputs, Coil, Holding Register, and Input Register as required. The
address range for each data type is 1 to 9999.

4. In the Discrete Inputs tab, click Add to add more addresses as
required. See the following table for the maximum quantity of
registers for different controllers.

Controller Maximum quantity of registers

ControlEdge 2020 Controller 8000

ControlEdge 900 Controller 16000

5. For each address:
For efficient communications, Modbus addresses should be
sequential in the mapping table.

a. Modify the Modbus Address if required.

b. Click the browse button under the Variable Name field and select
the relevant variable.

c. Click OK.
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6. Repeat Step 4 and Step 5 for each data type.

7. Click Save.

Adding a DNP3 Slave mapping table

1. From the Home Page, under I/O and Communications, select
Configure SCADA Mapping > DNP3 Slave.
A read-only Experion mapping table is set up by default ONLY for
reference. You can refer to it for creating a new mapping table, but
do not use it directly and do not delete it.

2. Click Add Mapping and enter the mapping table in the Name field.

3. Select Enable Experion Integration if this mapping is going to be
assigned to the DNP3 slave interface that is communicating with
Experion. This mapping will then also be included in the
configuration that is exported for use in Experion integration.

4. Click OK to add the mapping table.

5. Configure address mapping for each of the data types Binary
Inputs, Binary Outputs, Double Bit Inputs, Analog Inputs, and Analog
Outputs and Counters as required.
User can configure maximum of 2000 variables per DNP3 slave. A
counter type occupies two addresses, one for storing the counter
values and the other for freeze operation. That is to say, up to 1000
counter variables can be added if you only configure the counters.

6. In the Binary Inputs tab, click Add to add more addresses as
required.

7. For each address:
For efficient communications, DNP3 addresses should be
contiguous in the mapping table.

a. Modify the DNP3 Address if required.

b. Click the browse button under the Variable Name field and select
the relevant variable.

c. Click OK.

d. Select a respective class from the Class drop-down list. The
available classes are Class 0, Class 1, Class 2 and Class 3.
Selecting Class 1, 2 or 3 results in events being generated for
the address. Selecting Class 0 does not have events generated.

e. (Analog Inputs and Analog Outputs only) Modify the Dead Band.
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This determines how far a variable must move before a DNP3
event is recorded.

8. Repeat Step 5 to Step 7 for each data type.

9. Click Save.

Renaming a mapping table

ATTENTION: If the mapping table has been bound to
communication ports, renaming the mapping table will unbind
it from the ports automatically.

1. Select the target mapping table, and click the edit icon .

2. Enter the new name for this mapping table and click OK.

Deleting a mapping table

1. Select the target mapping table, and click .

2. Click Yes to delete the table.

Exporting a mapping table

1. Select the target mapping table, and click the export icon .

2. Enter the file name in the dialog provided and then click Save.
The exported .csv file with global variables is not immediately
editable in Microsoft Excel. If you want to edit it, first right-click
the column with variable name and select Format Cells. In the
Number tab, select Text and click OK.

Importing a mapping table
Before being imported , the variables should be created in IEC
Programming Workspace.

To import mapping addresses

1. Select the target mapping table, and click the import icon .

2. Select the target .csv file and click Open, a warning message
appears indicating that the imported variables will overwrite all the
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existing variables in the mapping table.
3. Click Yes to import the mapping table.
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CHAPTER

4 CONFIGURING MODULES AND CHANNELS

Configuring ControlEdge 2020 I/O modules
Configure the following channels for I/O modules.

n Eight Analog Input (HART) channels

n Two Analog Output (HART) channels

n Ten Digital Input channels

n Six Digital Output channels

n Two Pulse Input (High Speed) or Digital Input channels

Two PI channels can be configured as DI channels.

Adding an I/O module

1. From the Home Page, under I/O and Communications and click
Configure I/O.

2. Click Add I/O Module, the Add I/O Module dialog appears.

3. Select the Type, and set the IOM Scan Time for the I/O module. The
minimum IOM scan time of MIO28 Mixed SC-UMIX01 is 10 ms.
IOM scan time should be multiples of 10 and configured as one of
the following values: 10, 20, 30, 40, 50, 100, 150, 200, 250, 300,
350, 400, 450, 500, 1000, 2000 and 3000ms.
IOM scan time and task execution time should be set carefully. The
I/O data refresh time in a controller depends on the slower of the
IOM scan time and task execution time, so improper settings can
result in excessive overrun or tasks not being processed.
Additionally, Honeywell recommends configuring IOM scan time
and task execution time either as the same value, or as one being
an integral multiple of the other.

Table 4-1: Relationship between IOM scan time, task execution
time and I/O data refresh time
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IOM scan time (ms) Task execution time
(ms)

I/O data refresh
time (ms)

10 10 10

10 100 100

100 10 100

100 100 100

ATTENTION: When the task execution time is shorter than
the IOM scan time, all the delta time values will be ignored.
The value for the output channel is updated according the
IOM scan time.

4. Enter the Description and select the Address for the I/O module
which must be same as the rotary switch setting of the physical
device. The range of the address is from 1 to 99.

5. Click OK to complete the configuration.

Configuring Onboard I/O
From the Home Page, under the I/O and Communications, click
Configure I/O. Click Onboard I/O and you can view the five channels AI,
AO, DI, DO and PI. If the two PI channels are not enabled in the PI tab,
they can be used as 11th and 12th DI channels.

Configuring AI Channels

1. Click AI tab. The AI configuration parameters appear.

2. Select 50Hz or 60Hz from the AI Filtering drop-down list optionally.
The numerical value of AI filtering affects the response time of
enabled channels in the analog input module.

3. Select the channels to be used and configure the parameters as
required. See the following table for a description of each
parameter:

Parameter Description

Mode There are two options:

l Voltage

l Current
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Parameter Description

Raw Low
l If you select Voltage from the

Mode drop-down list, Raw Low
default value is 1.

l If you select Current from the
Mode drop-down list, Raw Low
default value is 4.

Raw High
l If you select Voltage from the

Mode drop-down list, Raw
High default value is 5.

l If you select Current from the
Mode drop-down list, Raw
High default value is 20.

HART Enable or Disable the HART
protocol.

EU Low1 EU Low default value is 0.

EU High1 EU High default value is 100.

EU Ex Low1 EU Ex Low default value is -10.

EU Ex High1 EU Ex High default value is 110.

EU Description (Optional) Enter Engineering Unit
description if it is required.

Note: Use the following algorithm to configure EU Low, EU High,
EU EX Low and EU EX High values to avoid warning messages.

l EU_EX _Low <= Fault Value <= EU_EX_High

l EU_EX _Low = EU_Low – (EU_High – EU_Low ) * 10%

l EU_EX_High = EU_High + (EU_High – EU_Low ) * 10%

l EU_EX _Low <= EU_Low < EU_High <= EU_EX_High

4. Bind I/O variables to physical I/O channels as follows:

a. For the target channel, click Bind.
The Select I/O Variable dialog appears. The available I/O
variables with data types compatible to the selected I/O
channel type are displayed automatically.
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b. If the required I/O variable exists in the list, select it and click
Bind. If the required I/O variable is not existing in the list, click
Add New Variable to create a new I/O variable. The Select I/O
Variable dialog appears.

c. Type the Name and Description, and then click Add.
The I/O variable is created and bound to the I/O channel
successfully.

d. Click Save.

e. Program the I/O variable optionally. See "Programming with
IEC 61131-3" on page 225 for more information.

5. (Optional)You can unbind I/O variables to physical I/O channels as
follows:

a. For the target channel, click Unbind. A warning message
appears that all the bound variables will be unbounded after
channel unbinding.

b. Click Yes to unbind the channel. Or you can click No to cancel
the procedure.

Configuring AO Channels

1. Click AO tab. The AO configuration parameters appear.

2. Select the channels to be used and configure the parameters as
required. See the following table for a description of each
parameter:

Parameter Description

Raw Low Raw Low default value is 4.

Raw High Raw High default value is 20.

HART Enable or Disable the HART protocol.

Fail Safe Output
Mode

There are two options:

l Hold Last Value

l Failsafe Value

TIP: Fail safe value will take
effective within two seconds once
the communication between I/O
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Parameter Description

module and controller fails.

User Config Output An appropriate value is needed for User
Config Output if the Fail Safe Output Mode
is selected as Failsafe Value.

EU Low1 EU Low default value is 0.

EU High1 EU High default value is 100.

EU Ex Low1 EU Ex Low default value is -10.

EU Ex High1 EU Ex High default value is 110.

EU Description (Optional) Enter Engineering Unit
description if it is required.

Note: Use the following algorithm to configure EU Low, EU High,
EU EX Low and EU EX High values to avoid warning messages.

l EU_EX _Low <= Fault Value <= EU_EX_High

l EU_EX _Low = EU_Low – (EU_High – EU_Low ) * 10%

l EU_EX_High = EU_High + (EU_High – EU_Low ) * 10%

l EU_EX _Low <= EU_Low < EU_High <= EU_EX_High

3. Bind I/O variables to physical I/O channels as follows:

a. For the target channel, click Bind.
The Select I/O Variable dialog appears. The available I/O
variables with data types compatible to the selected I/O
channel type are displayed automatically.

b. If the required I/O variable exists in the list, select it and click
Bind. If the required I/O variable is not existing in the list, click
Add New Variable to create a new I/O variable. The Select I/O
Variable dialog appears.

c. Type the Name and Description, and then click Add.
The I/O variable is created and bound to the I/O channel
successfully.

d. Click Save.
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e. Program the I/O variable optionally. See "Programming with
IEC 61131-3" on page 225 for more information.

4. (Optional)You can unbind I/O variables to physical I/O channels as
follows:

a. For the target channel, click Unbind. A warning message
appears that all the bound variables will be unbounded after
channel unbinding.

b. Click Yes to unbind the channel. Or you can click No to cancel
the procedure.

Configuring DI Channels

1. Click the DI tab. The DI configuration page appears.

2. Select the channels to be used and configure the parameters as
required. See the following table for a description of each
parameter:

Parameter Description

Direction There are two options:

l Direct: when a high level input is given to a DI
channel, the BOOL type DI value is TRUE; for a
low level input, it is FALSE.

l Reversed: when a high level input is given to a
DI channel, the BOOL type DI value is FALSE;
for a low level input, it is TRUE.

EU
Description

(Optional) Enter Engineering Unit description if it is
required.

State 0
Description

(Optional) Enter description if it is required.

State 1
Description

(Optional) Enter description if it is required.

3. Bind I/O variables to physical I/O channels as follows:

a. For the target channel, click Bind.
The Select I/O Variable dialog appears. The available I/O
variables with data types compatible to the selected I/O
channel type are displayed automatically.
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b. If the required I/O variable exists in the list, select it and click
Bind. If the required I/O variable is not existing in the list, click
Add New Variable to create a new I/O variable. The Select I/O
Variable dialog appears.

c. Type the Name and Description, and then click Add.
The I/O variable is created and bound to the I/O channel
successfully.

d. Click Save.

e. Program the I/O variable optionally. See "Programming with
IEC 61131-3" on page 225 for more information.

4. (Optional)You can unbind I/O variables to physical I/O channels as
follows:

a. For the target channel, click Unbind. A warning message
appears that all the bound variables will be unbounded after
channel unbinding.

b. Click Yes to unbind the channel. Or you can click No to cancel
the procedure.

Configuring DO Channels

1. Click DO tab. The DO configuration page appears.

2. Select the channels to be used and configure the parameters as
required. See the following table for a description of each
parameter:

Parameter Description

Direction There are two options:

l Direct: when a high level input is given to a DI
channel, the BOOL type DI value is TRUE; for a
low level input, it is FALSE.

l Reversed: when a high level input is given to a
DI channel, the BOOL type DI value is FALSE;
for a low level input, it is TRUE.

Fail Safe
Output
Mode

There are two options:

l Hold Last State
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Parameter Description

l Failsafe State

TIP: Fail safe value will take effective within
two seconds once the communication
between I/O module and controller fails.

User
Config
Output

An appropriate value is needed for User Config
Output if the Fail Safe Output Mode is selected as
Failsafe State.

EU
Description

(Optional) Enter Engineering Unit description if it is
required.

State 0
Description

(Optional) Enter description if it is required.

State 1
Description

(Optional) Enter description if it is required.

3. Bind I/O variables to physical I/O channels as follows:

a. For the target channel, click Bind.
The Select I/O Variable dialog appears. The available I/O
variables with data types compatible to the selected I/O
channel type are displayed automatically.

b. If the required I/O variable exists in the list, select it and click
Bind. If the required I/O variable is not existing in the list, click
Add New Variable to create a new I/O variable. The Select I/O
Variable dialog appears.

c. Type the Name and Description, and then click Add.
The I/O variable is created and bound to the I/O channel
successfully.

d. Click Save.

e. Program the I/O variable optionally. See "Programming with
IEC 61131-3" on page 225 for more information.

4. (Optional)You can unbind I/O variables to physical I/O channels as
follows:

a. For the target channel, click Unbind. A warning message
appears that all the bound variables will be unbounded after
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channel unbinding.

b. Click Yes to unbind the channel. Or you can click No to cancel
the procedure.

Configuring PI Channels

1. Click PI tab. The PI configuration page appears.

2. Select the channels to be used and enter the EU Description.

3. Bind I/O variables to physical I/O channels as follows:

a. For the target channel, click Bind.
The Select I/O Variable dialog appears. The available I/O
variables with data types compatible to the selected I/O
channel type are displayed automatically.

b. If the required I/O variable exists in the list, select it and click
Bind. If the required I/O variable is not existing in the list, click
Add New Variable to create a new I/O variable. The Select I/O
Variable dialog appears.

c. Type the Name and Description, and then click Add.
The I/O variable is created and bound to the I/O channel
successfully.

d. Click Save.

e. Program the I/O variable optionally. See "Programming with
IEC 61131-3" on page 225 for more information.

4. (Optional)You can unbind I/O variables to physical I/O channels as
follows:

a. For the target channel, click Unbind. A warning message
appears that all the bound variables will be unbounded after
channel unbinding.

b. Click Yes to unbind the channel. Or you can click No to cancel
the procedure.

Configuring Expansion I/O

1. From the Home Page, under I/O and Communications, click
Configure I/O.

2. Click the target expansion I/O, the five types of channel (AI, AO, DI,
DO and PI) are displayed as tabs. If the two PI channels are not
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enabled in the PI page, they can be enabled as 11th and 12th DI
channels.

3. Configure each of the I/O channels, See "Configuring Onboard
I/O" on page 66 for more information.

Configuring a third-party I/O, ST103A
The ST103A is an ultra-reliable data acquisition module that provides
I/O capabilities to controllers requiring high accuracy, or to fiscal or
custody transfer metering interfaces (e.g. Dual pulse fidelity
checking). The ST103A reads and updates its I/Os within 500 ms, and
provides external data access through a Modbus serial port.

While using ST103A as an I/O module, three cyclic tasks are created
during configuration:

o STTask: Reads the I/O from ST103A to the controller.

o AITask: Scales up AI channel inputs into engineering units and
determine its status.

o LiqTask: API 21.2 meter run task.

Prerequisites

Make sure ST103_DataTypes exists in the Data Types list. If not, you
should insert it manually.

1. From the IEC Programming Workspace, right-click Data Types,
and select Insert > Datatypes.

2. Enter the name ST103_DataTypes, and click OK.

To configure ST103A

1. From the Home Page, under I/O and Communications, click
Configure Third-Party I/O > ST103A.

2. Click Add ST103A Module. The Add I/O Module dialog appears.

3. Enter Description for ST103A module which will be a unique
identifier for binding with specific meter runs.

4. Select Slave ID for the drop-down list. The valid value is from 1 to
15.
The ST103A should be opened to set Slave ID and row 4 bit
switches will be available to configure the value from 1 to 15. See
"Configuring ST103A" in the ControlEdge 2020 Platform Hardware
Planning and Installation Guide for how to set Slave ID.
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ATTENTION: If there are other Modbus devices connected to
the same RS485 port along with ST103A, ensure that they
do not conflict with each other.

5. Select the port number, and provide values for Retries and Timeout.

Item Description

Port Number The physical interface of serial port connected:

3: RS 485 port 1

4: RS 485 port 2

Retries Retry times before it is classified as Failed.

The default value is 1.

Timeout The default value is 500 ms.

Timeout unit: millisecond.

6. Click OK to complete the configuration.

7. Only ST103A's analog input, pulse input, frequency and raw pulse
output can be configured via ControlEdge Builder. For more
information, see ST103A communication users manual.

Configuring AI channels

1. Click AI tab, and select the channel to be used.

2. Configure the parameters as required. See the following table for a
description of each parameter:

Parameter Description

Mode There are two options:

l Voltage

l Current

See "Configuring ST103A" in the
ControlEdge 2020 Platform Hardware
Planning and Installation Guide for
how to set AI channels in
Voltage/Current mode.
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Parameter Description

Raw Low
l If you select Voltage from the

Mode drop-down list, Raw Low
default value is 1.

l If you select Current from the
Mode drop-down list, Raw Low
default value is 4.

Raw High
l If you select Voltage from the

Mode drop-down list, Raw High
default value is 5.

l If you select Current from the
Mode drop-down list, Raw High
default value is 20.

EU Low1 EU Low default value is 0.

EU High1 EU High default value is 100.

EU Ex Low1 EU Ex Low default value is -10.

EU Ex High1 EU Ex High default value is 110.

EU Description (Optional) Enter Engineering Unit
description if it is required.

Note: Use the following algorithm to configure EU Low, EU High,
EU EX Low and EU EX High values to avoid warning messages.

l EU_EX _Low <= Fault Value <= EU_EX_High

l EU_EX _Low = EU_Low – (EU_High – EU_Low ) * 10%

l EU_EX_High = EU_High + (EU_High – EU_Low ) * 10%

l EU_EX _Low <= EU_Low < EU_High <= EU_EX_High

3. Bind I/O variables to physical I/O channels as follows:

a. For the target channel, click Bind.
The Select I/O Variable dialog appears. The available I/O
variables with data types compatible to the selected I/O
channel type are displayed automatically.

b. If the required I/O variable exists in the list, select it and click
Bind. If the required I/O variable is not existing in the list, click
Add New Variable to create a new I/O variable. The Select I/O
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Variable dialog appears.

c. Type the Name and Description, and then click Add.
The I/O variable is created and bound to the I/O channel
successfully.

d. Click Save.

4. (Optional)You can unbind I/O variables to physical I/O channels as
follows:

a. For the target channel, click Unbind. A warning message
appears that all the bound variables will be unbounded after
channel unbinding.

b. Click Yes to unbind the channel. Or you can click No to cancel
the procedure.

Configuring PI channels

1. Click PI tab, and select A, B or E for Pulse Fidelity Level.
In order to reduce uncertainty in the flow measurement, dual
pulse streams from flow meters will be checked against each
other to determine missed or added pulses, pulse phase,
frequency and alarm/error generation of any abnormality and
correction according to API MPMS 5.5 or ISO 6551 standards.
ST103A supports:

l A: Level A consists of continuous monitoring and verification
and correction by methods of comparison of pulse streams.

l B: Level B consists of continuous monitoring, error indication
and alarm signaling by methods of comparison of pulse
streams.

l E: Level E consists of no error checking and will be similar to 2
individual independent pulse streams.

When Pulse fidelity Level A/B is configured, 2 pulse streams from
pulse input channel 1 and 2 will be used for fidelity checking and
only one binding variable as output can be bound and configured
with single meter run.
When Level E is configured, both pulse input channel 1 and 2 can
be independently bound to 2 variables and configured to two
meter runs.

2. Select the channels to be used and click Bind.
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The Select I/O Variable dialog appears. The available I/O variables
with data types compatible to the selected I/O channel type are
displayed automatically.

3. If the required I/O variable exists in the list, select it and click Bind.
If the required I/O variable is not existing in the list, click Add New
Variable to create a new I/O variable. The Select I/O Variable dialog
appears.

4. Type the Name and Description, and then click Add.
The I/O variable is created and bound to the I/O channel
successfully.

5. Click Save.

6. (Optional)You can unbind I/O variables to physical I/O channels as
follows:

a. For the target channel, click Unbind. A warning message
appears that all the bound variables will be unbounded after
channel unbinding.

b. Click Yes to unbind the channel. Or you can click No to cancel
the procedure.

Configuring Frequency channels

ST103A can be configured to read frequency directly from
densitometers like Micro Motion Coriolis meter, Micro Motion
7835/7845, UGC, Sarasota and ITT Barton densitometer in
ControlEdge 2020 controller. The conversion of observed or
measured density from frequency needs to be done as part of project
engineering activity based on formulas provided by the
manufacturers. The API 21.2 function blocks expects to be configured
with measured density value along with status value. The ST103A
device status connection can be used with other logics to determine
final status value presented to API 21.2 function block.

1. Click Frequency tab, and select the channel to be used.

2. Click Bind.
The Select I/O Variable dialog appears. The available I/O variables
with data types compatible to the selected I/O channel type are
displayed automatically.

3. If the required I/O variable exists in the list, select it and click Bind.
If the required I/O variable is not existing in the list, click Add New
Variable to create a new I/O variable. The Select I/O Variable dialog
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appears.

4. Type the Name and Description, and then click Add.
The I/O variable is created and bound to the I/O channel
successfully.

5. Click Save.

6. (Optional)You can unbind I/O variables to physical I/O channels as
follows:

a. For the target channel, click Unbind. A warning message
appears that all the bound variables will be unbounded after
channel unbinding.

b. Click Yes to unbind the channel. Or you can click No to cancel
the procedure.

Configuring PO channels

1. Click PO tab, and select the channel to be used.

2. Select A or B for the Pulse Channel Selection. It detemines which
pulse stream from channles (A/B) should be selected from the
meter run to provide input to Prover to support proving process.

l A - Pulse input channel 1

l B - Pulse input channel 2

Configuring ControlEdge 900 I/O modules

Adding an I/O module

1. From the Home Page, under I/O and Communications, click
Configure Modules > Configure I/O Modules.

2. Click Add I/O Module, the Add I/O Module dialog appears.

3. Select the Type, assign the Rack and Slot, and set the IOM Scan Time
for the module.
See the following table for the parameter descriptions:

Parameter Description

Type I/O module type:
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Parameter Description

l UIO16 900U01: Universal Input/Output Module
(UIO Module), 16 Channel

l UAI08 900A01: Universal Analog Input -RTD,
TC, V, 8 Channel

l AI16 mA/V 900A16: Analog Input, 16 Channel

l AO04 900B01: Analog Output, 4 Channel

l AO08 900B08: Analog Output, 8 Channel

l DI16 AC 900G03: Digital Input, 120/240 VAC,
16 Channel

l DI32 DC 900G32: Digital Input, 24 VDC, 32
Channel

l DI16 Contact 900G01: Digital Input, 16
Channel

l DI-HV16 900G04: Digital Input, High voltage,
16 Channel

l DO08 AC 900H03: Digital Output, 120/240 VAC
8 Channel

l DO32 DC 900H32: Digital Output, 24 VDC 32
Channel

l DO08 Relay 900H01: Digital Output, 8 Channel

l SF04 PFQ 900K01: Pulse & Frequency Input,
Pulse Output, 4 Channel

Rack Rack address:

l If controller redundancy is enabled, the rack
address range is from 1 to 99.

l If controller redundancy is disabled, the rack
address range is from 0 to 99. 0 is only for the
local I/O rack.

l For an expansion I/O rack, the address must be
the same with the EPM address configured on
1x and 10x rotary switches.

For details about the rotary switches, see
“Assembling I/O racks” in the ControlEdge 900
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Parameter Description

Controller Hardware Planning and Installation
Guide.

Slot Slot number: the location of the I/O module mounted
in the rack

l If the I/O module is installed in a 4-slot rack, the
slot number is ranging from 1 to 4.

l If the I/O module is installed in an 8-slot rack,
the slot number is ranging from 1 to 8.

l If the I/O module is installed in a 12-slot rack,
the slot number is ranging from 1 to 12.

IOM Scan
Time

IOM scan time: the time interval for refreshing I/O
module data.

IOM scan time should be multiples of 10 and
configured as one of the following values: 10, 20, 30,
40, 50, 100, 150, 200, 250, 300, 350, 400, 450, 500,
1000, 2000 and 3000ms.

IOM scan time and task execution time should be set
carefully. The I/O data refresh time in a controller
depends on the slower of the IOM scan time and task
execution time, so improper settings can result in
excessive overrun or tasks not being processed.
Additionally, Honeywell recommends configuring
IOM scan time and task execution time either as the
same value, or as one being an integral multiple of
the other.

See the following table for examples of the
relationship between IOM scan time, task execution
time and I/O data refresh time.

The minimum IOM scan time for every I/O module is:

l UIO16 900U01: 10ms

l UAI08 900A01: 500ms

l AI16 mA/V 900A16: 100ms

l AO04 900B01: 500ms
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l AO08 900B08: 500ms

l DI16 AC 900G03: 10ms

l DI32 DC 900G32: 10ms

l DI16 Contact 900G01: 10ms

l DI-HV16 900G04: 10ms

l DO08 AC 900H03: 10ms

l DO32 DC 900H32: 10ms

l DO08 Relay 900H01: 10ms

l SF04 PFQ 900K01: 10ms

ATTENTION: For PFQ module, IOM scan
time must be lower than task execution time.

Table 4-2: Relationship between IOM scan time, task execution
time and I/O data refresh time

IOM scan time (ms) Task execution time
(ms)

I/O data refresh
time (ms)

10 10 10

10 100 100

100 10 100

100 100 100

ATTENTION: When the task execution time is shorter than
the IOM scan time, all the delta time values will be ignored.
The value for the output channel is updated according the
IOM scan time.

4. Click OK to complete the configuration.

Configuring Universal Input/Output modules (UIO16
900U01)
From the Home Page, under the I/O and Communications, click
Configure Modules > Configure I/O Modules. Select the target Universal
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Input/Output (UIO) module, and double-click the field under Type for
the target channel to configure the channel type. There are four types
can be selected: AI, AO, DI, and DO.

Configuring Analog Input channels

1. Select an AI channel. The AI configuration parameters appear.

2. Configure the parameters as required. See the following table for a
description of each parameter:

Parameter Description

Sensor Type There are two options:

l 0-20mA

l 4-20mA

Open Wire
Detection

Select the checkbox to enable Open Wire
Detection. It is only available when the sensor
type is 4-20mA.

For more information about Open Wire
Detection, see “UIO module wiring” in the
ControlEdge 900 Controller Hardware
Planning and Installation Guide.

Short Circuit
Detection

Select the checkbox to enable Short Circuit
Detection.

HART To enable or disable the HART protocol

EU Low1 EU Low default value is 0.00.

EU High1 EU High default value is 100.00.

EU Ex Low1
l It is not configurable for 0-20mA.

l The default value is -10.00 for 4-20mA.

EU Ex High1 EU Ex High default value is 110.00.

EU Description (Optional) Enter Engineering Unit
description if it is required.

Note 1: Use the following algorithm to configure EU Low, EU
High, EU EX Low and EU EX High values to avoid warning
messages.

Chapter 4 - Configuring modules and channels



Parameter Description

l EU_EX _Low <= Fault Value <= EU_EX_High

l EU_EX _Low = EU_Low – (EU_High – EU_Low ) * 10%

l EU_EX_High = EU_High + (EU_High – EU_Low ) * 10%

l EU_EX _Low <= EU_Low < EU_High <= EU_EX_High

3. Bind I/O variables to physical I/O channels as follows:

a. For the target channel, click Bind.
The Select I/O Variable dialog appears. The available I/O
variables with data types compatible to the selected I/O
channel type are displayed automatically.

b. If the required I/O variable exists in the list, select it and click
Bind. If the required I/O variable is not existing in the list, click
Add New Variable to create a new I/O variable. The Select I/O
Variable dialog appears.

c. Type the Name and Description, and then click Add.
The I/O variable is created and bound to the I/O channel
successfully.

d. Click Save.

e. Program the I/O variable optionally. See "Programming with
IEC 61131-3" on page 225 for more information.

4. (Optional)You can unbind I/O variables to physical I/O channels as
follows:

a. For the target channel, click Unbind. A warning message
appears that all the bound variables will be unbounded after
channel unbinding.

b. Click Yes to unbind the channel. Or you can click No to cancel
the procedure.

Configuring Analog Output channels

1. Select an AO channel. The AO configuration parameters appear.

2. Configure the parameters as required. See the following table for a
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description of each parameter:

Parameter Description

Sensor Type 4-20mA

HART To enable or disable the HART protocol

Open Wire
Detection

Select the checkbox to enable Open Wire
Detection. It is only available when the sensor
type is 4-20mA.

For more information about Open Wire
Detection, see “UIO module wiring” in the
ControlEdge 900 Controller Hardware
Planning and Installation Guide.

Fail Safe Output
Mode

There are two options:

l Hold Last Value

l Failsafe Value

Failsafe Value An appropriate value is needed if the Fail Safe
Output Mode is selected as Failsafe Value.

EU Low1 EU Low default value is 0.00.

EU High1 EU High default value is 100.00.

EU Ex Low1
l It is not configurable for 0-20mA.

l The default value is -10.00 for 4-20mA.

EU Ex High1 EU Ex Low default value is 110.00.

EU Description (Optional) Enter Engineering Unit
description if it is required.

Note: Use the following algorithm to configure EU Low, EU High,
EU EX Low and EU EX High values to avoid warning messages.

l EU_EX _Low <= Fault Value <= EU_EX_High

l EU_EX _Low = EU_Low – (EU_High – EU_Low ) * 10%

l EU_EX_High = EU_High + (EU_High – EU_Low ) * 10%

l EU_EX _Low <= EU_Low < EU_High <= EU_EX_High

3. Bind I/O variables to physical I/O channels as follows:
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a. For the target channel, click Bind.
The Select I/O Variable dialog appears. The available I/O
variables with data types compatible to the selected I/O
channel type are displayed automatically.

b. If the required I/O variable exists in the list, select it and click
Bind. If the required I/O variable is not existing in the list, click
Add New Variable to create a new I/O variable. The Select I/O
Variable dialog appears.

c. Type the Name and Description, and then click Add.
The I/O variable is created and bound to the I/O channel
successfully.

d. Click Save.

e. Program the I/O variable optionally. See "Programming with
IEC 61131-3" on page 225 for more information.

4. (Optional)You can unbind I/O variables to physical I/O channels as
follows:

a. For the target channel, click Unbind. A warning message
appears that all the bound variables will be unbounded after
channel unbinding.

b. Click Yes to unbind the channel. Or you can click No to cancel
the procedure.

Configuring Digital Input channels

1. Select a DI channel. The DI configuration parameters appear.

2. Configure the parameters as required. See the following table for a
description of each parameter:

Parameter Description

Direction There are two options:

l Direct: when a high level input is given to a DI
channel, the BOOL type DI value is TRUE; for a
low level input, it is FALSE.

l Reversed: when a high level input is given to a
DI channel, the BOOL type DI value is FALSE;
for a low level input, it is TRUE.

De-bounce For Channels that are configured with a de-bounce,
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Parameter Description

Time the UIO will declare that the channel has changed
state if all the consecutive samples are in the new
state for the configured de-bounce time period.

It ranges from 0.00 to 50.00 and its default value is
0.00.

For example, if a DI has been 0 and transitions
(without noise) to a 1 then the UIO detects that
transition and needs the input to stay in the new
state for the configured de-bounce time to declare
the new state as 1. If the signal is noisy, then the
counting process starts anew each time the DI
leaves the 0 state until it achieves the new state for
consecutive samples.

State 0
Description

(Optional) Enter description if it is required.

State 1
Description

(Optional) Enter description if it is required.

Open Wire
Detection

Select the checkbox to enable Open Wire Detection.

For more information about Open Wire Detection,
see “UIO module wiring” in the ControlEdge 900
Controller Hardware Planning and Installation Guide.

Short
Circuit
Detection

Select the checkbox to enable Short Circuit
Detection.

3. Bind I/O variables to physical I/O channels as follows:

a. For the target channel, click Bind.
The Select I/O Variable dialog appears. The available I/O
variables with data types compatible to the selected I/O
channel type are displayed automatically.

b. If the required I/O variable exists in the list, select it and click
Bind. If the required I/O variable is not existing in the list, click
Add New Variable to create a new I/O variable. The Select I/O
Variable dialog appears.

c. Type the Name and Description, and then click Add.
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The I/O variable is created and bound to the I/O channel
successfully.

d. Click Save.

e. Program the I/O variable optionally. See "Programming with
IEC 61131-3" on page 225 for more information.

4. (Optional)You can unbind I/O variables to physical I/O channels as
follows:

a. For the target channel, click Unbind. A warning message
appears that all the bound variables will be unbounded after
channel unbinding.

b. Click Yes to unbind the channel. Or you can click No to cancel
the procedure.

Configuring Digital Output channels

1. Select a DO channel. The DO configuration parameters appear.

2. Configure the parameters as required. See the following table for a
description of each parameter:

Parameter Description

Direction There are two options:

l Direct: when a high level input is given to a DI
channel, the BOOL type DI value is TRUE; for a
low level input, it is FALSE.

l Reversed: when a high level input is given to a
DI channel, the BOOL type DI value is FALSE;
for a low level input, it is TRUE.

Fail Safe
Output
Mode

There are two options:

l Hold Last State

l Failsafe State

Failsafe
State

An appropriate value is needed if the Fail Safe Output
Mode is selected as Failsafe State.

State 0
Description

(Optional) Enter description if it is required.

State 1 (Optional) Enter description if it is required.
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Parameter Description

Description

Open Wire
Detection

Select the checkbox to enable Open Wire Detection.

For more information about Open Wire Detection,
see “UIO module wiring” in the ControlEdge 900
Controller Hardware Planning and Installation Guide.

Short
Circuit
Detection

Select the checkbox to enable Short Circuit
Detection.

3. Bind I/O variables to physical I/O channels as follows:

a. For the target channel, click Bind.
The Select I/O Variable dialog appears. The available I/O
variables with data types compatible to the selected I/O
channel type are displayed automatically.

b. If the required I/O variable exists in the list, select it and click
Bind. If the required I/O variable is not existing in the list, click
Add New Variable to create a new I/O variable. The Select I/O
Variable dialog appears.

c. Type the Name and Description, and then click Add.
The I/O variable is created and bound to the I/O channel
successfully.

d. Click Save.

e. Program the I/O variable optionally. See "Programming with
IEC 61131-3" on page 225 for more information.

4. (Optional)You can unbind I/O variables to physical I/O channels as
follows:

a. For the target channel, click Unbind. A warning message
appears that all the bound variables will be unbounded after
channel unbinding.

b. Click Yes to unbind the channel. Or you can click No to cancel
the procedure.
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Configuring DI modules (DI16 AC 900G03, DI32 DC
900G32 , DI16 Contact 900G01, DI-HV16 900G04)

1. From the Home Page, under I/O and Communications, click
Configure Modules > Configure I/O Modules. Select the target DI
module.

2. Select a DI channel and configure the parameters as required. See
the following table for a description of each parameter:

Parameter Description

Direction There are two options:

l Direct: when a high level input is given to a DI
channel, the BOOL type DI value is TRUE; for a
low level input, it is FALSE.

l Reversed: when a high level input is given to a
DI channel, the BOOL type DI value is FALSE;
for a low level input, it is TRUE.

State 0
Description

(Optional) Enter description if it is required.

State 1
Description

(Optional) Enter description if it is required.

3. Bind I/O variables to physical I/O channels as follows:

a. For the target channel, click Bind.
The Select I/O Variable dialog appears. The available I/O
variables with data types compatible to the selected I/O
channel type are displayed automatically.

b. If the required I/O variable exists in the list, select it and click
Bind. If the required I/O variable is not existing in the list, click
Add New Variable to create a new I/O variable. The Select I/O
Variable dialog appears.

c. Type the Name and Description, and then click Add.
The I/O variable is created and bound to the I/O channel
successfully.

d. Click Save.

e. Program the I/O variable optionally. See "Programming with
IEC 61131-3" on page 225 for more information.

4. (Optional)You can unbind I/O variables to physical I/O channels as
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follows:

a. For the target channel, click Unbind. A warning message
appears that all the bound variables will be unbounded after
channel unbinding.

b. Click Yes to unbind the channel. Or you can click No to cancel
the procedure.

Configuring DO modules (DO08 AC 900H03, DO32
DC 900H32 , DO08 Relay 900H01)

1. From the Home Page, under I/O and Communications, click
Configure Modules > Configure I/O Modules. Select the target DO
module.

2. Select an DO channel and configure the parameters as required.
See the following table for a description of each parameter:

Parameter Description

Direction There are two options:

l Direct: when a high level input is given to a DI
channel, the BOOL type DI value is TRUE; for a
low level input, it is FALSE.

l Reversed: when a high level input is given to a
DI channel, the BOOL type DI value is FALSE;
for a low level input, it is TRUE.

Fail Safe
Output
Mode

There are two options:

l Hold Last State

l Failsafe State

Failsafe
State

An appropriate value is needed if the Fail Safe Output
Mode is selected as Failsafe State.

State 0
Description

(Optional) Enter description if it is required.

State 1
Description

(Optional) Enter description if it is required.

3. Bind I/O variables to physical I/O channels as follows:
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a. For the target channel, click Bind.
The Select I/O Variable dialog appears. The available I/O
variables with data types compatible to the selected I/O
channel type are displayed automatically.

b. If the required I/O variable exists in the list, select it and click
Bind. If the required I/O variable is not existing in the list, click
Add New Variable to create a new I/O variable. The Select I/O
Variable dialog appears.

c. Type the Name and Description, and then click Add.
The I/O variable is created and bound to the I/O channel
successfully.

d. Click Save.

e. Program the I/O variable optionally. See "Programming with
IEC 61131-3" on page 225 for more information.

4. (Optional)You can unbind I/O variables to physical I/O channels as
follows:

a. For the target channel, click Unbind. A warning message
appears that all the bound variables will be unbounded after
channel unbinding.

b. Click Yes to unbind the channel. Or you can click No to cancel
the procedure.

Configuring Universal Analog Input modules (UAI08
900A01)
The Universal Analog Input module has eight inputs, which can
include any combination of the following

1. From the Home Page, under I/O and Communications, click
Configure Modules > Configure I/O Modules. Select the target
Universal Analog Input module.

2. Select an UAI channel and configure the parameters as required.
See the following table for a description of each parameter:

Parameter Description

Sensor
Group

There are four options:

l T/C: Thermocouple is a sensor used to
measure temperature.
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Parameter Description

l RTD: Resistance Temperature Detector is a
sensor used to determine the temperature by
measuring the resistance of pure electrical
wire.

l Linear: Linear converts analog input value to
corresponding output in units based on a
linear 0 to 100% scale and specified high and
low range values.

l Special:

o Carbon

o Oxygen

Sensor
Type

Select the target sensor type after you select the
sensor group.

Filter Time A software digital filter is provided for the input
designated to smooth the input. You can configure
the first order lag time constant from 1.00 to 120.00
seconds.

The default value is 0.00.

0.00 = no filter

Bias Bias is used to compensate the input for drift of an
input value due to deterioration of a sensor, or some
other cause, ranging from -9999.00 to 9999.00.

The default value is 0.00.

EU Low For T/C or RTD - EU Low is implied by the sensor
type.

For Linear - output value that corresponds to 0 %
input value

For example:

Actuation Input = 4-20mA

Process variable = Flow

Range of Flow = 0 to 250 gal/min
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Parameter Description

High Range Display Value = 250

Low range Display Value = 0

Then 20mA = 250, 4mA = 0

EU High For T/C or RTD - EU High is implied by the sensor
type.

For Linear - output value that corresponds to 100 %
input value

For example: See "EU Low" above.

EU
Description

(Optional) For Linear Only. Enter Engineering Unit
description if it is required.

Burnout
l DownScale: Value set at "EU Low" field

l UpScale: Value set at "EU High" field

l UserValue: Use the value entered in the
appropriate field, ranging from EU Low to EU
High.

l None: Value set at "EU Low" field

User Value Enter the appropriate value, ranging from EU Low to
EU High.

Enable RCJ It is used only for Thermocouples when the
thermocouple Cold Junction is in a remote location.

Check or Uncheck the Enable RCJ checkbox.

If the Enable RCJ checkbox is selected, click the
browser icon to select an I/O variable.

3. Bind I/O variables to physical I/O channels as follows:

a. For the target channel, click Bind.
The Select I/O Variable dialog appears. The available I/O
variables with data types compatible to the selected I/O
channel type are displayed automatically.

b. If the required I/O variable exists in the list, select it and click
Bind. If the required I/O variable is not existing in the list, click
Add New Variable to create a new I/O variable. The Select I/O
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Variable dialog appears.

c. Type the Name and Description, and then click Add.
The I/O variable is created and bound to the I/O channel
successfully.

d. Click Save.

e. Program the I/O variable optionally. See "Programming with
IEC 61131-3" on page 225 for more information.

4. (Optional)You can unbind I/O variables to physical I/O channels as
follows:

a. For the target channel, click Unbind. A warning message
appears that all the bound variables will be unbounded after
channel unbinding.

b. Click Yes to unbind the channel. Or you can click No to cancel
the procedure.

Configuring AI modules (AI16 mA/V 900A16)

1. From the Home Page, under I/O and Communications, click
Configure Modules > Configure I/O Modules. Select the target AI
module.

2. Select an AI channel and configure the parameters as required.
See the following table for a description of each parameter:

Parameter Description

Sensor Type Select the target sensor type.

EU Low Output value that corresponds to 0 % input
value

For example:

Actuation Input = 4-20mA

Process variable = Flow

Range of Flow = 0 to 250 gal/min

High Range Display Value = 250

Low range Display Value = 0

Then 20mA = 250, 4mA = 0
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Parameter Description

EU High Output value that corresponds to 100 % input
value

For example: See "EU Low" above.

EU Ex Low
l It is not configurable for 0-20mA.

l The default value is -10.00 for 4-20mA.

EU Ex High EU Ex High default value is 110.00.

EU Description (Optional) Enter Engineering Unit description
if it is required.

Filter Time(sec) A software digital filter is provided for the
input designated to smooth the input. You
can configure the first order lag time constant
from 1.00 to 120.00 seconds.

The default value is 0.00.

0.00 = no filter

Bias Bias is used to compensate the input for drift
of an input value due to deterioration of a
sensor, or some other cause, ranging from -
9999.00 to 9999.00.

The default value is 0.00.

Sensor Type Option name shown in
the “Sensor Type”
dropdown list

PV Input
Range

Reference
Accuracy

Low High

mA 4-20 mA 4 20 ± 0.2%
F.S. (mA)*

mA 0-20 mA 0 20 ± 0.2%
F.S. (mA)*

Volts 0-1 V 0 1 ± 0.1%
F.S. (mV)

Volts 0-2 V 0 2 ± 0.1%
F.S. (mV)

Volts 0-5 V 0 5 ± 0.1%
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F.S. (mV)

Volts 0-10 V 0 10 ± 0.2%
F.S. (mV)

Volts -1-1 V -1 1 ± 0.1%
F.S. (mV)

Volts -2-2 V -2 2 ± 0.1%
F.S. (mV)

Volts -5-5 V -5 5 ± 0.1%
F.S. (mV)

Volts -10-10 V -10 10 ± 0.2%
F.S. (mV)

*Tolerances for these input types include that of the external
Dropping Resistors.

3. Bind I/O variables to physical I/O channels as follows:

a. For the target channel, click Bind.
The Select I/O Variable dialog appears. The available I/O
variables with data types compatible to the selected I/O
channel type are displayed automatically.

b. If the required I/O variable exists in the list, select it and click
Bind. If the required I/O variable is not existing in the list, click
Add New Variable to create a new I/O variable. The Select I/O
Variable dialog appears.

c. Type the Name and Description, and then click Add.
The I/O variable is created and bound to the I/O channel
successfully.

d. Click Save.

e. Program the I/O variable optionally. See "Programming with
IEC 61131-3" on page 225 for more information.

4. (Optional)You can unbind I/O variables to physical I/O channels as
follows:

a. For the target channel, click Unbind. A warning message
appears that all the bound variables will be unbounded after
channel unbinding.
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b. Click Yes to unbind the channel. Or you can click No to cancel
the procedure.

Configuring AO modules (AO04 900B01, AO08
900B08)

1. From the Home Page, under I/O and Communications, click
Configure Modules > Configure I/O Modules. Select the target AO
module.

2. Select an AO channel and configure the parameters as required.
See the following table for a description of each parameter:

Parameter Description

Sensor Type 0-20mA or 4-20mA

EU Low EU Low default value is 0.00.

EU High EU High default value is 100.00.

EU Ex Low
l It is not configurable for 0-20mA.

l The default value is -10.00 for 4-20mA.

EU Ex High EU Ex Low default value is 110.00.

EU Description (Optional) Enter Engineering Unit description
if it is required.

Failsafe Output
Mode

There are two options:

l Hold Last Value

l Failsafe Value

Failsafe Value An appropriate value is needed if the Fail Safe
Output Mode is selected as Failsafe Value.

3. Bind I/O variables to physical I/O channels as follows:

a. For the target channel, click Bind.
The Select I/O Variable dialog appears. The available I/O
variables with data types compatible to the selected I/O
channel type are displayed automatically.

b. If the required I/O variable exists in the list, select it and click
Bind. If the required I/O variable is not existing in the list, click
Add New Variable to create a new I/O variable. The Select I/O
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Variable dialog appears.

c. Type the Name and Description, and then click Add.
The I/O variable is created and bound to the I/O channel
successfully.

d. Click Save.

e. Program the I/O variable optionally. See "Programming with
IEC 61131-3" on page 225 for more information.

4. (Optional)You can unbind I/O variables to physical I/O channels as
follows:

a. For the target channel, click Unbind. A warning message
appears that all the bound variables will be unbounded after
channel unbinding.

b. Click Yes to unbind the channel. Or you can click No to cancel
the procedure.

Configuring PFQ modules (SF04 PFQ 900K01)

1. From the Home Page, under I/O and Communications, click
Configure Modules > Configure I/O Modules. Select the target PFQ
module.

2. Select a channel and double-click the field under Type for the
target channel to configure the channel type. There are three types
can be selected: PI, FI and PO.

Configuring Pulse Input channels

1. Select a PI channel. The PI configuration parameters appear.

2. Configure the parameters as required. See the following table for a
description of each parameter:

Parameter Description

Pulse per EU It measures quantity by scaling the
number of pulses to engineering units
(EU) .

Sample Time (0.5s) Enter sample time period for the average
rate calculation.

Time period Time unit used to scale the rate
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Parameter Description

Preset There are two options:

l User Value

l Variable: when variable is selected, the
variable should be picked from the
menu below.

User Value When User Value is selected, this option
scan is enabled. The default value is 0.00.

Preset Output Action Momentary: The PFQ module output pin
turns ON for 1 second.

Latched Until Reset: The PFQ module
output pin latches ON until reset.

3. Bind I/O variables to physical I/O channels as follows:

a. For the target channel, click Bind.
The Select I/O Variable dialog appears. The available I/O
variables with data types compatible to the selected I/O
channel type are displayed automatically.

b. If the required I/O variable exists in the list, select it and click
Bind. If the required I/O variable is not existing in the list, click
Add New Variable to create a new I/O variable. The Select I/O
Variable dialog appears.

c. Type the Name and Description, and then click Add.
The I/O variable is created and bound to the I/O channel
successfully.

d. Click Save.

e. Program the I/O variable optionally. See "Programming with
IEC 61131-3" on page 225 for more information.

4. (Optional)You can unbind I/O variables to physical I/O channels as
follows:

a. For the target channel, click Unbind. A warning message
appears that all the bound variables will be unbounded after
channel unbinding.

b. Click Yes to unbind the channel. Or you can click No to cancel
the procedure.
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Configuring Frequency Input channels

1. Select a FI channel. The FI configuration parameters appear.

2. Configure the parameters as required. See the following table for
the description of each parameter:

Parameter Description

Pulse Width There are three options:

l 500μs(10Hz-500Hz)

l 50μs(10Hz-5KHz)

l 2.5μs(10Hz-100KHz)

The input signal is rejected if it is below
this pulse width. The frequency of pulses
above this width must be in this
frequency range; otherwise the output
goes to failsafe and a failure-to-convert
error occurs.

Filter Time (sec) A software digital filter is provided for the
input designated to smooth the input.
You can configure the first order lag time
constant from 1.00 to 120.00 seconds.

The default value is 0.00.

0.00 = no filter

Bias Bias is used to compensate the input for
drift of an input value due to
deterioration of a sensor, or some other
cause, ranging from -9999.00 to
9999.00.

The default value is 0.00.

Low Input(Hz) Low frequency value of the input device.
Exceeding this limit causes an under -
range error.

High Input(Hz) High frequency value of the input device.
Exceeding this limit causes an under -
range error.
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Parameter Description

EU Low EU Low default value is 0.00.

EU High EU High default value is 100.00.

3. Bind I/O variables to physical I/O channels as follows:

a. For the target channel, click Bind.
The Select I/O Variable dialog appears. The available I/O
variables with data types compatible to the selected I/O
channel type are displayed automatically.

b. If the required I/O variable exists in the list, select it and click
Bind. If the required I/O variable is not existing in the list, click
Add New Variable to create a new I/O variable. The Select I/O
Variable dialog appears.

c. Type the Name and Description, and then click Add.
The I/O variable is created and bound to the I/O channel
successfully.

d. Click Save.

e. Program the I/O variable optionally. See "Programming with
IEC 61131-3" on page 225 for more information.

4. (Optional)You can unbind I/O variables to physical I/O channels as
follows:

a. For the target channel, click Unbind. A warning message
appears that all the bound variables will be unbounded after
channel unbinding.

b. Click Yes to unbind the channel. Or you can click No to cancel
the procedure.

Configuring Pulse Output channels

1. Select a PO channel. The PO configuration parameters appear.

2. Configure the parameters as required. See the following table for a
description of each parameter:

Parameter Description

Failsafe Output
Mode

l Immediate Low

l Finish Pulse
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Parameter Description

Frequency(Hz) The number of outputs per second, ranging
from 25 to 10000.

Pulse Width(ms) The input signal is rejected if it is below this
pulse width. The frequency of pulses above
this width must be in this frequency range;
otherwise the output goes to failsafe and a
failure-to-convert error occurs.

3. Bind I/O variables to physical I/O channels as follows:

a. For the target channel, click Bind.
The Select I/O Variable dialog appears. The available I/O
variables with data types compatible to the selected I/O
channel type are displayed automatically.

b. If the required I/O variable exists in the list, select it and click
Bind. If the required I/O variable is not existing in the list, click
Add New Variable to create a new I/O variable. The Select I/O
Variable dialog appears.

c. Type the Name and Description, and then click Add.
The I/O variable is created and bound to the I/O channel
successfully.

d. Click Save.

e. Program the I/O variable optionally. See "Programming with
IEC 61131-3" on page 225 for more information.

4. (Optional)You can unbind I/O variables to physical I/O channels as
follows:

a. For the target channel, click Unbind. A warning message
appears that all the bound variables will be unbounded after
channel unbinding.

b. Click Yes to unbind the channel. Or you can click No to cancel
the procedure.

5. (Optional) For PO channel, the controller only sends the command
to PFQ module once, and the module will continuously output
pulses even the eCLR is stopped. In this case, if you want to stop
outputting pulses when the eCLR is stopped, you can configure a
process to check the eCLR states and send a stop command to the
PFQ module.
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a. From the IEC Programming Workspace, create a System task,
and set System Event as Stop.

b. Create a new POU and set PO.ENABLE as 0.

c. Associate the POU to the task.

Configuring ControlEdge 900 communication
modules

Configuring serial modules
The section introduces how to add and configure a serial
communication module. Up to six serial modules can be added.

1. From the Home Page, under I/O and Communications, click
Configure Modules > Configure Serial Modules.

2. Click Add Serial Module, the Add Serial Module dialog appears.

3. Select the Type, assign the Rack and Slot for the module.
See the following table for the parameter descriptions:

Parameter Description

Type Serial module type: 900ES1: Serial Comm

Rack Rack address:

l If controller redundancy is enabled, the rack
address range is from 1 to 99.

l If controller redundancy is disabled, the rack
address range is from 0 to 99. 0 is only for the
local I/O rack.

l For an expansion I/O rack, the address must be
the same with the EPM address configured on
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Parameter Description

1x and 10x rotary switches.

For details about the rotary switches, see
“Assembling I/O racks” in the ControlEdge 900
Controller Hardware Planning and Installation
Guide.

Slot Slot number: the location of the I/O module mounted
in the rack

l If the I/O module is installed in a 4-slot rack, the
slot number is ranging from 1 to 4.

l If the I/O module is installed in an 8-slot rack,
the slot number is ranging from 1 to 8.

l If the I/O module is installed in a 12-slot rack,
the slot number is ranging from 1 to 12.

4. Click OK to add the serial module.

5. Select a serial module. There are four serial ports to be configured,
RS232-1, RS232-2, RS485-1 and RS485-2. Select the target port
and configure appropriate values for the following parameters.

Parameter Description

Baud
Rate

300, 600, 1200, 2400, 4800, 9600, 19200, 38400,
57600, 115200

Parity None, ODD, EVEN

Data Bits 7, 8

If you select Modbus RTU Slave or Modbus RTU
Master for the Protocol Binding, the Data Bits is set
as 8 by default.

Stop Bits 1, 2

For RS232-1 and RS232-2, you should configure one more
option: Flow Control. See the following table for the parameter
descriptions.

Parameter Description

Flow Control Only for RS232-1 and RS232-2
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Parameter Description

l None

l RTS-CTS

l RTS

6. Under Protocol Binding, select a protocol from the Port Protocol
drop-down list.
The following table provides information about various protocols
supported by serial ports.

Protocol Description

Modbus
RTU
Slave

The controller acts as the Modbus Slave and used for
communication between:

l Controller and SCADA

l Controller and third-party Modbus Master
devices

If you select Modbus RTU Slave:

l Data Bits is set as 8 by default.

l There are two more options to configure: Slave ID
and Mapping.

If the Mapping is empty, you must add a mapping
table first. See "Adding a Modbus Slave mapping
table" on page 61 for more information.

Modbus
RTU
Master

The controller acts as the Modbus Master and used for
communication between The controller and third-party
Modbus Slave devices, for example I/O modules.

If you select Modbus RTU Master, Data Bits is set as 8
by default.

Modbus
ASCII
Slave

The controller acts as the Modbus Slave and used for
communication between:

l Controller and SCADA

l Controller and third-party Modbus Master

If you select Modbus ASCII Slave, you must configure
two more options: Slave ID and Mapping. If the Mapping
is empty, you must add a mapping table first. See
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Protocol Description

"Adding a Modbus Slave mapping table" on page 61 for
more information.

Modbus
ASCII
Master

The controller acts as the Modbus Master and used for
communication between The controller and third-party
Modbus Slave devices, for example: I/O modules.

User
Defined

User Defined protocol.

When you select this option, the Delimiter Mode
(Optional) panel appears including three settings: Read-
interval Timeout (ms), Max Length (Bytes) and End
Delimiter (Hex). You can configure them optionally to
validate if a data frame is sent completely.

l Read-interval Timeout (ms): The interval between the
last data packet sent and the first keepalive probe,
ranging from 0 to 10000 (ms). If the interval
between the arrivals of any two bytes exceeds this
Timeout, system regards it has already received a
complete data frame.

The default value is 0 which means this option is
disabled.

l Max Length (Bytes): The maximum number of bytes
for a data frame, ranging from 0 to 532. If the length
of a received data frame exceeds the Max Length,
system regards it has already received a complete
data frame.

The default value is 0 which means this option is
disabled.

l End Delimiter (Hex): Configured special characters in
hexadecimal and based on bytes validates if a data
frame is sent completely. If the received data frame
has same characters with the End Delimiter, system
regards it has already received a complete data
frame.

The default setting is blank which means this option
is disabled.
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Protocol Description

For how to configure User Defined protocol, see
"User Defined Protocol" in the ControlEdge Builder
Function and Function Block Configuration
Reference.

7. Click Save to complete the configuration.

Managing a module

Removing a module

1. From the Home Page, click Configure Modules under I/O and
Communications, and select the target I/O or serial module.

2. Click the Delete icon. A warning message appears to confirm the
deletion.

3. Click Yes to delete the target module.

TIP: After deleting an I/O module, the channels in this I/O
module are unbound with the variables. However, the variables
still exists in the program.

Editing a module

1. From the Home Page, click Configure Modules under I/O and
Communications, and select the target I/O or serial module.

2. Click the Edit icon. The Edit I/O Module or Edit Serial Module page
appears.

3. Modify the rack address, slot number or IOM scan time as
required, and click Yes.

Exporting module configuration
The module configuration can be exported to a .csv file.

To export module configuration

108

Chapter 4 - Configuring modules and channels



109

1. From the Home Page, under I/O and Communications:

l For ControlEdge 2020 controller, click Configure I/O, and select
the target expansion I/O module.

l For ControlEdge 900 controller, click Configure Modules, and
select the target I/O or serial module.

2. Click Export icon, the Save As window appears.

3. Browse to the location you want to store the file and click Save to
export the module configuration.

Importing module configuration
You can configure all I/O modules or serial modules in a .csv file and
import it in ControlEdge Builder. Up to six serial modules can be
added.

To get a .csv file, See "Exporting module configuration" on the
previous page for more information.

See the following table for the I/O module configuration parameters.

Parameter Rule for I/O module configuration import

Rack Address Valid value ranges from 0 to 99.

Rack address for each channel of assigned module shall not
be empty.

Rack quantity must not be more than 12.

For the redundant controller, the I/O configuration in Rack 0 is
not applicable.

Slot Number For 4-slot rack, the slot number ranges from 1 to 4.

For 8-slot rack, the slot number ranges from 1 to 8.

For 12-slot rack, the slot number ranges from 1 to 12.

The quantity of slots assigned to one rack must not be more
than 12.

Each channel of the assigned module must be assigned a slot
number.

No duplicate slot numbers are allowed in a rack.
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Parameter Rule for I/O module configuration import

Module Type I/O module type

Channel Enabled Indicates whether a channel is enabled for this I/O.

Enter one of the following two values:

l False

l True

False is the default value.

Channel Number The channel number, which can be between 1 and 16, must be
aligned with the module type. All channels must have a
number assigned.

Channel Type The type of channel for this module.

Valid values are AI, AO, DI, DO, UAI, PI, FI and PO.

I/O Variable Optional

The variable to which this channel is to be bound.

Variable names cannot be duplicated, and must comply with
the IEC naming conventions:

l If the variable specified exists in the Variable table in the
IEC Programming Workspace, you must specify a
channel of the same type as that contained defined in
the table. When the I/O configuration file is imported, the
variable is automatically bound to the channel.

l If the variable specified does not exist in the IEC
Programming Workspace, it will be created automatically
after importing the I/O configuration file.

Description The description of I/O variable

EU Description Description of engineering unit.

It is available for all channels except digital input and digital
output channels.

If T/C or RTD is assigned as the sensor type, the assignable
value to this parameter shall be between C and F as per the
sensor type selected.

For any other sensor types, the inputs of this parameter is free.
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Parameter Rule for I/O module configuration import

Sensor Type The sensor type depends on the selected module type.

UIO module supports:

l For AI channel: 4-20mA or 0-20mA

l For AO channel: 4-20mA

EU Low Low range of engineering unit

It shall be smaller than EU High

This parameter does not need to be configured if the sensor
type is assigned as T/C or RTD.

EU High High range of engineering unit

This parameter does not need to be configured if the sensor
type is assigned as T/C or RTD.

EU Ex Low Optional

Extended low should be lower than EU Low. For details of the
algorithm, See "Configuring Universal Input/Output modules
(UIO16 900U01)" on page 82 for more information..

(EU Low) - (EU High - EU Low)*10% is the default value.

EU Ex High Optional

Extended high should be higher than EU High. For details of
the algorithm, See "Configuring Universal Input/Output
modules (UIO16 900U01)" on page 82 for more information.

(EU High) + (EU High - EU Low)*10% is the default value.

HART This parameter shall be ignored during I/O configuration
import process if the assigned module type doesn’t support
HART functionality.

HART functionality shall be disabled by default if it is not
assigned any option to or the assigned value is invalid.

OpenWireDetection Open Wire Detection: True or False

Only DI and DO channel of UIO module support Open Wire
Detection.

ShortCircuitDetection Short Circuit Detection: True or False
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Parameter Rule for I/O module configuration import

Only DI and DO channesl of UIO module support Short Circuit
Detection.

State 0 Description Optional

Description of State 0

Only Digital input and Digital output channels support State 0
Description.

State 1 Description Optional

Description of State 1

Only Digital input and Digital output channels support State 1
Description.

Direction Optional

The given signal of a DI or DO channel. There are two options:
Reverse or Direct.

Direction is direct by default.

Fail Safe Output
Mode

Optional

Determines the output behavior for AO and DO channel when
failsafe. There are two options: Hold Last Output or User Cfg
Output

Hold Last Output is the default value.

AO User Configured
Output

Optional

To assign the user configured output.

EU Ex Low <= User configured output <= EU Ex High

EU Ex Low is assumed if the assigned value is smaller than EU
Ex Low;

EU Ex High is assumed if the assigned value is beyond EU Ex
High.

0 is the default value.

DO User Configured
Output

Optional

Assigns the user configured output. There are two options: 0 or
1.
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Parameter Rule for I/O module configuration import

0 is the default value.

Remote CJ It should be enabled for T/C sensor type if the cold junction is
in the remote location.

Enter one of the following two values:

l TRUE

l FALSE

RCJVariable This variable should be analog input type.

The variable can be used for multiple channels at same time.

l If the variable defined in this file is existing in ControlEdge
Builder, there are two scenarios:

l If the variable type in ControlEdge Builder does not
match the required type, the I/O configuration import will
be terminated.

l If the variable type in ControlEdge Builder matches the
required type, the variable will be bound and used as
Remote CJ variable automatically during I/O
configuration import.

l If the variable defined in this file does not exist in
ControlEdge Builder, the system will create the variable
automatically during the import process. If the variable
name is not compliant with MP naming convention, the
variable cannot be created successfully and I/O
configuration import will be terminated.

This variable must be assigned in this file if "Remote CJ" is
enabled. It will be ignored during the import process if
"Remote CJ" is disabled.

BURNOUT It is used to disable or enable burnout function.

Enter one of the following values:

l Upscale

l Downscale
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Parameter Rule for I/O module configuration import

l User Value

l None

User Value Enter the appropriate value, ranging from EU Low to EU High

Filter Time Configure the first order lag time constant from 1.00 to 120.00
seconds to smooth the input.

It ranges from 0.00 to 120.00.

0 means disable this function and it is the default value.

Bias Assign a value used to compensate the input for drift of an
input value due to deterioration of a sensor, or some other
cause.

It ranges from -9999.00 to 9999.00.

0 is the default value.

See the following table for the serial module configuration
parameters.

Parameter Rule for serial module configuration import

Rack Address Valid value ranges from 0 to 99.

Rack address for each channel of assigned module shall not be empty.

For the redundant controller, the serial module configuration in Rack 0
is not applicable.

Slot Number For 4-slot rack, the slot number ranges from 1 to 4.

For 8-slot rack, the slot number ranges from 1 to 8.

For 12-slot rack, the slot number ranges from 1 to 12.

The quantity of slots assigned to one rack must not be more than 12.

No duplicate slot numbers are allowed in a rack.

Module Type Serial module type: Serial Comm

Name Serial port name: RS232-1, RS232-2, RS485-1 or RS485-2

Port Name It is un-configurable.

COM1: RS232-1
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Parameter Rule for serial module configuration import

COM2: RS232-2

COM3: RS485-1

COM4: RS485-2

Index Serial port No.

0: RS232-1

1: RS232_1

2: RS485-1

3: RS485-2

Port Type Serial port type: RS232 or RS485

Baud Rate BD_300, BD_600, BD_1200, BD_2400, BD_4800, BD_9600, BD_19200,
BD_38400, BD_57600, BD_115200

Parity None, ODD, EVEN

Data Bits BIT7, BIT8

If you select Modbus RTU Slave or Modbus RTU Master protocol, you
must configure BIT8 for Data Bits.

Stop Bits BIT1, BIT2

Flow Control Only for RS232-1 and RS232-2

l None

l RTS-CTS

l RTS

Protocol
l MBRTUSLAVE: Modbus RTU Slave

l MBRTUMASTER: Modbus RTU Master

l MBASCIISLAVE: Modbus ASCII Slave

l MBASCIIMASTER: Modbus ASCII Master

l USERDEFINED: User Defined protocol

Slave ID It is required when you select Modbus RTU Slave or Modbus ASCII
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Parameter Rule for serial module configuration import

Slave for Protocol.

It ranges from 1 to 247.

Mapping It is required when you select Modbus RTU Slave or Modbus ASCII
Slave for Protocol.

If the list is empty, you need add a Modbus slave mapping table first.
See "Adding a Modbus Slave mapping table" on page 61 for more
information.

Timeout When you select the User Defined protocol, you can configure it
optionally.

The interval between the last data packet sent and the first keepalive
probe, ranging from 0 to 10000 (ms). If the interval between the arrivals
of any two bytes exceeds this Timeout, system regards it has already
received a complete data frame.

The default value is 0 which means this option is disabled.

End
Delimiter

When you select the User Defined protocol, you can configure it
optionally.

Configured special characters in hexadecimal and based on bytes
validates if a data frame is sent completely. If the received data frame
has same characters with the End Delimiter, system regards it has
already received a complete data frame.

The default setting is blank which means this option is disabled.

Max Length
(Bytes)

When you select the User Defined protocol, you can configure it
optionally.

The maximum number of bytes for a data frame, ranging from 0 to
1024. If the length of a received data frame exceeds the Max Length,
system regards it has already received a complete data frame.

The default value is 0 which means this option is disabled.

See the following table for the expansion I/O module configuration
parameters.

Parameter Rule for serial module configuration import

Address Valid value ranges from 1 to 99.

It must be same as the rotary switch setting of the physical device.
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Parameter Rule for serial module configuration import

Scan Time IOM scan time.

IOM scan time and task execution time should be set carefully. The I/O
data refresh time in a controller depends on the slower of the IOM scan
time and task execution time, so improper settings can result in
excessive overrun or tasks not being processed. Additionally, Honeywell
recommends configuring IOM scan time and task execution time either
as the same value, or as one being an integral multiple of the other.

Module
Description

IOM description

Module Type IOM type

Filter AI Filter that affects the response time of enabled channels in the
analog input module.

l 50HZ

l 60HZ

Channel
Number

The channel number must be aligned with the module type. All
channels must have a number assigned.

l AI1~AI8

l AO1~AO2

l DI1~DI10

l DO1~DO6

l PI1~PI2

NOTE: Two PI channels can be configured as DI channels.

Channel
Type

The type of channel for this module.

Valid values are AI, AO, DI, DO and PI.

Channel
Enabled

Indicates whether a channel is enabled for this IOM.

l FALSE

l TRUE
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Parameter Rule for serial module configuration import

I/O Variable Optional

The variable to which this channel is to be bound.

Variable names cannot be duplicated, and must comply with the IEC
naming conventions:

l If the variable specified exists in the Variable table in the IEC
Programming Workspace, you must specify a channel of the same
type as that contained defined in the table. When the I/O
configuration file is imported, the variable is automatically bound
to the channel.

l If the variable specified does not exist in the IEC Programming
Workspace, it will be created automatically after importing the I/O
configuration file.

Description Optional

The description of I/O variable.

AI Mode There are two options:

l Voltage

l Current

EU Ex High Extended high should be higher than EU High. For details of the
algorithm, See "Configuring Onboard I/O" on page 66 for more
information.

(EU High) + (EU High - EU Low)*10% is the default value.

EU High High range of engineering unit

EU Low Low range of engineering unit

It shall be smaller than EU High

EU Ex Low Extended low should be lower than EU Low. For details of the
algorithm, See "Configuring Onboard I/O" on page 66 for more
information..

(EU Low) - (EU High - EU Low)*10% is the default value.

EU
Description

Optional

Description of engineering unit.

HART Enable or Disable the HART protocol.
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Parameter Rule for serial module configuration import

l TRUE

l FALSE

State 0
Description

Optional

Description of State 0

Only Digital input and Digital output channels support State 0
Description.

State 1
Description

Optional

Description of State 1

Only Digital input and Digital output channels support State 1
Description.

Direction The given signal of a DI or DO channel. There are two options: Reverse
or Direct.

Direction is direct by default.

Fail Safe
Output Mode

Determines the output behavior for AO and DO channel when failsafe.
There are two options: Hold Last Output or User Cfg Output

Hold Last Output is the default value.

AO User
Configured
Output

It is only applicable when Fail Safe Output Mode is configured as User
Cfg Output.

To assign the user configured output.

EU Ex Low <= User configured output <= EU Ex High

EU Ex Low is assumed if the assigned value is smaller than EU Ex Low;

EU Ex High is assumed if the assigned value is beyond EU Ex High.

0 is the default value.

DO User
Configured
Output

Assigns the user configured output. There are two options: 0 or 1.

0 is the default value.
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To import I/O or serial module configuration

1. From the Home Page, under I/O and Communications:

l For ControlEdge 2020 controller, click Configure I/O, and select
the target expansion I/O module.

l For ControlEdge 900 controller, click Configure Modules, and
select the target I/O or serial module.

2. Click Import icon, a warning message appears indicating that the
imported data may overwrite current I/O or serial module
configuration.

3. Click Yes to continue to import.

4. Browse to the location the target file stored and select the .csv file,
then click Open to import the I/O or serial module configuration.
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CHAPTER

5 CONFIGURING WIRELESS I/O

ControlEdge 2020 Controller supports wireless I/O configuration
enabling the user to design, configure, commission and monitor
ISA100 wireless networks and associated wireless field devices by
ControlEdge Builder.

FDAP: Field Device Access Point (FDAP) is a wireless infrastructure
node that acts as an ISA100.11a access point and a mesh node
member. FDAP can only communicate through ISA100.11a.

Field Device: A field instrument with no routing capability, provides
input or output channels for process control data.

Wireless I/O Device: A logical instance of a wireless field device.

Channel: A logical instance that presents the real value acquired from
field devices.

Provision: Associating field devices to the controller.

Commission: Configuration for FDAP and field device, including
enabling over-the-air provisioning, associating field devices to the
controller, configuring field device channels and so on.

ATTENTION: For wireless I/O, you must use time source as a
precision NTP server.

The following table list the wireless I/O configuration procedure.

Table 5-1: Wireless I/O Configuration Checklist

Task Go to

Wireless I/O device configuration - offline

Step
1

Set the controller time.
l See "Setting time source" on page 249 for

more information.

l If the NTP server is not available, see “Set_
RTC” in the Function and Function Block
Configuration Reference Guide to configure
the controller time.

Step Enable Wireless I/O See "Configuring Ethernet port" on page 123 for
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Task Go to

2 protocol on one of the
Ethernet port of the
controller.

more information.

Step
3

Configure ISA100
network ID.

See "Configuring ISA100 network ID" on the facing
page for more information.

Step
4

Import DD files. See "Importing DD files" on page 124 for more
information.

Step
5

Add wireless I/O devices. See "Adding wireless I/O devices" on page 125 for
more information.

Step
6

Configure channels for
wireless I/O devices.

See "Configuring channels" on page 125 for more
information.

Step
7

Bind channels to I/O
variables.

See "Binding channels to I/O variables" on page 126
for more information.

Step
8

Configure wireless I/O
diagnostic parameters

See "Configuring wireless I/O diagnostic
parameters" on page 126 for more information.

Step
9

Download the project. See "Downloading a project to the controller" on
page 239 for more information.

Configure and commission FDAP and field device - online

Step
10

Enable over-the-air
provisioning for the
controller.

See "Enabling over-the-air provisioning" on
page 146 for more information.

Step
11

Accept un-provisioned
FDAPs.

See "Provisioning the devices using over-the-air
provisioning method" on page 147 for more
information.

Step
12

Enable over-the-air
provisioning for FDAPs.

See "Enabling over-the-air provisioning" on
page 146 for more information.

Step
13

Configure field devices. See "Configuring field devices" on page 148 for
more information.

See "Configuring field device channels" on
page 154 for more information.

Step
14

Accept un-provisioned
field devices.

See "Provisioning the devices using over-the-air
provisioning method" on page 147 for more
information.

Step Bind wireless I/O devices See "Binding and unbinding field devices to wireless
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Task Go to

15 to field devices. I/O devices" on page 152 for more information.

Step
16

Activate channels for
bound field devices.

See "Activating channels" on page 158 for more
information.

Configuring the ISA100 wireless network

Configuring Ethernet port
Only one from ETH1 and ETH2 can be assigned for wireless I/O.

1. Click Configure Ethernet Ports from the Home Page and select the
target Ethernet port for wireless I/O.

2. Under Network Setting, configure the IP Address of the Ethernet
port. Select Use the following IP address to type in the details in IP
Address, Subnet Mask and Gateway manually.

3. Under Protocol Binding, select Wireless I/O.

4. DHCP Server is enabled automatically. Type in Start IP and End IP to
configure the address range for DHCP Server.

l DHCP address should be on the same network segment as the
IP address.

l IP address must not be in the range of DHCP address.

5. Click Save

Configuring ISA100 network ID
The ISA100 Network ID is the unique identifier for the network. It
must contain a value between 2 (default) and 65535.

1. Under Communication, select Configure ProtocolsWireless I/O.

2. Set the ISA100 Network ID in the Wireless I/O page.
If any Field Device Access Points (FDAP) or Field Devices (FD)
have been provisioned in the wireless I/O network, the ISA100
Network ID cannot be modified. If you want to change it, you must
un-provision all the devices first.
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Configuring wireless I/O devices
To configure wireless I/O devices, the Device Description (DD) file for
each type of device must be imported into ControlEdge Builder.
Importing DD files can be performed separately or as a part of adding
a new wireless I/O device. Imported DD files will be stored in
ControlEdge Builder.

When you open a project with a DD file, there are three scenarios:

n If the DD file was not imported to ControlEdge Builder, it will be
stored in ControlEdge Builder automatically.

n If the DD file was imported to ControlEdge Builder, and it is older
than the one in the project, then it will be replaced with the newer
DD file.

n If the DD file was imported to ControlEdge Builder, and it is newer
than the one in the project, then it will not be replaced with the
older DD file. When you add a wireless I/O device, both two DD
files will be displayed in the DD file list.

Importing DD files
A DD file is usually a zip file that can be downloaded from the device
vendor’s website. It contains information about the device type,
commands that are supported by the device, and other device-
specific data. A DD file for a particular field device is used to describe
the device and to interpret messages and the device status.

1. Click Configure Wireless I/O > Configure Wireless I/O Devices from the
Home Page.

2. Click Add Device, the Add Wireless I/O Device page appears.

3. Confirm that the DD file for the device already exists in
ControlEdge Builder. If it does not exist, click Import DD File, and
browse to the directory location of the DD file.

4. Select the DD file and click Open. The DD file is imported
successfully.

Updating DD files
On occasions, device vendors update DD files. To use a new version of
a DD file, you must import it and then perform a download to the
controller.
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ATTENTION: The updated DD file must be associated with at
least one Wireless I/O device. Only DD files associated with
Wireless I/O devices will be downloaded to the controller.

Adding wireless I/O devices

NOTE: It is recommended to use same DD file for same type of
wireless I/O devices.

1. Click Configure Wireless I/O > Configure Wireless I/O Devices from the
Home Page.

2. In the pop-up window, click Add Device, the Add Wireless I/O Device
page appears.

3. If the DD file list is empty, first import the DD file. See "Importing
DD files" on the previous page for more information. Select the
target DD file from the list.

4. Enter the required device Name and optional Description for the
newly added device. Click OK to add the device.

Editing wireless I/O devices
The name and description of the wireless I/O device can be edited.

1. Click on the expanded tool bar of the target wireless I/O device,
the Edit dialog box appears.

2. Modify the Name and Description, and then click OK.

Configuring channels
Based on its DD file, if a wireless I/O device does not support
instantiable channels, its Channel column is not editable. The channel
name can be modified by double clicking the Name field.

If a wireless I/O device supports instantiable channels, its Channel
column is editable. When the device is added, the default value of the
channel type is ‘Unassigned’.

To change the channel type and modify the channel name

1. Select the required type from the drop-down list of the Channel.

2. Double-click the Name field and type in a desired name for this
channel.

Chapter 5 - Configuring Wireless I/O



Binding channels to I/O variables
Channels are the logical instances that present the real value acquired
from field devices and can be implemented in programs. The user
must create I/O variables before binding them to channels of wireless
I/O devices.

1. From the Home Page, click Configure Wireless I/O > Configure
Wireless I/O Devices.

2. For the target channel, click Bind.
The I/O Variable dialog box appears. The available I/O variables
with data types compatible to the selected I/O channel type are
displayed automatically.

3. If the required I/O variable exists in the list, select it and click Bind.
If the required I/O variable is not existing in the list, click Add New
Variable to create a new I/O variable. The I/O Variable page appears.
You can also create I/O variables from IEC Programming Workspace.
See "Creating a variable" on page 230 for more information.

4. Enter the Name and Description, and then click Add.
The I/O variable is created and bound to the channel successfully.

5. Click Save.

6. The bound I/O variables can be used in the program. See
"Programming with IEC 61131-3" on page 225 for more
information.

Configuring wireless I/O diagnostic parameters
Synchronize variables of wireless I/O diagnostic parameters to the
Global Variables in IEC Programming Workspace.

1. Click on the expanded tool bar of the target wireless I/O device;
the Configuration Diagnostic dialog box appears.
Diagnostic parameters with default variable names and
description defined by the DD file are displayed here .
The length of the Variable text cannot exceed 30 characters and
cannot be ended with an underscore.
You can double-click the Variable field to edit it.
If you rename or clear a variable which is mapped for SCADA or
used in POUs, you need to map or program this variable in the
POUs again.
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2. Select the required diagnostic parameters and click OK; the
corresponding global variables are created in IEC Programming
Workspace. If you do not want to do the configuration, click Cancel.

NOTE: For detailed definition of the parameters, refer to the
connected device's user guide.

Deleting wireless I/O devices

1. If a wireless I/O device is bound with a field device, you must
unbound it first. See "Binding and unbinding field devices to
wireless I/O devices" on page 152 for more information.

2. From the Home Page, click Configure Wireless I/O > Configure
Wireless I/O Devices, the Configure Wireless I/O Device page appears.

3. Click on the expanded tool bar of the target wireless I/O device.
A warning message appears indicating that all the bound variables
will be unbound after deleting the device.

4. Click Yes to delete the device.
The global variables created in Configuration Diagnostics under this
wireless I/O device are also removed from the Global Variable in
IEC Programming Workspace.
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Commissioning wireless
When connect the controller with Field Device Access Point (FDAP)
for the first time, the user needs to set up wireless system. FDM can
be used to configure field devices through either of Ethernet ports.

When FDAPs connect to the controller, field devices connect to the
wireless network, they can be joined as un-provisioned devices. There
is no data communication between ControlEdge Builder and the
device in the un-provisioned state. You can accept or reject an un-
provisioned device via ControlEdge Builder in Commission Wireless I/O
page.

Understanding the wireless I/O user interface
Click Configure Wireless I/O > Commission Wireless I/O from the Home
Page, and the Commission Wireless I/O page appears.
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Figure 5-1: Commission Wireless I/O User Interface

Commission wireless I/O user interface comprises of the following
main elements.

Item Name Description

1 Ribbon
Bar

It consists of groupings of user interface controls for controlling
display elements and accessing various functions for monitoring and
maintaining the Wireless Network. These user interface controls are
contextual and are enabled based on user role and devices/channels
selected in the Selection Panel.

2 Selection
Panel

Display a list of all the devices that are configured in the Wireless
Network.

3 Map
View

Provides a visual representation of the Wireless Network.

4 Property
Panel

Contains configuration properties of all the devices configured in the
Wireless Network.

5 Status
Bar

Provides an overview of the network status by displaying the number
of online devices, active alarms and the progress of any maintenance
operation.

The following sections explain each element of the user interface in
detail.
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Ribbon Bar

Figure 5-2: Ribbon Bar

The ribbon bar in the user interface contains the following tabs and
icons.

Table 5-2: Ribbon Bar Elements

Tab/icon Description

Filter group

The Filter option in the ribbon bar allows you
to customize the device list by filtering the
devices. By default, all the devices appear in
the device list. You can filter by Device Type,
Device Status, Vendor, Model, Power Source,
Hop Level and Map.

When you set a filter, various system views
are altered. For example, the map highlights
only the devices for which the filter option is
applied. All the filtered out devices appear as
blurred in the map.

Filter includes an option to filter by Map.
This includes the Unplaced map so any
device that has not been placed on a map
can easily be detected.

Provisioning group

l Accept: Accepts devices that can be
provisioned using over-the-air
provisioning method.

l Reject: Rejects devices that are
attempting to join the network using
over-the-air provisioning method.

l Delete: Removes a provisioned device
from the network. Removing a device
from the network clears the
provisioning data and restores the
device to factory default state. It can
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Tab/icon Description

also be used to remove a rejected un-
provisioned device from the user
interface in case you have mistakenly
rejected a device earlier. Removing a
rejected device enables the device to
rejoin as an un-provisioned device. You
can then accept the un-provisioned
device to join the network.

Note the following points while deleting a
device from the network.

l Deleting a joined device removes the
provisioning data and the
configuration data from the device and
the controller. Also, the device restores
to factory default state.

l Deleting an offline device removes the
provisioning data and the
configuration data of the device only
from the controller. The provisioning
data and the configuration data needs
to be manually cleared from the device.

Channel group

l Activate: Activates all the channels of
the selected field device. Clicking the
Activate transitions the field device
channel state from OOS to the currently
configured Normal mode.

l Inactivate: Inactivates all the channels
of the selected field device. Clicking the
Inactivate button transitions the field
device channel state from AUTO to
OOS.

Maintenance group

l Commissioning Data Backup: Click it to
backup the commissioning data for the
FDAPs and field devices.
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Tab/icon Description

l Commissioning Data Restore: Click it to
restore the backed up commissioning
data to the FDAPs and field devices.

Upgrade group

l Application: Initiates firmware upgrade
operation for the application firmware
of the field devices.

l Radio: Initiates firmware upgrade
operation for the radio firmware of the
field devices and FDAPs.

Online/offline Binding group

Bind: Bind/Unbind the Wireless I/O device to
the field device.

Selection Panel
The Selection Panel in the Wireless user interface provides a list of all
the devices configured in the Wireless Network. It is docked to the left
of the user interface window and is horizontally expandable and
collapsible. It also provides an option to view the extended view of the
Selection Panel known as the extended Selection Panel. The extended
Selection Panel displays the device information in a tabular format.

The default view of the Selection Panel displays all the devices
arranged in the order - the Wireless interface, FDAPs, and field
devices. You can configure multiple locations for organizing the
devices. The following illustrations depict the default view of the
Selection Panel.
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Figure 5-3: Selection Panel

The following table describes the different elements/icons available in
the Selection Panel.

Table 5-3: Selection Panel Elements

Element Function

Click to expand the Selection Panel.

Click to collapse the Selection Panel.

Click to view the extended Selection Panel. It provides information about the
properties of the devices such as device type, status, vendor, model, serial
number, and so on.
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Element Function

Click to collapse the extended Selection Panel.

Click to collapse the devices in the Selection Panel.

Click to expand the devices in the Selection Panel.

Figure 5-4: Extended Selection Panel

The Show Radio Identification check box allows you to view the radio
related details about the field devices. The following illustration
depicts the extended Selection Panel with Show Radio Identification
check box selected.
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Figure 5-5: Extended Selection Panel with radio details of the devices

Understanding the device icons
The Selection Panel and the Property Panel display various device
icons for representing the network components. The following table
summarizes the appearance of the device icons and their
corresponding description and state.

Table 5-4: Status Bar Panes

If the
device
is...

Then it represents...

FDAP

FDAP router

Offline FDAP
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If the
device
is...

Then it represents...

Offline FDAP router

Over-the-air provisioning icons

FDAP with over-the-air provisioning (OTAP) enabled

FDAP router with OTAP enabled

FDAP in un-provisioned state

FDAP router in un-provisioned state

Field device in un-provisioned state

FDAP in joining or provisioning state

FDAP router in joining or provisioning state

Field device in joining or provisioning state

FDAP in rejected state

FDAP router in rejected state

Field device in rejected state

Field device icons
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If the
device
is...

Then it represents...

Routing field device (field device with routing capability)

Field device that has joined the network

Field device in offline state

Field device in joining or provisioning state

Channel icons

Channel in Auto or MAN mode

Channel in inactive or Out of Service (OOS) mode

Channel becomes grey when the data is being fetched from the device. For a
digital output channel, grey indicates the MAN mode, where you can manually
set the output value.

Offline channel

This device is bound to one wireless I/O device successfully.

This device is bound to one wireless I/O device, but the connection is
defective.

This device is not bound to one wireless I/O device.

Property Panel
The Property Panel in the Wireless user interface provides
configuration properties of all the devices configured in the Wireless
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Network. The Property Panel is docked to the right of the user
interface window and is horizontally expandable and collapsible.

The Property Panel allows you to perform configuration tasks
pertaining to FDAPs, and field devices and their channels. It also
allows monitoring the configuration attributes of the devices such as
Process Value (PV), communication links, signal quality, and so on.

Selecting the required device in the Selection Panel, automatically
displays all the configuration parameters of the devices that are
accessible from the Property Panel. These configuration parameters
are grouped into accordion panels that can be individually expanded
or collapsed.

Figure 5-6: Property Panel

The following table describes the different elements/icons available in
the Property Panel.
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Table 5-5: Property Panel Elements

Element Function

Click to expand the Property Panel.

Click to collapse the Property Panel.

Apply icon. Click to save any configuration changes applied. This icon is
enabled only if you have made any changes in the user interface.

Reset icon. Click to reset any unsaved changes made to the devices through
the Property Panel. This icon is enabled only if you have made any changes
in the user interface.

Status Bar
The status bar that is located at the bottom of the user interface
window displays messages that indicate the overall status of the
network.

Table 5-6: Status Bar Panes

Element Function

Firmware upgrade status is displayed when
you have initiated a firmware upgrade of any
device. Since the status bar displays the
progress, you can close the Firmware Upgrade
dialog box to allow the operation to run in the
background. Click this box to open the
Firmware Upgrade dialog box.

About the map view
Use the map view to create a visual topology map of the network. The
devices can be arranged in a map view according to the network
topology. The map view allows you to edit the topology by dragging
and dropping the devices from the device list in the Selection Panel.
Arrange the devices on the map according to the setup and set the
map visibility and overlays such as connection strength and
publishing rate.
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Figure 5-7: Map view

The following are the map navigation controls that are available in the
map view.

Table 5-7: Map navigation controls

Map navigation control Description

Pan control is used to move the map in
the up, down, left, and right directions.
You can also pan the map by clicking
and dragging on the map view.

Zoom control is used to zoom in or
zoom out the map view. You can also
use the scroll button on the mouse, to
zoom in or zoom out the map view.

Options: On the top-right of Map view,
click the Options list. The following are
the options:

l Map
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Map navigation control Description

l View

l Overlay

Map: On the top-right of Map view, click
Options > Map to view map option.

l Remove Devices: Enables you to
remove the selected devices from
the current map.

View: On the top-right of Map view, click
Options > View to view the View options.
The View option provides options for
controlling the map displayed.

The following are the View options:

l Show Map: Select the Show Map
check box to display the map
image.

l Map Opacity: Move the slider to
adjust the opacity of the map.
Move the slider left to increase the
visibility (fade in) of the map and
move the slider right to decrease
the visibility (fade out) of the map.

l Show Grid: Select the Show Grid
check box to display grid overlay
on the map.

l Lock Map: Select the Lock Map
check box to lock the map, locking
of the map prevents moving of
devices.

l Collapse All: Click the Collapse All
option to collapse all expanded
devices on the map.

l Expand All: Click the Expand All
option to expand all collapsed
devices on the map.
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Map navigation control Description

Overlay: On the top-right of Map view,
click Options > Overlay to view the Overlay
options.

The Overlay options provides options for
controlling connections displayed.

The following are the Overlay options:

l Display No Connections

l Display All Connections

l Display Routing Connections

l Display Time Synchronization
Connections

l Connection Status Options

ATTENTION: Depending on the
Overlay option selected, the other
options available are displayed

Click the Display No Connections option
for not displaying any connections on
the map.

Click the Display All Connections option
for displaying all connection details on
the maps. The following are the options:

l Show Inactive Connections: Select
the Show Inactive Connections check
box to display inactive
connections.

l No Display of Data: Click No Display
of Data for not displaying the data.

l Display RSQI: Click Display RSQI to
display RSQI.
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Map navigation control Description

l Display RSSI: Click Display RSSI to
display RSSI.

l Display Tx Fail Ratio: Click Display
Tx Fail Ratio to display Tx Fail Ratio.

Click the Display Routing Connections
option for displaying all routing
connection details on the maps. The
following are the options:

l Show Secondary Connections: Select
the Show Secondary Connections
check box to display secondary
connections

l No Display of Data: Click No Display
of Data for not displaying the data.

l Display RSQI: Click Display RSQI to
display RSQI.

l Display RSSI: Click Display RSSI to
display RSSI.

l Display Tx Fail Ratio: Click Display
Tx Fail Ratio to display Tx Fail Ratio.

l Display Routing Level: Click Display
Routing Level to display routing
level.

Click the Display Time Synchronization
Connections option for displaying all
clock connection details on the maps.
The following are the options:

l Show Secondary Connections: Select
the Show Secondary Connections
check box to display secondary
connections.

l No Display of Data: Click No Display
of Data for not displaying the data.

l Display RSQI: Click Display RSQI to
display RSQI.

Chapter 5 - Configuring Wireless I/O



Map navigation control Description

l Display RSSI: Click Display RSSI to
display RSSI.

l Display Tx Fail Ratio: Click Display
Tx Fail Ratio to display Tx Fail
Ratio.

l Display Clock Sigma: Click Display
Clock Sigma to display clock
sigma. Clock sigma represents the
standard deviation of clock
corrections with respect to a node
and a neighbor in units of micro
seconds.

l Display Time Master Address: Click
Display Time Master Address to
display time master address. The
Time Master Address is the network
address of the time master access
point.

l Display Time Distribution Level: Click
Display Time Distribution Level to
display time distribution level. The
Time Distribution Level is the
distance to the time master.

Connection Status Options enables you
to define the quality thresholds for link
quality. On the top right of Map view,
click Options > Overlay > Connection Status
Options.
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The device icons in the map view contain the following indicators
using which you can analyze the battery level, the publishing rate, and
the bandwidth usage of devices.

Table 5-8: Map view indicators

Device
performance
indicators

Description

Displays the battery level as low, medium, high, or unknown.

Displays the publishing rate at which the PV data is published.

Displays the bandwidth usage of the devices. This attribute is used to
determine the communication resource usage of field devices. It is
computed based on the percentage of active neighbors and the
percentage of links allocated. When the bandwidth usage becomes
100%, the device will no longer be able to handle additional
communication requests.

Position the devices on the map
You can position the devices on the map to reflect the physical design
and structure. The devices do not appear on the map view, by default.

The devices should be configured and commissioned.

To position the devices on the map

1. On the Selection Panel, select the device to be positioned on the
map.

2. Drag the device and drop it on the required location on the map.

3. Repeat steps 1 and 2 to place the other devices.

4. On the top-right of Map view, click Options > View.

5. Select Lock Map check box to the lock the map.
You must lock the map to prevent device locations from being
accidentally modified.

Remove the device from the map

1. Click the Monitoring tab to view the map view.

2. From the Selection Panel or map view, select the device.
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3. On the top-right of Map view, click Options > Maps > Remove
Devices.
The Remove Devices From Map dialog box appears.

4. Click Remove to remove the selected devices from the current
map.

Enabling over-the-air provisioning
FDAPs and field devices in the Wireless Network can be provisioned
using over-the-air provisioning method. The controller provisions the
FDAPs and the FDAPs that are enabled to function as provisioning
devices can provision the field devices. Provisioning role can be
enabled in Honeywell FDAPs when acting as a back bone router. To
enable over-the-air provisioning, you must enable this feature in
ControlEdge Builder.

To enable over-the-air provisioning for the controller

1. In the Commission Wireless I/O page, select the target controller
displayed, the corresponding Property Panel appears. Click System
Manager to expand it.

2. Under ISA100 Network Provisioning, in the Over the Air Provisioning
drop-down list, select Enabled. The controller is enabled for over-
the-air provisioning support.

3. Click Apply. The un-provisioned FDAPs start appearing in the
Selection Panel. You can filter the device list to view only the un-
provisioned FDAPs in the network.

To enable over-the-air provisioning for FDAPs

1. In the Commission Wireless I/O page, select the target FDAP
displayed, the corresponding Property Panel appears. Click Device
Management to expand it.

2. Under Over the Air Provisioning, click Enable for 60 Minutes.
The FDAP functions as a provisioning device for 60 minutes. The
un-provisioned field devices and the FDAPs that are in the factory
default state start appearing in the Selection Panel. Note that if
you do not accept or reject the devices within 60 minutes, the
devices automatically disappear from the user interface.

3. In the pop-up prompting dialog, click OK to enable provision for
the FDAP.
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Provisioning the devices using over-the-air
provisioning method
Any field device that is in the factory default state, when connected to
the Wireless Network can join the network as an un-provisioned
device. Also, there is no active data communication between the
controller and the device in the un-provisioned state. You can accept
or reject an un-provisioned device using ControlEdge Builder. If
accepted, the controller sends the provisioning data to the device and
the device transitions to provisioning state. A device with the new
security data sends join request to the controller.

n Wireless I/O devices have been configured in ControlEdge Builder.

n ControlEdge Builder project containing wireless I/O devices’
configuration has been downloaded to the controller.

To provision FDAPs

1. From the Commission Wireless I/O page, select the corresponding
un-provisioned wireless device.

2. Click Accept. When the Status changes from Un-Provisioned to
Joined, the wireless device is joined to FDAP successfully.

To provision Field Devices

1. From the Commission Wireless I/O page, select the corresponding
un-provisioned field devices.

2. Click Apply. When the Status changes from Un-Provisioned to
Joined, the field device is provisioned successfully.

Rejecting FDAPs and field devices
Reject function is only used for un-provisioned wireless devices.

1. From the Commission Wireless I/O page, select the corresponding
un-provisioned wireless device.

2. Click Reject. When the Status changes from Un-Provisioned to
Rejected, the wireless device is rejected successfully.

Deleting FDAPs and field devices
A provisioned device can be removed from the network. Removing a
device from the network clears the provisioning data and restores the
device to factory default state. The wireless device cannot be scanned
and displayed if you remove it in ControlEdge Builder.
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A rejected un-provisioned device from the user interface can be
removed too in case you have mistakenly rejected a device earlier.
Removing a rejected device enables the device to rejoin as an un-
provisioned device. You can then accept the un-provisioned device to
join the network.

To delete a device

1. From the Commission Wireless I/O page, select the corresponding
uprovisioned or rejected devices.

2. Click Delete. Devices will be removed from the device list.
The provisioning capability of FDAP will be disabled automatically
during the deleting progress. Click Enable for 60 minutes from the
Device Management tab on the Property Panel to enable the
provisioning capability again, and the un-provisioned devices
would be scanned and displayed again.

Configuring field devices

Configuring routing assignment
After joining the network for the first time, a field device capable of
operating as a router and an I/O device initializes its routing
assignment based on the current default routing policy. It is possible
to override the default routing policy by configuring routing
assignment for field devices. Configuring device routing assignment
results in restarting the device with a new role.

ATTENTION: Device routing assignment can be configured only
for devices that are capable of operating as routers and I/O
devices.

To configure routing assignment

1. On the Selection Panel, select the field device.

2. On the Property Panel, expand Device Management.

3. Select Routing Assignment, as appropriate.
The following are the Routing Assignment options available.

l Routing Disabled — Disables the ability of a routing field device
to function as a router. The field device can function only as an
I/O device.

l Routing Enabled — Enables the routing field device to function
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as a router and an I/O device. The default join policy configured
is Follow System Manager Policy.

l Not Applicable

l Does not apply to devices that are capable of operating as
access points.

l Does not apply to devices that are only capable of operating
as routers.

4. Select one of the following Join Assignment options, as required.

l The Join Assignment overrides the system manager join policy.
This is applicable only for routing field devices.

l Join Disabled — Disables device-join through this device.

l Join Enabled — Enables device-join through this device.

l Follow System Manager Policy — Enables the device to follow
the system manager join policy. Device-join through this
device depends on the configured system manager join
policy.

l The Join Status is a read-only parameter that indicates the
resultant join state for all the devices.

l Access Points, FDAP access points, and FDAP routers have
the Join Assignment permanently set to Join Enabled.

l Non-routing field devices have the Join Assignment
permanently set to Join Disabled.

l Routing field devices have the default Join Assignment set to
Follow System Manager Policy.

5. Click Apply.

Configuring publication rate
The publication data for input and output field devices can be
configured using the Input Publication and Output Publication panels
in the Property Panel. Depending on the device type, a field device can
have an Input Publication panel, or an Output Publication panel, or
both. This is determined by the DD file for the field device.

The Input/Output Publication panel contains the following
configuration options.
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n Contract Status — A contract is a communication resource
(bandwidth) allocation between two devices on the ISA100
network. The following are the status values that are displayed
depending on the status of the contract.

l Not Configured — No contract established due to incorrect
configuration of the device.

l Activating — Contract establishment is in progress.

l Active — Contract is active.

l Active, Negotiated Down — If a device requests a contract for
periodic publications at a fast rate (such as 1 second) and if the
communication resources are not available, the contract is
negotiated down to a slower publication period (such as 5
seconds).

l Terminating — Contract termination is in progress.

l Failed — Contract establishment is failed.

l Inactive — Contract is inactive.

n Rate — Rate at which a source node (field device or gateway)
publishes.

n Stale Limit — Defines the maximum number of stale input values
that can be received before the input status is set to Bad. It is
recommended that for 1 second publication period, the stale limit
should be set to 15 seconds. For all other publication periods (5
seconds, 10 seconds, 30 seconds, and 1 minute), the stale limit
should be set to 5.

n Destination — Destination is the target device where publications
should reach.

n Channel — The list of channels for which the publication
configuration applies.

n Attribute — Attribute is a parameter of a channel. It can be a
process value, a measurement, a configuration or a statistic of the
channel. For example MODE, PV, SCALE, and so on.

ATTENTION: When a device joins the network, the controller
automatically configures its publication period as 30 seconds.
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To configure publication rate and stale limit

1. On the Selection Panel, select the field device.

2. On the Property Panel, expand Input Publication or Output
Publication.

3. In the Rate field, select the publication rate, as appropriate.

4. In the Stale Limit field, select the stale limit, as appropriate.

5. Select the Channel and then the preferred Attribute.

6. Click Apply.

Calibrating field devices
Calibration can be initiated either by manually setting the calibration
parameters such as Cal Cmd, Cal Point High, Cal Point Low, and Cal
Unit in the Calibration panel or by using the Invoke Method button.
Invoke Method initiates the method manager, which guides you
through the calibration process. All the field devices might not
necessarily have the ability to calibrate. This is defined in the vendor
supplied DD file.

To calibrate field device using Invoke Method

1. On the Selection Panel, select the field device channel.

2. Click Inactivate in the Channel group from the Ribbon bar. Ensure
the channel has been inactivated before starting calibration. You
cannot perform calibration when the channel is online.

3. Click Inactivate in the pop-up Inactivate Channels dialog box.
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4. In the Property Panel, expand Calibration.

5. Click Invoke Method, the method dialog box appears.

6. Click Next and follow the instructions on-screen to complete
calibration. Click Abort to cancel the calibration process at any
stage of method execution. Once completed, a message appears
indicating that the calibration process completed successfully.

7. Click Activate in the Channel group from the Ribbon Bar.

8. Click Activate in the pop-up Activate Channels dialog box.

To calibrate field device by setting the calibration parameters

1. On the Selection Panel, select the field device channel.

2. Click Inactivate in the Channel group from the Ribbon bar. Ensure
the channel has been inactivated before starting calibration. You
cannot perform calibration when the channel is online.

3. Click Inactivate in the pop-up Inactivate Channels dialog box.

4. In the Property Panel, expand Calibration.

5. Set the following calibration parameters:

l Cal Cmd – The options available are None, Cal Lower (to calibrate
device with lower calibration limit), Cal Upper (to calibrate
device with higher calibration limit), Cal Restore (to restore
calibration setting), and Cal Clear (to clear calibration setting).

l Cal Point High

l Cal Point Low

l Cal Unit

6. Click Apply.

7. Click Activate in the Channel group from the Ribbon Bar.

8. Click Activate in the pop-up Activate Channels dialog box.

Binding and unbinding field devices to
wireless I/O devices

For process data acquired from field devices to be used in POUs, first
a provisioned field device must be bound to the related wireless I/O
device.
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ATTENTION: The field device Tag Name and Channel Name will
be changed to that of the bound wireless I/O device. If you want
to maintain the field device Tag Name and Channel Name , first
update the wireless I/O device to the same. When a field device
is unbound, its Tag Name will be changed to the 64-bit IEEE
MAC address.

n Make sure all the channels of the filed device are inactive. See
"Configuring channel instantiation" on page 155 for more
information.

n Make sure the channel types of the wireless I/O device and the
field device are the same.
For check the channel type of a wireless I/O device, See
"Configuring channels" on page 125 for more information.
For check the channel type of a field device, See "Configuring
channel instantiation" on page 155 for more information.

n Download wireless I/O device configuration before binding or
unbinding.

To bind field devices to wireless I/O devices

1. From the Home Page, select Configure Wireless I/O > Commission
Wireless I/O..
The commission wireless I/O page appears.

2. Click Bind on the Ribbon Bar.
All configured field devices in the network are displayed in the Bind
Wireless I/O Devices to Field Devices window.

3. Click Bind at the end of the row of the target field device.
All available wireless I/O devices that can be bound to the target
field device are displayed.

4. Select one of the available wireless I/O devices. Follow this
method to complete the binding for other wireless I/O devices,
and Click OK.
The Bind Wireless I/O Devices to Field Devices window appears.

5. Click Apply.
The Progress displays in progress. And when it displays Completed,
the binding is successful.
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TIP: You must back up data after commissioning wireless. See
"Backing up and restoring the commissioning data" on
page 162 for more information.

To unbind field devices

1. From the Home Page, select Configure Wireless I/O > Commission
Wireless I/O.

The commission wireless I/O page appears.

2. Click Bind on the Ribbon Bar.
All configured field devices in the network are displayed in the Bind
Wireless I/O Devices to Field Devices window.

3. Click Unbind at the end of the row of the target field device.
The Unbind button becomes Bind.

4. Click Apply.
The Progress displays in progress. And when it displays Completed,
the unbinding is successful.

After the binding/unbinding process is complete, the
binding/unbinding status is displayed accordingly in the Selection
Panel.

Configuring field device channels

Configuring Mode and Scale
To configure Scale

1. On the Selection Panel, select the field device channel.

2. On the Property Panel, expand Process Variable to view the
following read-only parameters in the OneWireless user interface.

l EU at 100%: Specifies the high range PV value in Engineering
Units.

l EU at 0%: Specifies the low range PV value in Engineering
Units.

l Units Index: Specifies the unit of the measurement value. The
value varies according to the sensor type selected for a
channel.For example, in a temperature device, when the sensor
type changes to a thermocouple (TC-J) or mV-50 range, the
transducer block sets the Units Index to °C or mV.
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3. Click Apply.
After applying the changes, the newly configured values appear
under the Scale panel.

To configure Mode

1. On the Property Panel, expand Mode.

2. In the Target list, select the mode as required.
The mode types available are Normal, OOS, and Auto. If the device
type is Digital Output (DO), an additional mode Man is also
available in the Target list.

3. Click Apply.

Configuring channel instantiation
OneWireless Network supports block instantiation for field device
channels. You can add, remove, and reconfigure channels on
supported field devices. An individual channel can be configured for
one of the several roles, such as an analog temperature input, an
analog current input, or a discrete input.

You can instantiate channels, only for supported field devices from
Honeywell.

n XYR 6000 Multi AI DI

n XYR 6000 Multi AI DI DO

n XYR 6000 Temp DI

You can add, remove, and reconfigure channels on a supported field
device using the user interface.

To inactivate the channel

1. On the Selection Panel, select the field device channel.

2. Do one of the following:

l On the Ribbon Bar, in the Channel group, click Inactivate.

l On the Property Panel, expand Mode and then in the Target list,
click OOS.

3. Click Apply.
The channel icon appears as blue indicating the inactive mode.

To remove channel from publication group
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1. On the Selection Panel, select the field device.

2. On the Property Panel, expand Input Publication.

3. For the channel to be removed from the publication group, click
None in the Channel drop-down list.

4. Click Apply.
Wait for a few seconds to save the changes.

To delete (uninstantiate) channel

1. Expand Channel Configuration and click Unassigned in the drop-
down list for the channel to be deleted.

2. Click Apply.
The channel disappears from the map view and the Selection
Panel.
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To instantiate channel

1. Expand Channel Configuration and click the respective instantiable
object type for the channel to be instantiated.
In the following example illustration, the temperature DI field
device has three instantiable channels. Each channel can be
instantiated as an analog input channel or a binary input channel.

2. Click Apply.

To add channel to publication group

1. On the Property Panel, expand Input Publication panel.

2. In the Channel drop-down list, click the channel for which data
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publication needs to be enabled.

3. Click Apply.

To activate the channel

1. On the Selection Panel, select the field device channel.

2. Do one of the following:

l On the Ribbon Bar, in the Channel group, click Activate.

l On the Property Panel, expand Mode and then in the Target list,
click Auto.

3. Click Apply.
The channel icon appears as green indicating active mode.

Activating channels
Activating channels of the selected field device changes the field
device channel state from OOS to the currently configured Normal
mode.

1. On the Selection Panel, select the field device channel or multiple
channels. Click and hold SHIFT key on the keyboard and select
multiple items in a successive list. Click and hold CTRL key on the
keyboard and select multiple items not in succession.

2. Click Activate in the Channel group from the Ribbon bar, the
Activate Channels dialog box appears.

3. Click Activate. The channel icon appears as green indicating active
mode.

4. Close the Activate Channels dialog box.

Removing channels from publication groups
To remove channels from publication groups

1. On the Selection Panel, select the field device channel.

2. On the Property Panel, expand Input Publication.

3. For the channel to be deleted from the publication group, click
None in the Channel drop-down list.

4. Click Apply.
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Deleting (uninstantiate) channels

n Ensure that the channel is set to OOS mode.

n Ensure that the channel is not configured for publication in any of
the Input/Output Publication groups. If configured, remove the
channel from the Publication group.

To delete channels

1. On the Selection Panel, select the field device channel.

2. On the Property Panel, expand Channel Configuration.
The Channel Configuration panel displays a list of instantiated
channels.

3. Select the channel to delete and select Unassigned in the
corresponding drop-down list.

4. Click Apply.

Adding notes for devices
You can add device notes for the controllers, FDAPs, or field devices.
These notes can be used as a logbook for the device.

Perform the following steps to add notes for any configured device.
Note that the notes added for devices are saved on the controller and
not on the device.

To add notes

1. On the Selection Panel, select the required device.

2. On the Property Panel, expand Notes.

3. Click Add note icon.
A text box appears.

4. Type the note and click Apply.

l All users can view all the notes added by other users.

l To delete any note added, click delete icon adjacent to the note.

Chapter 5 - Configuring Wireless I/O



l Users with User role can delete only notes added by them.

l Users with Administrator role can delete other user’s notes.

l Notes are not restored during a replace operation.
To edit a note already added, double-click on the note that you
want to edit, make the necessary changes, and then click Apply.

Monitoring the devices
You can monitor the performance of the devices that have joined the
network. All the devices that have joined the network are accessible
from the Selection Panel. The extended Selection Panel allows you to
view the details about the devices in the network.

Figure 5-8: Monitoring the network using extended Selection Panel

The following table explains the device and the channel attributes that
are available in the extended Selection Panel.

Table 5-9: The Device and Channel Attributes
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Device
attribute

Description

Tag Name Name of the device.

Type Device type, which can contain the following values.

l Device Manager for Wireless I/O Interface

l Routing for FDAP routers

l Device, Routing for field devices

l Device for non-routing field devices

Status Device status.

The status can be Offline, Joining or Joined.

Vendor Device vendor name.

Model Device model.

Revision Device sensor firmware revision number.

To view the radio firmware revision, select the Show Radio Identification
check box.

Serial Serial number of the device.

IPv6 Address IPv6 address of the device.

Power Source Power source of the device, which can contain the following values.

l Line for line powered FDAPs.

l High, Low or Medium for battery powered field devices.

Name Channel Name.

Channel Channel number.

Mode Device channel mode, which can contain the values AUTO, OOS or MAN.

Value Process Value.

Status PV status.

You can view the PV trend in the Value and Trends panel of the
channel’s Property Panel.
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Backing up and restoring the commissioning
data

The Backup Commissioning Data option enables you to back up the
provisioned FDAPs and field devices, field device binding information,
network routing configuration, and etc.

The Restore Commissioning Data option enables you to restore the
previously back up commissioning data to the controller replacement.

To back up the commissioning data

1. From the Commissioning Wireless I/O page, click Backup
Commissioning Data on the Ribbon Bar. The Export Wireless Device
Configuration dialog box appears.

2. Click Save File, browse to the target directory location, and enter
the File name.

3. Click Save. The Export Wireless Device Configuration dialog box is
displayed again indicating you that the backup is completed.

4. Click Close.

To restore the commissioning data

1. Open the project used to backup commissioning data and
download it to the controller.

2. From the Commissioning Wireless I/O page, click Restore
Commissioning Data on the Ribbon Bar. The Import Wireless Device
Configuration dialog box appears.

3. Click Load File, browse to the directory location of the target
backup file.

4. Click Open. The Import Wireless Device Configuration dialog box is
displayed again indicating you that the restore action is
completed.

5. Click Close.

Replacing FDAPs or field devices
You can replace a failed FDAP or a field device with a new device.

To replace an FDAP

1. Delete the failed FDAP. See "Deleting FDAPs and field devices" on
page 147 for more information.
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2. Physically replace the failed FDAP with a new one. See FDAP user
documentation from Honeywell support website for how to
replace a failed device.

3. Provision the new FDAP to allow it to join the network. See
"Provisioning the devices using over-the-air provisioning method"
on page 147 for more information.

To replace a field device

1. Delete the failed field device. See "Deleting FDAPs and field
devices" on page 147 for more information.

2. Physically replace the failed field device with a new one. See field
device user documentation from vendor’s website for how to
replace a failed device.

3. Provision the new field device to allow it to join the network. See
"Provisioning the devices using over-the-air provisioning method"
on page 147 for more information.

4. Configure the new field device. See "Configuring field devices" on
page 148 for more information.
Do not activate the device channels.

5. Bind the wireless I/O device which is bound to the failed field
device to the new replaced one. See "Binding and unbinding field
devices to wireless I/O devices" on page 152 for more information.

6. Activate the device channels. See "Activating channels" on
page 158 for more information.

Restarting devices
To restart FDAP or field device

1. On the Selection Panel, select the device to be restarted.

2. On the Property Panel, expand Device Management.
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3. In the Join Command list, select one of the following options:

l None

l Warm Restart – preserves static and constant attributes data.

l Restart as Provisioned – corresponds to the provisioned state of
the device in which the device only retains the data received
during its provisioning.

4. Click Apply.
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CHAPTER

6 ETHERNET/IP INTEGRATION

ControlEdge 900 controller supports an efficient EtherNet/IP™
(Ethernet industrial protocol) interface. The EtherNet/IP interface
facilitates a comprehensive integration between ControlEdge 900
controllers and the EtherNet/IP compatible nodes and I/O devices.

ControlEdge Builder provides options to create new device types for
the supported EtherNet/IP compatible devices. To enable easy
integration between ControlEdge 900 Controller and third-party
controllers, ControlEdge Builder also provides a function block for
the communication between controllers.

EtherNet/IP terms and definitions
Term Definition

Adapter A communication device which connects to the EtherNet/IP
network to serve data from a set of devices or modules underneath
it. Adapter typically supports I/O connectivity from Scanners via
implicit EtherNet/IP connections.

Assembly A set of data passed between a Originator and a Target after an
implicit I/O connection has been established on an EtherNet/IP
network.

CIP Common Industrial Protocol

EDS Electronic Data Sheet. A text file which specifies all the properties of
an EtherNet/IP device necessary for a Scanner module to
communicate with it. EDS files my be used in the first step of
creating an I/O module or device type for interfacing to an
EtherNet/IP device.

Originator Originator is the controller that initiate any data exchange with
EtherNet/IP devices on the EtherNet/IP network.

RPI Requested Packet Interval. The repetitive interval by which
assemblies are periodically transported over EtherNet/IP I/O
connections between Producer and Consumer.

Scanner A device which connects to the EtherNet/IP network to act as a
client of other EtherNet/IP connected devices. ControlEdge 900
Controller acts as EtherNet/IP Scanner. It connects to and
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Term Definition

exchanges data with Adapters of Modular IO stations, directly
connected devices and Rockwell AB ControLogix controllers.

Target Target is the EtherNet/IP device that address any data requests
generated by the controller.

Configuring EtherNet/IP Client
The ControlEdge 900 controller supports communication with
EtherNet/IP compliant third-party devices, such as I/O modules,
drives, and relays. To facilitate the integration of PLC with the
EtherNet/IP compliant devices, you must add and configure
equivalent devices by using ControlEdge Builder. Each configured
device represents an equivalent physical EtherNet/IP compliant-
device, which is installed on the EtherNet/IP network.

To enable communication between I/O modules and the EtherNet/IP
network, an adapter is needed. The adapter provides the Assembly
connection feature, which helps you in consolidating connections
from a group of I/O modules.

You can create EtherNet/IP device, drive, and I/O module types by
using Electronic Data Sheets (EDS) files. Or if you do not have the
EDS file, you can create a generic EtherNet/IP device.

Binding EtherNet/IP Client to an Ethernet port
This section introduces how to bind EtherNet/IP Client protocol to
ETH3.

ETH4 has the same configuration as ETH3, so only ETH3 should be
configured manually.

Star topology is required if you bind EtherNet/IP Client.

To bind EtherNet/IP Client

1. From Home Page, click Configure Ethernet Ports and select ETH3.

2. Under Network Setting, configure the IP address and the subnet
mask.

l The default IP address is 172.168.0.101.

l The range of the IP address is from 101 to 254.

l The IP address cannot be in the same network subnet as ETH1

166

Chapter 6 - EtherNet/IP integration



167

and ETH2.

l The IP address must be in the same network subnet as the
EtherNet/IP device.

l The IP address cannot be conflict with the IP address of
EtherNet/IP device.

l The IP address cannot be conflict with the EPM IP address.

3. Under Protocol Binding, select EtherNet/IP Client.

4. Under I/O Network Topology, Star Topology is selected automatically.
This configuration should match the position of 100X switch on
the EPM hardware. For more information about the switch, see
“Assembling I/O racks” in the ControlEdge 900 Controller
Hardware Planning and Installation Guide.

5. Click Save to complete the Ethernet port configuration.

6. Click Back to return to the Home Page.

Registering Electronic Data Sheets (EDS) files
EDS files are used to create EtherNet/IP device types or I/O module
types for communication with EtherNet/IP devices or I/O modules. To
enable the communication between I/O modules and the EtherNet/IP
network, you should register EDS files of I/O modules.

You can download EDS files from the third party vendor and register
them into the Device Type list. The registered information will be
stored under the location: C:\ProgramData\Honeywell\ControlEdge
Builder\EDSFiles. The registered information cannot be saved along
with project backups, you must back up them manually.

If you want to modify EDS files, you can access EZ EDS tool from
ODVA official website: https://www.odva.org/software/EZ-EDS-
Download. For how to modify EDS file, check the online help
embedded in the EZ EDS tool.

Prerequisites

n If you want to create the EtherNet/IP device types, or I/O module
types by using the EDS, ensure that you have the appropriate EDS
file. 

n Ensure that you have all the required device-related specifications,
which are available with the device, before you create the device,
or I/O module type. 
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To register EDS files

1. From the Home Page, click Configure EtherNet/IP Devices > Register
EDS Files, and click Register EDS File.

2. Enter a Device Type Name. The device type name cannot begin with
numbers and cannot contain any spaces and special characters.

3. Select Device Type according the type of the physical EtherNet/IP
device.
If a device supports both Input and Output channels, then select
Output here. For example, a device has analog input and analog
output, then select Analog Output.
If a device supports neither Input nor Output channels, then select
Generic Device here.

4. When you register an EDS file for an I/O module, indicate whether
the I/O module requires an associated adapter or not. If the I/O
module requires an adapter, select the Needs Adapter box.

NOTE: In a scenario where multiple I/O modules share a
single communication adapter to communicate with an
EtherNet/IP protocol, the Needs Adapter must be selected.
When you select Needs Adapter, the device type is only
available on the I/O Configuration tab when you create or
customize a generic EtherNet/IP Adapter.

NOTE: You cannot change this setting after compiling the
project. You must remove the device type from both
ControlEdge Configuration Workspace and IEC
Programming Workspace, and re-add a device type.

5. Click Select File, browse to the location stored the target EDS file,
select the EDS file and click Open.

6. You can view the basic information of the EDS file at the bottom
panel. You can also click View EDS to open the EDS file to view
more details.

NOTE: The EDS file is read-only and not allowed to modify.

7. Select the boxes for the following Assembly types according
devices types:
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l Input
An assembly transfers data from an EtherNet/IP device as
Producer device to a controller as Consumer.

l Output
An assembly transfers data from a controller as Producer
device to an EtherNet/IP device as Consumer.

l Configuration
An assembly which transports configuration data from the
EtherNet/IP device originating the connection to the
EtherNet/IP device or IO module which is the target of the
connection.

NOTE:  There might be more than one Input, Output and
Configuration assembly types. However, ensure that you
select one instance of Input, one instance of Output, and
one instance of Configuration assembly type per your
requirement.

8. Click OK to import the EDS file to ControlEdge Builder. Device
types are created and grouped by different vendors automatically
based on the "vendor" information in the EDS file.
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9. Click the vendor name to expand the group, and select the target
device type, you can view General, Configuration Assembly, Input
Assembly and Output Assembly information.

10. You can click the Delete icon to remove the device type. You can
also click the View EDS File icon to view more information of the
EDS file.

11. Click Save to complete the configuration.
After saving, the new device type will be populated in the Data Type
library with an input and and output channel in IEC Programming
Workspace. You can use the created device type from the library to
configure new devices.

Configuring EtherNet/IP devices using EDS files
Prerequisites

n Ensure you have imported the EDS file of the EtherNet/IP device
into ControlEdge Builder. See "Registering Electronic Data Sheets
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(EDS) files" on page 167 for more information.

n The following information in the EDS file are critical for device
type creation. Ensure that these details are available before using
the EDS file.

l Device and Vendor information

l Parameter information

l Assembly information

l Connection information

n Bind EtherNet/IP Client to an Ethernet port. See "Binding
EtherNet/IP Client to an Ethernet port" on page 166 for more
information.

To configure a device using an EDS file, without an adapter

1. From the Home Page, click Configure EtherNet/IP Devices >
Configure Devices, and click Add Device.

2. Click Select Device Type, all available device types are displayed.
You can enter keywords to search EDS files, and also can filter
them by selecting from the various filters for the Vendor and
Category fields.

3. Select the target device type, and enter the Device Name and
Description. The device name cannot begin with numbers and
cannot contain any spaces and special characters.

4. Click OK to add the device.
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5. In the General tab, configure the following parameters.

Parameter Description

IP Address The IP address of the EtherNet/IP
device which is provided by the
vendor.

Originator to Target RPI
(ms)

Requested Packet Interval (RPI)
specifies the rate at which data is
updated during a connection.

Set the rate for initiating the date
exchange with the EtherNet/IP device.

Target to Originator RPI
(ms)

Set the rate for reading data from the
EtherNet/IP device.

Electronic Keying It is used to control if accept the
connection when the identity
information of EDS file does not
match the EtherNet/IP device.

l Disable Keying: Allow the
connection with EtherNet/IP device
even the identity information of
EDS file and the EtherNet/IP device
are not match.

l Exact Match: The identity
information of EDS file must match
the EtherNet/IP device, and then
the connection will be allowed.

6. Click Configuration tab to configure parameters which are defined
by the corresponding EDS file. Configure them according vendor's
documents.

7. In the Configuration tab, you can also do the following options if
required:

l Click Change Device Type to re-select a device type.

l Click Clear Device Type to remove the device type.

8. You can click to edit the device name and description. You can

also click to remove the device if required.

9. Click Save to complete the configuration.
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To configure a device using an EDS file, associated with an adapter

1. From the Home Page, click Configure EtherNet/IP Devices >
Configure Devices, and click Add Device.

2. Select Create or Customize EtherNet/IP Device, and select Generic
EtherNet/IP Adapter.

3. Enter the Number of Slots ranging from 1 to 64.

ATTENTION: An attempt to communicate with the I/O
module fails if the number of slots entered does not match
the physical configuration. Therefore, ensure that the
number of slots matches the number of the physically
installed I/O modules and the adapter (number of slots =
number of I/O modules + one for the adapter). For example,
if the number of I/O modules is 7, the number of slots
should be 8. 

4. Enter the Device Name and Description. The device name cannot
begin with numbers and cannot contain any spaces and special
characters.

5. Click OK to add the device.

6. In the General tab, configure the following parameters.

Parameter Description

IP Address The IP address of the
EtherNet/IP device.
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Parameter Description

Apply RPI settings on all associated
I/O modules

Select the checkbox, the
RPI specified is applicable
for all the I/O modules
associated to the adapter.

If you do not select this
option, you should
configure the RPI for every
I/O modules separately in
the I/O Configuration tab.

Originator to Target RPI (ms) RPI specifies the rate at
which data is updated
during a connection.

Set the rate for initiating
the date exchange with the
EtherNet/IP device.

It is applicable for all the
I/O modules associated to
the adapter if the Apply RPI
settings on all associated I/O
modules option is selected.

It is un-configurable if the
Apply RPI settings on all
associated I/O modules
option is not selected.

Target to Originator RPI (ms) Set the rate for reading data
from the EtherNet/IP
device.

It is applicable for all the
I/O modules associated to
the adapter if the Apply RPI
settings on all associated I/O
modules option is selected.

It is un-configurable if the
Apply RPI settings on all
associated I/O modules
option is not selected.
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7. In the I/O Configuration tab, perform the following steps to
configure parameters.

a. You can click or to add or remove I/O modules.

b. Select the Enable box for an I/O module, configure the
following parameters.
If you do not select the Enable box, you cannot download
configurations to the controller.

Parameter Description

I/O Module
Name

Define a name for the I/O module. It cannot
begin with numbers and cannot contain any
spaces and special characters.

Description (Optional) The description for the I/O
module.

Target to
Originator RPI
(ms)

Set the rate for reading data from the
EtherNet/IP device.

It is un-configurable if the Apply RPI settings
on all associated I/O modules option is
selected in the General tab.

Originator to
Target RPI (ms)

Set the rate for initiating the date exchange
with the EtherNet/IP device.

It is un-configurable if the Apply RPI settings
on all associated I/O modules option is
selected in the General tab.

Electronic
Keying

It is used to control if accept the
connection when the identity information of
EDS file does not match the EtherNet/IP
device.

l Disable Keying: Allow the connection
with EtherNet/IP device even the identity
information of EDS file and the
EtherNet/IP device are not match.

l Exact Match: The identity information of
EDS file must match the EtherNet/IP
device, and then the connection will be
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Parameter Description

allowed.

c. Click Select Device Type to choose a device type. The Select
Device Type dialog appears.
The available device types are displayed. You can enter
keywords to search device types, and also can filter them by
selecting from the various filters for the Vendor and Category
fields.

d. Select the target device type, and click Next to configure more
parameters which are defined in the corresponding EDS file.
Configure them according vendor's documents.

e. Click OK to add the device type.

f. You can select Edit Device Type to re-configure the device type.
The Edit Configuration Assembly dialog appears.

l Click Change Device Type to re-select a device type.

l Click Clear Device Type to remove the device type.

g. If you complete all the configurations, the Status will change

from to .

8. From the left panel, you can click to edit the device name and

description. You can also click to remove the device if required.

9. Click Save to complete the configuration.

Configuring generic EtherNet/IP devices
If you do not have the EDS file, you can create and configure a
generic EtherNet/IP device.

Prerequisites

n Ensure that the following details are available before creating and
configuring the device: 

l Device and Vendor information

l Parameter information

l Assembly information

l Connection information

n Bind EtherNet/IP Client to an Ethernet port. See "Binding
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EtherNet/IP Client to an Ethernet port" on page 166 for more
information.

To configure a generic EtherNet/IP device

1. From the Home Page, click Configure EtherNet/IP Devices >
Configure Devices, and click Add Device.

2. Select Create or Customize EtherNet/IP Device, and select Generic
EtherNet/IP Device.

3. Enter the Device Name and Description. The device name cannot
begin with numbers and cannot contain any spaces and special
characters.

4. Click OK to add the device.

5. In the General tab, configure the following parameters.

Parameter Description

IP Address The IP address of the
EtherNet/IP device

Originator to Target RPI (ms) Set the rate for initiating
the date exchange with the
EtherNet/IP device.

Target to Originator RPI (ms) Set the rate for reading
data from the EtherNet/IP
device.

6. In the Connection tab, configure the following parameters.
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Parameter Description

Comm Format The data type of the update data reading
from EtherNet/IP devices.

There are four options: DINT, INT, REAL,
and SINT

Input Input assembly: An assembly transfers data
from an EtherNet/IP device as Producer
device to a controller as Consumer.

Output Output assembly: An assembly transfers
data from a controller as Producer device
to an EtherNet/IP device as Consumer.

Configuration Configuration assembly: An assembly which
transports configuration data from the
EtherNet/IP device originating the
connection to the EtherNet/IP device or IO
module which is the target of the
connection.

Assembly Instance The assembly instance number provided by
the vendor. For more information, see the
vendor's specification.

Assembly Size
(Bytes)

The data length of the assembly provided
by the vendor. For more information, see
the vendor's specification.

7. You can click to edit the device name and description. You can

also click to remove the device if required.

8. Click Save to complete the configuration.

Configuring communication with third-party
controllers

Configuring communication with C300/UOC
When ControlEdge 900 controller communicates with C300/UOC, it
acts as an EtherNet/IP Server. Only User-defined data type STRUCT is
supported for communicating with C300/UOC, which can include the
following elementary data types:
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n DATATYPE_BOOL (0x01)

n DATATYPE_SINT (0x02)

n DATATYPE_INT (0x03)

n DATATYPE_DINT (0x04)

n DATATYPE_USINT (0x05)

n DATATYPE_UINT (0x06)

n DATATYPE_UDINT (0x07)

n DATATYPE_REAL (0x08)

1. Bind EtherNet/IP Server to an Ethernet port. See "Binding
EtherNet/IP Server to an Ethernet port" on page 1 for more
information.

2. Declare a STRUCT data type.

a. From IEC Programming Workspace, right-click Data Types, select
Insert > Datatypes.

b. Enter a name for the data type, and click OK.

c. Double click the new data type, and from Edit Wizard, double
click STRUCT.

d. Enter the target elementary data types, and click Save.

3. Configure target variables data type as the STRUCT data type.

4. Select EtherNet/IP for target variables. See "Selecting EtherNet/IP
for variables" on page 1 for more information.

Configuring communication with ControlLogix
controllers
When ControlEdge 900 controller communicates with Rockwell AB
ControlLogix controllers, it can act as an EtherNet/IP Client or
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EtherNet/IP Server.

n If ControlEdge 900 controller acts as an EtherNet/IP Client,
ControlEdge Builder provides function blocks to enable
communication between 900 controller and third-party
controllers. For how to configure function blocks, see
"EtherNet/IP" in the ControlEdge Builder Function and Function
Block Configuration Reference.

n If ControlEdge 900 controller acts as an EtherNet/IP Server, See
"Configuring EtherNet/IP Server" on page 1 for more information.
User-defined data types are not supported. Rockwell AB
ControlLogix can read and write variables of ControlEdge 900
controller with the following data types:

l DATATYPE_SINT (0x02)

l DATATYPE_INT (0x03)

l DATATYPE_DINT (0x04)

l DATATYPE_USINT (0x05)

l DATATYPE_UINT (0x06)

l DATATYPE_UDINT (0x07)

l DATATYPE_REAL (0x08)

Configuring EtherNet/IP Server
This section introduces how to configure ControlEdge 900 controller
as an EtherNet/IP Server. EtherNet/IP Client can read, write and
monitor global variable, program local variable of the EtherNet/IP
Server through the Tag name configured in EtherNet/IP Client.

Global variable's tag name is @GV. <Varname>. If some controllers do
not support special characters such as @, the tag name should be
GV.GV.<Varname>.

Program Local variable's tag name is <Program Instance
Name>.<Varname>.

Binding EtherNet/IP Server to an Ethernet port
This section introduces how to bind EtherNet/IP Server to ETH1 or
ETH2. Only one Ethernet port can be bound at a time.
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To bind EtherNet/IP Server

1. From Home Page, click Configure Ethernet Ports and select ETH1 or
ETH2.

2. Under Network Setting, configure the IP addresses, subnet mask
and gateway.

3. Under Protocol Binding, select EtherNet/IP Server.

4. Click Save to complete the Ethernet port configuration.

5. Click Back to return to the Home Page.

Selecting EtherNet/IP for variables
EtherNet/IP must be selected for global variables or program local
variables of EtherNet/IP Server, so that EtherNet/IP Client can read,
write and monitor these variables through the Tag name configured
in EtherNet/IP Client.

Global variable's tag name is @GV. <Varname>. If some controllers do
not support special characters such as @, the tag name should be
GV.GV.<Varname>.

Program Local variable's tag name is <Program Instance
Name>.<Varname>.

1. Click IEC Programming Workspace on the toolbar, or from Home
Page, click Program with IEC61131-3.

2. Perform either of the following methods to select EIP for local
variables or global variables.

l From the variable sheets, select EIP.
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l From the variable properties dialog, select EIP.

3. Compile the configuration to the controller. See "Compiling a
project" on page 237 for more information.
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CHAPTER

7 CONFIGURING AND UPLOADING DATALOGS

The controller creates data logs, time stamps them and store them in
data files. These data log files must be transferred to a centralized
storage system where they can be archived and viewed.

Datalogging is used to record variables. This data can be retrieved
remotely and saved as .csv files.

Configuring datalog
TIP: For the redundant controller, if you configure datalog, it
will take longer to complete the synchronization.

1. Under Application of the Home Page, select Configure and Upload
Datalogs > Configure Datalogs.

2. Click anywhere in the table and click Add. In the pop-up window,
enter Datalog Name and Datalog Description to add a datalog. The
maximum datalog quantity is eight.

3. Click OK. The new datalog appears in the list with Log ID, Log Name
and Description. The parameter descriptions are as follows.

Parameter Description

Log ID This is a unique ID number for datalogging file. Its
range is from 1 to 8. And it is read only.

Log Name The name of the datalog. It can be modified by
clicking Edit. The datalog name cannot contain any
of the following characters: \ / : * ? ” < > |

Description Detailed description of the datalog.

4. To delete an existing datalog, select the target one and click Delete.

5. Select the target datalog and select SD card or Flash from Save
datalog to drop-down list to save the datalog.

l When SD card is selected, the datalog will be stored in the SD
card. An SD card must be inserted in the controller. Available
memory shows the memory available in the SD card space. The
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first number indicates the available memory while the second
one indicates the minimal recommending space of the SD card.
See "Preparing SD card" on page 251 for more information.
For SD class, both FAT and FAT32 are supported. The disk size
limit for FAT is 4 G bytes. NTFS is not supported.

l When Flash is selected, the datalog will be stored in the Flash
memory. Available memory shows the available memory of the
Flash memory. If space is insufficient, while trying to store, an
error message will be displayed.
The total memory size of Flash is 10.5 MB, including datalog,
EFM data and DNP3 events.

6. Select the appropriate values for Log Rate and Record Time. See the
following table for parameter descriptions.

Parameter Description

Log Rate There are seven options: 1s, 5s, 10s, 1m, 5m, 10m and
1h.

Record
Time

The records are logged based on the log rate. The
maximum record time is 90 days.

7. Enable Start/Stop Control to control the start time or end time
when the controller begins or stops to record datalogs.

a. Select Start/Stop Control, the browse button is enabled.

b. Click the browse button, and in the pop-up window select one
variable to trigger to start or stop datalogging. You can also
type in the Filter to search the target variable.

c. When the selected variable is triggered, the controller will
collect data at the log rate and save it in the file.

8. Under Datalog Points, click Add Variable. In the pop-up window
select one Datalog Point to be logged and click OK. You can select
a logged point and click Delete to remove the selected one from
the Datalog Points list.

9. Select Action on Full to control what action will be taken if the data
buffer is full.

l Overwrite: The previous data in the buffer will be overwritten
with new data.
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l Pause: The controller will stop datalogging until the space for
datalogging becomes available.

10. Select a datalog and its used space is displayed besides Datalog
size.

11. Click Save, and then click Back to return to the Home Page.

12. Click Download.

l If you modify Record Time, Datalog Points or change Save Datalog
To option to the target datalog, and click Download from the
toolbar, the previous datalog will be cleared and the new
settings begin to take effect.

l If you modify Log Name, Log Rate, Start/Stop Control, Action on
full in Configure Datalogs tab, and click Download from the
toolbar, it will continue to append log to existing log files.

Uploading datalog
For uploading datalogs (upload only), you can log in as the
Administrator, Engineer or Operator to connect the target controller.

For uploading and delete datalogs, you must log in as the
Administrator or Engineer to connect the target controller.

1. From the Home Page, under Application, select Configure and
Upload Datalogs > Upload Datalogs.

2. Click Refresh, and the configured and downloaded datalogs are
displayed.

3. Click Settings and Upload Settings window appears. Perform the
following steps to configure upload settings.

a. Select the Time Stamp format from the drop-down list.

b. Click browse button beside the Save in to select the directory to
save the datalog.

c. Select UploadOnly or UploadDelete besides Option. If UploadDelete
is selected, the start time will be updated to the last end time
automatically when the last datalog upload is completed.

4. Select the target datalog from the list and click Upload. The
datalog is saved inside the folder specified. Datalog data is saved
as csv format files. File name is in the format of “DatalogName_
StartTime _EndTime_x”. x indicates number in sequence from 1 to
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n.

l Do not click Download during the upload progress, otherwise
the datalog upload would be failed, and it could not be restored
until reconnect to the controller.

l Do not move from Upload Datalogs page during the upload
progress.

Bulk uploading datalogs
The user can upload datalogs of multiple controllers at the same time
by invoking "honeywell.controller.api.dll" file in scripts. The dll file is
under the directory of Honeywell\ControlEdge
Builder\builder\Apps\API\2.0 in the software installation location.

You can log in as the Administrator or Engineer or Operator to
connect the target controller and bulk upload datalogs.

1. Configure the corresponding datalogs. See "Configuring datalog"
on page 183 for more information.

2. Write the scripts including the three interface functions: Connect,
Upload and Disconnect.
See the following table for the input parameter description of each
interface function:

Interface
Function

Parameter Description

Connect IP
address

IP address of the controller

user
name

The user name logged in the controller

password User password

timeout Response time of request, the value
must be 0. It cannot be modified.

Upload Datalog
ID

Configured log ID, ranging from 1 to 8.
See "Configuring datalog" on page 183
for more information.

start time The start time of the datalog to be
uploaded.

end time The stop time of the datalog to be
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Interface
Function

Parameter Description

uploaded.

time
stamp
format

Time stamp format:

0: DD/MM/YY

1: MM/DD/YY

2: YY/MM/DD

file format Uploaded file format: .csv

local file
name

Uploaded datalog name including the
absolute path the datalog restored

timeout Response time of the request, the
default value is 20 seconds. It cannot be
modified.

mode 0: upload only

1: upload and delete

actual
start time

The start time of the datalog stored in
the controller. It is an output parameter
which does not need to be configured
and it will be displayed after running the
script automatically.

actual
end time

The stop time of the datalog stored in
the controller. It is an output parameter
which does not need to be configured
and it will be displayed after running the
script automatically.

Disconnect timeout Response time of the request, the
default value is 20 seconds. It cannot be
modified.

Viewing and controlling datalog status
You can check datalog statistics and stop or resume the datalog
under View and Control Datalog Status.

Before viewing and controlling datalog status, you must log in as the
Administrator or Engineer or Operator to connect the target
controller.
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1. Under Application, select Configure and Upload Datalogs > View and
Control Datalog Status. You can check the datalog statistics under
Datalog Details table including the Data ID, Datalog Name, Start
Time, End Time and Status.

2. Press the Refresh button to update the information. Also you can
select from the drop-down list of Interval to refresh automatically.

3. If you want to stop a running datalog, select the target datalog in
Datalog Details table and click Stop. Also, you can click Resume to
start the stopped datalog again.
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8 CONFIGURING ELECTRONIC FLOW
MEASUREMENT (EFM)

Electronic flow measurement systems are used for the measurement
and recording of flow parameters of gaseous phase hydrocarbon and
other related fluids for custody transfer applications utilizing industry
recognized primary measurement devices.

This section outlines how to build and manage Electronic Gas/Liquid
Flow Measurement components using ControlEdge Builder.

For the non-redundant controller, up to four meter runs, including
gas and liquid meter runs, can be created.

For the redundant controller, up to twelve meter runs, including gas
and liquid meter runs, can be created.

ATTENTION: If there are 12 meter runs configured in a project,
it takes more than 10 minutes to save the configuration.

Configuring gas meter runs
As for register range, offset, system event and description, See "EFM
meter run registers" on page 335 for more information.

Creating a new meter run

1. In Applications tab, click Electronic Flow Measurement > Configure
Gas Meter Runs.

2. Click Add and select a type of meter run. There are four meter run
types can be selected and see the following table for information
of the four meter types.

Parameter Description

Orifice Orifice meter run calculates the volumetric flow-rate
for an orifice meter using flange or pipe tap based on
the differential pressure, temperature and pressure
input parameters.

Turbine Turbine meter run corrects measured volume at
flowing conditions read by turbine meter to volume at

189



Parameter Description

base conditions. The main input parameter of the
Turbine meter is pulse.

Ultrasonic Ultrasonic meter run also corrects measured volume
at flowing conditions read by Ultrasonic meter to
volume at base conditions. The main input parameter
of the Ultrasonic meter is pulse. Technically both
Turbine and Ultrasonic meters are same.

Coriolis Coriolis meter run converts gas mass to volume. Gas
mass is directly measured from Coriolis Meter.

3. Configure parameters of the added meter according the
navigation tab, and click Finish to add the meter to the list at left of
the page.

4. Click the arrow besides each meter to unfold tabs, including Meter
Information, Variable Selection, Contract Settings, Composition and
Record. You can check and modify parameters in corresponding
tabs if applicable.

5. Click Save. It will take 3~5 minutes to save the configuration.

You can also copy a existing meter run by clicking to create a new
meter run.

Editing an meter run

1. Select EFM meters from the Navigation pane. A list of meters
appears with the first meter selected.

2. Select the target meter you want to edit. The properties tabs
enable you to edit the configuration of the meter.

3. Click Save. It will take 3~5 minutes to save the configuration.

Meter Information properties for a gas meter run
The Meter Information tab defines the basic information and advance
information of a meter.

n See the following table for basic information parameter
descriptions.
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Parameter Description

Meter
name

The name of the meter

In most cases, the meter number is also used as the
tag name.

Meter ID The unique identifier of the meter

Third-party flow analysis applications use the meter
ID to uniquely identify the meter.

Meter type There are four meter types: Orifice, Turbine,
Ultrasonic and Coriolis.

Input units Input unit system : US Unit or Metric Unit

Contract
units

Contract unit system : US Unit or Metric Unit

Description (Optional) A description of the meter

Up to 132 alphanumeric characters including
spaces can be added.

n Advance information is different according selected meter run
type.

l If meter run type is Orifice, see the following table for
parameter descriptions.

Parameter Description

Orifice Material Stainless Steel, Monel, CarbonSteel

Tap type Flange, PIPE

Tap location UpStream, DownStream

Pipe material Stainless Steel, Monel, CarbonSteel

Orifice diameter Orifice diameter in inches for US units or in
millimeter for Metric units

Pipe Diameter Pipe diameter in inches for US units or in
millimeter for Metric units

Viscosity Viscosity in CENTIPOISES for any unit
system
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Parameter Description

Orifice reference
temperature

Unit: F° (Fahrenheit in US units)

Unit: C° (Celcius in Metric Units)

Pipe reference
temperature

Unit: F° (Fahrenheit in US units)

Unit: C° (Celcius in Metric Units)

Beta radio Beta ratio is the ratio of Orifice diameter to
Pipe diameter.

Isentropic
exponent

It is a constant number.

Fluid type Compressible, Non-Compressible

l If meter run type is Turbine or Ultrasonic, see the following
table for parameter descriptions.

Parameter Description

Meter factor Meter factor is meter calibration factor.

Variable Selection properties for a Gas meter run
The Variable Selection tab defines the static pressure, differential
pressure, pulse, gas mass and temperature for a meter.

See the following table for static pressure parameter descriptions.

Parameter Description

Variable
name

Name of variable

EU Ex Low This parameter is extreme low value for static pressure. If static pressure
goes below this value then an alarm is logged. This value should be in
the same units chosen by user for static pressure.

EU Low This parameter is low value for static pressure. If static pressure goes
below this value then an alarm is logged. This value should be in the
same units chosen by user for static pressure.

EU High This parameter is extreme high value for static pressure. If static pressure
goes beyond this value then an alarm is logged. This value should be in
the same units chosen by user for static pressure.

EU Ex High This parameter is high value for static pressure. If static pressure goes
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Parameter Description

beyond this value then an alarm is logged. This value should be in the
same units chosen by user for static pressure.

Atmospheric
pressure

Absolute Pressure, Gauge Pressure

Local
atmospheric
pressure

If Atmospheric Pressure option is Gauge Pressure then local
atmospheric pressure must be entered by the user.

Unit: This value should be in the same units chosen by the user for static
pressure.

There are different configurable parameters according different
meter run types.

n If meter run type is Orifice, configure Differential Pressure
parameters. See the following table for parameter descriptions.

Parameter Description

Variable
name

Name of variable

EU Ex
Low

This parameter is extreme low value for differential
pressure. If differential pressure goes below this value
then an alarm is logged. This value should be in the
same units chosen by user for differential pressure.

EU Low This parameter is low value for differential pressure. If
differential pressure goes below this value then an
alarm is logged. This value should be in the same
units chosen by user for differential pressure.

EU High This parameter is extreme high value for differential
pressure. If differential pressure goes beyond this
value then an alarm is logged. This value should be in
the same units chosen by user for differential
pressure.

EU Ex
High

This parameter is high value for differential pressure.
If differential pressure goes beyond this value then an
alarm is logged. This value should be in the same
units chosen by user for differential pressure.

Low DP
cutoff

Low DP cutoff value checks the no flow condition in
the calculations. The value should be in the same
units chosen by user for differential pressure.
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n If meter run type is Turbine or Ultrasonic, configure Pulse
parameters. See the following table for parameter descriptions.

Parameter Description

Variable
name

Name of variable

EU Ex
Low

This parameter is extreme low value for pulse. If pulse
goes below this value then an alarm is logged. This
value should be in the same units chosen by user for
pulse.

EU Low This parameter is low value for pulse. If pulse goes
below this value then an alarm is logged. This value
should be in the same units chosen by user for pulse.

EU High This parameter is extreme high value for pulse. If
pulse goes beyond this value then an alarm is logged.
This value should be in the same units chosen by
user for pulse.

EU Ex
High

This parameter is high value for pulse. If pulse goes
beyond this value then an alarm is logged. This value
should be in the same units chosen by user for pulse.

Input Pulse: If the input is pulse.

Analog: if the input is uncorrected analog value.

Low pulse
cutoff

Low pulse cutoff value checks the no flow condition
in the calculations.

Low flow
detect
time

NA

n If meter run type is Coriolis, configure Gas Mass parameters. See
the following table for parameter descriptions.

Parameter Description

Variable
name

Name of variable

EU Ex
Low

This parameter is extreme low value for gas mass. If
gas mass goes below this value then an alarm is
logged. This value should be in the same units
chosen by user for gas mass.
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Parameter Description

EU Low This parameter is low value for gas mass. If gas mass
goes below this value then an alarm is logged. This
value should be in the same units chosen by user for
gas mass.

EU High This parameter is extreme high value for gas mass. If
gas mass goes beyond this value then an alarm is
logged. This value should be in the same units
chosen by user for gas mass.

EU Ex
High

This parameter is high value for gas mass. If gas mass
goes beyond this value then an alarm is logged. This
value should be in the same units chosen by user for
gas mass.

Low gas
mass
cutoff

Low gas mass cutoff value checks the no flow
condition in the calculations.

See the following table for Temperature parameter descriptions.

Parameter Description

Variable
name

Name of variable

EU Ex
Low

This parameter is extreme low value for temperature. If
temperature goes below this value then an alarm is
logged. This value should be in the same units chosen by
user for temperature.

EU Low This parameter is low value for temperature. If
temperature goes below this value then an alarm is
logged. This value should be in the same units chosen by
user for temperature.

EU High This parameter is extreme high value for temperature. If
temperature goes beyond this value then an alarm is
logged. This value should be in the same units chosen by
user for temperature.

EU Ex
High

This parameter is high value for temperature. If
temperature goes beyond this value then an alarm is
logged. This value should be in the same units chosen by
user for temperature.
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Contract Settings properties for a gas meter run
See the following table for Contract Settings parameter descriptions.

Parameter Description

Compressibility
Method

l Detailed: Gas densities calculation with all gas composition
parameters

l GrossMethod1: Gas densities calculation with fewer number of
parameters (CO2, Hydrogen and CO)

l GrossMethod2: Gas densities calculation with fewer number of
parameters (CO2, Hydrogen, CO and Nitrogen)

Averaging
Method

l TimeWeighted: Flow time weighted averaging method

l FlowWeighted: NA

Contract Hour It is the hour when day QTR is closed and new one starts.

Base
Temperature

Base temperature is input parameter for any compressibility method
to calculate density at base condition.

Base Pressure Base pressure is input parameter for any compressibility method to
calculate density at base condition.

Composition properties for a gas meter run
Composition tab defines Gas Composition of a meter and you can
configure percentage of each composition.

The configurable composition is different by selecting the different
Compressibility Method in Contract Settings tab.

n If Compressibility Method is Detailed, see the following table for
parameter descriptions.

Parameter Description

Source Constant, Live

Format Percentage, Mole Fraction

Configurable
Composition

Methane, CO2, Propane, H2S, CO, Argon, I_Butane,
I_Pentane, Hexane, Octane, Decane, Nitrogen,
Ethane, Water, Hydrogen, Oxygen, Helium, N_
Butane, N_Pentane, Heptane, and Nonane.

Normalize To normalize the gas composition values if their
sum is not 100.
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n If Compressibility Method is GrossMethod1 or GrossMethod2, see
the following table for parameter descriptions.

Parameter Description

Source Constant, Live

Format Percentage, Mole Fraction

Composition
Parameter

l CO2

l Hydrogen

l CO

l Nitrogen(Only for GrossMethod2)

Gas relative density Gas relative density measured at reference
condition, input parameter for Gross
Method 1 & 2.

Reference
Temperature For
Calori Meter Density

Reference temperature for calorimeter
density required parameter for Gross
Method 1 & 2.

Gas heating value Heating value for the gas mixture.

Reference Pressure
For Calori Meter
Density

Reference pressure for calorimeter density
required parameter for Gross Method 1 &
2.

Reference
Temperature For
Combustion

Reference temperature for combustion
required parameter for Gross Method 1 &
2.

Record properties for a gas meter run
Record tab defines Daily/Hourly Record Parameters of a meter. See the
following table for parameter descriptions.

Parameter Description

Date Date of the logged hourly/ daily QTR (Quantity Transaction Record)

Time Time of the logged hourly/ daily QTR

Flow Time Flow time in seconds for hourly/ daily QTR

Volume at
Base

Accumulated volume at base condition for hourly/ daily QTR
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Parameter Description

Mass Accumulated gas mass for hourly/ daily QTR

Energy Accumulated energy for hourly/ daily QTR

Temperature Averaged temperature for hourly/ daily QTR

Pressure Averaged pressure for hourly/ daily QTR

Differential
Pressure

Averaged differential pressure for hourly/ daily QTR

Density Averaged density for hourly/ daily QTR

Flow
Extension

Flow extension value for hourly/ daily QTR. Flow extension is only
applicable to Orifice Meter.

Relative
Density

Averaged relative density for hourly/ daily QTR

Observations

In NFR set up, with 8 tasks including EFM task having 12 meter runs
and DNP3 - 2000 Points & Datalog configured, deviation in flowtime
that is an attribute of QTR has been observed. Ideally in an hour it
should be 3600 seconds but it is seen as 3599, 3598 & 3597.

However, the above NFR project with full load runs fine with 3 tasks
including EFM task.

EFM Task Time

The recommended EFM task time for configured meter runs should
be > 600 ms & < 1000 ms.

Configuring liquid meter runs
As for register range, offset, system event and description, See "EFM
meter run registers" on page 335 for more information.

The ST103A is an ultra-reliable data acquisition module that provides
I/O capabilities to controllers requiring high accuracy, or to fiscal or
custody transfer metering interfaces (e.g. Dual pulse fidelity
checking). The ST103A reads and updates its I/Os within 500 ms, and
provides external data access through a Modbus serial port.

See the following solution diagram for Liquid Electronic Flow
Measurement system:
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Figure 8-1: Liquid Electronic Flow Measurement system

See the following table for the recommended configurations of liquid
meter runs:

n For a non-redundant system, up to 4 liquid meter runs are
supported:

No. of
meter
run

No. of ST103A
connected to serial
port

Task execution
time

Set task time
automatically?

1 ~ 3 3 ST103A devices
connect to one
serial port.

STTask: 250ms

AITask: 500ms

LiqTask: 1000ms

Yes

4 3 ST103A devices
connect to one
serial port, and the
fouth device
connects to the
other serial port.

n For a redundant system, up to 12 liquid meter runs are supported.

No. of
meter
run

No. of ST103A
connected to serial
port

Task execution
time

Set task time
automatically?

1 ~ 3 3 ST103A devices
connect to 1 serial
port.

STTask: 250ms

AITask: 500ms

LiqTask: 1000ms

Yes

1 ~ 6 3 ST103A devices
connect to one
serial port, and the
rest devices connect
to the other serial
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No. of
meter
run

No. of ST103A
connected to serial
port

Task execution
time

Set task time
automatically?

port.

7 ~ 12 6 ST103A devices
connect to one
serial port, and the
rest devices connect
to the other serial
port.

STTask: 750ms

AITask: 1500ms

LiqTask: 3000ms

No. You
should set it
manually.1

Note1: The slowest execution time for the LiqTask is <= 5000ms.
The execution time of the STTask is 25% of LiqTask's, and AITask
is 50% of LiqTask's.

TIP: If there are other Modbus serial devices needing to be
connected with ST103A in the same daisy chain, it will
impact the number or execution time of meter runs in the
current configuration. You should reduce the number of
meter runs based on the previous execution time.
Alternatively, you should slow the execution time and keep
the previous number of meter runs.

When a project requires flow calculation based on single pulse stream
from primary flow meter and secondary measurements as analog
input, onboard I/O or expansion I/O can be used.

See the following solution diagram for Liquid Electronic Flow
Measurement system with the onboard I/O or expansion I/O:

Figure 8-2: Liquid Electronic Flow Measurement system with the
onboard or expansion I/O

Prerequisites
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Make sure BatchTotalizer_DataTypes exists in the Data Types list. If
not, you should insert it manually.

1. From the IEC Programming Workspace, right-click Data Types,
and select Insert > Datatypes.

2. Enter the name BatchTotalizer_DataTypes, and click OK.

Creating a new meter run

1. In Applications tab, click Electronic Flow Measurement > Configure
Liquid Meter Runs.

2. Click Add and select a type of meter run. There are five meter run
types can be selected and see the following table for information
of the five meter types.

Parameter Description

Turbine, Positive
Displacement,
Ultrasonic, Coriolis

Different primary meter types measuring
liquid flow in a meter run.

Station Totalizer Station Totalizer is used when multiple
streams are connected to a station and the
totals should be calculated from multiple
streams.

3. Configure parameters of the added meter according the
navigation tab, and click Finish to add the meter to the list at left of
the page.

4. Click the arrow besides each meter to unfold tabs, including
Information, Liquid Type, Densitometer, Meter Information, Contract
Settings, Natural Gas Liquefied and Records. You can configure each
tab with required parameters.

5. Click Save. It will take 3~5 minutes to save the configuration.

Editing an meter run

1. Select EFM meters from the Navigation pane. A list of meters
appears with the first meter selected.

2. Select the target meter you want to edit. The properties tabs
enable you to edit the configuration of the meter.

3. Click Save. It will take 3~5 minutes to save the configuration.
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Information properties for a Liquid meter run
The Information tab defines the basic information of a meter.

n See the following table for basic information parameter
descriptions.

Parameter Description

Meter
name

The name of the meter

In most cases, the meter number is also used as the
tag name.

Meter ID The unique identifier of the meter

Third-party flow analysis applications use the meter
ID to uniquely identify the meter.

Meter bank
name

Meter Bank identifier.

Meter type There are five meter types: Orifice, Turbine,
Ultrasonic, Coriolis and Station Totalizer.

Input units Input unit system : US Unit or Metric Unit

Contract
units

Contract unit system : US Unit or Metric Unit

Description (Optional) A description of the meter

Up to 132 alphanumeric characters including
spaces can be added.

Liquid type properties for a Liquid meter run
The Liquid Type tab provides the options to select the liquid type to be
measured.
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n See the following table for Liquid Type parameter descriptions.

Parameter Description

Liquid to be
measured

You can measure the following liquid:

l Crude oil

l Refined Products

l Special products

l Lubricating Oil

l Natural Gas Liquefied

Thermal expansion
factor at 60F

It is ONLY applicable for the Special
products liquid type.

Thermal expansion coefficient at 60°F.

n See the following table for I/O Selection parameter descriptions.

Parameter Description

I/O Type for the
Meter Run

l ST103A

l Others

Select it if onboard I/O or expansion
I/O or any other device is used as an
I/O.

I/O Identifier It is available when you select ST103A for
I/O Type for the Meter Run.

Identifier of the connected ST103A I/O.

Select the target ST103A you have added.

MessageID It is available when you select ST103A for
I/O Type for the Meter Run.

Message ID from the connected ST103A
device. It is used as a heartbeat to know
whether ST103A is alive and able to
communicate with ControlEdge 2020
controller. Message ID will increment 2 in
1 second.
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Parameter Description

The global variable created automatically
after you add a ST103A device.

Watch Dog Time It is available when you select ST103A for
I/O Type for the Meter Run.

Maixmum wait time in seconds for
ST103A to restore the connection after
the connection failure with ControlEdge
2020 controller. Beyond this limit, pulse
increment will not be utilized in volume
calculations. The status for
hourly/daily/Batch totals will be set to 1,
i.e. the totals are unreliable.

Pulse Max Increment It is available when you select ST103A for
I/O Type for the Meter Run.

Maximum pulse increment limit for an
execution cycle. If the pulse increment is
beyond the limit, pulse increment will not
be utilized in volume calculations and an
alarm will be generated.

Densitometer properties for a Liquid meter run
The Densitometer tab provides the configuration required for meter
run calculations from densitometers.
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n See the following table for Densitometer parameter descriptions.

Parameter Description

Densitometer is available Option to set whether the
Densitometer is available or not.
The value should be either 1 for
Yes or 0 for No.

l Yes

l No

Coriolis meter to provide
density measurement

It is available when the meter run
type is Coriolis.

If the Coriolis meter is measuring
both flow and density
measurement, select the
appropriate option.

No. of Densitometer It is available when you select Yes
for Densitometer is available.

The number of Densitometers
available. The value should be
either 1 for Single or 2 for Dual
densitometer.

l 1 (A)

l 2 (A, B)

Base density It is available when you select No
for Densitometer is available.

Density at Base conditions. The
value should be in lb/ft^3 for US
unit and kg/m^3 for Metric unit.

If the measurement system does
not have on-line densitometer and
takes input from offline density
measurement, this option should
be selected.

n If you select Yes for Densitometer is available, configure the
Temperature parameters. See the following table for parameter
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descriptions.

Parameter Description

Variable name Parameter to set the Densitometer
temperature. The value should be
in Fahrenheit for US unit and in
Celcius for Metric unit.

Status Status for Densitometer
Temperature. The value should be
{0} for good status, or any positive
integer for bad status.

LOLO This is the LoLo limit for
Densitometer temperature. The
value should be in Fahrenheit for
US unit and in Celcius for Metric
unit.

Override Value Keypad value for Densitometer
temperature. This value is used
when the densitometer
temperature status is bad.

LO This is the Lo limit for
Densitometer temperature. The
value should be in Fahrenheit for
US unit and in Celcius for Metric
unit.

I/O Selection I/O selection for Densitometer
Temperature. The value should be
1 for Live or 2 for Keypad value.

HI This is the Hi limit for
Densitometer temperature. The
value should be in Fahrenheit for
US unit and in Celcius for Metric
unit.

HIHI This is the HiHi limit for
Densitometer temperature. The
value should be in Fahrenheit for
US unit and in Celcius for Metric
unit.
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n If you select Yes for Densitometer is available, configure the Gauge
Pressure parameters. See the following table for parameter
descriptions.

Parameter Description

Variable name Parameter to set the Densitometer
pressure. The value should be in
Psig for US unit and in Kpag for
Metric unit.

Status Status for Densitometer Pressure.
The value should be {0} for good
status, or any positive integer for
bad status.

LOLO This is the LoLo limit for
Densitometer pressure. The value
should be in Psig for US unit and
in Kpag for Metric unit.

Override Value Keypad value for Densitometer
pressure. This value is used when
the densitometer pressure status
is bad.

LO This is the Lo limit for
Densitometer pressure. The value
should be in Psig for US unit and
in Kpag for Metric unit.

I/O Selection I/O selection for Densitometer
pressure. The value should be {1}
for Live or {2) for Keypad value.

HI This is the Hi limit for
Densitometer pressure. The value
should be in Psig for US unit and
in Kpag for Metric unit.

HIHI This is the HiHi limit for
Densitometer pressure.The value
should be in Psig for US unit and
in Kpag for Metric unit.

n If you select Yes for Densitometer is available, and select No for No.
of Densitometer, configure the Density parameters. See the
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following table for parameter descriptions.

Parameter Description

Measured density Density value of the Densitometer.
The value should be in lb/ft^3 for
US unit and kg/m^3 for Metric
unit.

If you select 2 (A, B) for No. of
Densitometer, there will be two
options Measured density A and
Measured density B to be
configured.

Status Status of Densitometer. The value
should be {0} for good status, or
any positive integer for bad status.

If you select 2 (A, B) for No. of
Densitometer, there will be two
options Status A and Status B to be
configured.

Preferred Densitometer It is available when you select 2 (A,
B) for No. of Densitometer.

l A

l B

Override Value Keypad value for Densitometer
measured density. This value is
used when the densitometer status
is bad. The value should be in
lb/ft^3 for US unit and kb/m^3 for
Metric unit.

When the number of densitometer
is 2 and the status of preferred
densitometer is bad, the function
block automatically switches to
the other densitometer if its status
is good. If both densitometer
status is bad, then an override
(keypad) value will be used. In case
of measured density, the keypad
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Parameter Description

value needs to be a base density.

I/O Selection I/O selection for Density. The value
should be {1} for Live or {2} for
Keypad value.

Meter Information properties for a Liquid meter run
The Meter Information tab defines the basic information related to
primary measurement element and associated secondary
measurement devices.

n See the following table for the Advanced information parameter
descriptions.

Parameter Description

Meter K
factor

Meter K factor converts pulse from flow meter into
volume. The value should be in pulses/m3 or
pulses/ft3. When the flow type is analog, this is the
correction factor to apply for volume calculation and
the default value should be 1.0.

n See the following table for Temperature parameter descriptions.

Parameter Description

Variable name Parameter to set the meter
temperature. The value should be
in Fahrenheit for US unit and in
Celcius for Metric unit.

Status Analog input channel status for
meter temperature. The value
should be {0} for good status, or
any positive integer for bad status.

LOLO This is the LoLo limit for meter
temperature. The value should be
in Fahrenheit for US unit and in
Celcius for Metric unit.

Override Value Keypad value for meter
temperature. The value is used
when the densitometer
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Parameter Description

temperature status is not good.

LO This is the Lo limit for meter
temperature. The value should be
in Fahrenheit for US unit and in
Celcius for Metric unit.

I/O Selection I/O selection for meter
temperature. The value should be
{1} for Live or {2) for Keypad value.

HI This is the Hi limit for meter
temperature. The value should be
in Fahrenheit for US unit and in
Celcius for Metric unit.

HIHI This is the HiHi limit for meter
temperature. The value should be
in Fahrenheit for US unit and in
Celcius for Metric unit.

n If the meter run type is Coriolis, configure the Density parameters.
See the following table for parameter descriptions.

Parameter Description

Measured density Density value from the
Densitometer. The value should be
in lb/ft^3 for US unit and kg/m^3
for Metric unit.

Status Status of Densitometer. The value
should be {0} for good status, or
any positive integer for bad status.

Override Value Keypad value is used when
measured density status is bad.
Generally this will be base density.
The value should be in lb/ft^3 for
US unit and kg/m^3 for Metric
unit.

I/O Selection I/O selection for Density. The value
should be {1} for Live or {2} for
Keypad value.
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n See the following table for Gauge pressure parameter descriptions.

Parameter Description

Variable name Parameter to set the meter
pressure. The value should be in
Psig for US unit and in Kpag for
Metric unit.

Status Analog input channel status for
meter pressure. The value should
be {0} for good status, or any
positive integer for bad status.

LOLO This is the LoLo limit for meter
pressure. The value should be in
Psig for US unit and in Kpag for
Metric unit.

Override Value Keypad value for meter pressure.
The value is used when the meter
pressure status is bad.

LO This is the Lo limit for meter
pressure. The value should be in
Psig for US unit and in Kpag for
Metric unit.

I/O Selection I/O selection for meter pressure.
The value should be {1} for Live or
{2) for Keypad value.

HI This is the Hi limit for meter
pressure.The value should be in
Psig for US unit and in Kpag for
Metric unit.

HIHI This is the HiHi limit for meter
pressure. The value should be in
Psig for US unit and in Kpag for
Metric unit.

n See the following table for Pulse parameter descriptions.

Parameter Description

Variable name The parameter to set pulse/analog
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Parameter Description

input for flow.

Input Parameter to set the flow type. The
value should be {0} for Pulse and
{1} for Analog.

l Select Pulse if the flow meter
provides pulse stream as an
output.

l Select Analog if the flow meter
provides flow rate as an output,
and the value should be in
lb^3/hr. for US unit or m^3/hr.
for Metric unit.

TIP: For applications related
to control a flow rate, it is
recommended to select
Analog and use flow meters
which supports analog
output.

Low pulse cutoff Low pulse cut off limit determines
no flow conditions.

LOLO It is available when you select
Analog for Input.

This is the LoLo limit for analog
input. The value should be in
lb^3/hr for US unit or m^3/hr for
Metric unit.

LO It is available when you select
Analog for Input.

This is the Lo limit for analog input.
The value should be in lb^3/hr for
US unit or m^3/hr for Metric unit.

HI It is available when you select
Analog for Input.

This is the Hi limit for analog input.
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Parameter Description

The value should be in lb^3/hr for
US unit or m^3/hr for Metric unit.

HIHI It is available when you select
Analog for Input.

This is the HiHi limit for analog
input. The value should be in
lb^3/hr for US unit or m^3/hr for
Metric unit.

Contract Settings properties for a Liquid meter run
The Contract Settings tab defines the additional settings required for
Quantity Transaction Record (QTR) computation.

n See the following table for Contract Settings parameter
descriptions.

Parameter Description

Averaging
Method

Parameter to choose the Averaging method. By
default in AP21.2, the averaging method is flow
weighted average.

Averaging
Variable

Parameter to set the variable used for averaging.
The value should be {0} for Gross Volume or {1}
for Mass.

Contract
Hour

Parameter represents the time of daily QTR
generation. Its value should be from 0 to 23.

Base
Temperature

Temperature at Base conditions. The value should
be in Fahrenheit for US units and in Celcius for
Metric units. The contract unit setting on the Basic
Information is used for QTR calculation. The
default value for US unit is 60 Deg F and ranges
from 15 to 20 Deg C for Metric units.

API
Rounding

Option to enable or disable the API rounding. This
option will round-off the input and output float
values according to API standards.

l Enable

l Disable
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Parameter Description

Sediments &
water
measurement
is available

Parameter to set whether the Water and
Sediments is available in the Crude Oil or not. The
value should be {1} if it is available, otherwise it
should be {0}.

l Yes

l No

Sediments &
water

Parameter to set the percentage of Water and
Sediments present in the Crude Oil.

Status Analog input channel status for Water and
Sediments. The value should be {0} for Good or
any positive integer for Bad status.

Override
Value

Keypad value in percentage for Water and
Sediments. The value that should be used when
the Water and Sediments status is not good.

I/O Selection I/O selection for Water and Sediments value. The
value should be {1} for Live or {2} for Keypad
value.

n See the following table for Operation parameter descriptions.

Parameter Description

Maintenance Mode Flag Parameter to Start or Stop the
Maintenance Mode. The value
should be either {0} Maintenance
End or {1} for Maintenance Start.

Operation Type Parameter to set the type of
Operation. The value should be {1}
for Continuous or {2} for Batch.

Batch Identifier It is available when you select Batch
for Operation Type.

Identifier for a Batch operation.
This number will be incremented
for every batch run.

Batch Mode Flag It is available when you select Batch
for Operation Type.
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Parameter Description

Parameter to start or stop the
Batch operation.

Retrospective K-factor
Correction

It is available when you select Batch
for Operation Type.

Option to enable or disable the
retrospective K-factor handling in
Batch totolization.

Natural Gas Liquefied properties for a Liquid meter
run
The Natural Gas Liquefied tab defines the inputs parameters required
for Natural Gas Liquefied liquid type.

See the following table for the corresponding parameter descriptions.

Parameter Description

CPL calculation
type

CPL Calculation Type. The value should be {1} for None or {2} for
API21.2 or {3} for API21.2M.

Convergence
criteria

IP2 Convergence limit. Default value is 0.001.

Maximum
iterations

IP2 Max loop limit. Default value is 50.

Iteration method Main calculation method. The value should be either {1} for
ASTM or {2} for IP2.

Vapor pressure
input

Parameter to set the Vapour Pressure Input.

Vapor pressure
calculation method

Vapour Pressure calculation options. The value should be {1} for
None, {2} for User Observed or {3} for API 11.2.5

Station Totalizer properties for a Liquid meter run
When you create a Station Totalizer meter run, the Station Totalizer tab
appears.

The LiquidStationTotalizer function block calculates the meter station
totals for the multiple streams connected to the station. The station
totals are calculated by adding relevant individual totals from each
stream and totalizing them to create Station totals. Station totalizer by
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default totalize Gross standard Volume, Net Standard Volume, Mass
and water and sediments volume. The station totalizer by default
generate hourly and daily QTR similar to any other meter runs.

Station totalizer can be configured for totalizing 2 ~ 4 meter runs. The
maximum meter runs that can be added to station totalizer is 4 and
minimum is 2.

While configuring station totalizer, meter runs should have same
liquid type, operation type (period/batch) and same contract hour.
The function block will not do any error handling if the above
conditions are not met.

See the following table for the corresponding parameter descriptions.

Parameter Description

Meter ID The unique identifier of the meter.

Third-party flow analysis applications use the meter ID to uniquely
identify the meter.

Liquid
Type

Liquid to be measured:

n Crude oil

n Refined Products

n Special products

n Lubricating Oil

n Natural Gas Liquefied

Contract
units

Contract unit system: US Unit or Metric Unit.

Operation
Type

Parameter to set the type of Operation. The value should be {1} for
Continuous or {2} for Batch.

Records properties for a Liquid meter run
Records tab defines Daily/Hourly Record Parameters of a meter. See the
following table for parameter descriptions.

Parameter Description

Start Date Start date of the Quantity Transaction Record (QTR).
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Parameter Description

Start Time Start time of the QTR.

End Date End date of the QTR.

End Time End time of the QTR.

Pulse Start Pulse value at the start of the QTR.

Pulse End Pulse value at the end of the QTR.

Meter K-Factor Meter K factor converts pulse from flow meter into volume. The value
should be in pulses/m3 or pulses/ft3. When the flow type is analog,
this is the correction factor to apply for volume calculation and the
default value should be 1.0.

Weighted
Average
Temperature
Correction
Factor (CTL)

Flow weighted average temperature correction factor.

Weighted
Average
Pressure
Correction
Factor (CPL)

Flow weighted average pressure correction factor.

Weighted
Average
Observed
Density

Flow weighted Average of Observed Density for the hour / day.

Weighted
Average
Observed
Temperature

Flow weighted Average of Observed Temperature for the hour / day.

Weighted
Average Base
Density

Flow weighted Average of Base Density for the hour / day.

Weighted
Average
Temperature

Flow weighted Average of Temperature for the hour / day.

Weighted
Average

Flow weighted Average of Pressure for the hour / day.
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Parameter Description

Pressure

Gross Standard
Volume

Gross Standard volume total for this hour/day.

Sediments &
Water Volume

Sediments and Water volume total for this hour/day.

Mass Mass total for this hour/day.

Cumulative
Gross Standard
Volume/Mass

Non-Resettable or Cumulative total for Gross Standard volume/Mass.
In case of a Coriolis meter, this parameter represents mass. For other
meter types, this parameter represents volume.

Status Status of the flow calculation for the current hour/day.

Batch Identifier Identifier for a Batch operation.

Maintenance
Gross Standard
Volume/Mass

Non-resettable or cumulative total for Gross Standard volume/mass
in Maintenance mode. For a Coriolis meter, this parameter represents
mass, and for other meter types, it represents volume.

For station totalizer, the same description in the above table are
applicable.
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CHAPTER

9 CONFIGURING A CONTROLLER SIMULATOR

Controller simulator can be deployed on a Virtual Machine, and
enables the user to configure a controller without connecting a
physical controller.

For this release, the controller simulator does not support I/O
communication.

ATTENTION: It is not recommended to use the simulator in a
production environment, because simulator does not support
secured communication.

The following table lists the supported and non-supported features of
the controller simulator.

Features Support

Connect a controller simulator Yes

Download a project to a controller simulator Yes

Download a redundant project to a controller simulator Yes

Debug a program Yes

Force I/O value through I/O variables Yes

Force I/O value through I/O channels No

Upload system event log Yes

Monitor link status Yes

System diagnostics Yes

Secure communication No

Communication between SCADA and controller simulator Yes

Communication between controller simulators Yes

Communication between virtual and physical controllers Yes

Modbus TCP master/slave Yes

Modbus UDP slave No
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Features Support

Enron Modbus slave No

DNP3 slave No

OPC UA Server Yes

OPC UA Client No

CDA responder No

EtherNet/IP No

HART/HART-IP No

Wireless I/O No

Data logging No

EFM No

Secured communication No

Prerequisite

Make sure the IP addresses for the PCs installed simulator and
ControlEdge Builder are on the same subnet.

One virtual machine only supports one controller simulator.

Procedures

1. Install a virtual machine. Two virtual machines are verified:

l VMware Workstation Player 12.5.8 or higher hypervisor

l VMware vCenter Server 6.0.0 or higher hypervisor
For more information, see the vendor's documents.

2. Import or open an OVA file in the virtual machine, and play the
virtual machine. Honeywell provides three OVA files stored in
Simulator folder in the Media.
RXXX indicates the release number.

l ControlEdge 900 controller: ControlEdge_PLC_900CP1_
RXXX.ova

l ControlEdge 2020 controller:

l Non-redundant controller: ControlEdge_RTU_SCUCMX01_
RXXX.ova
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l Redundant controller: ControlEdge_RTU_SCUCNN11_
RXXX.ova

Take VMware Workstation Player 12.5.8 as an example here:

a. Click Player > File > Open, the Open Virtual Machine dialog
appears.

b. Browse to the location stored the target OVA file, select the OVA
file and click Open.

c. From the Import Virtual Machine dialog, name the virtual
machine, and select a storage location for the virtual machine.
Click Import.
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d. Click Play virtual machine.

e. For ControlEdge 900 controller, you should configure the
controller type.

l Enter 0 to configure the controller type as non-redundant.

l Enter 1 to configure the controller type as redundant.
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NOTE: The controller type cannot be changed once you
configure it, and you should re-import the OVA file and
configure it again.

An OVA file defines a controller simulator. To change the
controller simulator version, import the corresponding OVA file.
For more information, see the vendor's documents.

3. Connect to a controller simulator. See "Connecting a controller"
on page 26 for more information.
After you connect to a controller simulator, make sure the build
settings is I486_LE_GCC3. Click IEC Programming Workspace and
check the following parameter:

4. Configure a controller simulator. See the table above for the
supported configuration. Project version must match with the
controller simulator version.

5. Compile the project. See "Compiling a project" on page 237 for
more information.

6. Download the project to the controller simulator. See
"Downloading a project to the controller" on page 239 for more
information.
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CHAPTER

10 PROGRAMMING WITH IEC 61131-3

This chapter introduces general information about programming with
IEC 61131-3.

The following table shows and introduces the items in the Project Tree
Window.

TIP: Items in the Project Tree Window cannot use the same name.

Icon Description

Folder (closed/open) in the subtree "Libraries", "Data Types" or "Logical
POUs". This folder icon is also visible in SFC POUs, containing detail
worksheets (see below).

Libraries, includes firmware library (upper icon with key) and user
library, both contained in the "Libraries" folder.

Data types worksheet in the "Data Types" folder.

Program POU in the "Logical POUs'' folder containing one or several
code worksheets, a variables grid worksheet and an optional description
worksheet.

Function block POU in the "Logical POUs" folder containing one or
several code worksheets, a variables grid worksheet and an optional
description worksheet.

Function POU in the "Logical POUs" folder containing one or several
code worksheets, a variables grid worksheet and an optional description
worksheet.

Description worksheet, contained in a POU or configuration folder. The
worksheet contains optional description for documentation purposes.

Variables grid worksheet which is part of each POU containing the local
variables declarations. Contained in each POU folder.

Code worksheet in the textual programming language ST. Contained in
each ST POU folder.

Code worksheet in the textual programming language IL. Contained in
each IL POU folder.
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Icon Description

Code worksheet in the graphical programming language LD created
with the standard graphical editor. Contained in each LD POU folder.

Code worksheet in the graphical programming language FBD.
Contained in each FBD POU.

Code worksheet in the graphical programming language SFC.
Contained in each SFC POU.

Action or transition worksheet contained in an SFC POU.

Folder (closed/open) in the "Physical Hardware" tree, representing
either the entire subtree, a configuration or a resource.

Task folder (closed/open) in the "Physical Hardware" tree representing
either the "Task" root folder or a particular task with program and
function block instances inside.

DEFAULT task

CYCLIC task

EVENT task

SYSTEM task

Program instance contained in a task folder.

Function block instance contained in a program instance folder of a
task folder.

Global variables grid worksheet containing the declarations of
resource-global variables of the particular resource.

I/O configuration worksheet containing the declarations of input and
output groups (addresses) for the particular resource.

The following table introduces programming languages.

Programming
language

Description

IL Instruction List:

Code programmed in the textual language IL consists of a sequence of
instructions. Each instruction starts at a new line. A line number is
displayed in front of each line. Each line begins with an operator
followed by one operand.
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Programming
language

Description

ST Structured Text:

Code programmed in the textual language ST consists of statements
and expressions. Each code line must be terminated with a semicolon.

SFC Sequential Function Chart:

Code programmed in the graphical language SFC is composed of
steps and transitions which are connected with directed links. One or
several action blocks can be associated to a step.

FBD Function Block Diagram:

Code programmed in the graphical language FBD is composed of
functions and function blocks which are connected with each other or
with variables using lines. These lines can also be connected with each
other. In FBD networks it is not possible to connect outputs with
outputs. The set of connected objects is called FBD network.

LD Ladder Diagram:

Code programmed in the graphical language LD is composed of
contacts and coils. According to IEC 61131-3 different types of
contacts and coils can be used. Contacts lead (according to their type)
the power from the left to the right. Coils store the incoming value.
Both, contacts and coils, are assigned to Boolean variables.

See the embedded help for details about programming. Select Help >
Contents from the toolbar. In the pop-up help, expand Programming
System Help and click Programming a project.

Adding a library
The Libraries that are included in your project are either user-defined
libraries or firmware libraries.

n User Library: contains programs, function blocks, functions and
user-defined data types, and can be reused across projects.
Honeywell provides user libraries and user can create their own.
The file extensions for user library are *.mwt and *.mwe.

n Firmware Library: contains function blocks and functions
prepared by Honeywell for specific hardware. The file extension for
firmware library is *.fwl.
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For more information about the function and function block, see the
ControlEdge Builder Function and Function Block Configuration
Reference Guide.

To add a library

1. Click IEC Programming Workspace from the toolbar, or from Home
Page, click Program with IEC61131-3.

2. Right-click Libraries and click Insert. Select User Library or Firmware
Library.

l For User Library, select .mwt file and click Include.

l For Firmware Library, click the corresponding folder and select
the target .fwl file, and then click Include.

Creating a data type
Honeywell provides some read-only user-defined data types, and user
can also create and define data types. The maximum number of user
defined data types is 1024. User-defined data types can be used
within user function blocks and programs. They cannot be used in
user functions.

To create a data type

1. Click IEC Programming Workspace from the toolbar, or from Home
Page, click Program with IEC61131-3.

2. From the Project Tree Window, right-click Data Type and select Insert
> Datatypes and name the target data type.

3. Double-click the newly added data type, you can edit it in the text
editor.

For I/O_DataTypes, each I/O Channel has one or two structures. All of
the related information for this channel is grouped together in the
structures as shown below. You can use this information as reference
for I/O channel configuration and programming.

Table 10-1: I/O channel structures of the I/O_DataTypes
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Structure type Parameter Parameter type

ANALOG_INPUT_TYPE STS USINT

PV REAL

EUHI REAL

EULO REAL

EUHIEX REAL

EULOEX REAL

ANALOG_OUTPUT_TYPE OP REAL

ANALOG_OUTPUT_READBACK_
TYPE

STS USINT

OP_READBACK REAL

EUHI REAL

EULO REAL

EUHIEX REAL

EULOEX REAL

DIGITAL_INPUT_TYPE STS USINT

PV BOOL

DIGITAL_OUTPUT_TYPE OP BOOL

DIGITAL_OUTPUT_READBACK_TYPE STS USINT

OP_READBACK BOOL

PULSE_INPUT_TYPE STS USINT

COUNTER1 UDINT

RATE2 REAL

PREI3 BOOL

PULSE_INPUT_CONTROL_TYPE RST4 BOOL

HOLD5 BOOL

FREQUENCY_INPUT_TYPE STS USINT

FREQUENCY REAL
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Structure type Parameter Parameter type

PULSE_OUTPUT_TYPE PULSES UDINT

ENABLE BOOL

START BOOL

CONTINUE BOOL

PULSE_OUTPUT_READBACK_TYPE STS USINT

REMAIN UDINT

1. COUNTER: The accumulated Engineering Unit (EU) count.

2. RATE: Rate in EU/Time Period. Input pulses are counted over a specified Sample
Time and scaled to EU/Second, EU/Minute or EU/Hour.

3. PREI: Preset indicator. OFF [0] when COUNTER = less than the local or remote
preset value, ON when the count reaches the local or remote preset value. The
hardware module determines the state of the PREI output. PREI is cleared by the
RST input. A preset value of 0 effectively turns off the Preset allowing the counter to
count continuously until held or reset.

4. RST: An OFF to ON transition resets the module's pulse counter and the OUT to
zero. It also clears the FAIL, Overflow in STS and PREI.

5. HOLD: A Boolean value when set to 1 holds the EU count at its current value.

Creating a variable
This section introduces how to create and declare variables to
diagnose and monitor the system.

To create a variable

1. Click IEC Programming Workspace from the toolbar, or from Home
Page, click Program with IEC61131-3.

2. You can create local variables or global variables from the

corresponding grid worksheet. is the grid worksheet for local

variables, and is the grid worksheet for global variables.

For the following steps, let us take the global variable as an
example.

3. Double-click Global_Variables under Physical Hardware, the global
variable sheet appears.

4. Right-click under the corresponding group, and select Insert
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variable to add a new I/O variable.
For output channel variables, you must add corresponding read
back variables with suffix “_READBACK” in the Input I/O Variables
group.

5. Double-click the Name and Description fields to modify, and select
Type and Usage from the drop-down lists.
The maximum quantity of characters for a variable name is 30.
IEC address of the I/O variable is generated automatically after
you bind it with an I/O channel and click Make. If you add a new
I/O variable by copying an existing bound one in a compiled
project, you should delete the IEC address of the new variable
manually and click Make to generate it automatically.

6. If a variable will be used for Modbus, EFM or PID, you should
select Retain for it. Perform either of the following methods:

l From the variable sheets, select Retain.

l From the variable properties dialog, select Retain, and click OK.
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Creating a Programming Organization Unit
Logical Program Organization Units (POUs) are the language
elements of a program. They are small, independent software units
containing the program code. The name of a POU must be unique
within the project.

There are three different POU types:

n Program: contains a logical combination of function or function
block calls. Programs have input and output parameters and they
can have an internal memory.

n Function Block: POUs with multiple input/output parameters and
internal memory.

n Function: POUs with multiple input parameters and exactly one
output parameter.

To create a POU

1. Click IEC Programming Workspace from the toolbar, or from Home
Page, click Program with IEC61131-3.

2. From the Project Tree Window, right-click Logical POUs and select
Insert > Program/Function Block/Function, the Insert dialog appears.

3. Enter the Name for the new POU.

4. Select the desired programming Language. Depending on your
system configuration, some programming language are possibly
not available.

5. Enter a PLC type and/or a Process type if required.

6. Click OK, the new POU is inserted in the project tree. It contains
one code worksheet in the chosen language, a variable worksheet
and a description worksheet.

7. Expand the POU, and double-click the code worksheet, the
workplace appears.

8. Drag the target function or function block from the Edit Wizard
pane, and the function or function block is displayed.

9. Double-click the pin-outs of the function or function block, the
Variable Properties dialog appears.

10. Accept the proposed name, or enter a new name or select an
already existing name from the Name combo box.

11. Select the Data Type and Usage from the drop-down lists.
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l If you are creating a Program, there are two options for Usage:
VAR and VAR_GLOBAL.

l If you are creating a Function Block, there are five options for
Usage: VAR, VAR_INPUT, VAR_OUTPUT, VAR_IN_OUT and VAR_
GLOBAL.

l If you are creating a Function, there are two options for Usage:
VAR and VAR_INPUT.

See the following table for the description of variables.

Variable Description

VAR Local variable

VAR_GLOBAL Global variable

VAR_INPUT Local FB input variable

VAR_OUTPUT Local FB output variable

VAR_IN_OUT Local input/output variable

12. Assign the initial value and I/O address.

13. It is optional to select the target group from Global Variable Groups.
Click OK and the new variables are added to the selected groups.
If you do not select a Global Variable Group, the variables are added
to the Common Variables group by default.

Associating a program to a task
Tasks determine the time scheduling of the programs associated with
them. This means that programs have to be associated to tasks in
order to be executed. The settings of the task determine the time
scheduling.

To create a task and associate a program

1. Click IEC Programming Workspace from the toolbar, or from Home
Page, click Program with IEC61131-3.

2. From the Project Tree Window, under Physical Hardware, right-click
Task and select Insert > Task.

3. Enter the Name.
Task name and Instance name must start with a letter or an
underscore. The rest of the characters can be letters, numbers or
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underscores. The maximum quantity of characters which a task
name can have is 7 and that of a program instance is 24.

4. Select the Task type. See the following table for the descriptions of
task types.

Task type Description

DEFAULT Each resource can contain one default task. It is the
task with the lowest priority (lower than cyclic tasks)
and is not time scheduled.

CYCLIC Cyclic task executes their associated programs in
fixed time intervals.

EVENT Event task executes their associated programs each
time a particular event occurs.

SYSTEM System task executes its associated programs each
time a particular system event occurs.

5. Click OK.

6. Configure the parameters as required in the Task settings dialog.
See the following table for the parameter descriptions.
Depending on the associated task type, only some of the
parameters are available.

Parameter Description

Event No. Specifies the event which activates the execution of
the event task. Only available for event tasks.

Interval Specifies the time interval in ms in which the cyclic
task is executed. Only available for cyclic tasks.

SPG No. Specifies the system program (SPG) which is
associated with the task System programs. Only
available for system tasks.

Priority Assigns a priority for calling a task. 0 represents the
highest and 31 the lowest priority. The task with the
highest priority is called first.

Watchdog
Time

Specifies the time interval when the watchdog checks
if the cycle time has been exceeded or not. This time
interval should be shorter than or equal to the cycle
time of the cyclic tasks.
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Parameter Description

As for the project with multiple tasks, it is
recommended to disable the Watchdog function for
lower priority tasks.

Stack Specifies the size of the task stack. The stack size
depends on the amount of the local variables used. In
case of a task switching the values of the local
variables are stored in the stack. The default setting is
medium. Only if you get several times a stack overflow
you should use a higher stack size.

SAVE_
FPU

Saves the floating point register when switching the
tasks. This checkbox should be activated only, if you
use the data type REAL in different tasks and if the
hardware supports saving floating point registers
while task switching.

BYPASS Removes the task switching so that the associated
programs are executed immediately if the event
happens. Only available in case of an event task.

NO_
SUSPEND

Specifies that the associated program is executed in
all operational states including the STOP state. This
checkbox should be used for tasks with associated
programs containing code bodies which should be
executed continuously. It might be also useful if you
are setting breakpoints to assure that parts of your
programs are although executed.

7. Click OK. The new task is inserted.

8. Right-click the task you have inserted, and select Insert > Program
instance.

9. Enter a name in the Program instance field.
The program instance must not be named “RTU” or
“GlobalVariable”.

10. Select the program you want to associate in the Program type
drop-down list.

11. Click OK.
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CHAPTER

11 COMPILING A PROJECT
After configuring the project, you have to compile it.

To compile a project

Click Make or Rebuild Project as required to compile the project.

n Make: It is used to compile the changed worksheets.

n Rebuild Project: It is used to compile the whole project for the first
time or if an announced user library has been changed. The
command Rebuild Project should only be used if 'Make' generates
compiling errors or you have unzipped your project without the
frontend code.

While compiling, the message window displays the compilation
process. Any detected errors and warnings (e.g. syntax errors, memory
or file problems) and additional information are also displayed in the
appropriate message window sheet. You can use the message window
to access the suspected code body worksheet by double clicking on
the error message.

After compiling without any error, you have to download the project
to the controller. See "Downloading a project to the controller" on
page 239 for more information.
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CHAPTER

12 DOWNLOADING A PROJECT TO THE
CONTROLLER

After compiling a project without any error, you have to download the
project to the controller.

Before downloading the project to the controller, you have to ensure:

n The project is opened in ControlEdge Builder. See "Opening an
existing project" on page 21 for more information.

n The project is compiled without any error. See "Compiling a
project" on page 237 for more information.

n Log in as the Administrator or Engineer to connect the target
controller. See "Connecting a controller" on page 26 for more
information.

n The primary CPM is connected if the controller is redundant.

To download a project

1. From the Home Page, click Download. A eclrRes window appears:
See the following table for the parameter description of the eclrRes
window.

Parameter Description

State
l On: The controller is running and accessible via

online communication, but no application is
loaded.

l Loading: The state 'Loading' is only visible while
installing a controller application (e.g. while
loading a bootproject).

l Stop: The controller application is loaded and
ready to execute (by pressing one of the start
buttons).

l Starting: All necessary initializations are
performed including loading the drivers
depending on the start up modes
(cold/warm/hot).

l Running: The controller application is executed.
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Parameter Description

l state [DEBUG]: The appendix [DEBUG] after the
actual state can appear in conjunction with the
states RUN, STOP or HALT. [DEBUG] indicates,
that the debug mode is active, i.e. either
variables are forced or breakpoints are set (if a
breakpoint is reached, the state changes to
HALT [DEBUG]).

l HALT: The program execution is halted at a
breakpoint which has been set using the 'Debug'
dialog. In this state all user tasks are inactive
and the I/O images are not updated. The
program execution can be resumed with one of
the control dialog buttons 'Go', 'Step' or 'Trace'.

l HaltRequested: Intermediate state: During
program execution, a set breakpoint has been
reached. All necessary actions to halt the
execution of the controller application are
performed.

l Stopping: All necessary actions to stop the
execution of the controller application are
performed including unloading the drivers.

l Resetting: Unloads the controller application
and clears the eCLR application.

l TIMEOUT: This state which is also displayed in
the control dialog 'Resource_name' indicates
that the connection between the programming
system and the controller was not established
within the given time interval. The
corresponding time interval is set in the dialog
'Resource settings...' (field 'Timeout'). During this
interval, the system tries to connect the
controller. If the interval has elapsed without a
successful connection, the online part of the
programming tool enters the TIMEOUT state.

Stop Stop the program execution on the controller.

Cold When a cold start is executed:

l all data are initialized.
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Parameter Description

l all I/O drivers are executed.

l user task which is triggered by System event
"Cold start" is called.

l all user tasks are activated (ready to be
scheduled and executed).

Warm When a warm start is executed:

l only non-retentive data are initialized.

l all I/O drivers are executed.

l user task which is triggered by System event
"Warm start" is called.

l all user tasks are activated (ready to be
scheduled and executed).

Reset Reset the controller.

Download Download the current project to the controller.

For more information, see the embedded online help. Select Help >
Contents, and search for PLC state machine to display the
corresponding content.

2. A Download confirmation dialog appears to make sure you want
to download. Click Yes.

ATTENTION: If you want to upload this project in the future,
you should select Download the project archive, and a zip file
of the archived project will be stored in the controller.

3. There are two scenarios:

l If the controller does not contain any project or the project you
are going to download has a different name with the project is
already stored in the controller, you should click Stop in the
eclrRes window to stop the program execution. Then click
Download in the eclrRes window to continue the download.

l If the project with the same name is already stored in the
controller, the project will be downloaded directly without
stopping the program execution. It is also possible while
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variables are forced.
The following changes can be downloaded without stopping
the program execution:

l changing code of existing POU(s).

l inserting/deleting local and global variables.

l changing local and global variables (incl. initial value).

l declaring new function block (user/firmware) instance.

l adding/deleting data types.

l changing data type declarations.

l changing comments in code bodies.

l using a new POU type in a resource.

l adding/deleting program instances.

l adding/deleting tasks.

l changing any task properties (task type, cycle times, priority,
event number, SPG assignment, changing the watchdog
time, etc.)

l changing configuration in ControlEdge Configuration
Workspace.

ATTENTION: If the system is not able to ensure real-time,
because too many POUs have been changed and the
volume of POU instance data to be copied is too large, a
user interaction is required. The system displays a
message that informs you the program execution will be
stopped if you continue the download. Click Yes to
continue the download. Click No to cancel the download.

4. Click OK after the project is downloaded to the controller
successfully.
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CHAPTER

13 DEBUGGING THE PROGRAM

After the project has been downloaded to the controller, and you have
performed a cold or warm start, you can switch the worksheet to
online mode to verify and debug the program.

To debug the program, click from the toolbar under the IEC
Programming Workspace.

For more information about debugging and online mode, see the
embedded online help. Select Help > Contents, and search for Phase 5:
Debugging the project in online mode to display the corresponding
content.
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CHAPTER

14 FORCING VARIABLES

Our system and controller support force variables to check the
behavior of the program and to eliminate errors while
commissioning.

TIP: Forcing is only possible while the system is in online mode.

To force variables

1. Click the icon from the toolbar under the IEC Programming
Workspace, and double-click the variable you want to force. The
Debug: eclrRes dialog appears.

2. Enter the desired value for a non-Boolean value or choose TRUE
or FALSE for a Boolean variable.
For the real data type, its value should have at least one digit after
the decimal place. For example, if you want to set the force value
as 50, you should enter 50.0.

3. Click Force to force the variable.
Forced variables are indicated by a colored background in the
variables worksheet in online mode.

To reset forced variables

You can either reset one specific forced variable or all forced
variables.

1. Double-click the variable you want to reset, the Debug: eclrRes
dialog appears.

2. Click Reset force to reset the marked variable or Reset force list to
reset all forced variables at the same time.
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CHAPTER

15 UPLOADING A PROJECT

It is only applicable for ControlEdge 900 controller and Redundant
ControlEdge 2020 controller.

If a project is archived in a controller, you can upload and open this
project in ControlEdge Builder. Alternatively, you can upload and save
it to the PC.

ATTENTION: Only Administrator or Engineer levels can upload a
project.

Prerequisite

The project must be archived as a zip file in the controller. See
"Downloading a project to the controller" on page 239 for more
information.

To upload a project

1. From the Home Page, select More > Upload project from controller.
The Upload Confirmation dialog appears.

2. There are two options:

l Click Open. If a project is already open when you upload this
project, the open project will be saved and closed.
The uploaded project is saved to the following location by
default: C:\Users\Public\Documents\ControlEdge
Builder\ArchivedProjects
Click OK to open the project in ControlEdge Builder.

l Click Save As, and select a location to save this project. Click OK.
The uploaded project is stored in a folder named "Project name_
Date_Time".
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CHAPTER

16 ADMINISTRATION OF THE SYSTEM

Configuring date/time

Setting time source
The section introduces how to synchronize the controller time to the
SNTP server.

For ControlEdge 900 controller, the synchronization is required in
order to ensure robust operation of the embedded OPC UA server.

1. From the Home Page, under Miscellaneous, click Configure
Date/Time Options.

2. Select Enable and enter the IP addresses of SNTP servers in the
Primary Server and Secondary Server fields.
If you select Enable here, under Configure ProtocolsDNP3 Slave, you
should not select Enable DNP3 Time Synchronization in Application
Layer tab at the same time.

3. Adjust the Poll Interval to synchronize current controller time to
the SNTP server.
The SNTP message poll interval is Poll Interval power of 2 (2(Poll
Interval)) in unit of second.
The maximum poll interval is 17 (approx. 36 hours) and the
minimum is 6 (64 seconds).
It is recommended to set Poll Interval as 16 (approx. 18 hours). To
avoid the communication storm, the controller will pick a random
poll interval time in the range [2(Poll Interval), 2(Poll Interval+1)],
not exactly what is configured.
If the NTP server is not available, you can use the function block
(Set_RTC) to configure the controller time. For more information,
see “Set_RTC” in the ControlEdge Builder Function and Function
Block Configuration Reference Guide.

TIP: The recommended poll interval for EFM application is
14.
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Setting time zone

1. Click Configure Date/Time Options under Miscellaneous.

2. Select Set Time Zone tab, and select the target time zone from the
Time Zone drop-down list.

3. Select Automatically Switch to Daylight Saving Time if it is applicable.

User privileges
ControlEdge Builder supports three user types namely Operator,
Engineer and Administrator. Privileges for the various user types are
listed as following:

Table 16-1: Privileges for the various user types

Action Description Operator Engineer Administrator

Change own password Yes Yes Yes

Change other’s password N/A N/A Yes

View system diagnostics Yes Yes Yes

View I/O diagnostics Yes Yes Yes

Reset statistics N/A Yes Yes

Disable synchronization N/A Yes Yes

Enable synchronization N/A Yes Yes

Switchover N/A Yes Yes

Become primary N/A Yes Yes

Upload datalog (upload only) Yes Yes Yes

Upload datalog (upload and delete) N/A Yes Yes

View and control datalog status Yes Yes Yes

Upload bulk datalog Yes Yes Yes

Upload system event log N/A Yes Yes

Download configuration and program N/A Yes Yes

Upload a project N/A Yes Yes

Upgrade firmware N/A N/A Yes
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Action Description Operator Engineer Administrator

Reboot the controller N/A Yes Yes

Reset the connected controller to factory defaults N/A Yes Yes

The default password of each user type is listed as follows:

Table 16-2: Default password of each user type

User Name Password

Operator Oper@123

Engineer Engr@123

Administrator Admin@123

Changing the password
You must connect to the controller to change the password. Each
user (Administrator, Engineer and Operator) must change the default
password after logging in for the first time.

To change a user’s password

1. To change a user’s password, select Change Password under
Miscellaneous. The Change Password dialog appears.

2. Select the target User Name, type in the relevant information in the
Original password, New password and Confirm password fields and
click OK.
The password must have at least one capital letter, one lowercase
letter, one number and one non-alpha numeric character ( E.g.
!@#$%^&;*()) and the length must be minimum eight characters.

Preparing SD card
If you want to use SD card to save datalog or DNP3 event, you must
allocate files for data logging or DNP3 event in SD card.

If a redundant controller is used, you should insert SD cards with the
same type in both primary and secondary CPM. Otherwise, the
datalog or DNP3 event can only be saved in the CPM inserted an SD
card.
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1. Insert an SD card (32GB Class 6 / Class 10 industry standard) into
the computer in which ControlEdge Builder is installed.

2. In the Home Page, click Prepare SD Card under Miscellaneous.

3. In the pop-up window, the available memory of inserted SD card is
displayed in the Selected SD card volume field.

4. Select the suitable SD Card Size to set the memory in which the
datalogs or DNP3 events can be saved. Selected SD card size
cannot exceed the available memory of inserted SD card.

5. Click Start.
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CHAPTER

17 CONTROLLER OPERATION

This section applies to both ControlEdge 900 and 2020 controllers,
including non-redundant and redundant controllers. For operations
unique to redundant controllers, See "Redundant controller
operation" on page 257 for more information.

For related hardware diagnostic indications and actions, see
"Diagnostics and Troubleshooting" in ControlEdge 900 Platform
Hardware Planning and Installation Guide or ControlEdge 2020
Platform Hardware Planning and Installation Guide.

Overview
The operation of the system varies according to the following factors:

n Power transitions: Power off / Power on

Power off transitions are usually planned and controlled, but in
some cases such as power outages, are unintended. To ensure
proper operation in either case, the controller includes software
that controls operation at power restoration. The controller
handles a Power on transition as one of two types: Cold Start or
Warm Start.

n Operating modes: Running, Stopped, Run Locked and Stop Locked

Run Locked and Stop Locked only apply for ControlEdge 900
Controller.
Operating Modes are selected:

l (Only apply to ControlEdge 900 Controller)by positioning the
physical Mode switch on the CPM,

l by selecting parameters on ControlEdge Builder.
In some cases, mode transitions also restart (Cold Start or Warm
Start) controller operation.

n Results of faults: in case of system hardware or software fault, the
controller automatically alters operation as appropriate for the
diagnosed conditions.
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Warm Start

When a warm start is executed:

n Only non-retentive data are initialized.

n All I/O drivers are executed.

n User task which is triggered by System event "Warm start" is called.

n All user tasks are activated (ready to be scheduled and executed).

Cold Start

When a cold start is executed:

n All data are initialized.

n All I/O drivers are executed.

n User task which is triggered by System event "Cold start" is called.

n All user tasks are activated (ready to be scheduled and executed).
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Figure 17-1: Flowchart for the ControlEdge 900 Controller operation
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Figure 17-2: Flowchart for the ControlEdge 2020 Controller operation

256

Chapter 17 - Controller operation



257

Redundant controller operation
This section describes operations specific to redundant CPMs. In a
redundant system, the primary CPM performs all primary tasks
including interfacing with I/O racks, communicating with a local HMI,
exchanging data with other controllers, interfacing with Modbus
devices, and communicating with a Host PC application.

The primary CPM will initiate a switchover due to the CPM failure, that
is, transfer all primary tasks to the secondary CPM, establishing this
CPM as primary. A switchover can also be manually commanded by
using the global variable CNTLR_RDNSWITCHCMD under Redundancy
Local group.

For the operation flowchart, see the two figures above, Flowchart for
the ControlEdge 900 Controller operation or Flowchart for the
ControlEdge 2020 Controller operation.

Start up

n Assignment of primary and secondary status is determined at start
up.

l First available CPM assumes the primary.

l In case of a tie, CPM mounted in the left position of the rack
will be the primary.

l No user configuration or manual operations required to
establish the primary / secondary status.

n Primary CPM assumes control of I/O and all external
communication interfaces.

n Secondary CPM receives the configuration from the primary CPM.

Sync operations

n Primary CPM issues polls to IOMs for inputs.

n The primary CPM reads I/O responses from IOMs, and syncs to
the secondary CPM.

n Primary and secondary both execute function blocks in the
control strategy

n Only the primary CPM writes physical outputs to the IOMs.

n Primary CPM responds to communication messages from host
devices on the control network.
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n Primary and secondary exchange system status data to determine
conditions for switchover.

Primary/Secondary CPM synchronization

n Primary CPM automatically synchronizes the Secondary with the
configuration database.

l After download of a configuration from ControlEdge Builder to
the Primary

l After the operation to bring a secondary CPM from the
Unavailable state to the On-Line state

n Primary CPM automatically synchronizes the Secondary with run-
time data during each execution cycle.

n Both the primary and secondary CPMs execute the application
program in the control strategy, but only the primary CPM writes
the physical outputs to the IOMs.

n The primary and secondary CPMs exchange system status to
determine conditions for switchover.

Switchover

Automatic Switchover

Triggered on any of the following conditions of the primary CPM:

n Loss of communications with IOM(s)

n Processor exception conditions

n Loss of communications to the control network

ATTENTION: During the switchover, analog and digital output
status is maintained at the IOMs.

Manual Switchover

Via Software Command from ControlEdge Builder, or from controller
CPM detail display when integration with Experion, or from the third-
party SCADA/ HMI.
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Redundancy Diagnostic Monitoring

From ControlEdge Buider:

n Redundant System Status – current status of Primary/Secondary
CPM’s

n On-Line Monitoring, CPM Diagnostics

n Redundant Link Status – status of communications between
primary and secondary CPMs

n The primary CPM status

n The secondary CPM status

TIP: Redundancy diagnostics can also be monitored from the
CPM tab of the controller detail display when integration with
Experion, or from the third-party SCADA/HMI. For more
information about monitoring diagnostics from Experion, see
"Monitoring channel and controller communications" in the
Experion Server and Client Configuration Guide. 

Setting operating modes
The operating modes for the CPM are:

n (Only apply to ControlEdge 900 Controller) Stop Locked: All tasks
are inactive and ready to be executed, therefore the I/O channels
hold last value and no output signals are transmitted to the I/Os.

n (Only apply to ControlEdge 900 Controller) Run Locked: CPM
performs all control and communication tasks and on-line
configuration editing and configuration changes are inhibited.

n Running: CPM performs all control and communication tasks and
on-line configuration editing are permitted.

n Stopped: All tasks are inactive and ready to be executed, therefore
the I/O channels hold last value and no output signals are
transmitted to the I/Os.

See the following table as a reference when determining your CPM
operating mode:
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Table 17-1: Operating modes for ControlEdge 900 Controller

Mode Switch
position on
CPM

STOP RUN REMOTE

Operating
mode

Stop Locked Run Locked Running Stopped

Switchover
command

Yes Yes Yes Yes

Enabling sync Yes Yes Yes Yes

Disabling sync Yes Yes Yes Yes

Becoming
primary

Yes Yes Yes Yes

Resetting
statistics

Yes Yes Yes Yes

Configuration
download

Yes No Yes1 Yes

Firmware
download

Yes No Yes2 Yes

Forcing
outputs

Yes3 Yes Yes Yes3

Warm/Cold
reboot

Yes No No Yes

Factory reset Yes No No Yes

Warm/Cold
start command

No N/A N/A Yes

Stop Command N/A No Yes N/A

Note:

1. Two types of configuration download: download changes and download all.
Download all is only available when the system is in Stopped or Stop Locked
operating mode.

2. Only on-process firmware upgrade is allowed in the Running operating mode.

3. When forcing outputs are in the Stopped state, the forced values are pending
until it transits to the Running mode. When forcing outputs are in the Stopped or
Stop Locked operating mode, the forced values are pending until it transits to
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Mode Switch
position on
CPM

STOP RUN REMOTE

the Running or Run Locked operating mode.

To change the operating modes, turn the mode switch on CPM or configure from the
configuration tool when the mode switch is in REMOTE position.

Table 17-2: Operating modes for ControlEdge 2020 Controller

Operating mode Running Stopped

Switchover command Yes Yes

Enabling sync Yes Yes

Disabling sync Yes Yes

Becoming primary Yes Yes

Resetting statistics Yes Yes

Configuration download Yes1 Yes

Firmware download Yes2 Yes

Forcing outputs Yes Yes3

Warm/Cold reboot No Yes

Factory reset No Yes

Warm/Cold start command N/A Yes

Stop Command Yes N/A

Note:

1. Two types of configuration download: download changes and download all.
Download all is only available when the system is in Stopped or Stop Locked
operating mode.

2. Only on-process firmware upgrade is allowed in the Running operating mode.

3. When forcing outputs are in the Stopped state, the forced values are pending
until it transits to the Running mode. When forcing outputs are in the Stopped or
Stop Locked operating mode, the forced values are pending until it transits to
the Running or Run Locked operating mode.
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To change the operating mode

1. From the Home Page, click the Project Control Dialog icon on the
toolbar.

2. Click Warm or Cold to change the operating mode to Running.
Click Stop to change the operating mode to Stopped. About Warm,
Cold and Stop, See "Downloading a project to the controller" on
page 239 for more information.

262

Chapter 17 - Controller operation



CHAPTER

18 MAINTENANCE

Checking firmware versions
To check the CPM firmware version

1. From the Home Page of ControlEdge Builder, click Connect, and
then the Connect controller page appears.

2. All available CPMs in the same network are listed, check the
firmware version.

To check the EPM, IOM firmware version

1. From the Home Page of ControlEdge Builder, click Upgrade
Firmware under Maintenance.

2. Click EPM or I/O module tab, it will show the connected EPM,
IOM Boot Version and Application Version.

Downgrading firmware
For ControlEdge 2020 controller, this section is only applicable for
R110, R140, R150 and R151.
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For ControlEdge 900 controller, it is applicable for any releases.

NOTE: Only one ControlEdge Builder can be installed on one
computer.

Downgrading CPM

Prerequisite

n Install R151 ControlEdge Builder on your computer.

n Get the target CPM firmware package ready.

Procedure

See "Upgrading firmware for a non-redundant controller" on
page 268 for more information.

See "Upgrading firmware for a redundant controller" on page 271 for
more information.

Downgrading I/O modules

Prerequisite

n Use your existing ControlEdge Builder, or install a ControlEdge
Builder that is higher than the CPM version on your computer.

n Get the target IOM firmware package ready.

Procedure

See "Upgrading ControlEdge 2020 Expansion I/O firmware" on
page 283 for more information.

See "Upgrading ControlEdge 900 I/O module firmware" on page 277
for more information.

See "Upgrading serial module firmware" on page 280 for more
information.

Downgrading EPM

Prerequisite

n Make sure that CPM version is same with or higher than EPM
version. If CPM version is lower then EPM's, you must upgrade
CPM first.
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n Install ControlEdge Builder that is same with or higher than the
CPM version on your computer.

n Get the target EPM firmware package ready.

Procedure

See "Upgrading EPM firmware" on page 274 for more information.

Upgrading a system

Upgrading ControlEdge RTU

NOTE: This section only considers upgrading R110, R140, R150
to R151.

Prerequisite

n Install R151 ControlEdge Builder on your computer.

n Get R151 CPM and IOM firmware packages ready.

Procedure

1. Upgrade all IOM firmwares. See "Upgrading ControlEdge 2020
Expansion I/O firmware" on page 283 for more information.

2. Upgrade CPM firmware.
See "Upgrading firmware for a non-redundant controller" on
page 268 for more information.
See "Upgrading firmware for a redundant controller" on page 271
for more information.

3. Upgrade the project. See "Upgrading a project" on the next page
for more information.

4. Compile and download the project to the upgraded controller.

a. See "Compiling a project" on page 237 for more information.

b. See "Downloading a project to the controller" on page 239 for
more information.
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Upgrading ControlEdge PLC

NOTE: This section is applicable for upgrading any releases to
R151.

Prerequisite

n Install R151 ControlEdge Builder on your computer.

n Get R151 CPM, EPM and IOM firmware packages ready.

Procedure

1. Upgrade CPM firmware.
See "Upgrading firmware for a non-redundant controller" on
page 268 for more information.
See "Upgrading firmware for a redundant controller" on page 271
for more information.

2. Upgrade EPM firmwares. See "Upgrading EPM firmware" on
page 274 for more information.

3. Upgrade all IOM firmwares.
See "Upgrading ControlEdge 900 I/O module firmware" on
page 277 for more information.
See "Upgrading serial module firmware" on page 280 for more
information.

4. Upgrade the project. See "Upgrading a project" below for more
information.

5. Compile and download the project to the upgraded controller.

a. See "Compiling a project" on page 237 for more information.

b. See "Downloading a project to the controller" on page 239 for
more information.

Upgrading a project
To use a project of a previous release in ControlEdge Builder, it must
be upgraded first. If you choose not to upgrade the project when
prompted, it will abort the open procedure.

Before upgrading a project, it is recommended to:

n Upload any existing datalog files from the controller because they
will be deleted after the project is upgraded. See "Uploading
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datalog" on page 185 for more information.

n Back up the project. See "Managing a project" on page 21 for
more information.

n Install the latest ControlEdge Builder in your computer. See the
Software Installation User’s Guide for how to install ControlEdge
Builder.

n The controller firmware is upgraded successfully.

ATTENTION: This upgrade process is non-interruptible and
non-reversible. Once the project is upgraded to the new
version, it cannot be opened with a previous release of
ControlEdge Builder.

For ControlEdge 900 controller:

From R140 onwards, a maximum of 16 TCP ports can be configured
for bound protocol communications. If more than 16 TCP ports have
previously been configured, only 16 of them, randomly selected, will
receive data.

To upgrade a project

1. Launch the target ControlEdge Builder and open a project.

2. Select the target version from FW drop-down list. Click Yes to
continue or click No to cancel.

ATTENTION: The upgrade is a non-interruptible and non-
reversible operation, and the DNP3 mapping table
"Experion" will not be available after upgrade. If this table
has been used, it should be renamed before this operation.
And after upgrade, it should be bound to DNP3 slave
protocol again.

3. If TimeUTC and TimeLocal function blocks are used, they should
be replaced. See "Replacing TimeUTC and TimeLocal with
GetRealTimeClock" on page 289 for more information.

4. If the OPC UA function block with Timeout pins is used, the data
type UINT of Timeout should be replaced with Time.

5. Click Rebuild to compile the project.

6. Click Download to load the configuration to the controller.
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NOTE: For ControlEdge 2020 controller, you must click
Project Control Dialog first, and then click Download.

Upgrading firmware
ATTENTION: Do not power off when upgrading firmware.

n If a connected field device or FDAP is OWR300 firmware, the
controller must be upgraded to R140 or later releases.

n If a connected field device is Honeywell OW R300 or Third party
ISA100 2011 device, the controller must be upgraded to R140 or
later releases, and FDAP must be upgraded to OW R300.

n For ControlEdge 2020 controller:

l You can upgrade firmware from R110 to R151, R140 to R151,
R150 to R151 directly. For other versions, please contact with
GTAC.

l Expansion I/O modules must be upgraded before controllers.

n For ControlEdge 900 controller, make sure the CPM version is
same as or higher than the EPM version. In this case:

l No specific upgrade sequence

l Downgrade EPM before CPM

Before upgrading the firmware, it is required to:

n Log in as the Administrator to connect the target controller. See
"Connecting a controller" on page 26 for more information.

n Install the latest ControlEdge Builder on your computer. See the
ControlEdge Builder Software Installation User’s Guide for details.

Upgrading firmware for a non-redundant controller

ATTENTION: It is recommended to upgrade the firmware
without opening a project. Firmware upgrade could cause loss
of control in an operating process.

The firmware upgrade is ONLY allowed in Stop Locked, Running or
Stopped operating modes.
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For ControlEdge 900 controller, you can rotate the mode switch on
CPM to change operating modes, see "CPM mode switch" in
ControlEdge 900 Platform Hardware Planning and Installation Guide.
If the mode switch is in the REMOTE position, See "Setting operating
modes" on page 259 for more information.

To upgrade the firmware

1. From the Start Page, click Connect to connect the target controller.

2. From the Home Page, select Upgrade Firmware under Maintenance,
and select the controller you want to upgrade. See the following
tables for the target controller information.

Parameter Description

Module
Name

The configured controller name

Model
Number

Model number of the connected controller

State
l Running: The program execution is activated

and the inputs and outputs of the I/O image
are updating according to the I/O
configuration.

l Stopped: A program is loaded in the
controller but all user tasks are inactive,
therefore the I/O images are not updated
and no output signals are being transmitted
to the I/O.

l On: No program is loaded in the controller.

l FW Upgrading: Controller is in firmware
upgrade process.

l Not Available: It is failed to detect the
controller in an expected time after firmware
upgrade is started.

Redundancy
Role

l Non-Redundant: Indicates a non-redundant
controller system.

l Primary: Indicates a redundant controller
system and the primary controller is
connected.

l Secondary: (apply to ControlEdge 900
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Parameter Description

Controller) Indicates a redundant controller
system and the secondary controller is
connected.

Rack Address Address of the rack in which the controller is
installed

Slot Number The position of the slot on which the controller is
installed:

l A

l B (only apply to a redundant controller)

HW Version (apply to ControlEdge 900 Controller) Controller
hardware version

HW-Kernal
Version

(apply to ControlEdge 2020 Controller) The
version of the Kernal board

HW-
Application
Version

(apply to ControlEdge 2020 Controller) The
version of the App board

Boot

Version1

(apply to ControlEdge 900 Controller and the
redundant ControlEdge 2020 Controller) Boot
firmware version

The controller runs the boot firmware if the
application firmware is not available or corrupt.
The boot version has a colored icon to
differentiate it from application firmware version.

Application
Version1

Application firmware version

User configuration settings can only be
downloaded if the controller is running
application firmware.

Transferred
Version

The version of the firmware image which has been
transferred to the controller. The version has a
colored icon.

l : Indicates the transferred image is the
boot firmware image

l : Indicates the transferred image is the
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Parameter Description

application firmware image

The transferred firmware image will be deleted
from the controller after reboot.

Note1: If either of the Boot firmware or Application firmware is
invalid, only the invalid one can be upgraded.

3. Click Upgrade. The Upgrade firmware dialog appears.
The controller is keeping running when you transfer the firmware
to the controller, and will be stopped when you upgrade the
firmware. So when the controller is running, we provide the
interactive mode to control when the controller stops.

l If you select the Interactive mode, a dialog appears confirming
that the transfer is complete. Click Next to upgrade the firmware,
and the controller is stopped. You can also click Cancel to quit
the upgrade process.

l If you do not select the Interactive mode , the firmware will be
upgraded directly after the transfer. The controller will be
stopped without any prompt.

4. Click Proceed with Upgrade to continue.

5. From the Release Number list, select the target release module. The
target firmware version is displayed.

6. Click Next, the target firmware name, state and version are
displayed.

7. Click Next to transfer and upgrade the firmware.

8. After the boot firmware is upgraded, enter the password to re-
connect the controller. The application firmware is transferred and
upgraded.

9. After the application has been upgraded, enter the password to re-
connect the controller.

10. Click OK to complete the firmware upgrade.

Upgrading firmware for a redundant controller

ATTENTION: It is recommended to upgrade the firmware
without opening a project.
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There are two procedures for the firmware upgrade of an redundant
controller.

n On-process: The primary CPM is synced with the secondary CPM.

ATTENTION: On-process is ONLY applicable for upgrading
R150 to later release firmwares.

n Off-process: The primary CPM is not synced with the secondary
CPM.
For ControlEdge 900 Controller, it is ONLY allowed in Stopped,
Running or Stop Locked operating mode.
You can rotate the mode switch on CPM to change the operating
mode, see "CPM mode switch" in ControlEdge 900 Platform
Hardware Planning and Installation Guide. If the mode switch is in
the REMOTE position, See "Setting operating modes" on page 259
for more information.

Prerequisites

n Assume the primary CPM is at slot A and the secondary CPM is at
slot B.

n Both primary (slot A) and secondary (slot B) CPMs are powered
on.

To upgrade the firmware with On-process procedure

ATTENTION: For ControlEdge 2020 controller, on-process
procedure is ONLY applicable for a standalone redundant
controller without EFM configured and IOM connected.

1. From the Start Page, click Connect to connect the target primary
CPM (slot A).

2. From the Home Page, select Upgrade Firmware under Maintenance,
and select the CPM you want to upgrade.

3. Click Upgrade. The Upgrade firmware dialog appears.

4. From the Release Number list, select the target release module. The
target firmware version is displayed.

5. Click Next, the target firmware name, state, and version are
displayed.

6. Click Next to transfer and upgrade the firmware.

7. After the boot and application firmware is upgraded, enter the
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password to re-connect the controller.

8. Click Go Back to revert to the previous firmware version, or click
Proceed to complete the upgrade.

9. The primary CPM is synchronizing with the secondary CPM. Click
OK to complete the firmware upgrade.
The secondary CPM (slot B) becomes the primary one and the
original primary CPM (slot A) becomes the secondary one.

To upgrade the firmware with Off-process procedure

ATTENTION: This procedure could cause loss of control in an
operating process.

ATTENTION: For ControlEdge 2020 controller, if the controller
is connected with I/O modules, you must stop the program
before performing the off-process procedure.

1. From the Start Page, click Connect to connect the target primary
CPM (slot A).

2. From the Home Page, select Upgrade Firmware under Maintenance,
and select the CPM you want to upgrade.

3. Click Upgrade. The Upgrade firmware dialog appears.
The controller is keeping running when you transfer the firmware
to the controller, and will be stopped when you upgrade the
firmware. So when the controller is running, we provide the
interactive mode to control when the controller stops.

l If you select the Interactive mode, a dialog appears confirming
that the transfer is complete. Click Next to upgrade the firmware,
and the controller is stopped. You can also click Cancel to quit
the upgrade process.

l If you do not select the Interactive mode , the firmware will be
upgraded directly after the transfer. The controller will be
stopped without any prompt.

4. Click Proceed with Upgrade to continue.

5. From the Release Number list, select the target release module. The
target firmware version is displayed.

6. Click Next. The target firmware name, state and version are
displayed.
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7. Click Next to transfer and upgrade the firmware.

8. After the boot firmware is upgraded, enter the password to re-
connect the controller. The application firmware is transferred and
upgraded.

9. After the application has been upgraded, enter the password to re-
connect the controller.

10. The firmware upgrades.

11. Perform the relevant procedures for ControlEdge 2020 controller
and ControlEdge 900 controller.

l For ControlEdge 2020 controller:

a. Click OK. The primary CPM synchronizes the firmware with the
secondary CPM, and upgrades the firmware of the secondary
CPM automatically.

b. To check whether the secondary CPM upgrade is complete,
click Connect from the Home Page and check that the
Firmware version is the same as the primary CPM.

l For ControlEdge 900 controller:

l Upgrading the previous release to R150

a. Connect to the secondary CPM (slot B).

b. Repeat Step 1 to Step 10 to upgrade the firmware on the
secondary CPM.

l Upgrading R150 to the later release

a. Click OK. The primary CPM synchronizes the firmware with
the secondary CPM, and upgrades the firmware of the
secondary CPM automatically.

b. To check whether the secondary CPM upgrade is
complete, click Connect from the Home Page and check
that the Firmware version is the same as the primary CPM.

Upgrading EPM firmware
EPM firmware upgrade is ONLY allowed in Stop Locked, Running or
Stopped operating modes.

You can rotate the mode switch on CPM to change operating modes,
see "CPM mode switch" in ControlEdge 900 Platform Hardware
Planning and Installation Guide. If the mode switch is in REMOTE
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position, See "Setting operating modes" on page 259 for more
information.

ATTENTION: If the EPM is being upgraded, all I/O modules in
the same rack will keep in failsafe state until the firmware
upgrade is completed.

Prerequisites

For a redundant system with ring topology, you must disable the
synchronization first.

To upgrade EPM

1. From the Start Page, click Connect to connect the target controller.

2. From the Home Page, select Upgrade Firmware under Maintenance,
The Upgrade Firmware dialog appears.

3. Click EPM tab, all available EPMs are displayed with the following
information.
At least one I/O module, which is in the same rack with the target
EPM, must be added in the Configure I/O page, then the target
EPM will be displayed here. See "Configuring modules and
channels" on page 65 for more information.

Parameter Description

Module Name The configured EPM module type

Model
Number

Model number of EPM

States
l OK: EPM is working normally.

l Error: Error exists in EPM.

l Not Configured: Indicates the detected EPM
is not configured.

l FW Upgrading: Indicates EPM is in firmware
upgrade process.

l Offline: It is failed to detect the EPM in an
expected time after firmware upgrade is
started.

Redundancy
Role

l Non-Redundant: Indicates a non-redundant
EPM.
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Parameter Description

l Active: Indicates the EPM is active in dual
EPMs application.

Rack Address Rack address configured from 1x and 10x rotary
switches on EPM hardware, ranging from 1 to 99.

Slot Number The position of the slot on which EPM is
installed.

l A

l B (only applicable for a redundant EPMs)

HW Version EPM hardware version

Boot
Version1

Boot firmware version

EPM runs the boot firmware if the application
firmware is not available or corrupt. The boot
version has a colored icon to differentiate it from
application firmware version.

Application
Version1

Application firmware version

User configuration settings can only be
downloaded if the EPM is running application
firmware.

Transferred
Version

The version of the firmware image which has
been transferred to the target module. The
version has a colored icon.

l : Indicates the transferred image is the
boot firmware image

l : Indicates the transferred image is the
application firmware image

The transferred firmware image will be deleted
after reboot.

Note1: If either of the Boot firmware or Application firmware is
invalid, only the invalid one can be upgraded.

4. Select or multiselect the target EPMs and click Upgrade. The
Upgrade firmware dialog appears.
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The controller is keeping running when you transfer the firmware
to the controller, and will be stopped when you upgrade the
firmware. So when the controller is running, we provide the
interactive mode to control when the controller stops.

l If you select the Interactive mode, a dialog appears confirming
that the transfer is complete. Click Next to upgrade the firmware,
and the controller is stopped. You can also click Cancel to quit
the upgrade process.

l If you do not select the Interactive mode , the firmware will be
upgraded directly after the transfer. The controller will be
stopped without any prompt.

5. Click Proceed with Upgrade to continue.

6. From the Release Number list, elect the target release module. The
target firmware version is displayed.

7. Click Next. The target firmware name, state and version are
displayed.

8. Click Next to transfer and upgrade the fireware.

9. After the upgrade is completed, a dialog appears. You can check
which EPM is upgraded successfully, which one is failed.

10. Click OK.

Upgrading ControlEdge 900 I/O module firmware
I/O module firmware upgrade is ONLY allowed in Stop Locked, Running
or Stopped operating modes.

ATTENTION: The target I/O module must be added in the
Configure I/O page. See "Configuring modules and channels"
on page 65 for more information.

To upgrade I/O modules

1. From the Start Page, click Connect to connect the target controller.

2. From the Home Page, select Upgrade Firmware under Maintenance,
The Upgrade Firmware dialog appears.

3. Click the UIO 16 tab, all available I/O modules are displayed with
the following information.

Chapter 18 - Maintenance



Parameter Description

Module Name The configured I/O module type

Model Number Model number of the I/O module

States
l OK: The module is working

normally.

l Error: Error exists in the module.

l Not Configured: Indicates the
detected module is not
configured.

l Offline: It is failed to detect the
module in an expected time
within which upgrade process is
expected to be completed.

Redundancy Role N/A: Not applicable to I/O module.

Rack Address Rack address, 0 or ranging from 1 to
99

l If the I/O module is mounted in
the local I/O rack, the rack
address is 0.

l If the I/O module is mounted in
the expansion I/O rack, the rack
address is ranging from 1 to 99.

Slot Number The position of the slot on which the
I/O module is mounted, ranging from
1 to 12.

l If the I/O module is mounted in
the 4-slot rack, the slot number
is ranging from 1 to 4.

l If the I/O module is mounted in
the 8-slot rack, the slot number
is ranging from 1 to 8.

l If the I/O module is mounted in
the 12-slot rack, the slot number
is ranging from 1 to 12.
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Parameter Description

HW Version I/O module hardware version

Boot Version
1 Boot firmware version

The I/O module runs the boot firmware
if the application firmware is not
available or corrupt. The boot version
has a colored icon to differentiate it
from application firmware version.

Application Version
1 Application firmware version

User configuration settings can only
be downloaded if the I/O module is
running application firmware.

Transferred Version The version of the firmware image
which has been transferred to the
target module. The version has a
colored icon.

l : Indicates the transferred
image is the boot firmware image

l : Indicates the transferred
image is the application firmware
image

The transferred firmware image will be
deleted after reboot.

Note1: If either of the Boot firmware or Application firmware is
invalid, only the invalid one can be upgraded.

4. Select or multiselect the target I/O modules and click Upgrade. The
Upgrade firmware dialog appears.
The controller is keeping running when you transfer the firmware
to the controller, and will be stopped when you upgrade the
firmware. So when the controller is running, we provide the
interactive mode to control when the controller stops.

l If you select the Interactive mode, a dialog appears confirming
that the transfer is complete. Click Next to upgrade the firmware,
and the controller is stopped. You can also click Cancel to quit
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the upgrade process.

l If you do not select the Interactive mode , the firmware will be
upgraded directly after the transfer. The controller will be
stopped without any prompt.

5. Click Proceed with Upgrade to continue.

6. From the Release Number list, select the target release module. The
target firmware version is displayed.

7. Click Next, the target firmware name, state and version are
displayed.

8. Click Next to transfer and upgrade the firmware.

9. After the upgrade is completed, a dialog appears. You can check
which module is upgraded successfully, which one is failed.

10. Click OK.

Upgrading serial module firmware
Serial module firmware upgrade is ONLY allowed in Stop Locked,
Running or Stopped operating modes.

ATTENTION: The target serial module must be added in the
Configure Serial Modules page. See "Configuring serial
modules" on page 104 for more information.

To upgrade serial modules

1. From the Start Page, click Connect to connect the target controller.

2. From the Home Page, select Upgrade Firmware under Maintenance,
The Upgrade Firmware dialog appears.

3. Click the Serial Comm tab, all available serial modules are displayed
with the following information.

Parameter Description

Module Name The configured serial module type

Model Number Model number of the serial module

States
l OK: The module is working

normally.

l Error: Error exists in the module.
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Parameter Description

l Not Configured: Indicates the
detected module is not
configured.

l Offline: It is failed to detect the
module in an expected time
within which upgrade process is
expected to be completed.

Rack Address Rack address, 0 or ranging from 1 to
99

l If the serial module is mounted
in the local I/O rack, the rack
address is 0.

l If the serial module is mounted
in the expansion I/O rack, the
rack address is ranging from 1 to
99.

Slot Number The position of the slot on which the
serial module is mounted, ranging
from 1 to 12.

l If the serial module is mounted
in the 4-slot rack, the slot
number is ranging from 1 to 4.

l If the serial module is mounted
in the 8-slot rack, the slot
number is ranging from 1 to 8.

l If the serial module is mounted
in the 12-slot rack, the slot
number is ranging from 1 to 12.

HW Version Serial module hardware version

Boot Version
1 Boot firmware version

The serial module runs the boot
firmware if the application firmware is
not available or corrupt. The boot
version has a colored icon to
differentiate it from application
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Parameter Description

firmware version.

Application Version
1 Application firmware version

User configuration settings can only
be downloaded if the serial module is
running application firmware.

Transferred Version The version of the firmware image
which has been transferred to the
target module. The version has a
colored icon.

l : Indicates the transferred
image is the boot firmware image

l : Indicates the transferred
image is the application firmware
image

The transferred firmware image will be
deleted after reboot.

Note1: If either of the Boot firmware or Application firmware is
invalid, only the invalid one can be upgraded.

4. Select or multiselect the target serial modules and click Upgrade.
The Upgrade firmware dialog appears.
The controller is keeping running when you transfer the firmware
to the controller, and will be stopped when you upgrade the
firmware. So when the controller is running, we provide the
interactive mode to control when the controller stops.

l If you select the Interactive mode, a dialog appears confirming
that the transfer is complete. Click Next to upgrade the firmware,
and the controller is stopped. You can also click Cancel to quit
the upgrade process.

l If you do not select the Interactive mode , the firmware will be
upgraded directly after the transfer. The controller will be
stopped without any prompt.

5. Click Proceed with Upgrade to continue.

6. From the Release Number list, select the target release module. The
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target firmware version is displayed.

7. Click Next, the target firmware name, state and version are
displayed.

8. Click Next to transfer and upgrade the firmware.

9. After the upgrade is completed, a dialog appears. You can check
which module is upgraded successfully, which one is failed.

10. Click OK.

Upgrading ControlEdge 2020 Expansion I/O
firmware

ATTENTION: It is recommended to upgrade the firmware
without opening a project. Expansion I/O modules must be
upgraded before controllers.

1. From the Start Page, click Connect to connect the target controller.

2. From the Home Page, select Upgrade Firmware under Maintenance,
The Upgrade Firmware dialog appears.

3. Click Expansion I/O tab, all available expansion I/Os are displayed
with the following information.

Parameter Description

Module
Name

Expansion I/O module name

IOM
Address

The address of the expansion I/O module, ranging
from 1 to 99.

HW
Version

Expansion I/O module hardware version

Application
Version

Application firmware version

User configuration settings can only be downloaded
if the expansion I/O is running application firmware.

Transferred
Version

The version of the firmware image which has been
transferred to the target module. The version has a

colored icon , indicating the transferred image is
the application firmware image.
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Parameter Description

The transferred firmware image will be deleted after
reboot.

4. Select or multiselect the target Expansion I/O modules and click
Upgrade. The Upgrade firmware dialog appears.
The controller is keeping running when you transfer the firmware
to the controller, and will be stopped when you upgrade the
firmware. So when the controller is running, we provide the
interactive mode to control when the controller stops.

l If you select the Interactive mode, a dialog appears confirming
that the transfer is complete. Click Next to upgrade the firmware,
and the controller is stopped. You can also click Cancel to quit
the upgrade process.

l If you do not select the Interactive mode , the firmware will be
upgraded directly after the transfer. The controller will be
stopped without any prompt.

5. Click Proceed with Upgrade to continue.

6. From the Release Number list, elect the target release module. The
target firmware version is displayed.

7. Click Next. The target firmware name, state and version are
displayed.

8. Click Next to transfer and upgrade the fireware.

9. After the upgrade is completed, a dialog appears. You can check
which Expansion I/O is upgraded successfully, which one is failed.

10. Click OK.

Upgrading the FDAP and field device firmware
via Wireless

The FDAPs and field devices have radio firmware that can be
upgraded. Some field devices may have a separate application
firmware, which handles the functioning of the sensor in the device.
This can also be upgraded over the wireless network. For more
information about upgrading the firmware of field devices, refer to
the field device vendor’s documentation. Honeywell field devices
usually have separate firmware files for radio firmware and
application firmware. FDAPs have only radio firmware.
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ATTENTION: If either of the field device and FDAP is upgraded
to OW R300, the other one should be upgraded too.

Upgrading the field device firmware
The devices at the farthest hop level must be upgraded first.

To upgrade a field device firmware

1. On the Selection Panel, select the field device. You can select
multiple devices of the same type using the Selection Panel. Click
and hold SHIFT key on the keyboard and select multiple items in a
successive list. Click and hold CTRL key on the keyboard and
select multiple items not in succession.

TIP: It is recommended to select and accept up to three
devices at a time.

2. Click one of the following icons as required in the Upgrade group
from the Ribbon Bar. Application firmware must be upgraded
before upgrading the radio firmware.

l Application: To upgrade the application firmware of the selected
field device.

l Radio: To upgrade the radio firmware of the selected field
device.

The Application/Radio Firmware Upgrade dialog box appears.

3. Depending on the firmware type, the available upgrade files
appear by default. Select the required file from the list of upgrade
files. If the file is not available in the list, perform the following
steps.

a. Click Add to browse to the directory location of the firmware
upgrade file.

b. Select the target firmware upgrade file, and click Open.

4. Click Upgrade. The Application/Radio Firmware Upgrade dialog box
closes. The Firmware Upgrade Status dialog box displaying the
status of the upgrade appears. Closing the dialog box allows the
upgrade operation to run in the background.
Once the upgrade is complete, the status column displays the
status as complete. If firmware upgrade fails for a device, you can
abort the upgrade and start again. To abort firmware upgrade for
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individual devices, click the abort button next to the status
indicator.
See the following tips for other operations:

l To abort any firmware upgrade operation, click the Abort
Upgrade icon besides the upgrade status.

l To remove the devices whose firmware was upgraded
successfully, click the Clear Upgrade icon besides the upgrade
status.

l The field device will be rebooted after the field device radio
firmware upgraded successfully.

5. Close the Firmware Upgrade Status dialog box.

6. Verify the upgraded version of the field device firmware as follows:

a. On the Selection Panel, select the field device.

b. On the Property Panel, expand Device Manager Summary.

c. Under Identification, check Revision.

Upgrading the FDAP firmware

1. On the Selection Panel, select the target FDAP. You can select
multiple devices of the same type using the Selection Panel. Click
and hold SHIFT key on the keyboard and select multiple items in a
successive list. Click and hold CTRL key on the keyboard and
select multiple items not in succession.

2. Click Radio in the Upgrade group from the Ribbon Bar. The Radio
Firmware Upgrade dialog box appears.

3. In the Available Firmware Files list, select the required firmware
upgrade file. The firmware upgrade file should appear in the list by
default. If the file is not available in the list, perform the following
steps to open the firmware file.

a. Click Add to browse to the directory location of the firmware
upgrade file.

b. Select the target firmware upgrade file, and click Open.
Firmware files are stored in volatile memory due to memory
limitations in the controller. Hence these files will be removed on
power cycle.

4. Click Upgrade. The Firmware Upgrade Status dialog box appears. The
Progress column displays the progress of the upgrade.
See the following tips for other operations:
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l To abort any firmware upgrade operation, click the Abort
Upgrade icon besides the upgrade status.

l To remove the devices whose firmware was upgraded
successfully, click the Clear Upgrade icon besides the upgrade
status.

l The field device will be rebooted after the field device radio
firmware upgraded successfully.

5. Close the Firmware Upgrade Status dialog box.

6. Verify the upgraded version of the FDAP firmware as follows:

a. On the Selection Panel, select the FDAP.

b. On the Property Panel, expand Device Manager Summary.

c. Under Identification, check Revision.

Rebooting a controller
You can use ControlEdge Builder to remotely reboot a controller.

n Before rebooting the controller, you must log in as the
Administrator or Engineer to connect the target controller.

n Controller reboot is only allowed in Stopped or Stop Locked
operating mode.

To remotely reboot the controller

1. Click Reboot Controller under Maintenance. In the pop-up window,
select Warm Reboot or Cold Reboot and click Reboot. See the
following table for details on the effect of warm reboot and cold
reboot:

Items Warm Reboot Cold Reboot

Program Program is stopped and
then given a Warm start;
Only non-retentive are
initialized.

Program is stopped
and then given a Cold
start; All variables are
initialized.

I/O AO/DO goes to Fail Safe
Output Mode setting.

AO/DO goes to Fail
Safe Output Mode
setting.

DNP3 DNP3 event buffer is
retained.

DNP3 event buffer is
cleared.
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Items Warm Reboot Cold Reboot

Datalogging No impact.  No impact.

HART Online HART device list is
cleared.

Online HART device list
is cleared.

Firmware
Upgrade

Transferred firmware is
cleared.

Transferred firmware is
cleared.

2. A warning message prompts the user that ControlEdge Builder
will disconnect with the controller during the reboot. Click Yes to
continue.

3. In the pop-up message which prompts the user to check the
reboot result after 30 seconds, click OK.

Resetting to factory defaults
The controller can be reset to factory settings in the following two
ways:

n Reset Connected Controller Directly.

n Reset via SD Card.

ATTENTION: Factory reset is only allowed in Stopped or Stop
Locked operating mode.

Resetting a connected controller directly
Before resetting a controller, you must log in as the Administrator or
Engineer to connect the target controller.

For a redundant controller, you should connect the primary CPM. This
option will reset both the primary and secondary CPMs.

1. From the Home Page, under Maintenance, click Reset to Factory
Defaults > Reset Connected Controller Directly.

2. A warning message prompts you that the controller will be reset to
the default factory settings and all configurations in the controller
will be lost. During the reset, the controller will be rebooted
automatically and disconnected. Click OK to continue.

3. A pop-up message prompts you to check the reset status after 180
seconds. Click OK.
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Resetting via SD card

1. Insert SD card into the computer in which ControlEdge Builder is
installed.

2. From the Home Page, under Maintenance, click Reset to Factory
Defaults > Reset via SD Card.

3. Enter the Serial Number of the target controller in the pop-up
window, and click Save. The serial number can be found on the
label of the controller. Or click Platform under View Diagnostic to
find the Platform.SerialNumber.

4. In the pop-up window, select the root directory of SD card to save
the resetfile.rst file.
Do not rename the factory reset file.

5. Do the following steps to reset the non-redundant or redundant
controller.

l To reset the non-redundant controller:

a. Power off the controller and insert the SD card.

b. Power on the controller. The default factory settings are
applied.

l To reset the redundant controller:

a. Pull out the secondary CPM.

b. Power off the primary CPM and insert the SD card.

c. Power on the primary CPM. The default factory settings are
applied.

d. Re-insert the secondary CPM. The primary CPM
synchronizes the default factory settings to the secondary
CPM, which then reboots.

Replacing TimeUTC and TimeLocal with
GetRealTimeClock

This only applies to ControlEdge 2020 controller.

Starting with R120, TimeUTC and TimeLocal function blocks are
replaced with GetRealTimeClock function block.

For more information about the relevant function blocks, see the
ControlEdge Builder Function and Function Block Configuration Reference
Guide.
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Let us use TimeUTC as an example, with variables SEC, MIN, HOUR,
DAY, MON, YEAR, WDAY, YDAY connected to the outputs of TimeUTC
function block.

To replace TimeUTC with GetRealTimeClock

1. Once the project is upgraded, the TimeUTC function block is
highlighted as yellow indicating it is invalid.

2. Delete the function block but keep the input and output variables
unchanged.

3. Double-click the variable worksheet . Delete TimeUTC and YDAY
variables.

4. Click the Type field and change the type as USINT for the outputs
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variables of TimeUTC function block.

5. Double-click POU . Drag and drop GetRealTimeClock from
function library utilitylib in the Edit Wizard window to this POU. Re-
map the input and output variables to the pins accordingly.

6. Double-click the pin-out of the new input ENABLE and add a new
variable or a constant value.

l Add a new variable: Enter a Name and select the Data Type as
BOOL. Click OK.

l Add the constant value: Enter the Name as True, and then click
OK
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7. Save and close the POU.
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CHAPTER

19 DIAGNOSTICS

User can view diagnostics of System, I/O and EtherNet/IP Device from
ControlEdge Builder. The System Event Log and the Dump File can also
be uploaded from the controller.

Viewing diagnostics
You can log in as the Administrator, Engineer or Operator to connect
the target controller and view diagnostics information of System, I/O
and EtherNet/IP Device.

1. Click View Diagnostics under Diagnostics. The diagnostics page
appears.

2. You can view diagnostics information of System, I/O and
EtherNet/IP Device. Click down arrow on the right of the target tab
to expand the group.

The System group includes Platform, Redundancy, Modbus Slave,
Modbus Master, HART Server, EtherNet/IP Server, DNP3 Slave,
OnlineDiagnostic and Wireless information.

The I/O group includes all I/O modules diagnostics.

The EtherNet/IP Device group includes all EtherNet/IP devices
diagnostics.

NOTE: If the description of an item is too long to display
completely, you can hold the mouse cursor over the
description to show the full description.

Viewing system diagnostics
You can log in as the Administrator, Engineer or Operator to connect
the target controller and view basic diagnostics information.

1. Click View Diagnostics under Diagnostics. The diagnostics page
appears.

2. Auto-refresh is selected by default, you can set a refresh rate to
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update diagnostics regularly. You can also click Auto-refresh to
close it, and click Refresh to update diagnostics manually.

3. You can click Reset Statistics to reset statistic values to the default
values.

4. Click System, the controller diagnostics appears at the right page
including Controller Name, CPM Status, CPU Free, Memory Free, I/O
Network Topology, Current Controller Time and Enclosure Temperature.

5. Click the down arrow on the right of the System tab to expand the
group. This group includes Platform, Redundancy, Modbus Slave,
Modbus Master, HART-IP Server, EtherNet/IP Server, DNP3 Slave,
OnlineDiagnostic and Wireless information.

6. Click Redundancy, the general information for redundancy appears.
There are three options to be selected. These options are only
allowed for Engineer or Administrator.

Name Description

Disable
Synchronization

It is available only for the synchronization was
enabled.

Disable synchronization between the primary
controller and the secondary controller.

Enable
Synchronization

It is available only for the synchronization was
disabled.

Enable synchronization between the primary
controller and the secondary controller.

Switchover Exchange the roles of the primary and
secondary controllers. After that, ControlEdge
Builder and the controller will be disconnected.
The previous primary controller will reboot.

NOTE: For ControlEdge 2020 controller,
after the controller switchover, IOM LED
flashes on Yellow for 1~2 seconds. .The
I/O communication is without impact.

Become
Primary

When the primary controller is disconnected,
first connect the secondary controller and click
this option to set it to be the primary one.
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7. Click the down arrow on the right of the Redundancy tab to expand
the group. This group includes Local Status, Local History, Partner
Status and Partner History information.

8. Click Wireless, the following diagnostics appears.

Name Description

ISA100
Network ID

It is the unique identifier for the network. It must
contain a value between 2 (default) and 65535.

Over the Air
Provisioning

Over-the-air provisioning for ISA100 network.
Devices in the OneWireless network can be
provisioned using the over-the-air provisioning
method. The controller provisions the access
points and the access points that are enabled to
function as provisioning devices can provision the
field devices/line-powered FDAPs.

Maximum
Route
Depth

It specifies maximum number of hops between the
controller and a field device over ISA100 network.
Hops are defined as the number of routing devices
through which the data must pass to reach its
destination. By default, this parameter is set to four.

Default
Routing
Policy

It defines the routing behavior of a field device that
is capable of operating as a router as well as an I/O
device, after it joins the network.

l Routing Enabled = 0

Enables all the routing field devices to
function as a router and an I/O device.

l Routing Enabled, Line Powered Only = 1

Enables all the line-powered routing field
devices to function as a router and an I/O
device. In this case, the battery powered
routing field devices function only as I/O
devices.

l Routing Disabled = 2

Disables the ability of the routing field
devices to function as routers. The field
devices with routing capability can function
only as I/O devices.
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Name Description

Default Join
Policy

It specifies the system-wide join policy for the
routing devices (FDAP routers and routing field
devices). The system – wide join policy can be
overridden by the join policy of the device.

By default, the join policy for the devices is
configured as Join Enabled.

l Join Enabled = 0

Enables the devices to join the network through
FDAP routers and routing field devices.

l Join Enabled, Line Powered Only = 1

Enables the devices to join the network only
through FDAP routers.

Link Quality
Threshold

It is equivalent to the RSQI value between the
devices. The link between the devices is established
only if RSQI is equal to or greater than the Link
Quality Threshold limit. By default, Link Quality
Threshold is set to 127.

Link
Strength
Threshold

Minimum link strength (RSSI) to be considered as a
neighbor.

Transmit
Count

Number of messages transmitted from the
controller to a field device sensor.

Receive
Count

Number of messages received from a field device
sensor to the controller.

Timeout
Count

Number of timeouts between the controller and a
field device sensor.

Transmit
Rate

Number of messages per second transmitted from
the controller to a field device sensor.

Receive
Rate

Number of messages received per second from a
field device sensor to the controller.

Timeout
Rate

Number of timeouts per second between the
controller and a field device sensor.

Transmit
Rate Max

High water mark of messages per second
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Name Description

transmitted from the controller to a field device
sensor.

Receive
Rate Max

High water mark of messages received per second
from a field device sensor to the controller.

Timeout
Rate Max

High water mark of timeouts per second between
the controller and a field device sensor.

Viewing I/O diagnostics
For error codes, See "Error code reference" on page 321 for more
information.

You can log in as the Administrator, Engineer or Operator to connect
the target controller and view I/O diagnostics.

1. From the Home Page, click View Diagnostics under Diagnostics. The
diagnostics page appears.

2. Click the down arrow on the right of the I/O tab to view
diagnostics of I/O modules.

l For ControlEdge 2020 controller

a. The expansion I/O modules list is expanded. On the right
panel, the overview of the modules which are running in the
controller appears in Diagnostic tab.
See the following table for the configuration parameters:

Parameter Description

Module
Address

The assigned module address from the I/O
configuration in the running controller.

Module
Type

The type of the I/O module.

Status Status of I/O module:

l OK: No module level error exits and all the
channels of the module are running
without error.

l Error: Module level error exists, or a
module channel is with an error.
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Parameter Description

l Offline: Configured module is not
detected.

Auto-refresh is selected by default, you can set a refresh rate
to update diagnostics regularly. You can also click Auto-
refresh to close it, and click Refresh to update diagnostics
manually.

You can click Reset Statistics to reset statistic values to the
default values.

b. Click Communication tab, you can check the following
parameters.

Parameter Description

Module Address The assigned module address
from the I/O configuration in the
running controller.

CPM Write Request Write request count sent from
CPM to IOM

IOM Received Write
Request

Write request count that IOM
receives from CPM

CPM Read Request Read request count sent from
CPM to IOM

IOM Received Read
Request

Reda request count that IOM
receives from CPM

IOM Response for Read
Request

Response sent from IOM to CPM
for read request

CPM Received Response
for Read Request

Response received from IOM for
read request

c. Click IOM Offline tab, you can check the following
parameters.

Parameter Description

Module Address The assigned module address from
the I/O configuration in the running
controller and populates these

298

Chapter 19 - Diagnostics



299

Parameter Description

addresses here.

Times Offline Since
Reset

The offline count of an IOM since
the latest statistics reset

Reason for IOM
Offline

The reason for IOM offline

CPM Disconnects
Since Reset

The count that IOM loses
connection with CPM since the
latest statistics reset

Reason for CPM
Disconnection

The reason for IOM lost connection
with CPM

d. Click IOM Failsafe tab, you can check the following
parameters.

Parameter Description

Module Address The assigned module address
from the I/O configuration in the
running controller.

Times Failsafe Since
Reset

The failsafe count of an IOM
since the latest statistics reset

Reason for IOM Failsafe The reason for IOM failsafe

e. Click Others tab, you can check the following parameters.

Parameter Description

Controller Drop-sync
COUNT caused by IOM

The count of controller drop-sync
caused by IOM

Controller Switchover
count caused by IOM

The count of controller switchover
caused by IOM

IOM Failsafe count
caused by controller

The count of IOM failsafe caused
by controller

f. Click a module in the module List to view the following
information.
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Parameter Description

Module
Number

Module number of I/O module

Hardware
Version

Hardware version of I/O module

Firmware
Version

Firmware version of I/O module

Status Status of I/O module:

l OK: No module level error exits and all
the channels of the module are running
without error.

l Error: Module level error exists, or a
module channel is with an error.

Hold the mouse cursor over the shown
error code of a faulty I/O module to see
a description of the error.

l Offline: Configured module is not
detected.

Channel Defined channel of the assigned module type

Status Status of channel:

l OK

l Error

Hold the mouse cursor over the shown
error code of a faulty channel to see a
description of the error.

The channel status will not be displayed if the
type of the physically installed module does
not match the configured one.

The channel status cannot reflect signal
status, such as OverRangeHighExtended (11),
OverRangeHigh (12), OverRangeLow (13) and
OverRangeLowExtended (14).

Description Description of the channel

l For ControlEdge 900 controller

300

Chapter 19 - Diagnostics



301

a. The rack list is expanded, and the overview of the racks
which are running in the controller appears on the right
panel.
See the following table for the configuration parameters:

Parameter Description

Rack
Address

The assigned Rack Address number from the
I/O configuration in the running controller and
populates these addresses in Rack Overview
table.

Rack Type Based on the Rack Address, the system detects
physically installed racks with specific
addresses and populates them along with their
respective types and working status in the Rack
overview table.

Status Status of rack:

l OK: All the modules installed on the rack
are running without error.

l Error: Error exists in one or more of the
modules installed on the rack.

l Offline: A configured Rack address is not
detected, it may be caused by a
communication error between controller
and EPM, or the EPM with related address
is not physically existed.

Auto-refresh is selected by default, you can set a refresh rate
to update diagnostics regularly. You can also click Auto-
refresh to close it, and click Refresh to update diagnostics
manually.

You can click Reset Statistics to reset statistic values to the
default values.

b. From the rack list panel, click the down arrow on the right of
a rack name to view the module list for that rack. All the slots
of the rack are listed with or without module type according
to the configuration and the rack type detected.
The naming format used is:
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l Slot XX - Module Type: the slot is assigned to an IOM.

l Slot XX - Empty: the slot is not assigned to an IOM.
On the rightmost page, the detailed information of the rack
appears including the following parameters.

Parameter Description

Module
Number

Module number of CPM or EPM

TIP: If the I/O module is mounted in a
local I/O rack, the information of CPM is
displayed.

If the I/O module is mounted in an
expansion I/O rack, the information of
EPM is displayed.

Hardware
Version

Hardware version of CPM or EPM

Firmware
Version

Firmware version of CPM or EPM

Status Status of CPM or EPM:

l OK

l Error

Holding the mouse cursor over the shown
error code, the description of the error
appears.

l Offline

Power
Supply

Power supply status:

l OK

l Error

Slot
Number

Slot number mounted in the rack, ranging from
1 to 12.

Module
Type

The type of I/O module

Status Status of I/O module:
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Parameter Description

l OK: No module level error exits and all the
channels of the module are running
without error.

l Error: Module level error exists, or a
module channel is with an error.

l Offline: Configured module is not
detected.

c. Click a module in the Module List to view its diagnostic
information.
See the following table for the detailed diagnostic
information of I/O modules.

Parameter Description

Module
Number

Module number of I/O module

Module
Types

The type of the target I/O module

Hardware
Version

Hardware version of I/O module

Firmware
Version

Firmware version of I/O module

Status Status of I/O module:

l OK: No module level error exits and all
the channels of the module are running
without error.

l Error: Module level error exists, or a
module channel is with an error.

Hold the mouse cursor over the shown
error code of a faulty I/O module to see
a description of the error.

l Offline: Configured module is not
detected.

Channel Defined channel of the assigned module type
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Parameter Description

Status Status of channel:

l OK

l Error

Hold the mouse cursor over the shown
error code of a faulty channel to see a
description of the error.

The channel status will not be displayed if the
type of the physically installed module does
not match the configured one.

The channel status cannot reflect signal
status, such as OverRangeHighExtended (11),
OverRangeHigh (12), OverRangeLow (13) and
OverRangeLowExtended (14).

Description Description of the channel

See the following table for the detailed diagnostic
information of serial modules.

Parameter Description

Protocol
Type

The protocol bound to the port of the serial
module

Status Status of the serial module:

l OK

l Offline

Error
Frame
Counter

The number of data frame with parity error

Tx Frame
Counter

The number of frames sent by the module

Rx Frame
Counter

The number of received frames

Name Diagnostic name

Value Diagnostic value
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Parameter Description

Description Diagnostic description

If the description is too long to display
completely, you can hold the mouse cursor
over the description to show the full
description.

For more information of LED indicators, see "Serial
communication module indicators" in the ControlEdge 900
Platform Hardware Planning and Installation Guide.

Viewing EtherNet/IP device diagnostics
You can log in as the Administrator, Engineer or Operator to connect
the target controller and view EtherNet/IP device diagnostics.

1. From the Home Page, click View Diagnostics under Diagnostics. The
diagnostics page appears.

2. Click the down arrow on the right of the EtherNet/IP Device tab to
expand the group. The overview of the EtherNet/IP devices which
are connected with the controller appears at the rightmost page.
See the following table for the configuration parameters:

Parameter Description

CIP Connection
Used

The number of the used CIP connections.

CIP Connection
Remaining

The number of the unused CIP
connections.

CIP Connection
Active

The number of the active CIP connections.

Device Name EtherNet/IP device name

Device Type EtherNet/IP device type

Status Status of EtherNet/IP device:

l OK: All the devices are running
without error.

l Error: Error exists for the

Chapter 19 - Diagnostics



Parameter Description

connection.

Total Packets Sent The number of packets sent by the client

Total Packets
Received

The number of received packets from the
server

Packets Received
Per Second

The number of received packets from the
server per second

Packets Sent Per
Second

The number of packets sent by the client
per second

IP Address IP Address of the EtherNet/IP device

Connection Timeout The number of connection timeout

Auto-refresh is selected by default, you can set a refresh rate to
update diagnostics regularly. You can also click Auto-refresh to
close it, and click Refresh to update diagnostics manually.

You can click Reset Statistics to reset statistic values to the default
values.

3. Click an EtherNet/IP device name view its diagnostics displayed at
the rightmost page.

Parameter Description

Module Status The status of EtherNet/IP device

See "EtherNet/IP device error codes" on
page 332 for more information.

IP Address The IP Address of EtherNet/IP device

Device Type The EtherNet/IP device type

Vendor Vendor of EtherNet/IP device

Product Code EtherNet/IP device code

Revision EtherNet/IP device revision

Total Packets Sent The number of packets sent by the client

Total Packets
Received

The number of received packets from the
server
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Parameter Description

Packets Sent Per
Second

The number of packets sent by the client per
second

Packets Received
Per Second

The number of received packets from the
server per second

Communication
Errors

The number of communication error

Communication
Timeout

The number of device offline

4. For the EtherNet/IP device with an adapter, click the down arrow
at the right of the device to view I/O module list. Click an I/O
module to view its diagnostics.

Parameter Description

Module Status The status of I/O module

IP Address The IP Address of I/O module

Device Type The I/O module type

Vendor Vendor of EtherNet/IP device

Product Code EtherNet/IP device code

Revision EtherNet/IP device revision

Total Packets Sent The number of packets sent by the client

Total Packets
Received

The number of received packets from the
server

Packets Sent Per
Second

The number of packets sent by the client
per second

Packets Received
Per Second

The number of received packets from the
server per second

Communication
Errors

The number of communication error

Communication
Timeout

The number of device offline
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Uploading and viewing system event log
The controller logs operational and diagnostic events in the System
Event Log. Follow these procedures to upload and then view the
events.

Uploading system event log
Before uploading system event log, you must log in as the
Administrator or Engineer to connect the target controller.

1. Click View System Event Log > Upload System Event Log under
Diagnostics.

2. Select CPM, EPM or MIO28Mixed for Device Type. If you select
MIO28Mixed, then select IOM Address.

3. Select Event Log for File Type.

4. The current system event log destination path and name is
displayed. You can click the browse button to change the
destination and file name.

5. Click Upload button to retrieve the system event log from the
controller, EPM or expansion I/O module and store it to the
destination file. The system event log is now ready for viewing. See
"Viewing system event log" below for more information.

Viewing system event log
To view system events, you must upload the system event log from the
controller to a file on the computer first. See "Uploading system event
log" above for more information.

To view the system events

1. Click View System Event Log > View System Event Log under
Diagnostics.

2. Click View to select the relevant file you have uploaded, click Open.
The system events contained in the file will be displayed.

3. You can filter the events by selecting from the various filters for
the Application, Category, From and To fields. Then click Apply. See
the following tables for descriptions of Application filters and
Category filters.

Table 19-1: Description of Application filters
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Filter Description

eclr Embedded common language
runtime

eipclient EtherNet/IP client

platform Application process management

logsigner Tagged eventlog files

opcuaserver OPC UA server

rdnapp Redundancy application manager

root Printed by Linux kernel libraries

sntp Simple network time protocol

mbslave Modbus slave

cdarcoa CDA responder

hartsrv HART server

gclnamesrv Name server for gcl protocols

kernel Linux kernel

diagnostic Used to upload error.tar and dump
file

watchdogmgr Watchdog manager

certmngrapp Certificate manager

cpmiomgr I/O manager in CPM

onlinediag Online diagnostic manger

fwmgr Firmware upgrade manager

post Post test after system power on

init Boot process of Linux

udhcpc Dynamic host IP address
configuration tool

all All above

Table 19-2: Description of Category filters
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Category Description

crit Critical conditions

err Error conditions

warn Indicates that an error will occur if an action is not
taken.

notice Events that are unusual, but not error conditions.

info Normal operational messages that require no action.

debug Information useful to developers for debugging the
application.

all All above

Uploading a dump file
The dump file contains additional information for Honeywell technical
support. It does not contain any user actionable information. If
Honeywell technical support requests the dump file, follow these
procedures to upload the file before sending it to Honeywell.

ATTENTION: For the controller to generate a dump file, an SD
card (32GB Class 6 / Class 10 industry standard) must be
installed in the controller before an incident occurs. Without an
SD card, a dump file cannot be generated. After uploading a
dump file, if the file appears to be empty, then an SD card may
not have been inserted in the controller at the time of the
incident or the SD card may be full.

1. Click View System Event Log > Upload System Event Log under
Diagnostics.

2. Select CPM, EPM or MIO28Mixed for Device Type. If you select
MIO28Mixed, then select IOM Address.

3. Select Dump File for File Type.

4. The current dump file destination path and name is displayed. You
can click the browse button to change the destination path and
file name.

5. Click Upload button to retrieve the dump file from the controller,
EPM or expansion I/O module and store it to the destination file.
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The dump file is now ready for sending to Honeywell technical
support.

Capturing project diagnostic information
You can save the log files of a project, and send it back to Honeywell
technical support if ControlEdge Builder has an exception.

1. From Home Page, select Save Builder Logs under Diagnostics. The
Save Builder Logs dialog box appears.

2. Click the browser icon to select a directory and enter a file name.
Click Save.

3. Click Save.
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CHAPTER

20 TROUBLESHOOTING

Unable to open ControlEdge Builder
Cause

The Windows Firewall running on the system prevents ControlEdge
Builder from communicating to the controller.

Solution

Add ControlEdge Builder as an allowed program in the Windows
Firewall settings:

1. Select Control Panel and find Windows Firewall.

2. Click Allow a program or feature through Windows Firewall.

3. In the Allowed Programs pop-up window, click Change settings, and
then click Allow another program.

4. In the Add a Program pop-up window, click Browse and select
Mwt.exe file. Click Open to add it into Allowed program and features
list.
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5. Select appropriate options for mwt, and click OK to complete the
configuration.

Project rebuild fails
Cause

No available free space for new variables.

Solution

Delete unnecessary variables from the Global_Variables list.

Unable to delete POUs
The POUs under Project Tree Window in IEC programming
workspace cannot be deleted.

Cause

The eclrRes download dialog box is opened.

Solution

Close eclrRes download dialog box.
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The controller does not show any control
strategy loaded. The status LED flashes in
yellow

n After the controller has been power cycled, it shows no control
strategy loaded. The status LED flashes in yellow. or

n When the project is downloaded, it prompts that an existing
project is still running even though new project has been
downloaded successfully.

Check

Click Project Control Dialog from the toolbar, and press More button to
check if the option Permanent as Bootproject is selected:

Cause

The checkbox Permanent as Bootproject is not selected.

Solution

Select the checkbox Permanent as Bootproject.

To verify that boot project is loaded correctly, click Project Control
Dialog from the toolbar and press Info button to display state of the
controller as shown below:
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Illogical variable value change
Variable value is changed rapidly and illogically when traced in debug
mode.

Cause

n Execution order is not expected.

n You may have accidentally copied an existing variable, and two
variables end up with a same address so it consequently causes
odd behavior.

Solution

n Turn on the execution order (Menu item Layout/Execution Order)
to ensure logic is executing in the order you are expecting. If not,
you may need to move position of function blocks to change
execution order. Function blocks are executed from left to right
via connections. The execution order precedence is top-to-bottom
and left-to-right, if the function blocks are connected using
variables. If that is not your issue, check the properties of variable.

n If it has an address, delete it and “make” project again. This should
not be a problem in R120.

Downloading a project fails with “download
failed” error

Downloading a project in ControlEdge Builder is failed and throws a
with “download failed” error.
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Cause

SD card is not formatted according to the prescribed procedure.

Solution

If you are downloading any application data logs to an SD Card,
ensure the SD card is formatted according to the prescribed
procedure.

Projects not able to downloaded with error
code 27

Projects not able to be downloaded with error code 27.

Cause

Space constrain.

The maximum size of image.bin for the non-redundant ControlEdge
2020 Controller is 1.5MB. The image.bin file is stored in "Project
name" > c > "configuration name" > r > eclrres.

See the following example for how to check the configuration name:

Solution

1. Click More and in the pop-up window, click delete.

2. Download the project again.
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A project automatically connects with the
incorrect controller

When opening a new project by clicking File > Open Project from the
menu bar, or clicking Open Project from the toolbar, it connects with a
previously used, and incorrect controller.

Cause

The controller used previously is not automatically disconnected
when opening a new project.

Solution

1. From the Home Page, click Disconnect to disconnect the previous
controller.

2. From the Home Page, click Connect to connect the new controller.
See "Connecting a controller" on page 26 for more information.

Settings in ControlEdge Configuration
Workspace are not downloaded to the
controller.

The settings in ControlEdge Configuration Workspace are not
downloaded to the controller successfully.

Check

Click Project Control Dialog from the toolbar, and press More button to
check if the option Include Sources is selected:
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Cause

The checkbox Include Sources is selected.

Solution

Uncheck the option Include Sources.

The controller is stuck with 0% CPU free.
A controller will be stuck with 0% CPU free if it is running with "SEL"
function block in use with the following two conditions. ControlEdge
Builder is no responding and eCLR is timeout.

Cause

n "EN" is set to "TRUE".

n WORD or DWORD data type is used for output .B1/B2, or .X1/X2...

Solution

1. Recover the issue.

l For ControlEdge 900 controller. Manually stop the controller
using the mode switch, set "EN" to "False", and then download a
project to overwrite the current project.

l For ControlEdge 2020 controller. Power cycle the controller, set
"EN" to "False", and then download a project to overwrite the
current project.

2. Use "SEL_*" function blocks instead of the "SEL" function block.
Here is an example for using SEL_BOOL function block.
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Watchdog timeout
Watchdog timeout issue appears when a controller execute too many
programs.

Cause

Programs are too many to be executed completely within the Interval
of a task.

Solution

Configure a longer Interval for the task, and set a longer watchdog
time.

NOTE: Watchdog time should be shorter than or equal to the
Interval of tasks.

Redundant controller will drop sync due to
error between 88 and 232

Redundant controller drops sync.

Cause

The redundant controller drops sync due to the error between 88 and
232. See "Enumerations" on page 355 for more information.

Solution

Remove and insert the secondary CPM again.
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APPENDIX

A
See the following sections for error codes in ControlEdge Builder.

In this section:

System error code 322

Wireless error code 324

EPM status 326

I/O module status 327

I/O channel status 330

EtherNet/IP device error codes 332

ERROR CODE REFERENCE
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Appendix A - Error code reference

System error code
Error
Code

Description Cause Action

0 SUCCESS Success N/A

1 FAILURE Operation failure. Generic failure Upload System Event
Logs for debugging.

4 INVALID_OBJ_ID Invalid Object Id Upload System Event
Logs for debugging.

12 INVALID_VALUE Value not acceptable for other reason (too
large/too small/invalid eng. units code)

Upload System Event
Logs for debugging.

14 INVALID_SIZE Size not valid (may be too big/too small) Upload System Event
Logs for debugging.

27 INSUFFICIENT_
DEVICE_
RESOURCES

Insufficient device resources e.g. queue full,
buffers/memory unavailable

1. From the eclr
board, click More,
the Download
Options dialog
appears.

2. Click Delete to
remove the old
projects from the
controller.

40 INVALID_DATA Invalid data received from the builder. Send the controller error
log and builder log to
Honeywell.

129 TIMEOUT Usually the connection between the
controller and the builder is broken.

Check the status of the
controller.

501 INVALID_APP_ID Application ID in the request is invalid. Upload System Event
Logs for debugging.

502 INVALID_ATTR_ID Attribute ID in the request is invalid. Upload System Event
Logs for debugging.

503 INVALID_ATTR_
IDX

Attribute index in the request is invalid. Upload System Event
Logs for debugging.

504 INVALID_FC Function code in the request is invalid. Upload System Event
Logs for debugging.

505 READ_ONLY Attribute write request failed because
attribute is read-only.

Upload System Event
Logs for debugging.
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Appendix A - Error code reference

Error
Code

Description Cause Action

506 INAPPROPRIATE_
PROCESS_MODE

Request cannot be executed in the current
state. For example:

Wait for current
operation to complete
or cancel current
operation (if possible
and appropriate) and
retry.

Controller load request fails because the
controller is either in the process of upgrade,
reboot or shutdown.

Controller reboot request fails because a
reboot is already in progress.

Controller upgrade request fails because the
controller startup is not completed, or it is in
the process of reboot, load, upgrade or
shutdown.

507 UNSUPPORTED N/A N/A

508 INVALID_FILE_ID File ID specified in the request is invalid Upload System Event
Logs for debugging.

509 INVALID_
CONFIG_ENTITY

Config file is corrupted or not compatible
with existing release.

Upload System Event
Logs for debugging.

510 CONFIGFILE_
NOTEXIST

Config file does not exist. Controller database
might be corrupted.

Upload System Event
Logs for debugging.

511 UPLOADDATA_
NOTEXIST

Archiving backup files is having issue due to
memory limitations.

Try multiple times. If it is
still not working, upload
System Event Logs for
debugging.

513 IP_ADDRESS_
NOT_AVAILABLE

Requested static IP address cannot be
assigned to the interface because another
node with the same IP address already exists
on the network.

Assign a different static
IP address or remove the
node with the same IP
address from the
network and retry.

514 INVALID_
AUTHORIZATION_
ID

The user doesn’t have corresponding
authorization to perform the operations. For
example, the operator does not have the
privilege to change password for other users,
administrators or engineers.

Builder pops up an error
message.

515 INVALID_DATA_
TYPE

Data type in the request is invalid. Upload System Event
Logs for debugging.
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Error
Code

Description Cause Action

518 SESSION_
EXPIRED

No communication between the controller
and the builder for over ten minutes.

Reconnect to the
controller.

520 NOT_ALLOWED_
DOWNLOAD_NR_
PROJECT_TO_
RED_SETUP

Download a non-redundant project to a
redundant controller

Enable controller
redundancy or change a
redundant project to
download

Wireless error code
Error
Code

Description Cause Action

25 FIELD_
OPERATION_
CONDITION

Field specific condition prevented
request from succeeding e.g. lockout
or environmental condition not in
range

Upload System Event Logs for
debugging.

26 CONFIGURATION_
MISMATCH

Configuration conflict was detected Upload System Event Logs for
debugging.

28 VALUE_LIMITED Value is limited by device Upload System Event Logs for
debugging.

29 DATA_WARNING Value has been modified due to a
device specific reason

Upload System Event Logs for
debugging.

30 INALID_
FUNCTION_
REFERENCE

Function referenced for execution is
invalid

Upload System Event Logs for
debugging.

31 FUNCTION_
PROCESS_ERROR

Function referenced could not be
performed due to a device specific
reason

Upload System Event Logs for
debugging.

32 WARNING Operation is successful; but there is
additional info that may be of interest
to the user e.g. via accessing an
attribute or by sending an alert

Upload System Event Logs for
debugging.

33 WRITE_ONLY_
ATTRIBUTE

Write-only attribute (e.g. a command
attribute

Upload System Event Logs for
debugging.

34 OPERATION_
ACCEPTED

Method operation accepted Upload System Event Logs for
debugging.
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Error
Code

Description Cause Action

35 INVALID_BLOCK_
SIZE

Upload or download block size not
valid

Upload System Event Logs for
debugging.

36 INVALID_
DOWNLOAD_SIZE

Total size for upload or download is
not valid

Upload System Event Logs for
debugging.

37 UNEXPECTED_
METH_
SEQUENCE

Required method sequencing has not
been followed

Upload System Event Logs for
debugging.

38 TIMING_
VIOLATION

Object timing requirements have not
been satisfied

Upload System Event Logs for
debugging.

39 OPERATION_
INCOMPLETE

Method operation, or method
operation sequence not successful

Upload System Event Logs for
debugging.

40 SFC_INVALID_
DATA

Data received is not valid (e.g.,
checksum error, data content not as
expected)

Upload System Event Logs for
debugging.

41 DATA_
SEQUENCE_
ERROR

Data is ordered; data received is not
in the order required e.g. duplicate
data was received

Upload System Event Logs for
debugging.

42 OPERATION_
ABORTED

Operation aborted by server Upload System Event Logs for
debugging.

43 INVALID_BLOCK_
NUMBER

Invalid block number Upload System Event Logs for
debugging.

44 BLOCK_DATA_
ERROR

Error in block of data, example, wrong
size, invalid content

Upload System Event Logs for
debugging.

45 BLOCK_NOT_
DOWNLOAD

Specified block of data has not been
successfully downloaded

Upload System Event Logs for
debugging.

46-
127

ISA100_
STANDARD_
RESERVED

Standard ISA100 reserved error codes Upload System Event Logs for
debugging.

128-
255

ISA100_VENDOR_
SPECIFIC_ERROR

ISA100 Vendor specific error codes Upload System Event Logs for
debugging.

516 WIRELESS_NOT_
ENABLED

Wireless is not enabled or FDAP is
not connected to ControlEdge
Builder.

Enable wireless by binding to
one of the Ethernet ports or
connect FDAP to Ethernet port
configured for wireless I/O.
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Error
Code

Description Cause Action

517 WIRELESS_
ISA100_
NETWORKID_FAIL

If the Wireless protocol configuration
in project in done with different
ISA100 network ID, but there are
existing commissioned devices in the
controller with different ISA100
network ID

Either change the ISA100
network Id under Wireless
protocol in project
configuration and download or
delete all the wireless device in
Commissioning page

EPM status
The system provides 4 BYTE long variable (32 bit) to indicate the working state of
the module. Each bit represents one state, "1" means the state defined is active.
For example, if the value of bit 0 is "1", the state is offline; if the value is "0", the
state is online.

Multiple states can be detected at the same time.

Bit State Cause Action

0 Offline EPM is not installed or the communication
between controller and EPM is error.

Check if EPM have been
installed or communication line
have been connected.

1 Address
Conflict

Duplicated Rack Address is detected. Check the address setting on the
rack.

2 Hadrware
Error

Some hardware failure because of high
temperature voltage or striking.

Reboot or replace EPM
hardware.

4 Rack
mismatch

The maximum slot number in the
configuration is bigger than the maximum
slot number on the physical rack.

Check the rack type which is
physically installed and replcace
it with a proper type.

5 Flash Hard
Failure

Firmware signature on low rate on first bank. Update EPM firmware.

6 EEPROM
Soft Failure

FW public key and it’s CRC error. 1. Reboot controller and
check whether this failure
status, if it always true, go
step 2.

2. Upgrade firmware and
check whether this failure
status, if it always true, go
step 3.
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Bit State Cause Action

3. Replace the module.

7 MRAMHF The read value is inconsistent with the value
written in reserved area.

1. Reboot controller and
check whether this failure
status, if it always true, go
step 2.

2. Upgrade firmware and
check whether this failure
status, if it always true, go
step 3.

3. Replace the module.

8 FPGA Hard
failure

FPGA INIT signal check error. Reboot or replace EPM
hardware.

9 RAM Soft
Failure

The memory register show single bit error. Reboot or replace EPM
hardware.

10 RAM Hard
Failure

The memory register show muti bits error. Reboot or replace EPM
hardware.

11 Invalid CRC Data was disturbed by enviroment elements
during transferring.

Chech EPM working enviroment
or replace EPM hardware.

12 Left Power
Supply
Module error

The left power supply module is broken. Replace the module.

13 Right Power
Supply
Module error

The right power supply module is broken. Replace the module.

I/O module status
The system provides 4 BYTE long variable (32 bit) to indicate the working state of
the module. Each bit represents one state, "1" means the state defined is active.
For example, if the value of bit 0 is "1", the state is offline; if the value is "0", the
state is online.

Multiple states can be detected at the same time.

Bit State Cause Action

0 Offline Communication Check the physical installation and the configuration.
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Bit State Cause Action

error or module
doesn't physically
exist or module is
not powered on.

1 IOM Type
Mismatch

Configured IOM is
different from the
one physically
installed.

Check the installed IOM on the rack and the
configuration. Then replace the I/O module if the
type of the installed module is not expected or
Change the I/O Module type in the configuration if
the configured type is not correct.

2 Hardware Error Internal hardware
error.

Power recycle the field power for the affected module.
Replace module hardware if error persists.

3 Factory DataErr Module does not
contain the correct
factory data or
factory data is
corrupted.

Replace I/O module hardware.

5 FWImageErr Module does not
contain the correct
firmware image or
firmware image.

Upgrade the firmware image again. Replace I/O
module hardware if error persists.

6 WDTErr Module
encountered a
watchdog reset.

Restart the I/O module by powering it off and
powering back ON. Replace I/O module if error
persists.

7 ExternalPowerErr The external 24V
supply is not
connected/has lost
power/has an
overvoltage.

Check the 24V connections, check the 24V external
power supply and ensure that it is powered on and
connected. Check if the 24 V power supply does not
have an undervoltage/overvoltage.

8 InternalPowerErr Bad power supply
module on the rack
or hardware failure
on the UIO.

Check that the power supply and UIO modules are
correctly inserted in the rack and the mounting
screws are tight. Replace rack power supply if the
power supply error is still seen on this module or
other modules. Replace UIO hardware if error persists.

9 Over temperature The UIO module
detected that the
board temperature
is higher than the
threshold.

Check if there is sufficient ventilation between the
racks. Check if the current drawn from the UIO
module to the DO and AO channels do not exceed
the specification limits of 4.2 A. If the error persists,
replace module hardware.

328



Appendix A - Error code reference

Bit State Cause Action

10 FWUpgrading Module firmware is
upgrading.

None.

11 Not factory
calibrated

Module is not
factory calibrated or
calibration data
corrupted.

Replace I/O module hardware.

12 HI CJ
Temperature

One of the two CJs
on the module is
indicating a
temperature
reading greater
than 70 degrees C.

Replace the UAI module.

13 CJ Failure Either of the below
two condition will
trigger CJ failure:

l The CJs are
converting
properly, but
their
differential is
greater than
10 degrees C
(|CJ1-CJ2| >
10);

l Both cold-
junction
sensors are
failing to
convert.

Replace the UAI module

14 CJ Warning One cold-junction
sensors are failing
to convert and the
other is normal.

Replace the UAI module
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I/O channel status
Error
Code

State Cause Action Apply to

0 Good N/A N/A All I/O
modules

1 Bad Channel The module is offline,
or;

The module is with
errors.

Check the module status All I/O
modules

11¹ OverRangeHighExtended When input value is
larger than (EU High) +
(EU High - EU
Low)*10%

Check the input signal UIO(AI,
AO), UAI,
AO04,
AO08,
HLAI

12¹ OverRangeHigh When input value is in
the range from EU High
to (EU High) + (EU High
- EU Low)*10%

Check the input signal UIO(AI,
AO),
PFQ(FI),
AO04,
AO08,
HLAI

13¹ OverRangeLow When input value is in
the range from (EU
Low) - (EU High - EU
Low)*10% to EU Low

Check the input signal UIO(AI,
AO),
PFQ(FI),
AO04,
AO08,
HLAI

14¹ OverRangeLowExtended When iInput value is
smaller than (EU Low) -
(EU High - EU
Low)*10%

Check the input signal UIO(AI,
AO), UAI,
AO04,
AO08,
HLAI

16 OpenWired Field cable broken or
not connected to the
terminals of the module

Check field cable
connections and ensure that
the sensor or actuator is
connected to the I/O
module. In case of DI, the
correct values of external
resistors have to be used to
detect open wire

UIO
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Error
Code

State Cause Action Apply to

18 ShortCircuit Field cable has a short
circuit

Check field cable for short
circuit and ensure that the
sensor or actuator is
connected to the I/O
module. In case of DI, the
correct values of external
resistors have to be used to
detect short circuit. In case
of DO, the short circuit
protection prevents the
output to be driven.

UIO(AI,
DI, DO)

19 I/O HardwareErr Internal hardware error Power recycle the field
power for the affected
module or Replace module
hardware if error persists

UAI,
PFQ,
HLAI

20 Read Back Test Fail Analog/Digital output
channel is unable to
drive the desired output
current on the
terminals. This could
happen due to high
load resistance or a
broken wire.

Check field cable
connections and ensure that
the actuator is connected to
the I/O module

UIO (AO,
DO)

21 Channel conversion fail Internal hardware error Power recycle the filed
power for the affected
module. Replace the module
hardware if error persists.

UIO,
UAI,
PFQ,
HLAI

23 T/C Warning Thermocouple
measures between 100
ohms and 179 ohms

Check and replace the TC if
it is fault

UAI

24 T/C Failing Thermocouple
measures 180 ohms or
more

Check and replace the TC if
it is faulty.

UAI

25 CJ Warning One cold-junction
sensors are failing to
convert and the other is
normal.

Replace the UAI module. UAI
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Error
Code

State Cause Action Apply to

26 Burnout Failure When channel response
burnout fail, then return
burnout failure.

Check and replace the TC if
it is faulty.

UAI

27 CJ High Temperature Value of Local CJ1 or
Local CJ2 is greater
than 70.

Check and replace the TC if
it is faulty.

UAI

28 CJ Failure Both local Cj1 and
Local CJ2 are failed.

Check and replace the TC if
it is faulty.

UAI

29 Over current TBC 1. Check the wiring of DO
channel.

2. If the channel still cannot
work after the recovery from
over current, replace the
fuse of the channel.

DO DC

30 Remote CJ Failed Return Remote CJ
Failed except the case
of remote CJ AI is good,
over range high or over
range low.

Check and replace the TC if
it is faulty.

UAI

31 Remote CJ Value too
Low

RCJ value < -30 Check and replace the TC if
it is faulty.

UAI

32 Remote CJ Value too
High

RCJ value > 90 Check and replace the TC if
it is faulty.

UAI

33 PI Overflow Count on the module is
overflow

Reset the channel. PFQ

Note1: These codes are only for I/O status parameter (STS). They are not reflected by I/O channel
status on the I/O diagnostics page.

EtherNet/IP device error codes
EtherNet/IP device diagnostics are also displayed in IEC Programming Workspace.
Click IEC Programming Workspace, and double-click Global_Variables, check the
EtherNetIP Diagnostics group.
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Error code Status Description

0x0000 EIP_IO_STATE_STANDBY Device is standby.

0x1000 EIP_IO_STATE_FAULTED Connecting failed

0x1100 EIP_IO_STATE_FAULTED_WAITING_TO_
CONNECT

Connecting failed, waiting to re-
connect

0x1200 EIP_IO_STATE_FAULTED_CONNECTING Connecting failed, re-connecting

0x1300 EIP_IO_STATE_FAULTED_BAD_IP_ADDR Invalid IP address specified

0x1400 EIP_IO_STATE_FAULTED_SERVER_ALLOC_
FAILED

I/O server allocation failed

0x1500 EIP_IO_STATE_FAULTED_IO_ALLOC_
FAILED

I/O allocation failed

0x1600 EIP_IO_STATE_FAULTED_BAD_T2O_
DATAPTR

Invalid Target to Originator data size
and/or pointer

0x1700 EIP_IO_STATE_FAULTED_BAD_O2T_
DATAPTR

Invalid Originator to Target data size
and/or pointer

0x1800 EIP_IO_STATE_FAULTED_BAD_T2O_RPI Invalid Target to Originator RPI

0x1900 EIP_IO_STATE_FAULTED_BAD_O2T_RPI Invalid Originator to Target RPI

0x1a00 EIP_IO_STATE_FAULTED_BAD_CONFIGPTR Invalid configuration size and/or
pointer

0x3000 EIP_IO_STATE_CONNECTING Connecting

0x4000 EIP_IO_STATE_RUNNING Running

0x5000 EIP_IO_STATE_SHUTTING_DOWN Shutting down

0x7100 EIP_IO_STATE_WAITING_TO_CONNECT Waiting to connect

0x7200 EIP_IO_STATE_WAITING_TO_SHUTDOWN Waiting to shut down

0x7300 EIP_IO_STATE_WAITING_TO_RECONNECT Re-connect after forward close,
instead of freeing I/O

0x9000 EIP_IO_STATE_CNTRLR_SWITCHOVER Forward closing of I/O modules with
input channels after the controller
switch over
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This appendix introduces meter run register range, offset and register description.
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Meter run register range
Table B-1: Meter run register range

Purpose
Hourly
(Interval)/ Daily
Archive

Hourly/ Daily
Archive pointers

Alarm
Archive

AE
Pointer

Boolean
Range

Integer
Range

Long
Integer

Float

Run 1 701 - 702 7001-7002 32 7041 1100 to
1199

3100
to
3199

5100
to
5199

7100 to
7349

Run 2 703 to 704 7003-7004 32 7041 1200 to
1299

3200
to
3299

5200
to
5299

7350 to
7599

Run 3 705 to 706 7005-7006 32 7041 1300 to
1399

3300
to
3399

5300
to
5399

7600 to
7849

Run 4 707 to 708 7007-7008 32 7041 1400 to
1499

3400
to
3499

5400
to
5499

7850 to
8099

Run 5 709 to 710 7009-7010 32 7041 1500 to
1599

3500
to
3599

5500
to
5599

8100 to
8349

Run 6 711 to 712 7011-7012 32 7041 1600 to
1699

3600
to
3699

5600
to
5699

8350 to
8599

Run 7 713 to 714 7013-7014 32 7041 1700 to
1799

3700
to
3799

5700
to
5799

8600 to
8849

Run 8 715 to 716 7015-7016 32 7041 1800 to
1899

3800
to
3899

5800
to
5899

8850 to
9099

Run 9 717 to 718 7017-7018 32 7041 1900 to
1999

3900
to
3999

5900
to
5999

9100 to
9349

Run 10 719 to 720 7019-7020 32 7041 2000 to
2099

4000
to
4099

6000
to
6099

9350 to
9599

Run 11 721 to 722 7021-7022 32 7041 2100 to 4100 6100 9600 to
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Purpose
Hourly
(Interval)/ Daily
Archive

Hourly/ Daily
Archive pointers

Alarm
Archive

AE
Pointer

Boolean
Range

Integer
Range

Long
Integer

Float

2199 to
4199

to
6199

9849

Run 12 723 to 724 7023-7024 32 7041 2200 to
2299

4200
to
4299

6200
to
6299

9850 to
10099

Meter run register offset
Table B-2: Meter run register offset

Purpose Boolean Offset Integer Offset Long Integer Offset Float Offset

Run 1 0 0 0 0

Run 2 100 100 100 250

Run 3 200 200 200 500

Run 4 300 300 300 750

Run 5 400 400 400 1000

Run 6 500 500 500 1250

Run 7 600 600 600 1500

Run 8 700 700 700 1750

Run 9 800 800 800 2000

Run 10 900 900 900 2250

Run 11 1000 1000 1000 2500

Run 12 1100 1100 1100 2750
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QTR rollover details
Gas QTR

Hourly rollover index: 1050

Daily rollover index: 100

Liquid QTR

Hourly rollover index: 918

Daily rollover index: 100

System events
The system events registers are for event reference and cannot be read. System
events table is as follows.

Table B-3: System Events

Enron Register System Events

3001 EV_SYSTEM_COLD_START

3002 EV_SYSTEM_WARM_START

3003 EV_SYSTEM_POWER_OFF

3004 EV_SYSTEM_WATCHDOG_RESET

3005 EV_SYSTEM_TIME_CHANGED

Meter run register description
The Enron register mapping for the controller is displayed as follows. The actual
meter run specific register can be calculated by adding the offset mentioned in
the offset table.

Table B-4: Meter run register description

Enron Register Alarm & Events Description Meter run Configuration Parameter

3108 EV_CHANGE_INPUT_UNITS INPUT_UNITS

3109 EV_CHANGE_CONTRACT_UNITS CONTRACT_UNITS

3110 EV_CHANGE_VOLUME_UNIT Volume unit change
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Enron Register Alarm & Events Description Meter run Configuration Parameter

3111 EV_CHANGE_TEMPRATURE_UNIT Temperature unit change

3112 EV_CHANGE_PRESSURE_UNIT Pressure unit change

3113 EV_CHANGE_DENSITY_UNIT Density unit change

3114 EV_CHANGE_FLOW_UNIT Flow unit change

3115 EV_CHANGE_SOFTWARE_REVISION Software revision change

3116 EV_CHANGE_METER_ID Meter Id value change

3117 EV_CHANGE_LIQUID_TYPE Liquid type change

7101 EV_CHANGE_IS_ABSOLUTE_
PRESSURE

IS_ABSOLUTE_PRESSURE

7102 EV_CHANGE_ATMOSPHERIC_PRES ATMOSPHERIC_PRES

7111 EV_CHANGE_DP_LOW_CUTOFF DP_LOW_CUTOFF

7112 EV_CHANGE_IS_PULSE IS_PULSE

7113 EV_CHANGE_PULSE_LOW_CUTOFF PULSE_LOW_CUTOFF

7114 EV_CHANGE_LOW_FLOW_DETECT_
TIME

LOW_FLOW_DETECT_TIME

7115 EV_CHANGE_LOW_GAS_MASS_
CUTOFF

LOW_GAS_MASS_CUTOFF

7120 EV_CHANGE_COMPRESSIBILITY_
METHOD

COMPRESSIBILITY_METHOD

7121 EV_CHANGE_AVERAGING_METHOD AVERAGING_METHOD

7122 EV_CHANGE_CONTRACT_HOUR CONTRACT_HOUR

7123 EV_CHANGE_BASE_TEMP BASE_TEMP

7124 EV_CHANGE_BASE_PRES BASE_PRES

7131 EV_CHANGE_ORIFICE_MATERIAL ORIFICE_MATERIAL

7132 EV_CHANGE_ORIFICE_TAP_TYPE ORIFICE_TAP_TYPE

7133 EV_CHANGE_ORIFICE_TAP_
LOCATION

ORIFICE_TAP_LOCATION

7134 EV_CHANGE_ORIFICE_PIPE_
MATERIAL

ORIFICE_PIPE_MATERIAL
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Enron Register Alarm & Events Description Meter run Configuration Parameter

7135 EV_CHANGE_ORIFICE_DIAMETER ORIFICE_DIAMETER

7136 EV_CHANGE_ORIFICE_PIPE_
DIAMETER

ORIFICE_PIPE_DIAMETER

7137 EV_CHANGE_ORIFICE_VISCOSITY ORIFICE_VISCOSITY

7138 EV_CHANGE_ORIFICE_REF_TEMP ORIFICE_REF_TEMP

7139 EV_CHANGE_ORIFICE_PIPE_REF_
TEMP

ORIFICE_PIPE_REF_TEMP

7140 EV_CHANGE_ORIFICE_
ISENTROPIC_EXP

ORIFICE_ISENTROPIC_EXP

7141 EV_CHANGE_ORIFICE_FLUID_TYPE ORIFICE_FLUID_TYPE

7148 EV_CHANGE_THERMAL_
EXPANSION

Thermal Expansion Factor value
change

7149 EV_CHANGE_TEMP_KEYPAD_
VALUE

Temperature keypad value change

7150 EV_CHANGE_PRES_KEYPAD_
VALUE

Pressure keypad value change

7151 EV_CHANGE_TURB_METER_
FACTOR

TURB_METER_FACTOR

7152 EV_CHANGE_ULTRA_METER_
FACTOR

ULTRA_METER_FACTOR

7153 EV_CHANGE_LIQ_METER_FACTOR Liquid Meter Factor value change

7160 EV_CHANGE_GAS_COMP_SOURCE GAS_COMP_SOURCE

7161 EV_CHANGE_GAS_COMP_FORMAT GAS_COMP_FORMAT

7162 EV_CHANGE_GAS_COMP_
METHANE

GAS_COMP_METHANE

7163 EV_CHANGE_GAS_COMP_
NITROGEN

GAS_COMP_NITROGEN

7164 EV_CHANGE_GAS_COMP_CO2 GAS_COMP_CO2

7165 EV_CHANGE_GAS_COMP_ETHANE GAS_COMP_ETHANE

7166 EV_CHANGE_GAS_COMP_
PROPANE

GAS_COMP_PROPANE
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Enron Register Alarm & Events Description Meter run Configuration Parameter

7167 EV_CHANGE_GAS_COMP_WATER GAS_COMP_WATER

7168 EV_CHANGE_GAS_COMP_H2S GAS_COMP_H2S

7169 EV_CHANGE_GAS_COMP_
HYDROGEN

GAS_COMP_HYDROGEN

7170 EV_CHANGE_GAS_COMP_CO GAS_COMP_CO

7171 EV_CHANGE_GAS_COMP_OXYGEN GAS_COMP_OXYGEN

7172 EV_CHANGE_GAS_COMP_ARGON GAS_COMP_ARGON

7173 EV_CHANGE_GAS_COMP_HELIUM GAS_COMP_HELIUM

7174 EV_CHANGE_GAS_COMP_I_
BUTANE

GAS_COMP_I_BUTANE

7175 EV_CHANGE_GAS_COMP_N_
BUTANE

GAS_COMP_N_BUTANE

7176 EV_CHANGE_GAS_COMP_I_
PENTANE

GAS_COMP_I_PENTANE

7177 EV_CHANGE_GAS_COMP_N_
PENTANE

GAS_COMP_N_PENTANE

7178 EV_CHANGE_GAS_COMP_HEXANE GAS_COMP_HEXANE

7179 EV_CHANGE_GAS_COMP_
HEPTANE

GAS_COMP_HEPTANE

7180 EV_CHANGE_GAS_COMP_OCTANE GAS_COMP_OCTANE

7181 EV_CHANGE_GAS_COMP_NONANE GAS_COMP_NONANE

7182 EV_CHANGE_GAS_COMP_DECANE GAS_COMP_DECANE

7190 EV_CHANGE_GAS_RELATIVE_
DENSITY

GAS_RELATIVE_DENSITY

7191 EV_CHANGE_GAS_HEATING_VALUE GAS_HEATING_VALUE

7192 EV_CHANGE_REFTEMPERATURE_
COMBUSTION

REFTEMPERATURE_COMBUSTION

7193 EV_CHANGE_REFTEMPERATURE_
CALORIMETER

REFTEMPERATURE_CALORIMETER

7194 EV_CHANGE_REFPRESSURE_
CALORIMETER

REFPRESSURE_CALORIMETER
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Enron Register Alarm & Events Description Meter run Configuration Parameter

7201 EV_CHANGED_TEMP_LOW_LOW TEMP_LOW_LOW_LIMIT

7202 EV_CHANGED_TEMP_LOW TEMP_LOW_LIMIT

7203 EV_CHANGED_TEMP_HIGH TEMP_HIGH_LIMIT

7204 EV_CHANGED_TEMP_HI_HI TEMP_HI_HI

7205 EV_CHANGED_PRES_LOW_LOW PRES_LOW_LOW_LIMIT

7206 EV_CHANGED_PRES_LOW PRES_LOW_LIMIT

7207 EV_CHANGED_PRES_HIGH PRES_HIGH_LIMIT

7208 EV_CHANGED_PRES_HI_HI PRES_HI_HI_LIMIT

7209 EV_CHANGED_DIFFPRES_LOW_
LOW

DIFFPRES_LOW_LOW_LIMIT

7210 EV_CHANGED_DIFFPRES_LOW DIFFPRES_LOW

7211 EV_CHANGED_DIFFPRES_HIGH DIFFPRES_HIGH

7212 EV_CHANGED_DIFFPRES_HI_HI DIFFPRES_HI_HI

7213 EV_CHANGED_PULSE_LOW_LOW PULSE_LOW_LOW

7214 EV_CHANGED_PULSE_LOW PULSE_LOW

7215 EV_CHANGED_PULSE_HIGH PULSE_HIGH

7216 EV_CHANGED_PULSE_HI_HI PULSE_HI_HI

7217 EV_CHANGED_GASMASS_LOW_
LOW

GASMASS_LOW_LOW

7218 EV_CHANGED_GASMASS_LOW GASMASS_LOW

7219 EV_CHANGED_GASMASS_HIGH GASMASS_HIGH

7220 EV_CHANGED_GASMASS_HI_HI GASMASS_HI_HI

7201 EV_ALARM_TEMP_LOW_LOW N/A

7202 EV_ALARM_TEMP_LOW N/A

7203 EV_ALARM_TEMP_HIGH N/A

7204 EV_ALARM_TEMP_HI_HI N/A

7205 EV_ALARM_PRES_LOW_LOW N/A

7206 EV_ALARM_PRES_LOW N/A
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Enron Register Alarm & Events Description Meter run Configuration Parameter

7207 EV_ALARM_PRES_HIGH N/A

7208 EV_ALARM_PRES_HI_HI N/A

7209 EV_ALARM_DIFFPRES_LOW_LOW N/A

7210 EV_ALARM_DIFFPRES_LOW N/A

7211 EV_ALARM_DIFFPRES_HIGH N/A

7212 EV_ALARM_DIFFPRES_HI_HI N/A

7213 EV_ALARM_PULSE_LOW_LOW N/A

7214 EV_ALARM_PULSE_LOW N/A

7215 EV_ALARM_PULSE_HIGH N/A

7216 EV_ALARM_PULSE_HI_HI N/A

7217 EV_ALARM_GASMASS_LOW_LOW N/A

7218 EV_ALARM_GASMASS_LOW N/A

7219 EV_ALARM_GASMASS_HIGH N/A

7220 EV_ALARM_GASMASS_HI_HI N/A

7201 EV_ALARM_TEMP_LOW_LOW_
RESET

N/A

7202 EV_ALARM_TEMP_LOW_RESET N/A

7203 EV_ALARM_TEMP_HIGH_RESET N/A

7204 EV_ALARM_TEMP_HI_HI_RESET N/A

7205 EV_ALARM_PRES_LOW_LOW_
RESET

N/A

7206 EV_ALARM_PRES_LOW_RESET N/A

7207 EV_ALARM_PRES_HIGH_RESET N/A

7208 EV_ALARM_PRES_HI_HI_RESET N/A

7209 EV_ALARM_DIFFPRES_LOW_LOW_
RESET

N/A

7210 EV_ALARM_DIFFPRES_LOW_RESET N/A

7211 EV_ALARM_DIFFPRES_HIGH_
RESET

N/A
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7212 EV_ALARM_DIFFPRES_HI_HI_
RESET

N/A

7213 EV_ALARM_PULSE_LOW_LOW_
RESET

N/A

7214 EV_ALARM_PULSE_LOW_RESET N/A

7215 EV_ALARM_PULSE_HIGH_RESET N/A

7216 EV_ALARM_PULSE_HI_HI_RESET N/A

7217 EV_ALARM_GASMASS_LOW_LOW_
RESET

N/A

7218 EV_ALARM_GASMASS_LOW_RESET N/A

7219 EV_ALARM_GASMASS_HIGH_
RESET

N/A

7220 EV_ALARM_GASMASS_HI_HI_
RESET

N/A

7227 EV_CHANGE_DEN_TEMP_LOW_
LOW

Desitometer Temperature Low Low
alarm value change

7228 EV_CHANGE_DEN_TEMP_LOW Desitometer Temperature Low alarm
value change

7229 EV_CHANGE_DEN_TEMP_HIGH Desitometer Temperature High alarm
value change

7230 EV_CHANGE_DEN_TEMP_HI_HI Desitometer Temperature High High
alarm value change

7231 EV_CHANGE_DEN_PRES_LOW_
LOW

Desitometer Pressure Low Low alarm
value change

7232 EV_CHANGE_DEN_PRES_LOW Desitometer Pressure Low alarm value
change

7233 EV_CHANGE_DEN_PRES_HIGH Desitometer Pressure High alarm value
change

7234 EV_CHANGE_DEN_PRES_HI_HI Desitometer pressure High High alarm
value change

7257 EV_CHANGE_DEN_TEMP_KEYPAD_
VALUE

Desitometer Temperature Keypad Value
change

7258 EV_CHANGE_PRES_TEMP_ Desitometer pressure Keypad Value
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KEYPAD_VALUE change

7260 EV_CHANGE_WATER_SED_
KEYPAD_VALUE

Water and Sediments Keypad Value
change

7293 EV_CHANGE_LIQUID_PULSE_LOW_
CUT_OFF

Low Pulse Cut off value change

7289 EV_CHANGE_ANALOG_LOW_LOW Analog Low Low Alarm Value Change

7290 EV_CHANGE_ANALOG_LOW Analog Low Alarm Value Change

7291 EV_CHANGE_ANALOG_HIGH Analog High alarm value change

7292 EV_CHANGE_ANALOG_HIGH_HIGH Analog High High alarm value change

7227 EV_CHANGE_DEN_TEMP_LOW_
LOW_RST

Desitometer Temperature Low Low
alarm reset

7228 EV_CHANGE_DEN_TEMP_LOW_RST Desitometer Temperature Low alarm
value reset

7229 EV_CHANGE_DEN_TEMP_HIGH_
RST

Desitometer Temperature High alarm
value reset

7230 EV_CHANGE_DEN_TEMP_HI_HI_
RST

Desitometer Temperature High High
alarm value reset

7231 EV_CHANGE_DEN_PRES_LOW_
LOW_RST

Desitometer Pressure Low Low alarm
value reset

7232 EV_CHANGE_DEN_PRES_LOW_RST Desitometer Pressure Low alarm value
reset

7233 EV_CHANGE_DEN_PRES_HIGH_RST Desitometer Pressure High alarm value
reset

7234 EV_CHANGE_DEN_PRES_HI_HI_RST Desitometer pressure High High alarm
value reset

7235 EV_ALARM_DEN_TEMP_KEYPAD_
SET

Densitometer Temperature Keypad
alarm set

7236 EV_ALARM_DEN_PRES_KEYPAD_
SET

Densitometer Pressure Keypad alarm
set

7237 EV_ALARM_TEMP_KEYPAD_SET Temperature Keypad alarm set

7238 EV_ALARM_PRES_KEYPAD_SET Pressure Keypad alarm set
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7239 EV_ALARM_DESITY_KEYPAD_SET Density Keypad alarm set

7240 EV_ALARM_BASE_DESITY_
KEYPAD_SET

Base Density Keypad alarm set

7241 EV_ALARM_WATER_SED_KEYPAD_
SET

Water and Sediments Keypad alarm set

7242 EV_ALARM_THERMAL_EXP_
KEYPAD_SET

Thermal Expansion Factor Keypad
alarm set

7249 EV_CHANGE_TEMP_KEYPAD_
VALUE

Meter Temperature Keypad Value
change

7250 EV_CHANGE_PRES_KEYPAD_
VALUE

Meter Pressure Keypad Value change

7286 EV_ALARM_NO_FLOW_START No Flow start alarm set

7286 EV_ALARM_NO_FLOW_END No Flow end alarm set

7287 EV_ALARM_ERROR_START Error Start alarm

7287 EV_ALARM_ERROR_END Error End alarm

7288 EV_ALARM_MAINTENANCE_MODE_
START

Maintenance mode start alarm

7288 EV_ALARM_MAINTENANCE_MODE_
END

Maintenance mode end alarm

7294 EV_CHANGE_MAX_PULSE_
INCREMENT

Max Pulse increment value change

7295 EV_ALARM_RETRO_K_FACTOR_
CoRRECTED

Retrospective K-factor value corrected
alarm

7296 EV_CHANGE_DEN_TEMP_IO_
SELECTION

Densitometer Temperature IO Selection
change

7297 EV_CHANGE_DEN_PRES_IO_
SELECTION

Densitometer Pressure IO Selection
change

7298 EV_CHANGE_MEASURED_
DENSITY_IO_SELECTION

Measured Density IO Selection change

7299 EV_CHANGE_TEMP_IO_SELECTION Temperature IO Selection change

7300 EV_CHANGE_PRES_IO_SELECTION Pressure IO Selection change
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7301 EV_CHANGE_IO_TYPE IO Type change

7302 EV_CHANGE_SDWD_WAIT_TIME ST103A Watchdog wait time value
change

7303 EV_CHANGE_CORIOLISMTR_AS_
DENSIMTR

Coriolis Meter as Densitometer value
change

7304 EV_CHANGE_BASE_DENSITY Base Density value change

7305 EV_CHANGE_DEN_KEYPAD_VALUE Densitometer keypad value change

7306 EV_CHANGE_DENSITOMETER_
AVAILABLE

Densitometer Available value change

7307 EV_CHANGE_DENSITOMETER_
COUNT

Densitometer Count value change

7308 EV_CHANGE_PREFERRED_
DENSIMTR

Preferred Densitometer change

7309 EV_CHANGE_IS_SEDIMENTS_
WATER

Sediments and Water available change

7310 EV_CHANGE_ROUNDING_METHOD Rounding Method change

7311 EV_CHANGE_AVERAGING_
VARIABLE

Averaging Variable change

7312 EV_CHANGE_CPL_CALC_TYPE CPL Calc type change

7313 EV_CHANGE_CONVERGENCE_
CRITERIA

Convergence Criteria value change

7314 EV_CHANGE_MAX_ITERATIONS Maximum iterations value change

7315 EV_CHANGE_ITERATIONS_METHOD Iterations method change

7316 EV_CHANGE_VAPOUR_PRES Vapour Pressure value change

7317 EV_CHANGE_VAPOUR_PRES_
CALC_METHOD

Vapour Pressure Calc method change

Alarm and event operator Bit definition
The table below describes the meaning of each bit of the Alarm/Event value read
from the controller over Enron Modbus.

Table B-5: Alarm and event operator Bit definition
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0 Fixed value changed bit

1 NoFlow=1 Flow=0

2 KeyPad SET=1 RST=0

3 Operator entry work value

4 Error Alarm SET=1 RST=0

5 Fixed or variable flag

6 Maintainance Alarm SET=1 RST=0

7 System command change bit

8 Maxpulse Increment/Retrospective K Factor Alarm SET=1 RST=2

9 Operator change identified bit , 1 for events

10 LoLo bit

11 Lo bit

12 Hi bit

13 HiHi bit

14 Rate of change limit

15
l 1 = Alarm Set

l 0 = Alarm Reset

See the following example:

If the Alarm/Event received is 36864 which is 0x9000 in hex and its bitmap is
shown below.

15 14 13 12 11 10 9 8 7 6 5 4 3 2 1 0

1 0 0 1 0 0 0 0 0 0 0 0 0 0 0 0

From the table we see that bit 15 (alarm) and bit 12 (HI) are set. Thus it is a HI
Alarm.

See the following table for the alarm or event type and its alarm state as well as
event state:

Alarm/Event Type Alarm State Event State

LoLo 33792 1536
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LoLo-Reset 1024 N/A

Lo 34816 2560

Lo-Reset 2048 N/A

Hi 36864 4608

Hi-Reset 4096 N/A

HiHi 40960 8704

HiHi-Reset 8192 N/A

Flow 2 N/A

No-Flow 32770 N/A

KeyPad Set 32772 516

KeyPad Reset 4 N/A

Error Alarm Set 32784 N/A

Error Alarm Reset 16 N/A

Mainitainance ALarm Set 32832 N/A

Mainitainance Alarm Reset 64 N/A

Maxpulse Increment/ Retrospective K Factor Alarm Set 33024 N/A

Maxpulse Increment/ Retrospective K Factor Alarm Reset 256 N/A
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APPENDIX

C
You can check the diagnostic variable values and system status by checking the
global variables.

In this section:

Hxxxx parameters 352

Pxxxx parameters 353

Enumerations 355

GLOBAL VARIABLE PARAMETERS
REFERENCE DICTIONARY
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Hxxxx parameters

Hardware code

Specific to Block (s) SC-UCMX01, SC-UCNN11

Display Name FirmwareMngr.HardwareCode

Variable Name CNTLR_HARDWARECODE

Description Hardware Code

Data Type STRING

Data Size 1 character

Range
l 1 is for CPM

l 2 is for EPM

Class Static

Access Read Only

Related Parameters HardwareType

Hardware major version

Specific to Block (s) SC-UCMX01, SC-UCNN11

Display Name FirmwareMngr.HardwareMajor

Variable Name CNTLR_HARDWAREMAJOR

Description Hardware Major Version

Data Type STRING

Data Size 1 character

Range A, B, C, D...Z

Class Static

Access Read/Write

Related Parameters HardwareMinor
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Pxxxx parameters

PartnerRdnHistReason [1...16]

Specific to
Block (s)

SC-UCNN11

Display
Name

Redundancy.PartnerRdnHistReason

Variable
Name

N/A

Description Redundancy History Reason

Data Type UINT

Data Size 2

Range See "Redundancy History Reason Enumerations" on page 355 for more information.

Class Dynamic

Access Read Only

Related
Parameters

PartnerRdnHistState, PartnerRdnHistTime

Remarks This parameter is read from the redundant partner.

The Redundancy History Reason provides the rational for the occurrence of a
redundancy history state. Includes rational for initial redundancy role determination,
partner compatibility, commencing initial sync, redundancy role change, loss-of-sync,
and inhibit sync.

PartnerRdnHistState [1...16]

Specific to
Block (s)

SC-UCNN11

Display
Name

Redundancy.PartnerRdnHistState

Variable
Name

N/A

Description Redundancy History State
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Data Type UINT

Data Size 2

Range See "Redundancy History State Enumerations" on page 382 for more information.

Class Dynamic

Access Read Only

Related
Parameters

PartnerRdnHistTime, PartnerRdnHistReason

Remarks This parameter is read from the redundant partner.

The Redundancy History State indicates the last 16 milestones of redundancy related
activities. Refer to the associated Redundancy History Reason entry for additional
information (when applicable).

PartnerRdnHistTime [1...16]

Specific to
Block (s)

SC-UCNN11

Display
Name

Redundancy.PartnerRdnHistTime

Variable
Name

N/A

Description Redundancy History Time

Data Type UINT

Data Size 4

Range Local time, seconds since 00:00 1-Jan-1970 (UTC)

Class Dynamic

Access Read Only

Related
Parameters

PartnerRdnHistState, PartnerRdnHistReason

Remarks This parameter is read from the redundant partner.

The Redundancy History Reason provides the rational for the occurrence of a
redundancy history state. Includes rational for initial redundancy role determination,
partner compatibility, commencing initial sync, redundancy role change, loss-of-sync,
and inhibit sync.
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Enumerations

Redundancy History Reason Enumerations

Not all enumerations listed are used with all controllers.

Reason Description

Null (0) History State does not require rational.

PreviouslyPrimary (1) Initial redundancy role of Primary was chosen because
previously retained primary role.

PreviouslySynchronizedSecondary (2) Initial redundancy role of Secondary was chosen
because previously retained synchronized secondary
role.

PreviouslyStandbySecondary (3) Initial redundancy role of Secondary was chosen
because previously retained standby secondary role.

PreviouslyUnsynchronizedSecondary
(4)

Initial redundancy role of Secondary was chosen
because previously retained not synchronized secondary
role.

PreviouslyNonRedundant (5) Initial redundancy role of Non-Redundant was chosen
because previously retained non-redundant role.

PrimaryIpOccupied (6) Initial redundancy role of Secondary was chosen
because primary IP address occupied.

SecondaryIpOccupied (7) Initial redundancy role of Primary was chosen because
secondary IP address occupied.

HardwareLimitation (8) Initial redundancy role was chosen because of hardware
restriction.

OddDeviceIndex (9) Initial redundancy role of Primary was chosen because
module is configured with odd device index.

EvenDeviceIndex (10) Initial redundancy role of Secondary was chosen
because module is configured with even device index.

PartnerIsPrimary (11) Initial redundancy role of Secondary was chosen
because partner already in primary role.

PartnerIsSecondary (12) Initial redundancy role of Primary was chosen because
partner already in secondary role.

PartnerIsNonRedundant (13) Initial redundancy role of Secondary was chosen
because partner already in non-redundant role.
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Reason Description

PartnerIsNoDb (14) Initial redundancy role of Primary was chosen because
partner has no loaded strategy. Note that as a
consequence, the partner in NODB State is rebooted into
the secondary role.

PartnerRunningInBootFirmware (15) Initial redundancy role of Primary was chosen because
partner running in boot firmware. Note that if the partner
was in the primary role, it transitions into the secondary
role.

LaterWallClockTime (16) Initial redundancy role of Primary was chosen because
simultaneous conflict resolved by more recent wall-clock
time.

Compatible (17) Partner module is present and compatible.

Compatible indication for those platforms not sensitive
to difference in firmware versions.

This includes FIM, FIM4, FIM8, FTEB, IOLIM, PGM2, PLC,
and RTU.

DirectCompatible (18) Partner module is present, compatible, and has identical
firmware version. Compatible indication for those
platforms sensitive to difference in firmware versions
when firmware versions are identical.

MigrateCompatible (19) Partner module is present, compatible, but only supports
On Process Migration due to different firmware versions.
Compatible indication for those platforms sensitive to
difference in firmware versions when firmware versions
differ. This implies that the Controller Migration Wizard
must be invoked to coordinate OPM initial
synchronization and switchover to the different firmware
version.

HardwareType (20) Incompatible - Different Hardware Types. Check for a
Factory Information mismatch between the redundant
pair.

FirmwareType (21) Incompatible - Different Firmware Types.

DeviceIndex (22) Incompatible - Incorrect Device Index. Redundant pair
requires consecutive Device index pair.

OpmNotImplemented (23) Incompatible - On Process Migration not implemented.

OpmSequence (24) Incompatible - On Process Migration not supported
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across specified releases. Attempting to migrate across
more than one major release. For example, migration
between R101 and R300 is not allowed; this may be
allowed in later releases.

This reason is also used to prevent synchronization from
a primary controller with newer firmware to a secondary
controller with older firmware because the secondary
controller would not be able to interpret any new
synchronization data from primary controller with newer
firmware.

InitiateSwitchoverCommand (25) User issued switchover command.

InitiateSwapCommand (26) User issued swap command.

PrimaryLonelyOnFte (27) The original synchronized primary module became lonely
on FTE resulting in automatic switchover. In addition, the
unsynchronized controller performs initial-sync with
immediate switchover with this reason when the primary
controller suffers from dual FTE cable disconnect and
the secondary controller has visibility to the FTE network.

Migration (28) Automatic redundancy role change due to on-process
migration.

AlternateSync (29) Automatic redundancy role change due to Alternate Sync
command (that is, one time initial sync across FTE
instead of private path).

DiagnosticFailure (30) Switchover triggered due to diagnostic failure.

FatalError (31) Switchover triggered due to fatal error.

FteDeafMute (32) Switchover triggered due to FTE becoming deaf & mute
even though link integrity signal is still being sensed.

Link1IolLoopbackError (33) Link 1 IOL Loopback Error. The IOL processor has
detected that it cannot see what it has transmitted onto
the wire. This is a switchover trigger because it may
represent a fault in the IOL communication electronics.
Bad IOL wiring and/or rogue IOL device communications
also could cause Loopback Error.

PartnerRequest (34) Partner Requested operation. The redundant partner has
either requested initial sync to be inhibited / aborted or
for role change. Refer to the partner's redundancy history
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parameter for the actual reason.

PartnerBetterPrimary (35) Force role change because partner is better primary
candidate.

DisableSyncCommand (36) User issued disable synchronization command.

PartnerAbsent (37) Partner module absent. Initial-sync is not applicable
without a redundant partner.

PartnerNotCompatible (38) Partner module not compatible. Initial-sync is not
applicable with an incompatible redundant partner.

PartnerPrivatePathDisconnected (39) Redundancy private path cable disconnected.

RedundancyCommOutOfSequenceError
(40)

Redundancy communication out-of-sequence error.
Redundancy communication buffers have been lost
resulting in the receipt of an unexpected sequence
number. This could be a fault in the redundancy
communication private path or in the redundancy
communication electronics.

DataFormatError (41) Redundancy communication format error. Receipt of a
redundancy communication buffer that has an unknown
format ID indicates corrupted data. This could be a fault
in the redundancy communication private path or in the
redundancy communication electronics.

DataChecksumError (42) The secondary received corrupt sync data. The primary
redundancy subsystem applies a checksum on the sync-
data communication buffer and the secondary validates
the checksum against the received sync-data
communication buffer. This could be a fault in the
redundancy communication private path or in the
redundancy communication electronics.

SyncHardwareError (43) Synchronization hardware error. Loss-of-sync due to
sync hardware error disables Auto-Sync. Use the Enable
Synchronization command to trigger initial-sync.

CleanPointTimeout (44) Encountered a timeout condition while performing
clean-point processing. The primary is not able to send
redundancy data to the secondary partner in a timely
fashion.

PrimaryUnknownError (45) Unknown cause on primary module.
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SecondaryUnknownError (46) Unknown cause on secondary module.

AlternateSyncCommand (47) User commanded Alternate Synchronization.

EnableSyncCommand (48) User commanded Enable Synchronization.

MigrationCommand (49) Controller on-process migration.

PartnerReady (50) Compatible partner completed startup initialization.

PartnerPrivatePathConnected (51) Redundancy private path cable reconnected.

PartnerPrivatePathCommunicationError
(52)

Redundancy private path communication error. Invalid
redundancy data was received or the periodic partner
status message was not received over the redundancy
private path.

DataMessageSizeError (53) Redundancy unexpected message size error.

AutoSyncState (54) Auto Sync state is disabled. Initial sync is inhibited while
the Auto Sync State is set to disabled. This is a persistent
inhibit sync reason that is canceled via the Enable Sync
command.

NoFbStart (55) Missing FB_START indication.

SyncDataReceiveError (56) Error occurred on secondary receive of parameterized
sync data.

OutOfSyncBuffers (57) Sync data and tag buffers not allocated.

OutOfIMRs (58) Unable to acquire IMR for receipt of sync data.

LiveListMismatch (59) Mismatch between primary & secondary live list.

LinkStatus (60) Link status.

RtpAttendance (61) RTP attendance.

FteCableStatus (62) Indicates that either both FTE Ethernet cables have been
disconnected (i.e. FTE lonely) or at least one FTE
Ethernet cable has been reconnected. The primary
triggers switchovers due to dual-FTE-cable disconnect.
The synchronized secondary aborts sync due to dual-
FTE-cable disconnect and the secondary inhibits sync
due to dual-FTE-cable disconnect. This secondary
persistent inhibit sync reason can only be canceled by
restoring FTE communications.
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Link1NvsCommands (63) Link 1 Flash operations. Synchronization is aborted
and/or initial- sync is inhibited during the database
initialization that occurs upon I/O Link FB commanded
NVS compaction.

OpmRequired (64) Controller OPM required but not yet enabled.

OpmWaitRestore (65) Controller OPM waiting for Secondary Checkpoint
Restore.

OpmWaitSyncCommand (66) Controller OPM waiting for sync/ switch command from
the Controller Migration Wizard.

OpmAbortCommand (67) Control Migration Wizard commanded migration abort.

OpmRestoreTimeout (68) Controller OPM Secondary Checkpoint Restore timed
out; this occurs if the flow of checkpoint data is stalled
for longer than 2 minutes. This represents abnormal
OPM session termination.

OpmTimeout (69) The redundancy subsystem aborts controller OPM if
control is frozen (during the one-time OPM initial-sync
transfer of Dynamic Data) longer than the maximum
specified time. This represents abnormal OPM session
termination.

OpmInitialSyncTimeout (70) Controller OPM commence initial sync timed out. Initial
sync failed to commence within two minutes following
the receipt of the Migration Wizard command to
commence initial-sync as part of an OPM session. This
represents abnormal OPM session termination.

OpmIoConnectionsTimeout (71) Controller OPM I/O connection timeout. Loss-of-sync
occurred while waiting for the Secondary controller to
form at least the same number of I/O Connections as the
primary controller (as part of initial-sync during an OPM
session). The Secondary Platform FB's LASTOPMNAME
parameter is blank in this case. This represents abnormal
OPM session termination.

OpmIoDataFailure (72) Controller OPM I/O Data failure. Loss-of-sync occurred
while transferring I/O Connection Data (as part of initial-
sync during an OPM session). Although any loss-of-sync
triggers this behavior, the most probable loss-of-sync
cause is the inability of the secondary controller to
interpret the I/O Connection Data format. The Secondary
Platform FB's LASTOPMNAME parameter is blank in this
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case. This represents abnormal OPM session termination.

OpmPeerReferencesMismatch (73) Controller OPM peer reference mismatch. Loss-of-sync
occurred while transferring Peer Cross-Reference ID data
(as part of initial-sync during an OPM session). Although
any loss-of-sync triggers this behavior, the most
probable loss-of- sync cause is the presence of a ghost
peer connection reference. A ghost peer connection
reference exists if the primary controller has knowledge
of a peer connection ID that was not instantiated in the
Secondary controller during OPM Secondary Checkpoint
Restore. The Secondary Platform FB's LASTOPMNAME
parameter is blank in this case. This represents abnormal
OPM session termination.

OpmPeerReferencesFailure (74) Controller OPM peer reference data fail. The one-time
OPM initial-sync transfer of Dynamic Data that occurs
with control frozen contains two components of Peer
Dynamic Data and Block Dynamic Data with the latter
typically being the larger of the two. Loss-of-sync
occurred while transferring Peer Dynamic Data. Although
any loss-of-sync triggers this behavior, the most
probable loss-of-sync cause is the inability of the
secondary controller to interpret the Peer Dynamic Data
format. The Secondary Platform FB's LASTOPMNAME
parameter is blank in this case. This represents abnormal
OPM session termination.

OpmBlockDataTimeout (75) Controller OPM block data transfer timeout. The
redundancy subsystem aborts controller OPM if control
is frozen (during the one-time OPM initial-sync transfer
of Dynamic Data) longer than the maximum specified
time. This represents abnormal OPM session termination.

OpmBlockDataFailure (76) Controller OPM block data fail. The one-time OPM
initial-sync transfer of Dynamic Data that occurs with
control frozen contains two components of Peer
Dynamic Data and Block Dynamic Data with the latter
typically being the larger of the two. Loss-of-sync
occurred while transferring Block Dynamic Data. This
represents abnormal OPM session termination. Although
any loss-of-sync triggers this behavior, the most
probable loss-of-sync cause is either the inability of the
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secondary controller to interpret the Block Dynamic Data
format or the secondary controller has no destination
block to receive the Dynamic Data. The latter is possible
in the presence of a ghost block; a ghost block exists if
the primary controller has knowledge of a block that was
not instantiated in the Secondary controller during OPM
Secondary Checkpoint Restore. The Secondary Platform
FB's LASTOPMNAME parameter indicates the name of
the last block to be (on-process) migrated; the
LASTOPMNAME is used to isolate the name of the first
CEE subordinate block that has detected a dynamic
state data error. In the special case of a ghost block, the
LASTOPMNAME is either blank (because the ghost block
name no longer exists in the ERDB) or indicates the
name of a block that is not loaded to the controller (that
is, only exists on the Control Builder project tree).

OpmFormatError (77) Receive of Controller OPM data failed.

StartupInProgress (78) Platform startup in progress. Initial sync is not allowed
until after the controller has completed system startup.
This is a transient inhibit sync reason that is usually not
seen.

PlatformFunctionBlockLoadState (79) Platform FB load state. Initial-sync is not allowed until
after the Platform FB has been loaded to the controller.

RedundancyConfigurationState (80) The controller is configured as non-redundant. Initial-
sync is not allowed when explicitly configured as non-
redundant. This persistent inhibit sync reason can only
be canceled by reconfiguring the non-redundant
controller as redundant.

Link1PartnerTimeout (81) Link 1 partner startup timeout.

Link2PartnerTimeout (82) Link 2 partner startup timeout.

Link1PartnerNotVisible (83) Link 1 Partner Not Visible.

Link2PartnerNotVisible (84) Link 2 Partner Not Visible.

Link1PartnerMismatch (85) Link 1 Partner Mismatch.

Link2PartnerMismatch (86) Link 2 Partner Mismatch.

StateUnexpected (87) Unexpected State in State Machine. Loss-of-sync
occurred due to internal redundancy state machine
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unexpected transition.

InitialSyncDelay (88) Anti thrash delay in between initial sync attempts. There
is a guaranteed 30 second delay in between initial-sync
attempts. More specifically, for 30 seconds after a
compatible partner is identified, initial-sync is inhibited
with this transient reason.

InitialSyncFail (89) Multiple consecutive initial sync failures. After 3 failed
attempts to perform initial-sync, the Auto Sync State is
automatically set to disabled and the inhibit sync reason
is set to this persistent value. Refer to the redundancy
history for the reasons why initial-sync failed, and issue
the Enable Sync command to attempt initial-sync again
after correcting the abort-sync reason.

DroppingSync (90) Drop-synchronization in progress. Initial-sync cannot
commence until the previous abort sync operation has
been completed. This is a transient inhibit sync reason
that is usually not seen.

CclBinaryLoad (91) Synchronization cannot be maintained during CCL
Binary load.

CeeLoadOrDelete (92) Synchronization cannot be maintained during the
database initialization that occurs upon CEE FB load or
delete.

UnsupportedHardwareVersion (93) Unsupported controller HW version. Initial-sync is
inhibited for controller hardware version that does not
support controller redundancy.

BothRunningInBootFirmware (94) Both running in boot firmware. Initial-sync is only
possible when both partners of a redundant pair are
running in application firmware.

ThisRunningInBootFirmware (95) This module running in boot firmware. Initial-sync is only
possible when both partners of a redundant pair are
running in application firmware.

RedundancyCommOutOfTxBuffersError
(96)

Redundancy communication out-of-TX-buffers error. The
redundancy subsystem cannot send any more
redundancy messages because the TX buffers have been
exhausted. This is a drop-sync trigger.

RedundancyCommTransmitError (97) Redundancy communication transmit error.
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RedundancyCommReceiveError (98) Redundancy communication receive error.

RedundancyCommDeviceReset (99) Redundancy communication device reset.

RedundancyCommBadBufferIndex
(100)

Redundancy communication bad buffer index.

BecomePrimaryCommand (101) Become Primary command.

LowerSerialNumber (102) When performing initial-role-determination or dual role
correction upon re-establishing partner communication,
the redundancy subsystem’s role decision was chosen
due to lower serial number. This reason indicates that the
physical ID of the redundant pair is not well formed
resulting in serial number tie breaker.

HigherSerialNumber (103) When performing initial-role-determination or dual role
correction upon re-establishing partner communication,
the redundancy subsystem’s role decision was chosen
due to higher serial number. This reason indicates that
the physical ID of the redundant pair is not well formed
resulting in serial number tie breaker.

BetterControlAbility (104) Indicates that the controller is a better candidate to be
the primary controller. Switchover immediately occurs
following initial-sync when the secondary controller has
better control ability. Initial-sync is inhibited when the
primary controller has better control ability.

WorseControlAbility (105) Indicates that the controller is a worse candidate to be
the primary controller. Switchover immediately occurs
following initial-sync when only the primary controller
has worse control ability. Initial-sync is inhibited when
only the secondary controller has worse control ability.

PartnerFaultDetected (106) Partner Fault Detected. The partner module was
rebooted and/or powered off.

Link1LoadState (107) Link 1 load has not completed/occurred. Initial-sync is
not allowed to commence until after all link function
blocks have been loaded. This persistent inhibit sync
reason is negated upon load of the link function block to
the controller.

Link2LoadState (108) Link 2 load has not completed/occurred. Initial-sync is
not allowed to commence until after all link function
blocks have been loaded. This persistent inhibit sync
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reason is negated upon load of the link function block to
the controller.

Link3LoadState (109) Link 3 load has not completed/occurred. Initial-sync is
not allowed to commence until after all link function
blocks have been loaded. This persistent inhibit sync
reason is negated upon load of the link function block to
the controller.

Link4LoadState (110) Link 4 load has not completed/occurred. Initial-sync is
not allowed to commence until after all link function
blocks have been loaded. This persistent inhibit sync
reason is negated upon load of the link function block to
the controller.

Link5LoadState (111) Link 5 load has not completed/occurred. Initial-sync is
not allowed to commence until after all link function
blocks have been loaded. This persistent inhibit sync
reason is negated upon load of the link function block to
the controller.

Link6LoadState (112) Link 6 load has not completed/occurred. Initial-sync is
not allowed to commence until after all link function
blocks have been loaded. This persistent inhibit sync
reason is negated upon load of the link function block to
the controller.

Link7LoadState (113) Link 7 load has not completed/occurred. Initial-sync is
not allowed to commence until after all link function
blocks have been loaded. This persistent inhibit sync
reason is negated upon load of the link function block to
the controller.

Link8LoadState (114) Link 8 load has not completed/occurred. Initial-sync is
not allowed to commence until after all link function
blocks have been loaded. This persistent inhibit sync
reason is negated upon load of the link function block to
the controller.

UnexpectedPdTagSetOnLink (115) Unexpected set PD_TAG on link.

UnexpectedPdTagClearOnLink (116) Unexpected clear PD_TAG on link.

UnexpectedNodeAddrSetOnLink (117) Unexpected set node address on link.

UnexpectedNodeAddrClearOnLink Unexpected clear node address on link.
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(118)

DupeNodeAddrDetectedOnLink (119) Duplicate node address detected on link.

UnknownSmEventIndicationOnLink
(120)

Unknown SM event indication on link.

OnProcessMigrationDSDThrottling
(121)

Secondary cannot commit DSD fast enough

RedundancyCommBufferOverflow (122) Communication buffer overflow.

RedundancyDataOverrun (123) Secondary received more synchronization data than it
can accumulate. This is an indication that the secondary
cannot keep up with the rate of redundancy data being
generated by the primary controller.

RedundancyResourceLocked (124) Resource Locked.

OpenIoConnectionsTimeout (125) I/O connections open timeout.

RedundancyModuleRemoval (126) Controller detected removal under power. This may
indicate that the controller is not fully inserted into the
rack.

OpenSyncDataConnectionError (127) Sync connection open error.

OpenTrackDataConnectionError (128) Track connection open error.

InitialSyncTimeout (129) Initial-sync timed out

EnableStandbyCommand (130) User commanded Enable Standby.

BadAddressOnLink1 (131) Incorrect address on link 1. This is typically caused by
bad wiring, bad hardware, or both.

1 - Check that there is no "noise on the wire" as this
causes the FIM to change addresses per FF spec.

2 - Check that the primary and secondary FIMs are
connected to the same RTP.

3 - Check that the RTP is good and that it has a good
fuse.

4 - Check for proper termination on the H1 link.

5 - Check that there are no shorts in the wiring.

6 - Check that the wiring is properly shielded.

7 - Check that there are no failed devices.

BadAddressOnLink2 (132) Incorrect address on link 2. This is typically caused by
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bad wiring, bad hardware, or both.

1 - Check that there is no "noise on the wire" as this
causes the FIM to change addresses per FF spec.

2 - Check that the primary and secondary FIMs are
connected to the same RTP.

3 - Check that the RTP is good and that it has a good
fuse.

4 - Check for proper termination on the H1 link.

5 - Check that there are no shorts in the wiring.

6 - Check that the wiring is properly shielded.

7 - Check that there are no failed devices.

BadAddressOnLink3 (133) Incorrect address on link 3. This is typically caused by
bad wiring, bad hardware, or both.

1 - Check that there is no "noise on the wire" as this
causes the FIM to change addresses per FF spec.

2 - Check that the primary and secondary FIMs are
connected to the same RTP.

3 - Check that the RTP is good and that it has a good
fuse.

4 - Check for proper termination on the H1 link.

5 - Check that there are no shorts in the wiring.

6 - Check that the wiring is properly shielded.

7 - Check that there are no failed devices.

BadAddressOnLink4 (134) Incorrect address on link 4. This is typically caused by
bad wiring, bad hardware, or both.

1 - Check that there is no "noise on the wire" as this
causes the FIM to change addresses per FF spec.

2 - Check that the primary and secondary FIMs are
connected to the same RTP.

3 - Check that the RTP is good and that it has a good
fuse.

4 - Check for proper termination on the H1 link.

5 - Check that there are no shorts in the wiring.

6 - Check that the wiring is properly shielded.

7 - Check that there are no failed devices.
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BadAddressOnLink5 (135) Incorrect address on link 5. This is typically caused by
bad wiring, bad hardware, or both.

1 - Check that there is no "noise on the wire" as this
causes the FIM to change addresses per FF spec.

2 - Check that the primary and secondary FIMs are
connected to the same RTP.

3 - Check that the RTP is good and that it has a good
fuse.

4 - Check for proper termination on the H1 link.

5 - Check that there are no shorts in the wiring.

6 - Check that the wiring is properly shielded.

7 - Check that there are no failed devices.

BadAddressOnLink6 (136) Incorrect address on link 6. This is typically caused by
bad wiring, bad hardware, or both.

1 - Check that there is no "noise on the wire" as this
causes the FIM to change addresses per FF spec.

2 - Check that the primary and secondary FIMs are
connected to the same RTP.

3 - Check that the RTP is good and that it has a good
fuse.

4 - Check for proper termination on the H1 link.

5 - Check that there are no shorts in the wiring.

6 - Check that the wiring is properly shielded.

7 - Check that there are no failed devices.

BadAddressOnLink7 (137) Incorrect address on link 7. This is typically caused by
bad wiring, bad hardware, or both.

1 - Check that there is no "noise on the wire" as this
causes the FIM to change addresses per FF spec.

2 - Check that the primary and secondary FIMs are
connected to the same RTP.

3 - Check that the RTP is good and that it has a good
fuse.

4 - Check for proper termination on the H1 link.

5 - Check that there are no shorts in the wiring.

6 - Check that the wiring is properly shielded.

7 - Check that there are no failed devices.
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BadAddressOnLink8 (138) Incorrect address on link 8. This is typically caused by
bad wiring, bad hardware, or both.

1 - Check that there is no "noise on the wire" as this
causes the FIM to change addresses per FF spec.

2 - Check that the primary and secondary FIMs are
connected to the same RTP.

3 - Check that the RTP is good and that it has a good
fuse.

4 - Check for proper termination on the H1 link.

5 - Check that there are no shorts in the wiring.

6 - Check that the wiring is properly shielded.

7 - Check that there are no failed devices.

FTEB_IoManager (139) FTEB IO Manager.

Link1PartnerNotLoaded (140) Link 1 Partner Not Loaded.

Link2PartnerNotLoaded (141) Link 2 Partner Not Loaded.

Link1IoLinkLonely (142) Link 1 IOLINK Lonely.

Link2IoLinkLonely (143) Link 2 IOLINK Lonely.

Link2IolLoopbackError (144) Link 2 IOL Loopback Error. The IOL processor has
detected that it cannot see what it has transmitted onto
the wire. This is a switchover trigger because it may
represent a fault in the IOL communication electronics.
Bad IOL wiring and/or rogue IOL device communications
also could cause Loopback Error.

Link2NvsCommands (145) Link 2 Flash operations. Synchronization is aborted
and/or initial- sync is inhibited during the database
initialization that occurs upon I/O Link FB commanded
NVS compaction.

CommDriverTxFault (146) Redundancy communication driver TX fault. There are
too many outstanding requests prohibiting any further
transmissions.

Link1IntCircuitFail (147) Link 1 IOL Interrupt Circuit Failed. Upon receipt of an
Interrupt Circuitry Fault error from the IOL processor,
attempt redundancy role change. This occurs if the IOL
signals, CLRGHO and/or GAPINT, are rendered
inoperable (SA0 or SA1).
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Link2IntCircuitFail (148) Link 2 IOL Interrupt Circuit Failed. Upon receipt of an
Interrupt Circuitry Fault error from the IOL processor,
attempt redundancy role change. This occurs if the IOL
signals, CLRGHO and/or GAPINT, are rendered
inoperable (SA0 or SA1).

SimultaneousStartup (149) Simultaneous Startup detected. Target role is primary or
non-redundant but primary IP has been requested (that
is, ARPed during dual power on); override as secondary
to avoid dual primary role. Note that this intentionally
may result in dual secondary that is considered as being
better than dual primary.

ClnPointOverrun (150) Secondary received more cleanpoints than it can
process. This is an indication that the secondary cannot
keep up with the rate of redundancy data being
generated by the primary controller.

PrimaryRole (151) Primary redundancy role.

SecondaryRole (152) Secondary redundancy role.

NonRedundantRole (153) Non-Redundant redundancy role.

FieldDevNetworkAddr (154) Incompatible - Incorrect Sensor Network Address.

IpAddress (155) Incompatible - Incorrect IP Address.

NotLoaded (156) Configuration Not Loaded

ConfigurationMismatch (157) Configuration Mismatch

MessageType (158) Unexpected message type.

PartnerConnection (159) Connection not established with partner.

FieldDevNetworkID (160) Incompatible - Incorrect Sensor Network ID.

PriPartnIpAddress (161) Incompatible - Incorrect Pri Partner IP Address
configuration.

SecPartnIpAddress (162) Incompatible - Incorrect Sec Partner IP Address
configuration.

FieldDevFreqHopMode (163) Incompatible - Incorrect Sensor Frequency Hopping
Mode.

FieldDevFreqHopID (164) Incompatible - Incorrect Sensor Frequency Hopping ID.

FieldDevNetworkNotCnfg (165) Incompatible - Sensor Network not configured.
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InvalidSystemStatusMemory (166) System Status Memory in RAM or NVS is invalid or
resulted in access error.

NonRetentionStartup (167) Non-Retention Startup.

PhysicalIdA (168) Physical ID A.

PhysicalIdB (169) Physical ID B.

PrimaryAndSecondaryIpOccupied (170) Both Primary & Secondary IP addresses occupied.

Link1FieldNetworkFailure (171) PROFIBUS Network communication failure on link 1.

Link2FieldNetworkFailure (172) PROFIBUS Network communication failure on link 2.

FdnPrimaryIpOccupied (173) Initial redundancy role of Secondary was chosen
because the primary IP address is occupied on the Field
Device Network (FDN).

PcnPrimaryIpOccupied (174) Initial redundancy role of Secondary was chosen
because the primary IP address is occupied on the
Process Control Network (PCN).

FdnSecondaryIpOccupied (175) Initial redundancy role of Primary was chosen because
the secondary IP address is occupied on the Field Device
Network (FDN).

PcnSecondaryIpOccupied (176) Initial redundancy role of Primary was chosen because
the secondary IP address is occupied on the Process
Control Network (PCN).

FdnBothRedunIpOccupied (177) Primary and Secondary FDN IP Addresses are occupied.

PcnBothRedunIpOccupied (178) Primary and Secondary PCN IP Addresses are occupied.

FdnPcnBothRedunIpOccupied (179) Primary and Secondary, FDN and PCN IP Addresses are
occupied.

FdnConfiguration (180) Incorrect FDN Ethernet Interface configuration.
Redundant partners must have identical subnet masks,
and redundant partners must have unique IP addresses
that are visible to one another for the given subnet mask.

PcnConfiguration (181) Incorrect PCN Ethernet Interface configuration.
Redundant partners must have identical subnet masks,
and redundant partners must have unique IP addresses
that are visible to one another for the given subnet mask.

FdnEthernetStatus (182) Indicates that the FDN Ethernet cable was either
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disconnected or reconnected. The synchronized primary
triggers switchovers due to FDN Ethernet cable
disconnect. The synchronized secondary aborts sync and
the secondary in general inhibits sync due to FDN
Ethernet cable disconnects. This secondary persistent
inhibit sync reason can only be canceled by restoring
FDN Ethernet communications.

PcnEthernetStatus (183) Indicates that the PCN Ethernet cable was either
disconnected or reconnected. The synchronized primary
triggers switchovers due to PCN Ethernet cable
disconnect. The synchronized secondary aborts sync and
the secondary in general inhibits sync due to PCN
Ethernet cable disconnects. This secondary persistent
inhibit sync reason can only be canceled by restoring
PCN Ethernet communications.

PartIDConflict (184) Indicates that both controllers have the same physical ID.

NtpConfigNeeded (185) Indicates that secondary has not yet configured its NTP
daemon from primary. Initial sync is blocked until NTP
configuration completes.

UCNnumber (186) The controller was loaded resulting in a different UCN
address and redundancy state than the current
redundancy state requiring a role change.

SecureCommConfigMisMmtch (187) The primary and secondary have different secure
communication security levels which inhibits initial
synchronization.

SecureCommPolicyMismatch (188) The primary and secondary have different secure
communication active policies which inhibits initial
synchronization.

DownlinkNetworkCableSts (189) Indicates that the Downlink Ethernet cable was either
disconnected or reconnected. The synchronized primary
triggers switchovers due to Downlink Ethernet cable
disconnect. The synchronized secondary aborts sync due
to Downlink Ethernet cable disconnect and the
secondary inhibits sync due to Downlink Ethernet cable
disconnects. This secondary persistent inhibit sync
reason can only be canceled by restoring Downlink
Ethernet communications.

FdnPartNotVis (190) Partner not visible across FDN interface.
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PcnPartNotVis (191) Partner not visible across PCN interface.

UpgStartTask (192) C200-to-C300 Upgrade: Start Task

UpgConnOpened (193) C200-to-C300 Upgrade: Connection Opened

UpgResetEnable (194) C200-to-C300 Upgrade: Reset Enable

UpgSessionComplete (195) C200-to-C300 Upgrade: Session Complete

UpgConnFailed (196) C200-to-C300 Upgrade: Connection to the Targets
Failed.

UpgResetFailed (197) C200-to-C300 Upgrade: Reset Targets Failed.

Unused (198) Unused

Unused (199) Unused

Unused (200) Unused

FteNetworkDisconnected (201) A redundancy communication error over the FTE network
implies there is break in the communication path.

DownlinkNetworkDisconnected (202) A redundancy communication error over the Downlink
Ethernet network implies there is break in the
communication path.

FTENetworkCommunicationError (203) Invalid redundancy data was received or the periodic
partner status message was not received over the FTE
network.

DownlinkNetworkCommunicationError
(204)

Invalid redundancy data was received or the periodic
partner status message was not received over the
Downlink Ethernet network.

SyncDataUnexpectedState (205) The primary controller is unable to participate in initial-
sync because a block refused to commence initial-sync.

ProfibusDriverWatchdogTimeout (206) The PROFIBUS Driver has abnormally terminated
operation due to watchdog timeout. When detected on a
synchronized primary, this results in redundancy
switchover. One possible cause may be that the
controller has a high CPU load.

ProfibusDriverStoppingTimeout (207) The PROFIBUS Driver has abnormally terminated
operation due to stop command timeout. When detected
on a synchronized primary, this results in redundancy
switchover.
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ProfibusDriverResettingTimeout (208) The PROFIBUS Driver has abnormally terminated
operation due to reset command timeout. When
detected on a synchronized primary, this results in
redundancy switchover.

ProfibusDriverChannelInitFail (209) The PROFIBUS Driver has abnormally terminated
operation due to channel initialization failure. When
detected on a synchronized primary, this results in
redundancy switchover.

ProfibusDriverConfLoadFail (210) The secondary has lost view to the primary because
PROFIBUS Driver has failed to load link configuration.
When detected, the synchronized or synchronizing
secondary aborts sync.

ProfibusDriverLostViewToPrimary (211) The secondary controller monitors the presence of the
partner across the PROFIBUS network and aborts
synchronization when it the primary does not respond to
the secondary’s scan request.

ProfibusDriverChannelReadFail (212) The PROFIBUS Driver has abnormally terminated
operation due to I/O read failure. When detected on a
synchronized primary, this results in redundancy
switchover.

FTENetworkConnectionReset (213) The partner intentionally reset the redundancy
communication connection over the FTE network. When
detected, the synchronized or synchronizing controller
aborts sync.

DownlinkNetworkConnectionReset
(214)

The partner intentionally reset the redundancy
communication connection over the Downlink Ethernet
network. When detected, the synchronized or
synchronizing controller aborts sync.

PrimaryLonelyOnDownlinkNetwork
(215)

When an unsynchronized primary controller suffers from
Downlink Ethernet network cable disconnect and the
secondary controller has visibility to the Downlink
Ethernet network, the controller performs initial-sync
with immediate switchover with this reason.

PrimaryDupIpOnDownlinkNetwork (216) When an unsynchronized primary controller suffers from
Duplicate IP Address on the Downlink Ethernet network
and the secondary controller has visibility to the
Downlink Ethernet network, the controller performs
initial-sync with immediate switchover with this reason.

374



Appendix C - Global variable parameters reference dictionary

Reason Description

DownlinkNetworkDuplicateIp (217) The primary and secondary controllers change their
controllability parameter to worse with this reason when
they detect a duplicate IP Address on the Downlink
Ethernet network.

DownlinkNetworkConfiguration (218) The secondary controller inhibits synchronization until it
has configured its IP Address and Mask for the Downlink
Ethernet network communication and confirmed that no
duplicate IP address exists on the Downlink Ethernet
network.

DownlinkNetworkCommunication (219) When the primary has visibility to the Downlink Ethernet
network, it inhibits synchronization (with this reason)
until it establishes communication with the secondary
over the Downlink Ethernet network. This ensures that
the secondary has the same view as the primary on the
Downlink Ethernet network.

FTENetworkCommunication (220) When the primary has visibility to the FTE network, it
inhibits synchronization (with this reason) until it
establishes communication with the secondary over the
FTE network. This ensures that the secondary has the
same view as the primary on the FTE network.

DeviceConnectionStatus (221) The Primary Interface Module triggers switchover (with
this reason) when the primary transitions from
communicating with at least one Device to unable to
communicate with all Devices (and there are Devices
configured). The Secondary Interface Module drops
synchronization (with this reason) when the secondary is
unable to open a connection with a Device (when the
primary interface module has successfully established a
connection with the same Device).

RedundancyCommOutOfRxBuffersError
(222)

Redundancy communication out-of-RX-buffers error.
The redundancy subsystem cannot receive any more
redundancy messages because the RX buffers have been
exhausted. This is a drop-sync trigger because received
messages are discarded until RX buffers are freed
resulting in suspect redundancy communication.

RedundancyCommQueueFull (223) Redundancy communication queue is full error. The
redundancy subsystem has received more
communication events than it can process resulting in
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queue overflow. This is a drop-sync trigger because
received messages are discarded until queue entries are
freed resulting in suspect redundancy communication.

LiveListReadFailedLink1 (224) Live List reads fail on Link 1.

The primary controller triggers switchover (with this
reason) when the primary can no longer read and verify
its copy of the Fieldbus Live List.

The secondary controller aborts synchronization (with
this reason) when the secondary can no longer read and
verify its copy of the Fieldbus Live List.

This is typically caused by bad wiring, bad hardware, or
both.

1 - Check that there is no "noise on the wire" as this
prevents normal communications on the H1 link.

2 - Check for proper termination on the H1 link.

3 - Check that there are no shorts in the wiring.

4 - Check that the wiring is properly shielded.

5 - Check that there are no failed devices.

LiveListReadFailedLink2 (225) Live List reads fail on Link 2.

The primary controller triggers switchover (with this
reason) when the primary can no longer read and verify
its copy of the Fieldbus Live List.

The secondary controller aborts synchronization (with
this reason) when the secondary can no longer read and
verify its copy of the Fieldbus Live List.

This is typically caused by bad wiring, bad hardware, or
both.

1 - Check that there is no "noise on the wire" as this
prevents normal communications on the H1 link.

2 - Check for proper termination on the H1 link.

3 - Check that there are no shorts in the wiring.

4 - Check that the wiring is properly shielded.

5 - Check that there are no failed devices.

LiveListReadFailedLink3 (226) Live List reads fail on Link 3.

The primary controller triggers switchover (with this
reason) when the primary can no longer read and verify
its copy of the Fieldbus Live List.
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The secondary controller aborts synchronization (with
this reason) when the secondary can no longer read and
verify its copy of the Fieldbus Live List.

This is typically caused by bad wiring, bad hardware, or
both.

1 - Check that there is no "noise on the wire" as this
prevents normal communications on the H1 link.

2 - Check for proper termination on the H1 link.

3 - Check that there are no shorts in the wiring.

4 - Check that the wiring is properly shielded.

5 - Check that there are no failed devices.

LiveListReadFailedLink4 (227) Live List reads fail on Link 4.

The primary controller triggers switchover (with this
reason) when the primary can no longer read and verify
its copy of the Fieldbus Live List.

The secondary controller aborts synchronization (with
this reason) when the secondary can no longer read and
verify its copy of the Fieldbus Live List.

This is typically caused by bad wiring, bad hardware, or
both.

1 - Check that there is no "noise on the wire" as this
prevents normal communications on the H1 link.

2 - Check for proper termination on the H1 link.

3 - Check that there are no shorts in the wiring.

4 - Check that the wiring is properly shielded.

5 - Check that there are no failed devices.

LiveListReadFailedLink5 (228) Live List reads fail on Link 5.

The primary controller triggers switchover (with this
reason) when the primary can no longer read and verify
its copy of the Fieldbus Live List.

The secondary controller aborts synchronization (with
this reason) when the secondary can no longer read and
verify its copy of the Fieldbus Live List.

This is typically caused by bad wiring, bad hardware, or
both.

1 - Check that there is no "noise on the wire" as this
prevents normal communications on the H1 link.
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2 - Check for proper termination on the H1 link.

3 - Check that there are no shorts in the wiring.

4 - Check that the wiring is properly shielded.

5 - Check that there are no failed devices.

LiveListReadFailedLink6 (229) Live List reads fail on Link 6.

The primary controller triggers switchover (with this
reason) when the primary can no longer read and verify
its copy of the Fieldbus Live List.

The secondary controller aborts synchronization (with
this reason) when the secondary can no longer read and
verify its copy of the Fieldbus Live List.

This is typically caused by bad wiring, bad hardware, or
both.

1 - Check that there is no "noise on the wire" as this
prevents normal communications on the H1 link.

2 - Check for proper termination on the H1 link.

3 - Check that there are no shorts in the wiring.

4 - Check that the wiring is properly shielded.

5 - Check that there are no failed devices.

LiveListReadFailedLink7 (230) Live List reads fail on Link 7.

The primary controller triggers switchover (with this
reason) when the primary can no longer read and verify
its copy of the Fieldbus Live List.

The secondary controller aborts synchronization (with
this reason) when the secondary can no longer read and
verify its copy of the Fieldbus Live List.

This is typically caused by bad wiring, bad hardware, or
both.

1 - Check that there is no "noise on the wire" as this
prevents normal communications on the H1 link.

2 - Check for proper termination on the H1 link.

3 - Check that there are no shorts in the wiring.

4 - Check that the wiring is properly shielded.

5 - Check that there are no failed devices.

LiveListReadFailedLink8 (231) Live List reads fail on Link 8.

The primary controller triggers switchover (with this
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reason) when the primary can no longer read and verify
its copy of the Fieldbus Live List.

The secondary controller aborts synchronization (with
this reason) when the secondary can no longer read and
verify its copy of the Fieldbus Live List.

This is typically caused by bad wiring, bad hardware, or
both.

1 - Check that there is no "noise on the wire" as this
prevents normal communications on the H1 link.

2 - Check for proper termination on the H1 link.

3 - Check that there are no shorts in the wiring.

4 - Check that the wiring is properly shielded.

5 - Check that there are no failed devices.

PlatformConfig (232) Indicates the controller blocks initial-sync to perform
configuration alignment where the secondary controller
is updated to match the primary controller’s
configuration.

RS232SignalFailure (233) RS232 Signal Failure

RS485SignalFailure (234) RS485 Signal Failure

Ethernet0LinkStatus (235) Ethernet device #0 cable connection status.

Ethernet1LinkStatus (236) Ethernet device #1 cable connection status.

Ethernet2LinkStatus (237) Ethernet device #2 cable connection status.

Ethernet2RingStatus (238) Ethernet device #2 ring switch status.

FirmwareAlignment (239) Indicates the controller blocks initial-sync to perform
firmware alignment where the secondary controller is
updated to match the primary controller’s firmware
version.

OnProcessMigration (240) Firmware Load - On-Process Migration.

OffProcessMigration (241) Firmware Load - Off-Process Migration.

SDCardValidation (242) Check the redundant pair have compatible SD Cards.

IOTASlot1 (243) When performing initial-role-determination or dual role
correction upon re-establishing partner communication,
the redundancy subsystem’s role decision was chosen
due to lower slot number. This reason indicates that the
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physical ID of the redundant pair is well formed resulting
in slot number tie breaker.

IOTASlot2 (244) When performing initial-role-determination or dual role
correction upon re-establishing partner communication,
the redundancy subsystem’s role decision was chosen
due to lower slot number. This reason indicates that the
physical ID of the redundant pair is well formed resulting
in slot number tie breaker.

DualRoleOnLoad (245) Configuration load resulted in dual-role. This scenario is
possible when a CPM in slot 1 is configured non-
redundant, another CPM is inserted into the partner slot
2, and this new partner takes the primary role. Upon
updating the configuration of the slot 1 CPM to enable
redundancy, it detects the partner in slot 2 and
commands it to reboot with this reason.

RestartCmd (246) The restart command to the primary controller is an off-
process operation that results in drop-sync with this
reason before performing the commanded operation.

ResetFactoryDefaultCmd (247) The reset-to-factory-defaults command to the primary
controller is an off-process operation that results in
drop-sync with this reason before performing the
commanded operation.

EthernetConfiguration (248) On startup the default Ethernet configuration is not valid
for redundant controller operation when the controller is
at factory default configuration. Load the controller with
a valid configuration to recover.

SecEclrException (249) The secondary controller encountered a common
language runtime.

SecRecErrSeqNum(250) The secondary controller’s common language runtime
application received an erroneous sequence number.

PreviouslyInitialSyncdSecondary (251) Initial redundancy role of Primary was chosen because
previously retained initial-syncd secondary role.

EthCommsException (252) I/O communication exception resulted switchover.

IOConnectionIsZero (253) I/O connection count is zero so cause Drop on
secondary, check secondary connection count.

PriEclrException (254) The primary controller encountered a common language
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runtime exception.

DnpRetainedEventsInit (255) Retained events initialization.

FlashRDWRErr (256) Internal flash read/write error.

MRAMRDWRErr (257) Internal MRAM read/write error.

OnlineDiagSoftFailure (258) Online diagnostics detected a soft failure.

OnlineDiagHardFailure (259) Online diagnostics detected a hard failure.

PlcStop (260) Inhibit sync when controller is in the stopped state.

ConfigLoad (261) Synchronization is not supported during configuration
load to the controller. The controller drops and inhibits
sync on configuration load with this transient reason.

PreInitialSyncFail (262) Multiple consequtive pre-initial-sync failures. After 3
failed attempts to perform pre-initial-sync, the Auto Sync
State is automatically set to disabled and the inhibit sync
reason is set to this persistent value. Refer to the
redundancy history for the reasons why pre-initial-sync
failed, and issue the Enable Sync command to attempt
initial-sync again after correcting the abort-sync reason.

ModeSwitchMismatch (263) Synchronization is not supported when the controllers
have mismatched Mode Switch settings.

SecureBootMismatch (264) Synchronization is not supported when the controllers
have mismatched Secure Boot status.

InvalidBootFirmware (265) The controller has two firmware versions boot (recovery)
and application (product). Steady-state synchronization
is not supported while a controller’s boot firmware is
invalid.

ReportConnStatus (266) Report Connection Status.

IPSecEnrollmentInfoMismatch (267) Primary does not have IPSec enrollment information, but
secondary does.

IPSecProfileStatusMismatch (268) One or more profile statuses do not match.

IPSecStatusMismatch (269) IPSec statuses on the primary and secondary do not
match.

IPSecSyncFailure (270) Failure on primary when attempting to send sync data to
secondary.
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SecureBootKrlMismatch (271) The Secure Boot Key Revocation List (KRL) of the
primary and secondary controllers are different.

Redundancy History State Enumerations

Not all enumerations listed are used with all controllers.

State Description

Null (0) N/A history state null entry.

Startup (1) Module released from reset.

NonRedun (2) Module configured as non-redundant.

Primary (3) Module transitioned into the Primary redundancy role. Refer to
the associated Redundancy History Reason for the reason why.

Secondary (4) Module transitioned into the Secondary redundancy role. Refer
to the associated Redundancy History Reason for the reason
why.

NoPartner (5) Partner absent synchronization state. This module is not
communicating with a redundant partner This could be due to
a fault in the redundancy private path, a fault in the redundancy
communication electronics, or simply because the partner is
powered off.

Incompatible (6) Incompatible synchronization state. This module is
communicating with a partner across the redundancy private
path, but that partner is incompatible. Refer to the associated
Redundancy History Reason for the reason why.

PartnerVisble (7) Partner visible synchronization state. This module is
communicating with a compatible redundancy partner.

SyncInProgress (8) Synchronization in progress synchronization state. This module
is performing initial transfer of redundancy data from the
primary to the secondary. Redundancy role change is not
possible in this state. Initial synchronization takes on the order
of minutes.

Synchronized (9) Synchronized synchronization state. This redundant pair has
completed initial synchronization and is performing
continuous synchronization maintenance. Redundancy role
change is allowed in this state.
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Standby (10) Standby synchronization state. The purpose of the Standby
mode of operation is to improve the software upgrade scenario
by providing the user with a convenient means to fallback to a
previous software and database, if problems are encountered
during upgrade. While in the Standby State, the secondary
controller has a database that was previously synchronized with
the primary controller but the secondary is no longer receiving
synchronization-data updates from the primary controller.
Moreover, a Standby Secondary controller is able to switchover
into the primary role with this stale database. There is no time
limit to the time duration of the Standby mode of operation,
and as a consequence of the secondary not being
synchronized, switchover to the secondary may cause a bump
in outputs.

AutoSyncDsbled (11) Auto synchronization disabled. Refer to the associated
Redundancy History Reason for the reason why.

AutoSyncEnbled (12) Auto synchronization enabled. This transition only occurs on
the receipt of the Enable Synchronization command.

AlternateSyncCommand (13) Module received the Alternate Synchronization Command.
When the primary redundancy electronics are faulted, this is
used to perform one-time initial-sync over FTE (instead of the
redundancy private path) followed by immediate switchover.

BecomePrimaryCommand (14) Module received the Become Primary command. This
commands an unsynchronized secondary module to transition
into the primary role in the absence of a partner module. More
specifically, this command is only applicable if the
unsynchronized secondary has no view to a partner module
across the redundancy cable and the primary IP address is not
occupied.

DisableSyncCommand (15) Module received the Disable Sync Command. This is used to
drop synchronization for a module in the
syncing/syncd/standby state and prevent future initial-sync
attempts by disabling Auto-Sync.

EnableSyncCommand (16) Module received the Enable Sync Command. This transitions
the Auto-Sync state to Enabled, resets the initial-sync failure
count (to allow maximum of 3 trys), and triggers initial-sync.

EnableStandbyCommand (17) Module received the Enable Standby Command. This
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commands a redundant controller pair in the Synchronization
Maintenance State to switchover into the Standby State. While
in the Standby State, the secondary controller has a database
that was previously synchronized with the primary controller but
the secondary is no longer receiving synchronization-data
updates from the primary controller. This command is useful for
testing the expected behavior of a configured control strategy
if the redundant controller pair ever had to invoke the Go-Back
option during a controller On-Process Migration. More
specifically, after entering the Standby State, issue the
switchover command, and the controller with the stale database
switches into the primary role. The Disable Synchronization
command exits the Standby State.

SyncAbort (18) Encountered loss-of-sync condition. Refer to the associated
Redundancy History Reason for the reason why.

RoleChange (19) Redundancy Role Change occurred. Refer to the associated
Redundancy History Reason for the reason why.

InitialSyncFail (20) Once the Auto Sync State is enabled, loss of synchronization is
automatically followed by an automatic attempt to
resynchronize the redundant controller pair. However, after a
maximum of 3 initial-sync failures, the Auto Sync State is
disabled with an inhibit sync reason of Initial Sync Fail. Once
initial-sync is inhibited due to “Initial Sync fail”, the Enable
Synchronization command must be used to retry initial-sync
(after the problem preventing initial-sync has been resolved).

AbortSync (21) Encountered loss-of-sync condition. Refer to the associated
Redundancy History Reason for the reason why.

AllowSync (22) Indicates negation of an inhibit sync reason. Refer to the
associated Redundancy History Reason for the reason why.

InhibitSync (23) Indicates assertion of an inhibit sync reason. Refer to the
associated Redundancy History Reason for the reason why.

ControllabilityBetter (24) This module is better able to control. Refer to the associated
Redundancy History Reason for the reason why.

ControllabilityEqual (25) Both modules of a redundant pair are equally able to control.

ControllabilityWorse (26) This module is worse able to control. Refer to the associated
Redundancy History Reason for the reason why.

OpmSessionEnabled (27) The Controller Migration Wizard has commenced a controller
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On-Process Migration session.

OpmBlocksCreated (28) As part of an OPM session, the Migration Wizard completed
Secondary Checkpoint Restore to instantiate the control
strategy on the secondary controller.

OpmInitialSync (29) Controller Migration Wizard commanded the controller to
commence initial-sync as part of an OPM session.

OpmOpenIoConnections (30) The primary controller has commenced transfer of I/O
connection related data as part of initial-sync during an OPM
session.

OpmMatchPeerReferences (31) The primary controller has commenced transfer of CDA Peer
Cross-Reference ID data as part of initial-sync during an OPM
session.

OpmTransferData (32) The primary controller has commenced transfer of Block
Dynamic Data as part of initial-sync during an OPM session.

OpmSessionSuccess (33) Upon the successful completion of OPM initial-sync,
switchover follows shortly after (for example, <100 ms). This
represents successful completion of the controller OPM
session.

OpmSessionFailure (34) OPM session terminated due to failure. Refer to the associated
Redundancy History Reason for the reason why.

RedundancyCommunicationError
(35)

Redundancy Communication Error. Refer to the associated
Redundancy History Reason for the reason why.

BecomePrimaryDecision (36) When redundancy communication is established after both
modules are committed to the same redundancy role, the
redundancy subsystem tries to correct dual-role situations. This
module has won primaryship in a dual primary situation. Refer
to the associated Redundancy History Reason for the reason
why.

BecomeSecondaryDecision (37) When redundancy communication is established after both
modules are committed to the same redundancy role, the
redundancy subsystem tries to correct dual-role situations. This
module has won secondaryship in a dual secondary situation.
Refer to the associated Redundancy History Reason for the
reason why.

SwitchoverTrigger (38) Redundancy role change has been requested. Refer to the
associated Redundancy History Reason for the reason why.
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OpmPartialColdInit (39) In the event that one or more blocks have not yet implemented
OPM support, the default behavior is to cold initialize that
block. This indicates that one or more blocks have been cold
initialized. This represents successful completion of the
controller OPM session.

ConfiguredRedundant (40) The controller is configured as redundant.

ConfiguredNonRedundant (41) The controller is configured as non-redundant.

PhysicalIdA (42) [WDM] Physical ID changed to A. On the primary, the user
issued the command to toggle physical ID. On the secondary,
either the secondary’s physical ID was the same as that of
primary (i.e. automatic correction) or the user issued the
command to toggle physical ID.

PhysicalIdB (43) [WDM] Physical ID changed to B. On the primary, the user
issued the command to toggle physical ID. On the secondary,
either the secondary’s physical ID was the same as that of
primary (i.e. automatic correction) or the user issued the
command to toggle physical ID.

UCNAddrChg (44) Redundancy Role Change occurred for a UCN resident
controller. Refer to the associated RDNHISTREASON for the
reason why.

UpgStartTask (45) C200-to-C300 Upgrade: Start Task

UpgConnOpened (46) C200-to-C300 Upgrade: Connection Opened

UpgResetEnable (47) C200-to-C300 Upgrade: Reset Enable

UpgSessionComplete (48) C200-to-C300 Upgrade: Session Complete

UpgConnFailed (49) C200-to-C300 Upgrade: Conn to the Targets Failed

UpgResetFailed (50) C200-to-C300 Upgrade: Reset Targets Failed

UpgBecomePriCmd (51) C200-to-C300 Upgrade: Become Primary command

CutoverStart (52) ACERR

InitialSyncd (53) Initial Syncd synchronization state. This module is performing
post-initial-syncr of non-critical redundancy data from the
primary to the secondary. Redundancy role change is possible
in this state. Post-initial-synchronization can take on the order
of hours depending on the amount of non-critical data.
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NOTICES

Trademarks

Experion® is a registered trademark of Honeywell International, Inc.

ControlEdge™ is a trademark of Honeywell International, Inc.

OneWireless™ is a trademark of Honeywell International, Inc.

Other trademarks

Microsoft and SQL Server are either registered trademarks or trademarks of
Microsoft Corporation in the United States and/or other countries.

Trademarks that appear in this document are used only to the benefit of the
trademark owner, with no intention of trademark infringement.

Third-party licenses

This product may contain or be derived from materials, including software, of
third parties. The third party materials may be subject to licenses, notices,
restrictions and obligations imposed by the licensor. The licenses, notices,
restrictions and obligations, if any, may be found in the materials accompanying
the product, in the documents or files accompanying such third party materials, in
a file named third_party_licenses on the media containing the product, or at
http://www.honeywell.com/ps/thirdpartylicenses.

Documentation feedback

You can find the most up-to-date documents on the Honeywell Process Solutions
support website at:

http://www.honeywellprocess.com/support

If you have comments about Honeywell Process Solutions documentation, send
your feedback to:

hpsdocs@honeywell.com

Use this email address to provide feedback, or to report errors and omissions in
the documentation. For immediate help with a technical problem, contact your
local Honeywell Technical Assistance Center (TAC).
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How to report a security vulnerability

For the purpose of submission, a security vulnerability is defined as a software
defect or weakness that can be exploited to reduce the operational or security
capabilities of the software.

Honeywell investigates all reports of security vulnerabilities affecting Honeywell
products and services.

To report a potential security vulnerability against any Honeywell product, please
follow the instructions at:

https://honeywell.com/pages/vulnerabilityreporting.aspx

Submit the requested information to Honeywell using one of the following
methods:

n Send an email to security@honeywell.com.
or

n Contact your local Honeywell Technical Assistance Center (TAC) listed in the
“Support” section of this document.

Support

For support, contact your local Honeywell Process Solutions Customer Contact
Center (CCC). To find your local CCC visit the website,
https://www.honeywellprocess.com/en-US/contact-us/customer-support-
contacts/Pages/default.aspx.

Training classes

Honeywell holds technical training classes that are taught by process control
systems experts. For more information about these classes, contact your
Honeywell representative, or see http://www.automationcollege.com.
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